Contents

Introduction to Project Controls ................................................................. 13
About this Guide .......................................................................................... 13
Components of Project Controls ................................................................. 15
Unifier Structure for Project Controls .......................................................... 17
  uDesigner ................................................................................................ 17
    Business Process Module .................................................................... 18
    Cost Manager Module ....................................................................... 18
    Resource Manager Module ............................................................ 18
    Schedule Manager Module .............................................................. 19
    Shell Manager Module ..................................................................... 19
    Portfolio Manager Module .............................................................. 19
  Data Structure Setup ............................................................................ 19
  Access Control ..................................................................................... 19
  User Administration .............................................................................. 19
  Configuration ........................................................................................ 20
  Standards & Libraries ........................................................................... 20
  Company Workspace ............................................................................. 20
  Templates or Shell Templates ............................................................. 21
  Reports .................................................................................................. 21
Setting up Project Controls ........................................................................... 23
Business Processes (BPs) and Project Controls ................................................. 23
  About Workflow BPs .......................................................................... 26
    Accessing the Workflow Progress Window .................................. 30
    Resolving Actions and Completion Policy ................................... 30
    Status ............................................................................................. 31
  About Non-Workflow BPs ..................................................................... 32
  Creating a BP Record ........................................................................... 33
    Business Process Type: Line Item or Cost ................................... 34
    Business Process Type: Document ................................................. 34
    Business Process Type: Text .............................................................. 36
    Comment ......................................................................................... 36
    Task Note ........................................................................................ 37
    Assign Users to the Next Step ...................................................... 37
  Opening an Existing BP Record ........................................................ 38
  About BP Forms .................................................................................. 38
Contents

Primavera Project Delivery Management (PPDM).......................................................... 71
Accessing PPDM........................................................................................................... 71
Using PPDM.................................................................................................................. 72
PPDM Reports ............................................................................................................... 73
PPDM Dashboards ........................................................................................................ 74
PPDM Business Processes ........................................................................................... 75
  Action Items Business Process ............................................................................... 77
  Purpose ..................................................................................................................... 77
  Characteristics ......................................................................................................... 77
  Roles .......................................................................................................................... 77
  Creating an Action Items Record ............................................................................ 77
  Revising an Action Items Record ............................................................................ 79
  Closing an Action Items Record .............................................................................. 79
  Architect/Engineer Daily Observations Business Process ....................................... 81
  Architect/Engineer Daily Observations Business Process Workflow ....................... 82
  Creating Architect/Engineer Daily Observations Record ....................................... 82
  Revising Architect/Engineer Daily Observations Record ....................................... 83
  Approving Architect/Engineer Daily Observations Record ..................................... 83
  Viewing Closed Architect/Engineer Daily Observations Record ............................ 83
  Architect's Supplemental Instructions Business Process .......................................... 85
  Architect's Supplemental Instructions Business Process Workflow ......................... 86
  Creating Architect's Supplemental Instructions Record ......................................... 86
  Revising Architect's Supplemental Instructions Record .......................................... 87
  Approving Architect's Supplemental Instructions Record ....................................... 87
  Viewing Closed Architect's Supplemental Instructions Record ............................. 87
  Correspondence Business Process .................................................................... 89
  Correspondence Workflow ..................................................................................... 90
  Creating a Correspondence Record ....................................................................... 90
  Revising a Correspondence Record ...................................................................... 92
  Approving a Correspondence Record ................................................................... 92
  Viewing a Closed Correspondence Record ........................................................... 92
  Daily Reports Business Process ..................................................................... 93
  Daily Reports Business Process Workflow .......................................................... 94
  Creating Daily Reports Record ............................................................................... 94
  Routing a Vendors Evaluations Record from the Approval Step ............................ 95
  Closing Daily Reports Record ............................................................................... 95
  Viewing Closed Daily Reports Record .................................................................. 95
  Design Change Request Business Process ......................................................... 97
  Design Change Request Business Process Workflow ............................................ 98
  Creating a Design Change Request Record ......................................................... 98
  Revising a Design Change Request Record ........................................................... 99
  Approving a Design Change Request Record ....................................................... 99
  Viewing a Closed Design Change Request Record ............................................... 99
  Design Reviews Business Process .................................................................. 101
  Design Reviews Workflow ..................................................................................... 102
  Creating a Design Reviews Record ....................................................................... 102
  Reviewing Design Reviews Record ...................................................................... 103
  Approving Design Reviews Record ..................................................................... 103
  Viewing Closed Design Reviews Record ............................................................. 104
  Incident Reports Business Process .................................................................. 105
  Incident Reports Business Process Workflow ....................................................... 106
Creating Incident Reports Record ........................................................ 106
Revising Incident Reports Record ........................................................ 107
Approving Incident Reports Record ...................................................... 107
Viewing Closed Incident Reports Record ................................................. 107

Lesson Learned Business Process ............................................................ 109
Creating a Lesson Learned Record ....................................................... 109
Viewing a Lesson Learned Record ........................................................ 110
Saving the Estimates Record .............................................................. 110

Meeting Minutes Business Process .......................................................... 111
Meeting Minutes Workflow ................................................................ 112
Creating a Meeting Minutes Record ...................................................... 112
Reviewing a Meeting Minutes Record .................................................... 114
Updating and Posting a Meeting Minutes Record ...................................... 115
Viewing a Closed Meeting Minutes Record .............................................. 115

Monthly Updates Business Process .......................................................... 117
Monthly Updates Business Process Workflow ........................................... 118
Creating Monthly Updates Record ........................................................ 118
Revising Monthly Updates Record ........................................................ 119
Approving Monthly Updates Record ...................................................... 119
Viewing Closed Monthly Updates Record .............................................. 119

Notices to Proceed Business Process ........................................................ 121
Notices to Proceed Business Process Workflow ........................................ 122
Creating Notices to Proceed Record ..................................................... 122
Revising Notices to Proceed Record ..................................................... 123
Approving Notices to Proceed Record ................................................... 123
Viewing Closed Notices to Proceed Record ............................................. 123

Project Closeout Business Process ........................................................... 125
Creating Project Closeout Record ........................................................ 125
Adding Line Items to the Payment Record ............................................. 126
Saving the Payments Record .............................................................. 126

Project Requests Business Process .......................................................... 127
Project Request Workflow ................................................................. 128
Creating a Project Requests Record ..................................................... 128
Routing a Project Requests Record ...................................................... 130

Punchlist Business Process .................................................................... 133
Punchlist Business Process ..................................................................... 134
Creating Punchlist Record ................................................................. 134
Revising Punchlist Record ................................................................. 135
Approving Punchlist Record ............................................................... 135
Viewing Closed Punchlist Record ......................................................... 135

Requests for Information (RFI) Business Process .......................................... 137
Requests for Information (RFI) Business Process Workflow........................ 138
Creating RFI .................................................................................. 138
Coordinating RFI ............................................................................. 138
Clarifying RFI ................................................................................. 139
Responding to RFI Clarification Request ................................................ 139
Sending for RFI for Technical Review ................................................... 140

Submittal Register Business Process ......................................................... 141
Additional Information ..................................................................... 141
Submittal Register Workflow .............................................................. 142
Creating a Submittal Register Record ................................................... 142
Adding a Submittals record to the Submittal Register Record ...................... 144
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linking a Submittals record to the Submittal Register Record</td>
<td>145</td>
</tr>
<tr>
<td><strong>Submittals Business Process</strong></td>
<td>147</td>
</tr>
<tr>
<td>Submittals Business Process Workflow</td>
<td>148</td>
</tr>
<tr>
<td>Creating a Submittals Record</td>
<td>148</td>
</tr>
<tr>
<td>Reviewing a Submittals Record</td>
<td>150</td>
</tr>
<tr>
<td>Approving a Submittals Record</td>
<td>151</td>
</tr>
<tr>
<td>View and Close Submittals Record</td>
<td>152</td>
</tr>
<tr>
<td><strong>Transmittals Business Process</strong></td>
<td>153</td>
</tr>
<tr>
<td>Transmittals Business Process Workflow</td>
<td>154</td>
</tr>
<tr>
<td>Creating a Transmittals Record</td>
<td>154</td>
</tr>
<tr>
<td>Revising a Transmittals Record</td>
<td>156</td>
</tr>
<tr>
<td>Approving a Transmittals Record</td>
<td>157</td>
</tr>
<tr>
<td>Viewing a Closed Transmittals Record</td>
<td>157</td>
</tr>
<tr>
<td><strong>Warranties Business Process</strong></td>
<td>159</td>
</tr>
<tr>
<td>Creating a Warranties Record</td>
<td>159</td>
</tr>
<tr>
<td>Revising a Warranties Record</td>
<td>160</td>
</tr>
<tr>
<td>Saving the Risk &amp; Issues Record</td>
<td>160</td>
</tr>
<tr>
<td><strong>Primavera Cost Controls (PCC)</strong></td>
<td>161</td>
</tr>
<tr>
<td>Accessing PCC</td>
<td>161</td>
</tr>
<tr>
<td>Using PCC</td>
<td>162</td>
</tr>
<tr>
<td>Setting Up PCC (Administrators)</td>
<td>162</td>
</tr>
<tr>
<td>Setting Up Module Permissions</td>
<td>163</td>
</tr>
<tr>
<td>Adding Users to the Company</td>
<td>164</td>
</tr>
<tr>
<td>Creating a Project From the Project Template</td>
<td>164</td>
</tr>
<tr>
<td>Assigning Users to Projects and Groups</td>
<td>164</td>
</tr>
<tr>
<td>Setting Up Company-level and Project-level Cost Sheets</td>
<td>165</td>
</tr>
<tr>
<td>Defining Cost Code Structure</td>
<td>167</td>
</tr>
<tr>
<td>Setting Up Project Templates: Cost Sheet Template</td>
<td>168</td>
</tr>
<tr>
<td>Adding Cost Codes to Cost Sheet Templates Manually</td>
<td>168</td>
</tr>
<tr>
<td>Adding Cost Codes to Cost Sheet Templates by Importing</td>
<td>169</td>
</tr>
<tr>
<td>Setting Up Project Templates: Schedule Sheet Template</td>
<td>171</td>
</tr>
<tr>
<td>Adding an Activity to a Schedule Sheet Template</td>
<td>172</td>
</tr>
<tr>
<td>Associating a Dependency with an Activity</td>
<td>173</td>
</tr>
<tr>
<td>Exporting Schedule Files</td>
<td>174</td>
</tr>
<tr>
<td>Importing Schedule Files</td>
<td>174</td>
</tr>
<tr>
<td>Defining Data Mapping</td>
<td>175</td>
</tr>
<tr>
<td>Copying an Activity from another Schedule Sheet</td>
<td>178</td>
</tr>
<tr>
<td>Configuring the Resource Manager and Creating a Role</td>
<td>178</td>
</tr>
<tr>
<td>Setting Up Project Templates: Funding Sheet</td>
<td>180</td>
</tr>
<tr>
<td>Adding Funding Codes to Funding Sheet</td>
<td>182</td>
</tr>
<tr>
<td>Importing Fund Details via CSV Files</td>
<td>182</td>
</tr>
<tr>
<td>Changing the Set Up of PCC Business Processes (BPs)</td>
<td>183</td>
</tr>
<tr>
<td>BP General Tab</td>
<td>184</td>
</tr>
<tr>
<td>BP Settings Tab</td>
<td>184</td>
</tr>
<tr>
<td>BP Notification Tab</td>
<td>185</td>
</tr>
<tr>
<td>BP Auto Creation Tab</td>
<td>186</td>
</tr>
<tr>
<td>Setting Up Queries for Auto Creation</td>
<td>188</td>
</tr>
<tr>
<td>BP Record Copy Tab</td>
<td>190</td>
</tr>
<tr>
<td>Changing the Set Up of PCC Business Processes (BPs) Workflows</td>
<td>191</td>
</tr>
<tr>
<td>Setting Up PCC (Users)</td>
<td>200</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----</td>
</tr>
<tr>
<td>PCC Business Processes</td>
<td>201</td>
</tr>
<tr>
<td>Blanket Purchase Orders (BPO) Business Process</td>
<td>203</td>
</tr>
<tr>
<td>Creating a Blanket Purchase Order Record</td>
<td>204</td>
</tr>
<tr>
<td>Upper Form</td>
<td>204</td>
</tr>
<tr>
<td>Item Logs</td>
<td>205</td>
</tr>
<tr>
<td>Adding Line Items</td>
<td>205</td>
</tr>
<tr>
<td>Line Item Table</td>
<td>206</td>
</tr>
<tr>
<td>Saving the BPO Record</td>
<td>206</td>
</tr>
<tr>
<td>Viewing the Blanket Purchase Order Record Summary Sheet</td>
<td>206</td>
</tr>
<tr>
<td>Budget Approvals Business Process</td>
<td>209</td>
</tr>
<tr>
<td>Budget Approvals Workflow</td>
<td>210</td>
</tr>
<tr>
<td>Creating a Budget Approvals Record</td>
<td>211</td>
</tr>
<tr>
<td>Upper Form</td>
<td>211</td>
</tr>
<tr>
<td>Item Logs</td>
<td>212</td>
</tr>
<tr>
<td>Routing a Budget Approvals Record from the Approval Step</td>
<td>213</td>
</tr>
<tr>
<td>Routing a Budget Approvals Record from the Revision Step</td>
<td>214</td>
</tr>
<tr>
<td>Viewing a Budget Approvals Record on the End Step</td>
<td>215</td>
</tr>
<tr>
<td>Budget Changes Business Process</td>
<td>217</td>
</tr>
<tr>
<td>Budget Changes Workflow</td>
<td>218</td>
</tr>
<tr>
<td>Creating a Budget Changes Record</td>
<td>218</td>
</tr>
<tr>
<td>Upper Form</td>
<td>219</td>
</tr>
<tr>
<td>Item Logs</td>
<td>220</td>
</tr>
<tr>
<td>Routing a Budget Changes Record from the Approval Step</td>
<td>221</td>
</tr>
<tr>
<td>Routing a Budget Changes Record from the Revision Step</td>
<td>222</td>
</tr>
<tr>
<td>Viewing a Budget Changes Record on the End Step</td>
<td>223</td>
</tr>
<tr>
<td>Budget Transfers Business Process</td>
<td>225</td>
</tr>
<tr>
<td>Budget Transfers Workflow</td>
<td>226</td>
</tr>
<tr>
<td>Creating a Budget Transfers Record</td>
<td>226</td>
</tr>
<tr>
<td>Upper Form</td>
<td>228</td>
</tr>
<tr>
<td>Item Logs</td>
<td>228</td>
</tr>
<tr>
<td>Routing a Budget Transfers Record from the Approval Step</td>
<td>229</td>
</tr>
<tr>
<td>Routing a Budget Transfers Record from the Revision Step</td>
<td>230</td>
</tr>
<tr>
<td>Viewing a Budget Transfers Record on the End Step</td>
<td>231</td>
</tr>
<tr>
<td>Change Orders Business Process</td>
<td>233</td>
</tr>
<tr>
<td>Change Orders Workflow</td>
<td>235</td>
</tr>
<tr>
<td>Creating a Change Orders Record</td>
<td>235</td>
</tr>
<tr>
<td>Upper Form</td>
<td>236</td>
</tr>
<tr>
<td>Item Logs</td>
<td>238</td>
</tr>
<tr>
<td>Routing a Change Orders Record from the Approval Step</td>
<td>239</td>
</tr>
<tr>
<td>Routing a Change Orders Record from the Revision Step</td>
<td>240</td>
</tr>
<tr>
<td>Viewing a Change Orders Record on the End Step</td>
<td>241</td>
</tr>
<tr>
<td>Contracts Business Process</td>
<td>243</td>
</tr>
<tr>
<td>Contracts Workflow</td>
<td>245</td>
</tr>
<tr>
<td>Creating a Contracts Record</td>
<td>245</td>
</tr>
<tr>
<td>Upper Form</td>
<td>246</td>
</tr>
<tr>
<td>Item Logs</td>
<td>248</td>
</tr>
<tr>
<td>Routing a Contracts Record from the Approval Step</td>
<td>249</td>
</tr>
<tr>
<td>Routing a Contracts Record from the Revision Step</td>
<td>250</td>
</tr>
</tbody>
</table>
Contents

Viewing a Contracts Record on the End Step ................................................. 251

Estimates Business Process ......................................................................... 253
  Creating an Estimates Record..................................................................... 254
  Upper Form.............................................................................................. 254
  Adding Line Items to the Estimates Record ............................................. 255
  Line Item Table...................................................................................... 255
  Saving the Estimates Record .................................................................. 256

Fund Appropriations Business Process ...................................................... 257
  Fund Appropriations Workflow............................................................ 258
  Creating a Fund Appropriations Records ................................................ 258
  Upper Form.............................................................................................. 259
  Item Logs ............................................................................................... 260
  Routing a Fund Appropriations Record from the Approval Step ............ 260
  Routing a Fund Appropriations Record from the Revision Step ............. 261
  To view a Fund Appropriations record on the End step .......................... 263

Invoices Business Process ......................................................................... 265
  Invoices Workflow................................................................................. 267
  Creating an Invoices Record .................................................................. 267
  Upper Form.............................................................................................. 268
  Item Logs ............................................................................................... 270
  Routing an Invoices Record from the Approval Step .............................. 271
  Routing an Invoices Record from the Revision Step ................................ 272
  Viewing an Invoices Record from the End Step ..................................... 273

Journal Entries Business Process ............................................................ 275
  Journal Entries Workflow ..................................................................... 276
  Creating a Journal Entries Record ....................................................... 277
  Item Logs ............................................................................................... 278
  Routing a Journal Entries Record from the Approval Step ................. 278
  Routing a Journal Entries Record from the Revision Step ................... 279
  Viewing a Journal Entries Record on the End Step .............................. 281

New User Requests Business Process ...................................................... 283
  New User Requests Workflow.............................................................. 284
  Creating a New User Requests Record ................................................ 284
  Upper Form.............................................................................................. 285
  Routing a New User Requests Record from the Approval Step ............ 286
  Routing a New User Requests Record from the Revision Step ............. 287
  Viewing a New User Request on the End Step ...................................... 287

Payment Applications Business Process .................................................. 289
  Payment Applications Workflow.......................................................... 291
  Creating a Payment Applications Record .......................................... 291
  Upper Form.............................................................................................. 292
  Item Logs ............................................................................................... 295
  Routing a Payment Applications Record from the Approval Step ......... 297
  Routing a Payment Applications Record from the Revision Step ......... 298
  Viewing a Payment Applications Record on the End Step .................... 299

Payments Business Process ...................................................................... 301
  Creating a Payments Record ............................................................... 302
  Upper Form.............................................................................................. 302
  Adding Line Items to the Payment Record .......................................... 304
  Line Item Table...................................................................................... 304
  Saving the Payments Record ............................................................... 305
PO Amendments Business Process ................................................................. 307
PO Amendments Workflow ............................................................................. 308
Creating a PO Amendments Record............................................................. 309
Upper Form ................................................................................................... 310
Item Logs ...................................................................................................... 312
Routing a PO Amendment Record from the Approval Step ......................... 312
Routing a PO Amendment Record from the Revision Step .......................... 314
Viewing a PO Amendment Record on the End Step ................................... 315

Potential Change Orders Business Process .................................................. 317
Potential Change Orders Workflow ............................................................... 318
Creating a Potential Change Orders Record .................................................. 318
Upper Form ................................................................................................... 319
Item Logs ...................................................................................................... 321
Routing a Potential Change Orders Record from the Approval Step .............. 322
Routing a Potential Change Orders Record from the Revision Step ............... 323
Viewing a Potential Change Orders Record on the End Step ........................ 324

Purchase Orders Business Process ............................................................... 325
Purchase Orders Workflow ........................................................................... 326
Creating a Purchase Orders Record ............................................................... 327
Upper Form ................................................................................................... 328
Item Logs ...................................................................................................... 329
Routing a Purchase Orders Record from the Approval Step ......................... 330
Routing a Purchase Orders Record from the Revision Step .......................... 331
Viewing a Purchase Orders Record on the End Step ................................... 332

Requests for Bid Business Process ............................................................... 335
Requests for Bid Workflow ........................................................................... 336
Creating a Requests for Bids Record ............................................................. 337
Prerequisites ................................................................................................. 337
Upper Form ................................................................................................... 337
Item Logs ...................................................................................................... 339
Routing a Requests for Bid Record from the Bid Package Finalization Step ...... 340
Routing a Requests for Bid Record from the Package Revision Step ............... 340
Inviting Bidders to Submit a Bid ................................................................. 341
Submitting a Bid .......................................................................................... 342
Adding an Attachment to a Bid ................................................................. 343
Opening a Bid Draft ..................................................................................... 344
Withdrawing a Bid ....................................................................................... 344
Resubmitting a Withdrawn Bid ................................................................. 345
Communicating Bid Information Via uMail ............................................... 345
Comparing Vendors’ Bids .......................................................................... 345

Requests for Substitution Business Process .................................................. 349
Requests for Substitution Work Flow ........................................................... 350
Creating a Requests for Substitution Record ................................................. 350
Upper Form ................................................................................................... 351
Item Logs ...................................................................................................... 353
Routing a Requests for Substitution Record from the Approval Step ............ 354
Routing a Requests for Substitution Record from the Revision Step ............. 355
Viewing the Requests for Substitution on the End step ............................... 356

Risks & Issues Business Process ................................................................. 357
Publishing Documents ................................................................................... 356
Contents

Creating a Risks & Issues Record ................................................................. 358
Upper Form .................................................................................................... 358
Item Logs ....................................................................................................... 360
Adding Line Items to the Risks & Issues Record ........................................... 360
Line Item Table ............................................................................................ 360
Saving the Risk & Issues Record ................................................................. 361

Timesheets Business Process .................................................................. 363
Timesheets Workflow .................................................................................. 364
Creating a Timesheets Record .................................................................... 364
Upper Form .................................................................................................... 365
Item Logs ....................................................................................................... 367
Routing a Timesheets Record from the First Save as Draft Step .................. 368
Routing a Timesheets Record from the Second Save as Draft Step .......... 369
Routing a Timesheets Record from the Review Step ..................................... 370
Viewing the Timesheets Record on the End Step ......................................... 370

Vendor Prequal Requests Business Process .............................................. 371
Vendor Prequal Requests Workflow ............................................................. 372
Creating a Vendor Prequal Requests Record ............................................. 372
Upper Form .................................................................................................... 373
Routing a Vendor Prequal Requests Record from the Approval Step ............ 375
Routing a Vendor Prequal Requests Record from the Revision Step ............. 376
Viewing a Vendor Prequal Requests Record on the End Step ....................... 377

Vendors Business Process ......................................................................... 379
Creating a Vendors Record Manually ......................................................... 380
Upper Form .................................................................................................... 380
Item Logs ....................................................................................................... 382
Adding Line Items ........................................................................................ 382
Line Item List Table ..................................................................................... 383
Saving the Vendors Record ........................................................................ 383

Vendors Evaluations Business Process ................................................... 385
Vendors Evaluations Workflow ................................................................. 386
Creating a Vendors Evaluations Record ...................................................... 386
Upper Form .................................................................................................... 387
Routing a Vendors Evaluations Record from the Approval Step ................. 389
Routing a Vendors Evaluations Record from the Revision Step .................... 390
Viewing a Vendors Evaluations Record on the End Step ............................ 390

Work Releases Business Process ............................................................... 393
Work Releases Business Process Workflow ................................................. 394
Creating a Work Releases Record ............................................................... 394
Upper Form .................................................................................................... 395
Routing a Work Releases Record from the Approval Step ............................ 396
Routing a Work Releases Record from the Revision Step ............................ 397
Viewing a Work Releases Record on the End Step ....................................... 398

For More Information ................................................................................. 399
Where to Get Documentation ....................................................................... 399
Where to Get Training ................................................................................ 406
Where to Get Support .................................................................................. 406
Additional Support ...................................................................................... 407

Legal Notices ............................................................................................... 410
Introduction to Project Controls

Primavera Unifier Project Controls base product consist of the following three components:

- Primavera Capital Planning (PCP)
- Primavera Project Delivery Management (PPDM)
- Primavera Cost Controls (PCC)

A suite of business processes (BPs) associated with each component is available for use in Unifier. These BPs are designed and configured for your use. Depending on your permission status, you can access all available BPs in the following locations (in the left-pane Navigator), based on the default setup of Unifier:

- Logs node: in your Project/Shell tab (User Mode)
- Company Logs node: in Company Workspace tab (User Mode)

**Note:** The project administrator can set up the structure of the items in the Navigator. Depending on the project administrator’s business process setups, the three components (PCP, PPDM, and PCC) may appear inside individual folders in the Navigator.

About this Guide

This guide provides details about the following components of Unifier Project Controls base product:

- Primavera Capital Planning (PCP)
- Primavera Project Delivery Management (PPDM)
- Primavera Cost Controls (PCC)

**Notes:**

- Information common to all components appear at the beginning sections of this guide.
- Before you use the Project Controls base product, you need to prepare and configure the data that you need for using each component, in Unifier. Refer to the *Primavera Unifier User’s Guide* for instructions on how to prepare and configure the necessary data.

This guide also explains how to:

- Create a business process record
Use the business processes

**Note:** The information in this guide is based on the default setup of Unifier.

To learn how to use Unifier, refer to the *Primavera Unifier User's Guide* for details.

To learn how to use uDesigner, refer to the *Primavera uDesigner User's Guide* for details.

To learn about the Administration mode and administration features, refer to the *Primavera Unifier Administration Guide* for details.

See the "For More Information" chapter in this guide for details on Unifier documentation, training, and support.

For the most up-to-date versions of all manuals and technical documents related to installing, administering, and using Primavera Unifier, go to Oracle Primavera Unifier Documentation Library (http://www.oracle.com/technetwork/documentation/default-1870233.html).
Components of Project Controls

With the Project Controls base product, you receive the following components:

- Capital Planning: See the *Primavera Capital Planning (PCP)* (on page 46) chapter in this guide.
- Cost Controls: See the *Primavera Cost Controls (PCC)* (on page 161) chapter in this guide.
- Project Delivery Management: See the *Primavera Project Delivery Management (PPDM)* (on page 71) chapter in this guide.
- Selected platform structure to support the included business processes and shells: See the *Unifier Structure for Project Controls* (on page 17) section in this guide.
- A suite of business processes that work together to accomplish the tasks: See the following sections in this guide:
  - *Business Processes (BPs) and Project Controls* (on page 23)
  - *PPDM Business Processes* (on page 75)
- Preset company-level and shell-level groups to which you will assign users.
- A suite of reports to keep you abreast of project status: See the *Unifier Structure for Project Controls* (on page 17) section in this guide.

---

**Notes:**

- The instructions in this guide are only applicable if you have prepared and configured the necessary data that you need for using the Project Controls base product.
- Before using the Project Controls base product, check with your Administrator to ensure that your Administrator has created a "Projects" shell using the PROJECT TEMPLATE (*Templates > Shells > Projects > PROJECT TEMPLATE*).
- Before you continue, set your preferences in Unifier. Refer to the *Primavera Unifier User's Guide* for details.
Unifier Structure for Project Controls

The following nodes contain necessary components and are available for Project Controls.

- uDesigner
- Data Structure Setup
- Access Control
- User Administration
- Configuration
- Standards & Libraries
- Company Workspace
- Templates or Shell Templates
- Reports

You can use these nodes to make other changes to the Project Controls business process forms, workflows, rules, cash flows, data cubes, and data structure; however, we do not recommend using these features until you are familiar with Primavera Unifier and how it works.

The following sections provide information about each node (and their respective modules) that have been set up for Project Controls operation.

In This Section

uDesigner ................................................................................................................ 17
Data Structure Setup ............................................................................................... 19
Access Control ........................................................................................................ 19
User Administration ................................................................................................. 19
Configuration ........................................................................................................... 20
Standards & Libraries .............................................................................................. 20
Company Workspace .............................................................................................. 20
Templates or Shell Templates ................................................................................. 21
Reports ..................................................................................................................... 21

uDesigner

You can access the uDesigner node from the Company Workspace tab (Administration Mode), if you have the appropriate permissions.
Note: The uDesigner node is a design tool for those customers who want to create and publish their own customized shells, managers, and business processes. This guide explains the features of the business processes that have been set up for Project Controls operation and does not include instructions on how to use the uDesigner node. Refer to the Primavera Unifier uDesigner User's Guide for detailed instructions on how to use the uDesigner node.

The uDesigner node contains the following modules that have been set up for Project Controls operation:

- Business Process
- Cost Manager
- Resource Manager
- Schedule Manager
- Shell Manager
- Portfolio Manager

The modules are designed and set up for use with Project Controls. Refer to the Primavera uDesigner User's Guide if you need to change the fields in any of the forms within each node or modules.

The following sections provide information about the modules that are included in uDesigner node.

**Business Process Module**

This module contains a suite of business processes.

**Cost Manager Module**

This module contains these forms:

- A Cost Attributes form to set up the cost sheet
- A Fund Attributes form to set up funding and the funding sheet

**Resource Manager Module**

This module contains a Role Attributes form to specify the roles necessary to perform the project work, such as crane operator, industrial crane, or steel.

In the Resource Manager you can create and manage roles that you can assign to schedule sheet activities. A role can be virtually anything, for example, a role can be a job title, or it can be a piece of machinery. Each role can have its own role rate.

The Resource Manager is set up with a role attribute form that is linked to the Schedule Manager for the purpose of populating activities on the Schedule Sheet with roles for the work to be done on the project.
Unifier Structure for Project Controls

Schedule Manager Module

This module contains these forms:
- An Activity Attributes form (necessary to set up the schedule)
- A Resource Activity form for assigning a resource type and a role to an activity

For the purpose of populating activities on the Schedule Sheet with roles for the work to be done on the project, the Resource Manager is set up with a role attribute form that is linked to the Schedule Manager.

Shell Manager Module

This module contains the following shells:
- An anchor shell called All Projects
- A project shell called Projects

Portfolio Manager Module

This module contains a Capital Projects portfolio and a Capital Planning attribute (detail) form that sets up the manager.

Data Structure Setup

This node contains these modules:
- Data Cube Definitions
- Data Views

You can also use the Data Structure Setup node to make changes to a data cube or data view definition for reports and dashboards. Refer to the Primavera Unifier Administration Guide for details.

Access Control

Use this node to grant:
- Administrative and user permissions to users and groups
- Permissions to your company users and groups so they can work in different areas in Unifier

User Administration

Use this node to:
- Add users to Unifier and assign users to groups so they have access to Project Controls.
- Access the following groups, which have a set of default permissions, also:
  - All Company Users: To include the user in an umbrella group for Company-level permissions to both the:
- Document Manager
- Company-level business processes
  - Company Administrators: To identify the users as company administrators
  - Creator: To identify the users as the creator of a business process, report, etc.
  - Project Administrators: To identify the users as project administrators
  - Reviewer: To identify the users as reviewers, usually on a workflow step for a business process or a drawing or document in the Document Manager

### Configuration

This node, and the following subordinate nodes, contain settings configured for Project Controls:
- Business Processes
- Shell Manager (including All Projects and Projects)
- Portfolio Manager > Capital Projects

The Configuration node also includes the Custom Reports and the User Mode Navigator. You can use the Configuration node to make changes to the configuration of the Business Processes, Shell Manager, and Portfolio Manager. Refer to the *Primavera Unifier Administration Guide* for details.

### Standards & Libraries

This node, and the following subordinate nodes, contain the following data for Project Controls:
- Cash Flow > Data Sources
- Cash Flow > Distribution Profiles
- Period Structure with a January to December Planning Period

You can also use the Standards & Libraries node to make changes to cash flow data sources, cash flow data distribution profiles, or planning period for the portfolio. Refer to the *Primavera Unifier Administration Guide* for details.

### Company Workspace

This node, and the following subordinate nodes, contain settings already configured for Project Controls:
- Business Processes
- Report (visible in User Mode)

You can also use the Company Workspace node to make changes to the:
- Setup of company-level business processes
- Automatic update of active-project statuses
- Setup of company-level reports

Refer to the *Primavera Unifier Administration Guide* for details.
Templates or Shell Templates

This node, and the following subordinate nodes, contain the following data for Project Controls:

- Costs Sheet > Project Cost Sheet
- Funding > Funding Sheet > Funding Sheet
- Schedule of Values > General Spends SOV
- Schedule of Values > Payment Applications SOV
- Schedule Sheets > Project Schedule Sheet
- Access Control
- User Administration > Users (default user: Coadmin)
- User Administration > Groups (shell level group permissions for All Project Users, Creator, Project Administrators, Reviewer)
- Setup > Business Processes
- Setup > Dashboards > Project Delivery
- Cost Manager > Cash Flow
- Document Manager > Documents (contains a default folder structure)
- Document Manager > Project Documents (contains a default folder structure)
- Reports > User-Defined

You can also use the Templates or Shell Templates node to change:

- A Cost Manager with a capital planning cash flow
- The access control to project functions for users and groups
- The user/group administration to add and manage project users and groups
- The business processes that you want to automatically include in the project
- A dashboard to display project information on the shell landing page
- A Document Manager to store drawings, spreadsheets, image files, specifications, and other project documentation
- The reports specific to Primavera Project Delivery
- The Project cost sheet
- The Funding sheet
- The Schedule of Values (SOV)
- The Project schedule sheet
- The Rules for cost calculations

Refer to the Primavera Unifier Administration Guide for more details.

Reports

The Reports node is designed and set up for use with Project Controls.
Reports (Company Workspace-User mode)

The Reports node, depending on the level of your permission, includes the User-Defined module containing User-Defined Reports (UDRs).

Reports (Shell-User mode)

The Reports node, depending on the level of your permission, includes the following modules containing reports pertaining to each category.

- User-Defined
- Custom
- System

**Note**: The Custom and System modules are accessible if you have BI server connection, only.
The Project Controls, which includes the Primavera Capital Planning (PCP), Primavera Project Delivery Management, and Primavera Cost Controls (PCC), can be used after an initial setup.

**Note**: Before you use the Project Controls base product, you need to prepare and configure the data that you need for using each component, in Unifier. Refer to the Primavera Unifier User’s Guide for instructions on how to prepare and configure the necessary data.

The following lists the features that need to be set up after you sign in to Unifier. Refer to the Primavera Unifier User’s Guide for information about signing in and out of Unifier. For details on how to set up these features, refer to the Primavera Unifier Administration Guide.

a) Add users to the company  
b) Assign users to the preconfigured groups  
c) Create a project using project template  
d) Add users to the project  
e) Assign users to the preconfigured groups in the project

### Business Processes (BPs) and Project Controls

Business processes (BPs) manage the flow of information, drive transactions and collaboration, and can be associated with specific projects or applicable to the entire company.

For details on how to develop a new business process (BP), refer to the Primavera uDesigner User’s Guide.

Each component of the Project Controls base product has a suite of specific BPs. See the following sections in this guide for details:

- **PPDM Business Processes** (on page 75)  
- **PCC Business Processes** (on page 201)

**Note**: The Primavera Capital Planning (PCP) does not have pre-defined BPs.

In general, a BP consists of forms, workflows, and logs.
Forms

Forms are electronic versions of paper forms, used to enter or review data and to respond to tasks. Most BP forms consist of three major sections:

- Header or upper form: Present in all BP types
- Action (or task) details: Present only in workflow BPs
- Form content or lower form: Changes based on BP type and design

Workflows

Workflows define the routing and behavior that represents an organization’s decision-making process.

A BP workflow specifies how the BP should proceed (from start to finish) and consist of steps connected by links:

- Step: Each step is associated with one or two forms that govern step behavior.
- Link: Connects steps in a business process. It defines record routing and status, based on the design of the workflow. (A record is an instance of a business process after it is routed from the creation step to the next workflow step.)

When you participate in a BP workflow, you are taking action on the form (for example, reviewing and approving an invoice, or responding to a request for information). Depending upon the workflow setup, you may choose the next recipient of the BP in the workflow, or this may be automatically selected for you. When you send the BP to the next step, it proceeds along the workflow and records each action taken at each step.

Logs

BPs are stored in Logs, accessible through the Navigator. You can think of Logs as a filing cabinet with multiple drawers.

Each BP (drawer) listed under Logs has its own log which displays (on the right-hand pane) a list of records (instances or forms) for that particular BP.

To access an existing record within a particular BP you need permission. This applies to the records that you have created and the records that other users have created.

By default, you can access the records that you have created. If you have been included in the workflow of a record (recipient, assignee, copied, etc.), you can access that record, as well.

The following are the common BP types:

- Simple: Add company or project information that does not require line items. For example, project information, vendors, and service requests.
- Line item: Use to document miscellaneous information for a project or company. For example, use a meeting minutes business process to capture the minutes of all team meetings, with each line item generating an action item for a team member.
- Document: Route documents for review. Document business process is an extension of the line item type; its line items display file attachments. Examples are submittals and transmittals.
- Text: Enter comments and view an audit trail of communication between workflow participants. For example, action items, Request for Information (RFI), and issue resolution BPs.
Workflow and non-workflow business processes

A business process type can include a workflow or several workflows. A workflow business process represents a set of coordinated tasks and activities that accomplish a specific business goal. For example, a workflow BP is used to create a contract and then manage changes to the contract, such as approvals for increases in labor costs and materials.

Some BP types have a single purpose of storing data. These BP types are often data entry forms designed to enter information directly into Unifier and are referred to as non-workflow business processes. A non-workflow business process is used to manage data. For example, a non-workflow business process is used to store information about vendors (Vendors BP).

Since there is no workflow, non-workflow BPs do not contain the middle Action (or Task) Details section.

There are several ways to create a non-workflow BP record after all required fields have been completed:
- Click Finish Editing
- Click Save (This does not create a draft, as seen in a workflow business processes.)
- Add a line item
- Add general comments

Business process (BP) record

A BP record is created when a form in the workflow is sent to the next person, generating a task. Creating a new BP record typically involves the following steps:
- Click New
- Complete the form
- Select Workflow Action
- Assign recipients
- Click Send

You can create a BP record and generate a task in these areas:
- Business process logs
- Tasks log
- Master Log in the Home tab
- Document Manager

Responding to Tasks

These are the typical steps in working with tasks:
- Review the task before accepting it
- Respond to the task
- Route the record to the next workflow step

Each workflow step, except Creation and End, has two phases: Review and Response, separated by the Accept Task action.

The Review phase displays a read-only view form. Examine the entire view form to:
Understand how the task came to the recipient
Decide to accept or decline the task
Identify pre-work needed to complete the task
Prioritize work

The *Response* phase presents an active action form:
- Accept the task
- Enter data
- Select the appropriate workflow action
- Add task and message recipients
- Attach files, and possibly linking other records or mail
- Add comments or notes
- Send the record to the next step

When *routing* a section:
- Select **Workflow Action**
- Assign recipients
- Click **Send**

**Routing to the End Step**

The End step denotes the end of a workflow. If the End step is a view form, you cannot take action -- all forms are read-only.

An End step can also be associated with an action form where some fields are editable.

**About Workflow BPs**

Workflow BPs utilize Unifier workflow engine to route a record to another step in the workflow. Record status on a step is part of the business process design. Workflow step settings define who can participate on a step. Most workflow business processes in the PCC route a record through an approval process that follows these steps:
- Creation Step
- Approval Step
- Revision Step
- End Step
Each step in the workflow is set up individually. Step-by-step, the administrator can define responsibilities for users and groups through task assignments, completion policies and resolving action settings, and email notification settings. Non-administrative users can complete business process forms, select Workflow Actions, and assign task recipients. They can track business process routing between steps and trace a record's path through the workflow.

In the workflow example above, the Creator fills out the business process form and sends it for approval. The act of sending the form creates a permanent record and a task for the Approval step assignee.

Depending on the step the task is on, there are different Workflow Action selections. For example, Workflow Actions from the Approval step include:

- **Approve** — This Workflow Action routes the record to the End step in Approved status.
- **Reject** — This Workflow Action routes the record to the End step in Rejected status.

Workflow Actions from the Revision step include:

- **Send for Revision** — This Workflow Action routes the record back to the Approval step in Pending status.
- **Resubmit for Approval** — This Workflow Action routes the record back to the Approval step in Pending status.
- **Cancel** — This Workflow Action routes the record to the End step in Canceled status.

Workflow business process forms consist of:

- An Upper form
- Task Details (visible before task acceptance)
- Action Details (visible after task acceptance)
  
  Note that Non-workflow business processes do not have an Action Details section.
- Line Item Details, unless otherwise noted.
You can minimize and later expand a business process form. For example, you might want to minimize the General and workflow portions of the form to avoid scrolling through many line items.

**Toolbar**: The workflow business process form has a toolbar at the top of the form, with the following buttons:

![Toolbar Image]

After you are done working on the business process form, click **Send** to route the workflow business process to the specified recipients. You can click **Save** to save a draft of the form, so you can work on it again. Click **Spelling** to check the spelling in your form. You can click **Add Attachment** to add attachments to the form. If the BP is designed to include discussions among members of a group, you can click **Discussion** to open a discussion forum. When you have completed work on the business form, click **Close Window**.

**Note**: The Close Window action does not save the information on the form. To save the information, you must click **Save** before you click the **Close Window** button.

**Upper Form**: The upper portion of the business process contains the basic (General) information that the form is managing, such as the name of the record and its description, who created the record and when, and other general information. It may also contain fields for referencing other forms, and it may contain fields that are required for specific functionality. This is an example of an upper form for a business process type called Work Orders:
**Workflow or Action Details:** This section appears in the middle part of workflow business processes. It is for viewing or assigning the next assignee in the workflow or shows the last person who took action on it. Depending on how the workflow has been set up for the BP, the next assignees may be predetermined, or you may be able to choose the next assignee or send a copy of the BP to another user. You can print the Workflow Progress using custom print.

Non-workflow business processes do not have an Action Details section.

This is an example of the Action Details section of a business process.

- Track a step through the workflow by clicking "Click here" to view latest content.
- Add task assignees and message recipients via the To: and Cc: buttons, which are active after you select a workflow action.
  - The Workflow Actions drop-down menu is in the upper right corner of the form.
- Click the notepaper icon next to **Task Notes** in the Action Details section to add notes to the routed task. These are notes for the task recipients.

**Line Items List:** The lower portion of the form contains record details, such as line items, file attachments for document-type business processes such as transmittals or submittals, or comments or instructions in text-type BPs such as RFIs. Simple-type BPs do not have a Line Item List section.

Line Item type and Cost type business processes can have up to eight tabs in their Line Items List.

Tip: If the entire name is too long to appear on the tab, hover the mouse over the tab. Unifier will display the complete name in a tool tip.

There are buttons under the Line Item List that enable you to work with line items:

- **Add** button — Use this button to add detail or summary line items to the record.
- **Copy** button — Use this button to copy another line item from the record, included consolidated line items.
- **Import** button — Use this button to import a line item from a CSV file.
- **Remove** button — Use this button to delete a line item from the record.
Grid button — Use this button to enter line items directly into the line item list. (This is best used for short line items.)
Find button — Use this button to locate a line item in a long list of line items.

Links at the bottom of the business process form allow you to view, attach, or link files, records, comments, or uMail.

Refer to the Primavera Unifier User's Guide for more information about workflow BPs.

Accessing the Workflow Progress Window

In the Workflow Progress window you can see:

- The step you are currently on — in this case Approval
- The Completion Rule for that step — in this case any user who was assigned the task can accept and take action on that task
- The record status — in this case In Progress
- An image of the workflow by clicking View Graphic

Resolving Actions and Completion Policy

A resolving action moves the step to either a following step, a previous step, or a conditional step that essentially "re-addresses" or "revisits" the task. This step must be completed before the workflow can continue. The assignees on this resolving action step can include the original task assignees and can also include new assignees.
Your administrator sets a "completion policy" on each step in a workflow. This policy determines when the step is complete and where the step proceeds from there. A step can be complete under the conditions listed below.

- **Single** completion policy: Any single user can accept a task and complete it, and the record will move forward to the next step.
- **All-majority** completion policy: All assignees to the task have responded to it and a majority has agreed on the action that moves the record forward to the next step. If there is no clear majority on the action, Unifier will use a *resolving action* to determine how the record moves forward.
- **All-consensus** completion policy: All assignees to the task have responded to it and all assignees have agreed on the action that moves the record forward to the next step. If there is no consensus on the action, Unifier will use a *resolving action* to determine how the record moves forward.

### Status

The Status conditions you see on the "Tasks for the selected step" window are internal to Unifier and are used only to display the status of the workflow step *relative to the completion policy*.

The Status conditions are:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Started</td>
<td>The assignee has not accepted the task.</td>
</tr>
<tr>
<td>In Progress</td>
<td>The assignee has accepted the task.</td>
</tr>
<tr>
<td>Locked</td>
<td>This status is used when the step has a single completion policy and one of the assignees accepted the task. This status denotes those assignees who were also assigned to the task, but because of the single completion policy, the task was locked and these assignees no longer have access to it.</td>
</tr>
<tr>
<td>View Only</td>
<td>This status indicates that this user was cc'd on the task, but is not expected to take action on the task.</td>
</tr>
<tr>
<td>Complete d</td>
<td>This status is given to an assignee’s action if the task was finished and needed no resolving action. At any step, a task can have only one status of &quot;Completed.&quot;</td>
</tr>
<tr>
<td>Closed</td>
<td>This status is given to an assignee’s action if the task was finished, but triggered a resolving action. The task will either return to a previous step, move forward to a next step, or divert to a conditional step, which will resolve the condition and move the task forward in the workflow. The step the action moves to for resolution will show a status of &quot;Not Started.&quot; The number of times the task shows a &quot;Closed&quot; status indicates the number of times the step has been revisited.</td>
</tr>
</tbody>
</table>

To illustrate:
### About Non-Workflow BPs

Non-workflow business processes store data and do not have routing capability. As with all business processes they have an upper form and may, or may not, have line items. You can use them when you need to access a single source for your data. Non-workflow business processes comprise both single and multiple-type business processes. For example:

- A project may require a "gold-standard" data sheet; a **single-type** business process suits the purpose because you only need one record.
- A company may use many vendors; a **multiple-type** business process suits the purpose because you can create many unique records that collect similar data.

A non-workflow business process does not generate tasks and is viewable in its business process log or in the Data Manager, provided you have permissions. When you save a non-workflow business you can save it in either edit mode or read-only mode. If the record is in a terminal status and you click Finish Editing to save it, the record becomes permanently read-only with no way to return it to edit mode.
Creating a BP Record

Each time you fill out a business process (BP) form, you are creating a new record for that BP. These BP forms can be routed to project team members or other Unifier users via workflows.

**Note:** BPs that do not have a workflow are stored as information records.

BP records are stored in logs. For more information about business processes, see the following sections:

- *Business Processes (BPs) and Project Controls* (on page 23)
- *Opening an Existing BP Record* (on page 38)

A BP record contains an upper form, an action area, and, for some BPs, a detail form (for example, the Meeting Minutes BP provided with PPDM).

The following instructions explain how to fill in the upper form (detail form), choose an action, and send the record into use.

To create a new BP record:

1. Click **New** on the tool bar at the top of the log to open the BP form.
2. Fill out the form.
   - **To fill out a form:**
     1. Complete the upper portion of the form. The fields that are marked with a red asterisk (*) require input.
     2. Complete the content (detail) section:
        - If this is a line item or cost-type BP, add line items as necessary. See *Business Process Type: Line Item or Cost* (on page 34).
        - If this is a document-type BP, attach the documents to the form. See *Business Process Type: Document* (on page 34).
        - If this is a text-type BP, complete the text portion. For example, for an action item, include the instructions in the text box in the lower portion of the form. See *Business Process Type: Text* (on page 36).
     3. (Optional) You may add additional information, including:
        - Add general comments.
        - Attach a file to a general comment.
        - Add or review graphical markups to an attached document.
     4. When you have completed the form, do one of the following:
        - If this is a non-workflow business process:
            a. Click **OK** to save your changes.
            b. Click **Finish Editing**.
        - If this is a workflow BP:
            a. In the Action Details area of the form, designate the next assignees (users and groups) who will receive the form on the next step in the workflow as a task.
            b. (Optional) You can also add Task Notes for the next participants in the workflow. Task Notes apply to the next workflow step only and are not stored with the permanent record.
c. When you have completed any necessary edits or additions, select an action from the Workflow Actions drop-down list at the top of the form. The action you take depends on the task assigned. For example, if this is a review step, an action that you may be able to select is "approve."

d. Click **Send**.

- If the workflow has not been completed yet, the form will be forwarded to the next team members in the workflow.
- If the workflow has been completed (that is, your input was the last step of the workflow), the record will appear as complete in the BP log.

The next section shows you how to

---

**Business Process Type: Line Item or Cost**

To *add* a line item to a record:

1) From the bottom of the form, click **Add**.

   - If the business process (BP) does not use summary line items, Unifier opens the Line Item window.
   - If the BP uses summary line items, choose **Detail Line Item** or **Summary Line Item**, as appropriate, to open the Line Item window.

2) Complete the line item fields and then click **OK**.

To *edit* a line item:

   **Note**: As long as the BP form is still a draft, you can edit a line item at any time.

1) Select a line item and click **Open**.
2) Make your changes to the line item.
3) Click **OK**.

To *remove* a line item:

1) Click on a line item to select.
2) Click Remove.

---

**Business Process Type: Document**

Document-type business processes such as Transmittals or Submittals, can be used for routing documents such as specifications or drawings for review. Comments and graphic markups can be added to individual files, and the document list is easily accessible from the BP form. Some document-type BPs can be designed such that files can be added to individual line items, which allows users to assign line-item status to individual documents.

To *add files* to Document-type BP records:
Open the form and do one of the following:

- If the BP has line items, click **Add** and choose **Import Line Item w/ Attachments > My Computer**.
- If the BP does not use line items, click **Add Attachment** and choose **My Computer**.

The method for attaching files is dependent upon the file transfer option you chose in the user preferences.

To **attach files** from the Document Manager:

Open the form and do one of the following:

- If the BP has line items, click **Add** and choose **Import Line Item w/ Attachments > Primavera Unifier Folder**.
- If the BP does not use line items, click **Add Attachment** and choose **Primavera Unifier Folder**.

The Select Files window opens.

From the Select Files window, select the documents or folders to attach and click **OK** when finished.

If you want to include the comments that may be attached to the document, select the **Copy Comments** checkbox and click **OK**.

The files appear in the lower portion of the window.

---

**Note:** If the BP has line items and you select a folder or multiple documents, each document will be added in a separate line item.

---

To **remove attachments** from Document-type BP records:

To remove attachments from Document-type BP records you can do one of the following:

- Remove the entire line item:
  1. From the form, select the line item to be removed.
  2. Click the Remove button.
  3. Click Yes to confirm. The line item and attachment are removed.

- Remove the attachment from the line item:
  1. From the form, double-click the line item. The detail line item window opens.
  2. Click **Remove**.
  3. Click Yes to confirm. The line item and attachment are removed.

Since "Name" is a required field, you must give the line item a new name before closing the line item detail window. If you close the detail line item window before entering a new name, the name of the file that has been removed will remain in the field. Click Yes to confirm. The attachment is removed from the line item.
Business Process Type: Text

Comment

When you add a comment to a business process (BP) form, it remains as a draft until you send the form to the next step in the workflow. Draft comments remain editable until you send the form. You cannot modify a comment after you send a form that has comment.

To add general comments to the BP form:
1) At the bottom of the BP form, click the General Comments link. The General Comments window opens.
   - **Note**: If any comments already exist on a BP, the existing comments will be listed in the Comments section of the window.
2) Click Add. The Edit General Comment window opens.
3) Type your comments in the text box. You can spell-check by clicking the Spelling button.
4) To add files to the comment, click Attach.
   - **My Computer**: Attach the file from your local system. The procedure is the same as for uploading files to the Document Manager and depends on your file transfer option.
   - **Primavera Unifier Folder**: Attach documents from the Document Manager. The window opens displaying the project documents files and folders. Select the files and folders to attach and click OK. Folders are not attached. Instead, the contents of selected folders are attached in a flat list. Documents with duplicate file names will not attach.
5) Click OK to save the comment and close the Edit General Comment window.
   - **Note**: The Text Comments box does not recognize formatting, including line breaks. Even if you press the Enter key to make a new line in the Edit General Comment window, the final comment will not reflect the new line.
6) Click Close Window to save your comments and return to the BP form.
   An icon will appear at the bottom of the form next to the General Comments link.

To add a comment to an attached document:

   **Note**: For document-type BP (such as Transmittals or Submittals), you can add comments directly to an attached document.

1) Select the document from the document list at the bottom of the form.
2) Click Comments.
3) Click Add to add the comment.
4) Enter the text comment. You can also add a graphic markup to the document or attach a file to the comment.
5) Click OK.

To edit a comment:
1) From the General Comments window, select the comment to edit and click Modify from the toolbar. The Edit General Comment window opens.
2) Make the necessary edits. Comments are editable until you click **Send** (workflow BP) or **Finished Editing** (non-workflow BP).

To delete a comment:

From the General Comments window, select the comment to delete and click **Remove**.

---

**Task Note**

Notes that are specific to a task can be added to a business process (BP) form. They are temporary notes that can be used as comments or specific instructions to the next user in the workflow. Task notes are not forwarded throughout the workflow and are not archived. You can think of them as sticky notes that stay with the form for one step in the workflow only.

To add a task note to a business process:

1) In the Action Details section of the BP, click the **Task Notes** icon. The Add Notes window opens.
2) Enter the text for the task note and click **OK**.

---

**Assign Users to the Next Step**

Depending upon the workflow configuration and your user permissions, you can select one or more users or groups to whom the form will be sent at the next step in the workflow.

The assignee fields are:

- **To**: The users or groups that you choose will be assigned the next task in the workflow. Team members listed will receive an e-mail notification of the task.
- **Cc**: These users and groups receive an e-mail notification and a copy of the record in their Message log. They can review the record, but cannot take action on the workflow.

To assign team members to the next workflow step:

1) In the **Assignee** portion of the form, click **To**. The User/Group picker opens.
2) Select the users or groups you want to send the form to and click **Add**, then click **OK**. Unifier adds the assignees you specified to the **To** field.

When the business process form is sent, each member will receive an e-mail message regarding their task assignment and a copy of the form in their Tasks log.

To send a copy of the BP form to another user:

1) Click **Cc**. The User/Group picker opens.
2) Select users or groups you want to copy and click **Add**, then click **OK**. Unifier adds the assignees you specified to the **Cc** field.

When the BP form is sent, each member will receive an e-mail message and a copy of the form in their Messages log.
Opening an Existing BP Record

Each business process (BP) has its own log, which displays a list of records (instances or forms). Permissions allow you to access existing records from these logs, including:

- Records with which you are involved (as creator, assignee or Cc recipient).
- All company records created by other users in those logs.

**Note:** The following information is based on the default setup of Unifier.

To open a BP log at the *project level*:

1) Open a project.
   - You can use the All Projects tab to access the list of your projects.
2) From the left Navigator, expand the **Logs** node.
3) Open a business process to see the log.
   - The log, which opens on the right-hand pane, displays a list of records for that particular business process.

To open a BP log at the *company level*:

1) Go to the Company Workspace tab and click Company Logs in the left Navigator. The Navigator shows a list of the business processes that reside at the company level.
2) In the left Navigator, double-click the name of the business process. Unifier opens the log in the right pane.

About BP Forms

The electronic forms in Unifier are consistent throughout Unifier, with a similar look and feel. When you send a workflow business process form to the next step, the assignee receives a task.

When you first open a task, it appears in "view" mode. On the "view" version of this form, you can do the following:

- Accept the task
- Decline the task
- Print the form
- Terminate the record
- Send uMail
- Transfer ownership of the record
- Add an assignee to the current step
- Copy users to the current step
- Audit the progress of the record
- Add a comment, if you have permission

If you accept the task, the form becomes editable. On the editable, or "action," version of this form, you can do the following:

- Undo task acceptance, which allows someone else to accept the task.
Decline the task, which takes you out of the list of assignees.
Select the step’s next action.
Add or edit form content
Save a draft of the record
Terminate the record
Transfer ownership of the record
Display the view form of the business process
Audit the progress of the record
Spell check the record content
Add attachments, line items, etc.
Send the form to the next step

The electronic form appears similar to a paper form—you complete the form by typing information directly into the form fields or choosing options through drop-down lists, pickers, or checkboxes.

**Note:** The section labels are determined in uDesigner and may vary. The basic form functionality remains the same.

Refer to the "About Business Processes" chapter in the *Primavera Unifier User’s Guide* for information about:
- Filling out a BP form
- Saving a draft of a Workflow BP
- Adding, editing, or removing a Line Item
- Working with file attachments and markups
- Attaching files and markups
- Adding or viewing graphic markups to a BP Attachment
- Attaching files to a Document-type BP
- Removing attachments from a Document-type BP Record
- Linking BP Records
- Email notifications for BPs
- Initiating, participating in, or closing a discussion group

For any action other than creating a new business process (BP) record, we recommend that you monitor BPs using your Tasks Log.

Business process logs list every record of that business process type, but the Tasks Log lists only those records that have been assigned to you for action.

If you are participating in a workflow, these tasks will be the forms you need to complete on a workflow step. Tasks that are late appear in red on the log.
Tasks Logs are located in projects, in the company workspace, and in one central Tasks Log for all company and project business processes.

The following tasks may appear in your Tasks logs:

- You are part of a BP workflow and are requested or required to take some sort of action.
- You have been invited to join a discussion group by another user who is requesting assistance with drafting comments or markups on a BP. These are indicated as being sent for "Discussion" in the Tasks Log.
- You are an editor on a BP, which means you are a user or member of a group that can edit a BP without being granted explicit record-level permission. This allows users other than the assignee to edit the BP record. Editors can be added to these workflow or non-workflow business process types:
  - Line Item
  - Cost (all types, including Lease and Line Item with Multiple Codes)
  - Document
  - Simple
  - RFB
  - Text

If you are an editor on a business process, you can open and edit any record that you can see listed in the log, per your view access permission (View User Records, View Company Records, or View All Records).

You must have at least one of these permissions to be able to view the record in the log to access it to edit.

- Editors cannot edit a workflow record until the task assignee accepts the task, and saves the draft.
- Edits performed by editors are not audited.
- Edits performed on the end step of a workflow BP affect the record directly, as no draft exists.

Refer to the *Primavera Unifier User's Guide* for details about the following topics:

- Viewing your tasks
- Opening and accepting tasks
- Undoing accepted tasks
- Declining a task
The Cost Manager consists of the modules and features listed below.

- **Cash Flow Curves** — Cash flow is the distribution of cost over time; in other words, it is the movement of cash into or out of a project measured during a specific time period. Unifier displays this data using cash flow worksheets that can display baseline, spends, and forecast curves.
- **Cost Sheets** — Cost sheets capture data from data sources, such as cost code data values, budget, business processes by status, and manager sheets, for example Schedule Manager. Unifier dynamically updates the company cost sheet with information from project cost sheets.
- **Funding Sheets** — Funding sheets track company funding through allocation to, and consumption at, the project level.
- **Schedules of Values** — Unifier’s Schedule of Values (SOV) feature provides a way to assemble information from contract, change order, and invoice and payment business processes into an SOV sheet, streamlining the process of invoicing for completed phases of a project. There are two types of SOVs: **Payment Application SOV** and **General Spends SOV**.

Cost rules affect how users can work with modules and features listed above.

- The **Budget** must be greater than 0 — This rule validates that a budget line item cannot be reduced below $0.
- The **Revised Budget** must be greater than or equal to **Approved Commitments** — This rule validates revised budget (approved budgets, budget transfers and budget changes) vs approved commitments (approved contracts, change orders, purchase orders and po amendments)
- An **Invoice** must be less than or equal to **Approved Purchase Orders** and **PO Amendments** — This rule validates invoices (approved invoices) vs approved purchase orders (approved purchase orders and po amendments)
- A **Payment Application** must be less than **Approved Contracts** and **Change Orders** — This rule validates approved payment applications vs approved commitments (approved contracts, change orders)

The actions that can trigger a rule are:

- You attempt to "send" a business process record to the next step whose status activates the rule.
  - For example, the rule may be designed to activate when a record gets to the Pending or Approved status.
- Data is loaded into a cost sheet manually.
- Web services calls create records.
- Records are auto-created from other records.

For more details about the following information refer to the *Primavera Unifier User's Guide*.

- Defining the budget
Document Manager

Document Manager maintains all the files and documents for a project. Each project includes its own Document Manager, and another Document Manager resides at the company level. The Document Manager ensures that employees and project members are always using the most current versions of documents and makes accessing and distributing documents efficient.

Documents are organized into a "folder" structure to categorize them and make them easily available, much like a filing cabinet.

The Document Manager is integrated with business processes. You can initiate a business process directly from the Document Manager and automatically attach files and folders to it.

For detailed information about Document Manager and working with documents, refer to the Primavera Unifier User's Guide.

Changes made to a business process (BP) attachments (in forms or line items) will be automatically published to pre-defined folders in Unifier Document Manager.

Attachments in company-level BP will be published to specified folders in Company Documents and those in project-level BP will be published to folders in a project's Documents log.

Files that are attached to a BP form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow BP.

The administrator must then publish the files in the Unpublished Documents folder in Document Manager to the Documents folder.

By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment, and collaborate.

Using Document Manager

In Unifier, the Documents node in the navigator is where all documents—such as drawings, spreadsheets, image files, Microsoft Office files—are stored and managed.

Under this node, at the project level, we have provided an extensive Project Documents node containing a folder structure to support an array of document types, such as Project Budgets and Schedules, Bids and Contracts, and Permits and Fees.

You can upload, download, revise, or mark up all documents from this node. The Documents node has check-in/check-out, document lock, and revision history features for version control.
The Unpublished Documents node is the temporary, automatic repository for files that have been uploaded from local machines and attached to business processes, but which have not yet been "published" to the Documents node.

When you upload a file from a local machine and attach it to a business process, the document is automatically stored in the Unpublished Documents node with a link to the business process to which it belongs.

The link to the business process allows the administrator to review where the document originated from. This way, the administrator can control the documents that are accessible in the Document Manager.

For example, a subcontractor might submit a Request for Information (RFI) with attached documents requesting input from the architect. The attached documents can be traced to the original business process through the link, and the documents will become available in the unpublished node.

The administrator can then review the documents, decide where to store them, and publish them to the Documents node; or the administrator can decide not to publish them at all.

To view the published file attachments of a project-level BP record:

1) In a project's Navigator, click Document Manager and select Documents.

2) In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level BP record:

1) In the Company Workspace Navigator, click Document Manager and select Company Documents.

2) In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

Refer to the Primavera Unifier User's Guide for details about the following topics:

- Working with documents (accessing, opening, copying, moving, and deleting)
- Uploading files (using various methods)
- Downloading documents and files
- Adding and viewing graphic markups
- Revising documents

Launching a BP Record from Document Manager

A BP record can be launched directly from documents within the Document Manager. This function applies to any business processes (BPs) that support attachments directly to the form. This is not applicable to file attachments to comments.

For document-type BPs, the documents can to be added as line items, or they can be attachments to the form. For non-document-type BPs, the documents are added directly as form attachments.

Notes:
Text-type BPs such as Action Items cannot be launched directly from the Document Manager. This is because text-type BPs, by design, can have file attachments only to the comments section, not the form itself.

Only document-type BP can support folders. If you are trying to attach one or more folders to a non-document-type record, the files within the folders will be attached, but the folder structures will be flattened.

You cannot attach multiple files with the same name to the same folder. If you select multiple files and there are two or more with the same name, none of those files will be attached. After the form is created, you can attach the correct files using the Add Attachment button.

The business process list that you see in the drop-down menu is the list of all available active BPs in the project. Once you select a business process, a permission check will be run. You must have at least create permission on that business process to launch it from the Document Manager.

To launch a business process from the Document Manager:

1) Select one or more files or folders in the Documents log.
   You can also launch a business process record without selecting any documents or folders. In this case, the business process record will be created with an empty attachment area.

2) Click New > Business Process and choose the business process to launch. The Select Workflow window opens.

   Note: Unifier will not display the Select Workflow window if:
   - This is a non-workflow process.
   - There is only one workflow schema you can choose for this business process.

3) Choose the workflow schema to use and click OK.

4) You can add additional documents to the record as you normally would.

5) Complete the BP form and send. The attached documents are linked to the business process record.

Viewing Documents Linked to BP Records

If a document has been attached to one or more business process records, an icon will appear in the Business Process column next to the document in the log. You can view the records to which the document is attached.

To view business process records to which a document is linked:

1) In the Documents log, select a document. Documents with the paper-clip icon in the Business Process column are linked to business process records.

2) Click the View menu and select Linked BP Records. The View Linked Records window opens.

3) To open the record, select it from the list and click the Open button or double-click the record.
Schedule Manager

The Schedule Manager tracks project schedules through activities in schedule sheets. You can create a project schedule sheet that lists your project activities and associates each activity to dates (such as start and finish dates), cost codes, roles, and dependencies. You can track schedule progress and variables, and calculate the schedule critical path.

In Unifier, you can also import project schedule records from other sources. For example, you can import project schedule records from Oracle Primavera P6 to provide additional detail, or supporting schedule information, such as subcontractor or vendor schedules. You can edit imported schedules within Unifier and generate reports based on that data processed.

Schedule sheets present schedule activities, such as interactive Gantt charts, where you can:

- Zoom in to see tasks at the day, week, or month level
- Move activities and add dependency relationships, and automatically update the dates on the schedule
- Create critical path calculations that will flag activities that, if delayed, can cause the schedule to go beyond the planned project end date

Each project can have multiple schedule sheets, and one master schedule sheet. The master sheet drives project start and end dates, tracks the project’s progress, and integrates cost items on the schedule with the Cost Manager.

For more information about the Schedule Manager, refer to the Primavera Unifier User's Guide. For details about setting up schedule sheet templates, see the Setting Up Project Templates: Schedule Sheet Template (on page 171) section.

For details about Schedule Sheet refer to the Primavera Unifier User's Guide.

Running a User-Defined Report

See the Reports (on page 21) section for additional Information.

To run a user-defined report:

1) Open the project or company workspace.
2) Navigate to the Reports log, and click User-Defined. The User-Defined Reports log opens.
3) Select a report in the log and click the Open button. The User-Defined Report window opens.
4) Complete the tabs as follows:
Query tab: The query has already been set up. However, at the bottom of this tab, choose the format in which you want to run the report. The report format options are:

- **HTML**: Displays the report in the standard format in a browser window.
- **CSV**: Formats the report in an exportable CSV format, usually in Microsoft Excel or another application you have set up for this format. You will be prompted to save the file or open it.
- **Excel**: The report opens in Microsoft Excel format in the browser window.
- **PDF**: Opens Adobe Acrobat Reader and displays the report in PDF format.
- **XML**: Generates the output in XML format. Before the results are generated, a confirmation window will open, giving you the option to save the XML file to your local machine (click **Save**), or display the results in a pop-up browser window (click **Open**).

On the Query tab, you can also choose to save report results somewhere in Unifier. Under the **Save Report Location**, you can choose to save a PDF or XML report in Unifier. You can also save any report in the Document Manager. To do so, click the **Select** button beside the **Location** field. A Select Target Location window opens, where you can specify the folder in the Document Manager where the report should be saved.

Shells tab: Ignore this tab. The report will include all the projects in the All Projects shell, except inactive projects.

Notes tab: You can enter report notes that will be included only on the current report results to be generated, and will not be saved or generated in any subsequent report results.

5) Click **Run** to generate the report.

PDF files will open in Acrobat Reader, from which you can save the file to your local drive by clicking **File > Save**. All other file formats will open in a pop-up browser window, where you can click **File > Save** to save the file to your local drive.

## Primavera Capital Planning (PCP)

In general, Capital Planning enables a company:

- Manage the current and proposed capital projects that are aligned with the strategic goals
- Prioritize projects based on available budgets

PCP (in Unifier Portfolio Manager) is used for managing budget forecasts for ongoing and planned projects in a company.

The following sections provide details about PCP and is based on the default setup of Unifier.

**Note**: There are no business processes (BPs) designed and set up for use with PCP.
Using PCP

PCP helps the portfolio planners:

- Create multi-year financial plans to determine which projects to undertake.
- Set up criteria for inclusion of planned and ongoing projects into the plan.
- Facilitate top-down (assign budget from capital plan) and bottom-up (assign budget at project level) PCP.
- Create multiple scenarios to compare and achieve optimal budget and forecast distributions aligned to strategic goals.
- Facilitate collaboration with project managers.

In Unifier, two factors impact PCP directly:

- Portfolio Manager: at a higher level within the Shell hierarchy (e.g., All Projects)
- Cash Flow: at a lower level within the Shell hierarchy (e.g., Projects)

Using the PCP entails using the Portfolio Manager to gather cost and schedule information on ongoing and planned projects and perform analyses on "what if" scenarios. See the *Accessing Portfolio Manager* (on page 52) section for details.

During scenario analysis, the portfolio planner will likely contact the project managers to negotiate numbers and dates. This exchange of information continues until all parties involved reach an agreement.

**Note:** Before you use the Project Controls base product, you need to prepare and configure the data that you need for using each component, in Unifier. Refer to the *Primavera Unifier User's Guide* for instructions on how to prepare and configure the necessary data.

Administrators can refer to the *Primavera Unifier Administration Guide* to learn more about the following related topics:

- Portfolio Manager cash flow data sources:
  - In Unifier: Company Workspace (Admin mode) > Standards & Libraries > Cash Flow > Data Sources
- Project Cash Flow - Capital Planning:
  - In Unifier: Company Workspace (Admin mode) > Templates > Shells > Projects > Project Template > Cost Manager > Cash Flow

The following sections provide details about PCP and is based on the default setup of Unifier.

**Portfolio Manager**

The core of PCP is the Portfolio Manager.

Portfolio management entails collaboration and negotiation between you, as the budget forecast planner (planner), and the project managers in your company.

The Portfolio Manager node:
Primavera Unifier Project Controls User's Guide

- Allows budget forecast planners (planners) to gather cost and schedule information on ongoing and planned projects.
- Allows the planners to analyze on "what if" scenarios. These scenarios are used to propose an optimal mix of projects for a portfolio, based on available budget targets and the strategic goals of the company.

PCP provides an efficient collaboration between the Portfolio Manager and Cash Flow (Cost Manager) in Unifier.

### Cash Flow and Capital Planning

Cash flow is the movement of money in or out of a business or project during a specific time period.

At their respective project levels, project managers maintain project information and create cash flow budgets and projections in the Cost Manager. This information is used in the Portfolio Manager scenario sheets. See *Portfolio Manager: Portfolio Scenario Sheet* (on page 49) for more information about scenario sheets.

With the Primavera Capital Planning (PCP), you receive a PCP cash flow record with a family of curves to support PCP needs. Following are the curves that are included:

- Baseline
- Forecast
- Original Budget
- Shared Budget
- Approved Budget
- Actuals

Once your projects are in operation and your Portfolio Manager sheets are set up, Unifier collects budget, forecast, and actuals data from the project cash flow curves.

A preconfigured worksheet, Project Cash Flow - Capital Planning, is provided in a project cash flow module.

After the project manager provides baseline data, the worksheet enables the planner to view the data and then manipulate it as needed to fit the budgetary and organization priorities for a portfolio.

In the bottom-up method of PCP, project cash flow management includes the following steps:

- Establish a baseline spending plan. (Yearly baseline values become the data sources for a portfolio scenario.)
- Negotiate budgets and dates with planner.
- Work with budget approved by planner.

A portfolio planner can create scenarios to plan an optimal portfolio of projects for the company, based on available budget targets and strategic goals.

Portfolio management entails collaboration and negotiation between you, as the budget forecaster, and the project managers in your company. At their respective project levels, project managers maintain project information and create cash flow budgets and projections in the Cost Manager.

During a scenario analysis, you can:

a) Apply regional budget targets
b) Group the projects in the scenario according to project characteristics
c) Sort and filter the rows of project data and analyze the summary totals
d) Accept the project managers’ budget numbers or propose new numbers
e) Accept the schedule dates, or remove or postpone planned projects
f) Create additional scenarios to reflect other possible forecasts

**Note:** The numbers you propose in a scenario will **not** affect a project’s live data. Your proposed numbers are stored only in the Portfolio Manager and will **not** affect live project data until a scenario has been approved by your company management.

During the scenario analysis, the portfolio planner collaborates with the project managers to negotiate the numbers and dates until they reach an agreement.

The project managers do not see the changes the portfolio planner makes on the portfolio scenario sheet because a portfolio manager deals with multiple projects but each project manager deals with only one project and may not have permission to access the information about another project.

To communicated the portfolio scenarios to the project managers:

The portfolio planner must share the portfolio scenarios (see **Scenario Tab** on page 56)) with the project managers and the project manager must:

- Have access to the project Cash Flow module
- Set up Cash Flow Curves accordingly (Shared, Original, Approved)

The Cash Flow Curve shows the portfolio planner's proposed budget numbers for the project. The project manager can include the Cash Flow Curve on the Cost Worksheet (along with the forecast budget or any other budget curve) in order to see the difference between the project numbers and the portfolio planner's proposed budget numbers.

After the portfolio manager completes the budget forecast analysis, using scenarios, and the project manager approves the results, the portfolio manager can mark the scenario as Approved.

**Portfolio Manager: Portfolio Scenario Sheet**

Portfolio planners can create a portfolio for a specific "planning horizon" (for example, from 2020 through 2026) and then create multiple scenarios in that portfolio.
Each *scenario* can use forecast numbers and actuals for both planned and active projects.
The *portfolio scenario* sheets have been set up to pull in the following data from your projects:

- General project information
- Project start and end dates
- Cash flow data (both forecasted and actual) from each project’s Cost Manager

With this data, planners can forecast costs over a specific time period (called a "planning period"). They can then manipulate scenarios by:

- Including or excluding projects
- Pushing start dates for planned projects into the future
- Modify project end dates to change the project’s duration
- Proposing different cash flow distribution numbers by manually editing the cash flow columns
- Negotiating proposed budgets with project managers

Once these scenario analyses have been completed, the best scenarios can be sent to the executive decision makers for approval.

Once a scenario has been approved, Unifier:

- Marks the approved scenario "shared" so that project managers can see the approved dates and numbers. The scenario is set to read-only mode and can no longer be modified or deleted.
- Updates each projects’ original budget numbers with the proposed numbers on the approved scenario.
- Updates each projects’ monthly or yearly cash flow numbers with the proposed numbers on the approved scenario.
- Updates the project start date (if it was changed) for any planned projects that will begin during the portfolio’s planning period.
- Locks the budget and cash flow numbers to prevent any further changes.

With Primavera Capital Planning (PCP), you receive a template for the portfolio scenario sheets that you use to create the scenarios for analyzing and forecasting capital budgets. The template has been set up to automatically add all your active projects to the sheet as rows.

The template contains:

- The planning options for the portfolio scenario sheet, such as the period structure and data linking options
- Project phases that identify a project as planned or in execution
- The data sources to be used for the analysis, such as project dates and cash flow sources
- The query that will extract the project data that should be included on the scenario
- The column layout that will appear on the scenario sheet
In general, a portfolio scenario sheet contains a list of available projects in a given scenario. See the **Project Portfolio Manager** (on page 53) section for more details. Unifier populates the portfolio scenario sheet with all the projects that have met the criteria for inclusion (the budget and projection numbers are from Cost Managers node, and the project start and end dates are from project information). See **Creating a New Portfolio Scenario Sheet** (on page 66) section for more details.

### Portfolio Manager: Cash Flow Budget Curves

Portfolio Cash Flow budget curves are part of the Cost Manager function. Users in the project can view Cash Flow budget curves from the Cash Flow node of the Cost Manager.

There are three Portfolio Cash Flow Budget Curves:

- **A Shared Budget** curve. This curve shows your proposed numbers for the project. The project manager will not have access to this curve until you share a scenario. The project manager can include this curve on the cost worksheet, along with the forecast budget, or any other budget curve, in order to see the difference between the project’s numbers and your proposed budget numbers.

- **An Approved Budget** curve. When a scenario is approved in the Portfolio Manager, the budgets for each project in the scenario are marked "approved." They are then locked and stored in the Portfolio Manager. An Approved Budget curve shows the approved budget for the project for that planning period (usually a year).

- **An Original Budget** curve. This curve is for a project in execution. This budget is the last approved budget for the project before it moved into its execution phase. This approved budget becomes the project’s original budget; and this original budget, plus any changes that occur to the numbers during the life of the project, becomes the project’s approved budget.

For example, an approved budget for the year 2015 might include a planned project for road construction that is scheduled to begin in 2017 with a budget of $100,000. The approved budget for the year 2016 will continue to include the planned road construction budget, with an addition of $15,000 to the forecasted budget. In the year 2017, the road construction project goes into execution, and the approved budget is $115,000. This figure becomes the original budget for the road construction project. From then on, as budget forecasting continues, the approved budget for the road construction will be the original budget, plus any changes that occur to the numbers during the life of that project.

### Viewing the Portfolio Cash Flow Budget Curves

With the Primavera Capital Planning (PCP), you receive a capital planning cash flow that shows the following curves in an S-curve display. This cash flow is an aggregate of these curves for all the projects in the scenario.

- Baseline
- Forecast
- Original Budget
- Shared Budget
- Approved Budget
Once projects are in operation and portfolio scenario sheets are set up, Unifier collects the curve data from the Cost Sheet in each project and produces the capital planning cash flow curves. The produced cash flow curve contains a "shared" budget curve that shows the portfolio planner’s proposed numbers for the project.

Project managers do not see the changes the portfolio planner makes on a portfolio scenario sheet. Instead, the project managers can include this curve on their cost worksheet, along with the forecast budget, or any other budget curve, in order to see the difference between the project numbers and the portfolio planner’s proposed budget numbers.

To view the portfolio cash flow curve:
1) Go to the All Projects tab and switch to User Mode.
2) Open the project in which you want to see the cash flow curve.
3) In the left Navigator, click Cost Manager > Cash Flow and open the cash flow in the right pane.

### Accessing Portfolio Manager

**Notes:**
- The following instructions are only applicable if you have prepared and configured the necessary data that you need for using this feature in Unifier.

To access the Portfolio Manager node:
1) **Sign in** to Unifier. Refer to the Primavera Unifier User’s Guide for additional information.
2) Open All Projects tab.
3) Switch to **User** mode. The Portfolio Manager node appears in the Navigator.

**Note:** The administrator sets up the structure of the nodes and modules in the Navigator. BPs could appear in folders that are placed in appropriate nodes.

The following sections provide details about using the PCP BPs and is based on the default setup of Unifier.

### Viewing Portfolios

**Note:** The following instructions are only applicable if you have prepared and configured the necessary data that you need for using this feature in Unifier.
**To view portfolios**

1) Go to the **All Projects** tab and switch to User Mode.

2) In the Navigator, Click **Portfolio Manager** to expand the node and to see the portfolio types currently loaded into Unifier.

3) Click **Capital Projects** (portfolio type) node to see the available Capital Projects portfolios in the right-hand pane.

**Opening Portfolios**

**To open a portfolio**

1) Go to the **All Projects** tab and switch to User Mode.

2) In the Navigator, Click **Portfolio Manager** to expand the node and to see the portfolio types currently loaded into Unifier.

3) Click **Capital Projects** (portfolio type) node to see the available Capital Projects portfolios in the right-hand pane.

4) Click to select a portfolio and click **Open**. Unifier opens the portfolio in the Project Portfolio Manager window (see the **Project Portfolio Manager** (on page 53) section).

**Project Portfolio Manager**

The Project Portfolio Manager window lists the projects and the projects portfolio scenarios (represented in tabs). Collectively, the items listed in the Project Profile Manager window is referred to as the portfolio scenario sheet, which contains a list of available projects in a given scenario (Portfolio > Projects > Scenarios).

The portfolio scenario sheet is populated with all active projects in the company. The link icon in front of each row indicates that projects are linked to the scenario and data is drawn from Project Details and the Cash Flow worksheet.

**Toolbar**

The Project Portfolio Manager toolbar options are:

**Save icon**

To save changes made in the portfolio scenario sheet.

**Link/Unlink**

To link or unlink one or multiple projects. When linked, project data is updated when you open the sheet. Projects become unlinked when you modify data on the sheet.

**Properties**

To view the portfolio's properties.

**Export**

To export an Excel file of the data structure.
Columns
The information about each project in a portfolio, and within a scenario, is presented in columns in the Project Portfolio Manager window.

The columns in the Project Portfolio Manager window contain the following information:

Note: Use the horizontal scroll bar, at the bottom of the Project Portfolio Manager window to move through the columns.

If you (the portfolio planner) move your computer pointing device (mouse pointer) over each of the first seven column label (starting with Project Name), a drop-down arrow displays automatically on the right-hand side of the column label box. Use the drop-down list to sort, group, clear grouping, and filter the information presented in each column.

If you click on the column label (all columns), you can sort the rows according to the information presented in the column that you clicked.

Item number
Contains an automatically assigned number.

Link
If a link icon is present, then the project is linked to the project data, and the application updates the data on the portfolio scenario sheet as soon as you open the sheet.

When the portfolio planner creates a portfolio scenario sheet, Unifier populates the portfolio scenario sheet on with all the projects that have met the criteria for inclusion on the portfolio scenario sheet.

Note: These criteria were set up in a query that was included in the Portfolio Manager module under Configuration node (Company Workspace - Admin mode).

When a column value is edited, Unifier automatically unlinks that project row from the project data. The modified cell values are italicized, indicating a discrepancy between scenario and project data, and the row is tagged in the first column.

Project Name
The name of the project in the portfolio.
You cannot edit the Project Name.

Project Number
The number assigned to the project in the portfolio.
You cannot edit the Project Number.

Project Type
The type of the project in the portfolio.
You cannot edit the Project Type.

Project State
The Project State column shows that the scenario includes planned and current projects.
Estimated Budget

The estimated budget amount is set by the project manager.

Start Date

The start date is set by the project manager.

End Date

The end date is set by the project manager.

Pre-Actuals

Pre-Actuals represents the Actuals sum of all previous actuals, up to current date. If checked mid year, the Pre-Actuals also represents the sum of all previous actuals and forecast values, up to the end of year.

Total

- Indicates the project total budget amount,
- Automatically updated by Unifier.

Cash flow columns for each year in the planning period

- Unifier collects the budget and projection numbers from the Cost Managers node of each of your projects and displays them in the cash flow columns.
- The year columns display a range of five years. The first two columns are broken into months, corresponding to the data distribution in project cash flow. You can click the double-arrow to collapse the year columns. Sort, column, and filter options are available in each year and month column.

See the following sections for more details:

- *Hiding or Showing Columns* (on page 63)
- *Filtering Information on Portfolio Scenario Sheet* (on page 63)

<table>
<thead>
<tr>
<th>Total</th>
</tr>
</thead>
</table>
The total section is located below the list of projects and provides the following information:

**Total**

Captures cash flow totals, showing the sum of the amounts in each numeric column.

**Target**

Allows the portfolio planner to enter a target number designated for the time period, manually.

**Difference**

Automatically calculates the difference between the target number and total in each column.
**Splitter Arrows**

In some portfolio scenario sheets, you may see two large arrows (splitter arrows) at the bottom of the Project Portfolio Manager window, left-hand corner. The portfolio planner can use the splitter arrows to split the windows and add additional projects, from project candidates list, to the portfolio manually.

The option for manually adding projects to the portfolio can be set up by the Administrator.

Company Workspace (Admin mode) > Configuration > Portfolio Manager > Capital Projects > Query tab > Projects: If selected, deselect "Auto-add/auto-remove projects to and from the portfolio based on the query."

*Note:* Changing this option applies to new portfolios, only.

---

**Current Project Data**

The Current Project Data section is located below the totals and provides the current project data for any project (row) that you select.

When a column value is edited, Unifier automatically unlinks that project row from the project data. The modified cell values are italicized, indicating a discrepancy between scenario and project data, and the row is tagged in the first column.

See the following sections for more information about project data:

- *Accessing Project Data* (on page 59)
- *Editing Project Data* (on page 60)

---

**Scenario Tab**

In addition to the list of projects in a profile, the Project Portfolio Manager window displays the projects portfolio scenarios (represented in tabs). The Scenario tabs are located below the total grid.

*Note:* After the portfolio planner completes the budget forecast analysis, using scenarios, and the project manager approves the results, the portfolio manager can mark the scenario as Approved.

The portfolio scenario sheet enables a planning manager to modify values and see the resulting budget analysis immediately. The following values on the portfolio scenario sheet can be edited:

- Cash flow projections
- Targets for cash flow and numeric columns
- Start Date and End Date for planned projects

Unifier dynamically updates totals and calculates the difference between target numbers and totals.
Note: The values proposed in a scenario do not impact the live data within a project until the scenario is approved.

If a project manager does not have permission to view a scenario, the planning manager can share it. This enables a project manager to view the difference between initial baseline projections and the planning manager’s proposed numbers.

Note: The planning manager can undo a previously shared or approved scenario to make future changes.

When a column value is edited, Unifier automatically unlinks that project row from the project data. The modified cell values are italicized, indicating a discrepancy between scenario and project data, and the row is tagged in the first column.

Linking and Unlinking Projects

When you create a scenario, Unifier populates the sheet with all the projects that have met the criteria for inclusion on the sheet.

Note: The criteria were set up in a query that was included in the Portfolio Manager configuration.

This is a dynamic process that occurs whenever you open a portfolio scenario sheet. The projects that appear on the sheet will fluctuate, depending on whether they still meet the criteria for inclusion. For example, a project that was previously on the portfolio scenario sheet may be dropped from the sheet if it no longer meets the query criteria and another project may be added to the sheet because it now meets the query criteria.

According to the Portfolio Manager configuration, all the projects on the scenario sheet will be automatically linked when you first open the portfolio scenario sheet.

The data on the portfolio scenario sheet is linked to the project data and is updated every time you open the sheet.

Any new project that is added to the sheet will also be linked.

You can unlink one or multiple projects from the portfolio scenario sheet. If projects are unlinked, the data on the portfolio scenario sheet is not linked to the project data and will not be updated by changes in the project data. In addition, any new project that is added to the sheet will also be unlinked. See the Columns (on page 54) section for additional information.

To link a project back to the sheet:

1) Select the project rows that you want to link.
   - For a single project row, click the link icon in the second column, or click the Link/Unlink button.
   - For multiple project rows, click the Link/Unlink button.

When the project is linked, Unifier will display a link icon in the second column beside the names of the projects.

2) Click the Save icon.
To unlink a project from the scenario sheet:

1) Select the project rows that you want to unlink.
   - For a single project row, click the link icon in the second column, or click the Link/Unlink button.
   - For multiple project rows, click the Link/Unlink button.

   When the projects are unlinked, Unifier will delete the link icon in the second column beside the names of the projects.

2) Click the Save icon.

   You can also unlink a project by editing any cell in the row. Once you start editing, Unifier will automatically unlink the project from the project data.

   If an unlinked project shows a discrepancy between the actual project data and the data you entered on the sheet, Unifier will display the numbers in italics and flag the actual cell data that differs with a dark bar.

---

### Removing a Project from a Portfolio Scenario Sheet

Although the Portfolio Manager has been configured by Unifier to automatically add and remove projects to and from a portfolio scenario sheet (when they meet the correct inclusion or exclusion criteria), the portfolio planner can also manually remove a project from the portfolio scenario sheet. See the **Splitter Arrows** (on page 56) section for additional information.

The portfolio planner can use the splitter arrows to split the windows and add additional projects, from project candidates list, to the portfolio manually.

You can use the up arrow or down arrow on the splitter bar to add or remove projects.

The project candidate list shows only those projects that have not been added to any other portfolio for the same planning period. Also, the project candidate list does not show any projects that have already been added to the scenario.

When you remove a project from a portfolio scenario sheet, Unifier moves the project back to the project candidates list at the bottom of the window. If that project continues to match the query criteria for inclusion on the portfolio scenario sheet, it will remain on the candidates list; otherwise, it will drop from the list.

To remove a project:

1) Select the project that you want to remove from the portfolio scenario sheet.
   - To select multiple projects, hold down the CTRL key on your keyboard and click on the projects.
   - To select all the projects, highlight the first project, then hold down the SHIFT key and select the last project.

2) Click the remove arrow (down arrow). Unifier removes the project from the portfolio scenario sheet and recalculates the numbers.
**Editing Numbers on a Portfolio Scenario Sheet**

A primary function of portfolio scenario sheets is:

- To make it easy for the portfolio planner to modify numbers
- To see the resulting budget analysis quickly.

The portfolio planner can edit the following numbers on the portfolio scenario sheet:

- Cash flow projections
- Targets for cash flows and numeric columns
- Start and end dates for planned projects

When the portfolio planner edits any of these numbers, Unifier dynamically updates totals and calculates the differences between target numbers and those totals; however, Unifier does not change a project live data.

The portfolio planner’s proposed numbers are stored only in the Portfolio Manager and do not impact live project data until a portfolio scenario sheet has been approved by the company management.

**Note:** When the portfolio planner edits numbers in a project row, Unifier automatically unlinks that project row from the project data.

To edit numbers on the sheet:

1) Double-click the cell containing the number you want to change. The cell becomes editable.

   **Note:** If any yearly projections have been broken down into months, the portfolio planner must make edits in the month cells and not in the yearly total.

2) Enter the change.
3) Press the **Enter** key on your keyboard, or press the Tab key to move to the next editable cell in the row.

   Unifier updates the values in the Total and Difference rows for this column, and flags the cell to indicate that there is a discrepancy between the number you entered and the project data.

   **Note:** To leave a cell without saving changes, press the **Esc** key on the keyboard. Unifier restores the original numbers to the cell.

4) Click **Save All**.

**Accessing Project Data**

During the planning cycle, you (the portfolio planner) might need quick access to project data in order to view project characteristics, schedule activities, cost data, cash flow data, and other information.

In addition, you might need to update some of this data as you are working on a scenario.
For this purpose, the project names on a scenario sheet are hyperlinked to the project. If you have permissions, you can open the project's landing page from the scenario sheet and view or edit data directly in the project.

To drill down to project data:

1) On the scenario sheet, click the hyperlinked project name. Unifier opens the project landing page in a new window.
2) From the project landing page, navigate to project data and view or edit the data directly.

**Note**: The portfolio scenario sheet remains open in a separate window so that you can easily work on both the project data and the scenario sheet at the same time.

---

**Editing Project Data**

Your portfolio scenario sheets typically contain some project data or information. If this project information was configured to be editable, you (the portfolio planner) can edit it.

If you edit the project information, the changes that you make do not impact the project live data. Instead, your edits are stored only in the Portfolio Manager and do not impact the live project data until the pertinent portfolio scenario sheet has been approved by your company management.

When the portfolio scenario sheet is approved, Unifier updates specified edited shell information with the approved portfolio scenario sheet data, and you will be notified by email of the updates.

You cannot edit:

- Project name
- Number
- Status
- Location

**Note**: When you edit information in a project row, Unifier automatically unlinks that project row from the project data.

To edit project information:

1) Double-click the cell containing the information you want to change. The cell becomes editable.
2) Enter the change.
3) Press the **Enter** key on your keyboard, or press the **Tab** key to move to the next editable cell in the row.

Unifier updates the information in this column, and flags the cell to indicate that there is a discrepancy between the data you entered and the project's data.

**Note**: To leave a cell without saving your changes, press the **Esc** key on the keyboard. Unifier restores the original numbers to the cell.

4) Click **Save All**.
Changing Start Dates

You (the portfolio planner) can change the start dates of planned projects, but you cannot change the start dates of the projects that are in execution stage.

When you change a start date, Unifier shifts the end date to preserve the project duration. Unifier also shifts the cash flow numbers (excluding pre-actuals) left, or right, to preserve the cash flow distribution.

To change a start date:

1) Double-click the date in the Start Date column. Unifier displays a calendar.
2) Choose the new date from the calendar and press the Enter key on your keyboard.

Unifier shifts the end date and the cash flow numbers to reflect the change.

Before date change:

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Pre-Actuals</th>
<th>Total 2012</th>
<th>Total 2013</th>
<th>Total 2014</th>
<th>Total 2015</th>
<th>Total 2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/26/2011</td>
<td>05/31/2013</td>
<td>$7,777.78</td>
<td>$994,444.44</td>
<td>$592,222.22</td>
<td>$102,222.22</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

After date change:

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Pre-Actuals</th>
<th>Total 2012</th>
<th>Total 2013</th>
<th>Total 2014</th>
<th>Total 2015</th>
<th>Total 2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/26/2012</td>
<td>09/29/2013</td>
<td>$7,777.78</td>
<td>$994,444.44</td>
<td>$494,444.44</td>
<td>$500,000.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

How Unifier Distributes Cash Flow

Unifier stores all cash flow amounts by month in the database. The logic Unifier uses to distribute cash flow dollars is rendered in monthly allocations and presented as follows:

- If you move the start date backwards by (for example) three months, Unifier will move all the cash flow amounts (excluding the pre-actuals column) left by three months and display a zero dollar amount in the last three month columns for that year. Amounts from the following fiscal year will not move left.
- If you move a start date forward by three months, Unifier will move all the cash flow amounts (excluding the pre-actuals column) right by three months and display a zero dollar amount in the first three month columns. The cash flow amounts will continue to move forward in time, replacing the values of the next three months with the values of the past three months. If the cash flows through multiple years, the total for the next year will increase by the three months’ amount, and the monthly cash flow for the last three months of the previous year will replace the new year’s first three months. The rest of the new year’s monthly values will move forward three columns.

Changing Cash Flow Amounts

You can change the cash flow amounts of any project on the sheet, planned or in execution. When you change a number in the cash flow amounts, Unifier unlinks the project from the live project data. See Cash Flow and Capital Planning (on page 48) section for additional information.
To change a cash flow amount
1) Double-click the cell containing the amount you want to change.
2) Enter your change and press the Enter key on your keyboard.

The project’s Total amount and the year’s total amount increases or decreases by the amount you entered. Unifier calculates the difference, indicates the edited column amounts in italics, and also places a dark bar at the top of the cell in the actual project data.

Before change:

After change:

$15,000 added to Jan 2014 column. Total column and 2014 year column increased by $15,000. Dark bar added to cell in the actual project data that was changed by the edit.
Hiding or Showing Columns

To make viewing information easier on either the scenario sheet or the project candidate list, you (the portfolio planner) can hide any cash flow columns that might not contain data relevant to your current task.

To hide columns:
1) Click the arrow beside the column name and choose Columns.
2) On the list that appears, select the check box beside the columns you want to hide. Primavera Unifier removes those columns from view.

To show columns:
1) Click the arrow beside the column name and choose Columns.
2) On the list that appears, de-select the check box beside the columns you want to show. Primavera Unifier opens those columns to view.

See the **Columns** (on page 54) section for additional information.

Filtering Information on Portfolio Scenario Sheet

To make viewing project information easier, you (the portfolio planner) can use filters on both the scenario sheet and the project candidate list to narrow the focus of information to particular specifics, such as a date range, or a budget amount.

See the **Columns** (on page 54) section for additional information.

For example, you might want to see only those projects in a specific date range, or only those projects with budgets greater than a specific amount, or projects of a specific type.

How you filter information depends on the column you choose to use as a filter.

To filter information using a text column:
1) Click the arrow beside the column name and choose Filters.
2) In the text box that appears, enter the text you want to use as a filter, such as a project name or prefix.
   Unifier displays those projects that match the text you entered.

To filter information using a date column:
Click the arrow beside the column name and choose **Filters**.

- Choose **Before** to specify a date period before a particular date. Click the date on the calendar that appears. Unifier displays all the projects with a date value that occurs before the date you specified on the calendar.
- Choose **After** to specify a date period after a particular date. Click the date on the calendar that appears. Unifier displays all the projects with a date value that occurs after the date you specified on the calendar.
Choose **On** to specify a specific date. Click the date on the calendar that appears. Unifier displays all the projects with a date value that matches the date you specified on the calendar.

To filter information using a numeric column:

Click the arrow beside the column name and choose Filters.

- Enter a number **"greater than"** a specific number to display all the projects with numbers in that column greater than the number you specified.
- Enter a number **"less than"** a specific number to display all the projects with numbers in that column less than the number you specified.
- Enter a number **"equal to"** a specific number to display all the projects with numbers in that column that match the number you specified.

To return the sheet to an unfiltered state:

To return the sheet to an unfiltered state, click the arrow beside the column name and deselect the Filters check box.
You can group the data on the portfolio scenario sheet by column. Grouping data can make it easier to identify projects with similar characteristics, such as estimated cost or start date. You can group by any column except the Pre-Actuals and year columns. See the *Columns* (on page 54) section for additional information.

When you group data, Unifier displays a sub-total amount by group.

To group the data:

1) Identify the column by which you want to group the data and click the down arrow beside the heading.

2) Select *Group By This Field*.

Unifier groups the data by the column value. Groupings are separated and identified by the column value you grouped on, such as *Project State* "In Execution" and "Planning."

---

<table>
<thead>
<tr>
<th>Project Name</th>
<th>Project Number</th>
<th>Project State</th>
<th>Estimated Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Store</td>
<td>Proj-0005</td>
<td>Execution</td>
<td>$0.00</td>
</tr>
<tr>
<td>T:Maxx</td>
<td>Proj-0006</td>
<td>Execution</td>
<td>$0.00</td>
</tr>
<tr>
<td>Parking Extension</td>
<td>Proj-0003</td>
<td>Execution</td>
<td>$0.00</td>
</tr>
<tr>
<td>Banking Center HQ</td>
<td>Proj-0006</td>
<td>Execution</td>
<td>$0.00</td>
</tr>
<tr>
<td>Ast created Proj</td>
<td>Proj-0007</td>
<td>Execution</td>
<td>$0.00</td>
</tr>
<tr>
<td>ER Facility</td>
<td>Proj-0009</td>
<td>Execution</td>
<td>$0.00</td>
</tr>
<tr>
<td>Warehouse Expansion</td>
<td>Proj-0004</td>
<td>Execution</td>
<td>$0.00</td>
</tr>
<tr>
<td>Regional Bank/Branch 39</td>
<td>Proj-0002</td>
<td>Execution</td>
<td>$0.00</td>
</tr>
<tr>
<td>Project 2</td>
<td>Proj-0010</td>
<td>Execution</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

| Subtotals          |                |               | $2,083.33     |

<table>
<thead>
<tr>
<th>Project Name</th>
<th>Project Number</th>
<th>Project State</th>
<th>Estimated Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Expansion</td>
<td>Proj-0001</td>
<td>Planning</td>
<td>$0.00</td>
</tr>
<tr>
<td>Gates 3</td>
<td>PRJ-09007</td>
<td>Planning</td>
<td>$212,689.02</td>
</tr>
<tr>
<td>Mathilda Parking Lot</td>
<td>PRJ-0101</td>
<td>Planning</td>
<td>$50.00</td>
</tr>
<tr>
<td>Mathilda Shopping Complex</td>
<td>PRJ-0102</td>
<td>Planning</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>Rapid Transit Terminal 3</td>
<td>Proj-0027</td>
<td>Planning</td>
<td>$5,000,000.00</td>
</tr>
<tr>
<td>Rapid Transit Terminal 2</td>
<td>Proj-0026</td>
<td>Planning</td>
<td>$2,000,000.00</td>
</tr>
<tr>
<td>Reactor container repair</td>
<td>Proj-0024</td>
<td>Planning</td>
<td>$10,000,000.00</td>
</tr>
</tbody>
</table>

| Subtotals          |                |               | $2,083.33     |

---

You can expand and collapse a group by clicking the arrow here.

Once you have grouped the data, you can further refine the view by sorting and filtering the data within each group.

3) If you want to maintain the data in this grouping, click the *Save* icon. Whenever you open the sheet, it will display the data in this grouping.

To clear grouping of data:
1) Click the down arrow beside the column heading.
2) Select **Clear Grouping**.

### Sorting Data on Portfolio Scenario Sheet

To make data easier to locate alphanumerically on either the portfolio scenario sheet, or the project candidate list, you can sort the information by column in ascending or descending order.

To sort the sheet by column, click the arrow beside the column heading and choose **Sort Ascending** or **Sort Descending**.

You can also sort the data by multiple columns.

To do so, hold down the **Ctrl** key on the keyboard and click the arrows beside the column headings you want to sort by.

### Creating a New Portfolio Scenario Sheet

When you (the portfolio planner) create a portfolio scenario sheet, Unifier automatically creates one initial portfolio scenario sheet; however, you can create additional scenario sheets.

To create a new scenario sheet:

1) To add a new scenario sheet, click the plus sign at the bottom of the scenario sheet window.

   ![Click the plus sign.](image)

   Unifier adds a "new scenario" tab to the bottom of the window.

2) Enter a name for the new scenario and press the **Enter** key on your keyboard.

   You can include up to 30 characters in the name. Letters, numbers, hyphens, spaces, underscores, and special characters are allowed.

3) Click **Save All**.

   The project records that will be included on the scenario sheet are extracted from the database using a query that is part of your Portfolio Manager configuration.

   Whenever you create or open a portfolio scenario sheet, Unifier re-runs the query and adds or removes projects from the portfolio scenario sheet depending on whether the project matches the query criteria, or not.

   For example, a project that was previously on the portfolio scenario sheet may be dropped from the sheet if it no longer meets the query criteria. Another project may be added to the portfolio scenario sheet because it now meets the query criteria.

See the following sections for more information:

- **Portfolio Manager: Portfolio Scenario Sheet** (on page 49)
- **Scenario Tab** (on page 56)

### Editing the Name of a Portfolio Scenario Sheet

To edit the name of a portfolio scenario sheet:
1) At the bottom of the portfolio scenario sheet window, click on the tab showing the name you want to edit. The tab name becomes editable.

2) Change the name as necessary. You can include up to 30 characters in the name. Letters, numbers, hyphens, spaces, underscores, and special characters are allowed.

See the following sections for more information:

- **Portfolio Manager: Portfolio Scenario Sheet** (on page 49)
- **Scenario Tab** (on page 56)

### Duplicating a Portfolio Scenario Sheet

To duplicate a portfolio scenario use the the manage scenario (star) icon.

1) At the bottom of the portfolio scenario sheet window, select the tab containing the scenario you want to copy.

2) Click the manage scenarios icon and choose **Duplicate Selected Tab**.

Unifier copies the scenario into a new tab, which you can rename. All the projects in the original scenario will be copied to the new scenario, including their linked or unlinked state, and current column widths, targets, sorting, etc.

For the new scenario, Unifier will calculate the new totals and then calculate the variance to show the difference.

3) When finished, click **Save**.

See the following sections for more information:

- **Portfolio Manager: Portfolio Scenario Sheet** (on page 49)
- **Scenario Tab** (on page 56)

### Sharing a Portfolio Scenario Sheet

Sharing a portfolio scenario sheet allows the budget numbers that you (the portfolio planner) propose to become available to the project managers for review.

Since the project managers do not see the portfolio scenario sheet, or the changes that you have made, the project managers must use a read-only portfolio budget curve in the Cash Flow node of the Cost Manager to view both their original budget curve and a parallel scenario curve that shows the differences between their initial forecast projections and your proposed numbers.

In order for the project managers to see the portfolio budget curve, you must share the scenario.

For information about the portfolio budget curve, refer to the *Primavera Unifier User's Guide*. 
See the following sections for additional information:

- **Cash Flow and Capital Planning** (on page 48)
- **Portfolio Manager: Cash Flow Budget Curves** (on page 51)
- **Changing Cash Flow Amounts** (on page 61, [http://www.](http://www.))

**Notes:**
- The portfolio planner must have "full access" permission to share a scenario.
- The portfolio planner can share only one scenario at a time.

To share a portfolio scenario use the the manage scenario (star) icon.

1) At the bottom of the scenario sheet window, select the tab containing the scenario you want to share.
2) Click the manage scenarios icon and choose **Share Selected Tab**.
3) Click **Save All**.

Unifier visually marks the scenario tab with a "shared" icon and makes the scenario numbers visible on the portfolio budget cash flow curve for the project manager to see.

To stop sharing a scenario:

1) At the bottom of the scenario sheet window, select the tab containing the scenario you want to stop sharing.
2) Click the manage scenarios icon and choose **Stop Sharing Selected Tab**.
3) Click **Save All**.

**Deleting a Portfolio Scenario Sheet**

To delete a portfolio scenario use the the manage scenario (star) icon.

1) At the bottom of the scenario sheet window, select the tab containing the scenario you want to delete.
2) Click the manage scenarios icon and choose **Delete Selected Tab**.

3) Click **Save All**.

### Approving and Rejecting a Portfolio Scenario Sheet

After the project managers and portfolio planner agree on a portfolio scenario sheet, the portfolio planner can proceed to mark the scenario as "approved."

*Note:* The portfolio planner must have "full access" permission to approve a scenario.

Once the portfolio planner approves a portfolio scenario sheet, Unifier:

- Marks the approved scenario "shared" so that project managers can see the approved dates and numbers. The scenario is set to read-only mode and can no longer be modified or deleted.
  - *Note:* At this stage, the scenario tab shows both the shared and approved icons, next to the scenario name.

- Updates the original budget numbers of each project with the proposed numbers on the approved scenario.
- Updates the monthly or yearly cash flow number of each project with the proposed numbers on the approved scenario.
- Updates the project start date (if it was changed) for any planned projects that begins during the portfolio planning period.
- Updates the project/shell data with any project/shell information that was changed on the scenario sheet, and sends you an email notification of the updates.
- Locks the budget and cash flow numbers to prevent any further changes.

To approve a portfolio scenario use the the manage scenario (star) icon.

1) At the bottom of the scenario sheet window, select the tab containing the scenario you want to approve.
2) Click the **Manage Scenarios** icon and choose **Approve Selected Tab**.

3) Click **Save All**.

When you approve a scenario, Unifier automatically shares the scenario and visually marks the scenario tab with an **Approved and Shared** icon to indicate to project managers that this is the approved scenario.

A portfolio planner can reject an approved portfolio scenario sheet if:

- Major changes occur in the business environment that impact priorities and require diversion of budget.
- There is a need to alter an existing or approved plan.

To reject a portfolio scenario sheet:

1) At the bottom of the scenario sheet window, select the tab containing the scenario you want to un-approve.
2) Click the manage scenarios icon and choose **Un-Approve Selected Tab**.
   - The portfolio planner deletes the approval icon from the tab, but does not delete the shared icon.
   - If the portfolio planner decides to stop sharing the scenario as well, the portfolio planner must click the manage scenarios icon and choose **Unshare Selected Tab**.
3) Click **Save All**.

   **Note**: If the portfolio planner rejects a portfolio scenario sheet, Unifier does not reset dates to their original values and the date fields retain the approved values.

---

**Exporting a Portfolio Scenario Sheet**

To use a portfolio scenario sheet data for additional purposes, you (the portfolio planner) can export your scenario sheets to Excel.
To export a portfolio scenario sheet:

Click **Export**, at the top of the Portfolio Planner window, to begin exporting the portfolio scenario sheet to Excel.

Follow the prompts and open, or save, the Excel sheet.

When you open the Excel sheet, the application displays the data from each scenario sheet, arrayed in tabs and columns identical to the Portfolio Manager scenarios.

The Excel sheet includes any formulas that were created in the Portfolio Manager for calculating values.

The Excel sheet also honors the frozen columns and the scrolling ability (so that you can scroll through the cash flow columns).

---

**Primavera Project Delivery Management (PPDM)**

Primavera Project Delivery Management (PPDM) is designed to optimize your project results. PPDM contains a set of interactive tools (including dashboards) for project team members to collaborate, communicate, collect documents, share reports, and track tasks.

You can use these interactive tools to create project artifacts essential for keeping everyone on the same page and establishing an audit trail.

Once you enter your company users into Unifier, and grant your company users permissions to PPDM, PPDM is ready for use with no additional design or configuration required.

**Note:** Before you use the Project Controls base product, you need to prepare and configure the data that you need for using each component, in Unifier. Refer to the **Primavera Unifier User’s Guide** for instructions on how to prepare and configure the necessary data.

The following sections provide details about PPDM and is based on the default setup of Unifier.

---

**Accessing PPDM**

**Notes:**

- The following instructions are only applicable if you have prepared and configured the necessary data that you need for using this feature in Unifier.

- Before you continue, set your preferences in Unifier. Refer to the **Primavera Unifier User’s Guide** for details.

- All of the pre-configured designs are in the shell templates. Administrators have to first create a shell/project using the pre-configured shell template.
To access Primavera Project Delivery Management (PPDM) business processes (BPs):

1) **Sign in** to Unifier. Refer to the *Primavera Unifier User's Guide* for additional information.
2) Open a project.
3) Switch to **User** mode. The Logs node appears in the Navigator.
4) Click **Logs** node to expand and access the PPDM BPs.

**Note:** The administrator sets up the structure of the nodes and modules in the Navigator. Business processes could appear in folders that are placed in appropriate nodes.

The following sections provide details about using the PPDM BPs and is based on the default setup of Unifier.

**Using PPDM**

Using PPDM involves day-to-day monitoring of a project's life cycle.

With PPDM you can:
- Collaborate and communicate with project team members
- Collect documents
- Share reports
- Track tasks
- Create project information that is essential for keeping everyone on the same page
- Establish an audit trail of project events

With the PPDM business processes (BPs) you can:
- Transmit project documentation, such as drawings and specifications, route these items through the approval process, and create a permanent record of the transmission
- Communicate with team member on project-related issues
- Route a design review record through the approval process
- Create punch lists and route them through the approval process

With the PPDM Reports you can monitor:
- Open Action Items
- Architect's Supplemental Instructions
- Correspondence
- Daily Reports
- Design Change Requests
- Meeting Minutes
- Punchlist Summary
- Punchlist Details
- Submittals
- Transmittals
- Warranties
See the PPDM Reports section for more details.

Using the Document Manager, you can also maintain all the files and documents for a project. The Document Manager ensures that employees and project members are always using the most current versions of documents and makes accessing and distributing documents efficient. See the Document Manager section for details.

### PPDM Reports

The following reports are included in PPDM. These reports can give you insight into the status of your project delivery. The reports provide data from the shell level (Projects), company level, and shell and company level.

#### Shell-level reports

- Action Items Progress Report
- Open Action Items
- Architect's Supplemental Instructions Summary
- Architect/Engineer Daily Observations Summary
- Correspondence Log
- Daily Reports
- Design Change Requests Summary
- Design Reviews Summary
- Incident Reports Summary
- Lessons Learned Summary
- Meeting Minutes Summary
- Monthly Updates Summary
- Notices to Proceed Summary
- Punchlist Summary
- Punchlist Detail
- RFIs Status Report
- Submittals Summary
- Transmittals Summary
- Warranties Summary

#### Company-level Report

- Project Requests Summary

#### Shell-level and Company-level Reports

- Project Information
- Project Status
- Project Users
Custom Reports

Shell-Level Reports
- Design Reviews
- Items Overdue
- Project Daily Reports
- Submittals by Submittal Package
- Tasks Due within 7 Days

Top-Level Shell Reports
- All Projects Daily Reports

PPDM Dashboards

Configurable shell dashboards display project data from the shell hierarchy in an at-a-glance format. With PPDM you receive a configured dashboard showing Project Delivery information.

The dashboard consists of four blocks that aggregate project business process records:
- Action Items by Status
- Incidents by Injury Type
- RFIs by Status
- Submittals by Status

For more information about dashboards, refer to the Primavera Unifier User's Guide.
PPDM Business Processes

The Project Delivery Management business processes reside at two levels: the company level, and the project level.

Notes:

- You receive these business processes with the Project Controls base product.
- These business processes have been designed for immediate use; they do not need to be configured or set up.
- The following sections provide necessary details about each Project Delivery Management business process.

At the company level, the following business processes reside:

- **New User Requests**: Use this business process to ask the administrator to create a new user.
- **Project Requests**: Use this business process to initiate the approval process for new projects.
- **Vendor Prequal Requests**: Use this business process to initiate and confirm or deny a new vendor approval request.
- **Vendors**: Use this business process to capture and store vital information regarding a Vendor.

At the project level, the following business processes reside:

- **Action Items**: Use this business process to capture tasks identified in meetings, and track these items through completion.
- **Architect/Engineer Daily Observations**: Use this business process for documenting observed structural elements, their locations, and any deficiencies in the project.
- **Architect’s Supplemental Instruction**: Use this business process for architects to submit additional instructions and route the record through the approval process.
- **Correspondence**: Use this business process to document and track correspondence.
- **Daily Reports**: Use this business process to create daily reports for equipment, materials, visitors, and workforce.
- **Design Change Request**: Use this business process to request design changes.
- **Design Reviews**: Use this business process to route the design review record through the approval process.
- **Incident Reports**: Use this business process to record any project incidents.
- **Lessons Learned**: Use this business process to record project issues, reasons, solutions, and recommendations.
- **Meeting Minutes**: Use this business process to record meeting minutes and to automatically generate “Action Items” business process records.
- **Monthly Updates**: Use this business process to create and route monthly reports.
- **Notices to Proceed**: Use this business process to create and route notices to proceed with a contract through the approval process.
- **Project Closeout**: Use this business process to keep track of project closeout items.
- **Project Information**: Use this business process to record and store project details.
Punchlist: Use this business process to create punch lists and route them through the approval process.

Requests for Information (RFI): Use this business process to ask project-related questions.

Submittals: Use this business process to submit project documents.

Submittal Register: Use this business process to list submittals and track their statuses.

Transmittals: Use this business process to transmit project documentation, such as drawings and specifications, route these items through the approval process, and create a permanent record of the transmission.

Warranties: Use this business process to record and store warranty information.

Each business process is explained in the proceeding sections.

For more details about business processes, refer to the:

- Primavera uDesigner User's Guide
- Primavera Unifier User's Guide

In This Section

Action Items Business Process ................................................................. 77
Architect/Engineer Daily Observations Business Process ................................ 81
Architect’s Supplemental Instructions Business Process ................................ 85
Correspondence Business Process .............................................................. 89
Daily Reports Business Process ................................................................. 93
Design Change Request Business Process .................................................. 97
Design Reviews Business Process ............................................................... 101
Incident Reports Business Process ............................................................. 105
Lesson Learned Business Process ............................................................. 109
Meeting Minutes Business Process ............................................................ 111
Monthly Updates Business Process ............................................................ 117
Notices to Proceed Business Process ......................................................... 121
Project Closeout Business Process ............................................................. 125
Project Requests Business Process ............................................................ 127
Punchlist Business Process ........................................................................ 133
Requests for Information (RFI) Business Process ........................................ 137
Submittal Register Business Process ........................................................... 141
Submittals Business Process ...................................................................... 147
Transmittals Business Process .................................................................... 153
Warranties Business Process ..................................................................... 159
**Action Items Business Process**

**Purpose**
Create and assign tasks to one or more people.

**Characteristics**
This is a Project or Shell level business process with a workflow. Action items are often auto-created in the Meeting Minutes business process.

**Roles**
Members of All Project Users group.

**In This Section**
Creating an Action Items Record ............................................................................. 77
Revising an Action Items Record ............................................................................. 79
Closing an Action Items Record ............................................................................. 79

**Creating an Action Items Record**
1) Go to your project and ensure that you are in User Mode.
2) Click Collaboration node to expand and click Tasks to open the Tasks log.
3) Click New from the menu and click Action Items to open the Create New Action Items window for your project.
4) Complete the form according to the following information.

   **Note:** You must enter a value in all required fields (*) before you can save the form.

**Action Item tab**

**General**

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Title</td>
<td>(Required) Enter a title for this BP</td>
</tr>
<tr>
<td>Project Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Creator</td>
<td>No action.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>No action.</td>
</tr>
<tr>
<td>Due Date</td>
<td>No action.</td>
</tr>
</tbody>
</table>
Primavera Unifier Project Controls User's Guide

Status | No action.

Action Item Information

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Item Status</td>
<td>(Required) Select the status</td>
</tr>
<tr>
<td>Short Description</td>
<td>Enter a brief description</td>
</tr>
<tr>
<td>Priority</td>
<td>No action.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Enter the workflow Due Date.</td>
</tr>
</tbody>
</table>

Meeting Details

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Meeting Minute Line</td>
<td>No action.</td>
</tr>
</tbody>
</table>

Description

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a comprehensive description</td>
</tr>
<tr>
<td>Notes/Resolution</td>
<td>Enter notes</td>
</tr>
</tbody>
</table>

Creation Details tab

Create New Action Items

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Enter email address of the recipients</td>
</tr>
<tr>
<td>Cc</td>
<td>(Optional)</td>
</tr>
</tbody>
</table>
In this field: | Do this:
---|---
Task Notes | Click on the icon (Task Notes) to open Add Notes window and enter notes.

- Click **Save** to save a draft, and click **OK**.
- After completing the form, select **Send for Response** from the **Workflow Actions**. The **Action Details** tab is enabled only after you select a workflow action.
- Click **Send**. When the **Notification** window opens, review the content and click **OK**.

**Revising an Action Items Record**

1) Go to your project and ensure that you are in **User Mode**.
2) Click **Collaboration** node to expand and click **Tasks** to open the **Tasks** log.
3) From the Task log, click to select the task that you want to work with. See the **Tasks Log** (on page 39) section for more details.
4) From the menu, click **Open** to open the **Action Items** record.
5) Review the record and click **Accept Task** to continue.
6) Complete the form accordingly and click **Save**.
7) From the **Workflow Actions** list, select **Send for Review**.
8) Select and add recipients, follow the prompts, and click **Send**.

**Closing an Action Items Record**

To review and close the Action Items record and send the record to the End step:

1) Go to your project and ensure that you are in **User Mode**.
2) Click **Collaboration** node to expand and click **Tasks** to open the **Tasks** log.
3) From the **Task** log, click to select the task that you want to review and close.
4) Click **Open** from the menu to open the Action Items record.
5) Complete the form accordingly and click **Save**.
6) From the **Workflow Actions** list, select **Close Action Item**.
7) Select and add recipients, follow the prompts, and when finished, click **Send**.

The **Action Items** record is closed and removed from the **Tasks** log.
Architect/Engineer Daily Observations Business Process

Purpose
Record an architect's or engineer's daily structural observations at a site.

Characteristics
This is a Project or Shell level with a workflow.

Roles
Architect or engineer creates the architect/engineer daily observation business process record and forwards it to the project manager for review and approval.

In This Section
Architect/Engineer Daily Observations Business Process Workflow ......................... 82
Creating Architect/Engineer Daily Observations Record ........................................ 82
Revising Architect/Engineer Daily Observations Record ......................................... 83
Approving Architect/Engineer Daily Observations Record ...................................... 83
Viewing Closed Architect/Engineer Daily Observations Record ............................... 83
Architect/Engineer Daily Observations Business Process Workflow

The following diagram shows the four steps of the Architect/Engineer Daily Observations workflow. The action you take on a step determines the record status on the next step. For example, if on the Revision step you select Cancel Daily Observation, the record moves to the End step with a record status of Canceled. Sending a record to either the Approval step or the Revision step creates a task for the record recipient.

Creating Architect/Engineer Daily Observations Record

Create an Architect/Engineer Daily Observations record in the Tasks log to initiate and accept/reject a new Architect/Engineer Daily Observations request.

Attach files such as drawings and specifications to the record for reference purposes.

After completing the Architect/Engineer Daily Observations form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

Note: You must enter a value in all required fields (*) before you can save the form.

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks to create business process records and manage tasks.
4) Click New.
5) Click Architect/Engineer Daily Observations.
6) (Required) In the Title field, enter a title.
7) In the Structural Observer field, enter a description.
8) In the **Observation Period Form** field, click the **Date/Time** icon, select a date, and click **OK**.
9) In the **Observation Period To** field, click the **Date/Time** icon, select a date, and click **OK**.
10) In the **Observed Structural Elements** field, enter a description.
11) In the **Location** field enter the location of the specified structural elements.
12) Click **Add Attachment**, select **Unifier Folder**, select a file, and click **OK**. The **Attachments** link indicates (1) file is attached to the record.
13) From the **Workflow Actions** list, select **Send for Approval**. The **To** field is auto-filled with the names of the users who can approve the record, according to the workflow.
14) Click **Send** to route the record for approval and then click **OK**.

---

**Revising Architect/Engineer Daily Observations Record**

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** and open an **Architect/Engineer Daily Observations** task.
4) Review the record and click **Accept Task**.
5) Fill out the form according to your needs.
6) From the **Workflow Actions** list, select **Resubmit for Approval**.
7) Click **Send** to route the record for approval and then click **OK**.

---

**Approving Architect/Engineer Daily Observations Record**

1) Navigate to the **Tasks** log in your project.
2) In the **Items Requiring You Attention** section click **Tasks**.
3) Select a task, open and review the content
4) Click **Attachments**, select a file, click **Download** or **View**, and click **Close Window**.
5) Click **Accept Task**.
6) From the **Workflow Actions** list select **Approve Daily Observation**.
7) Click **Send** to conclude the approval process.

---

**Viewing Closed Architect/Engineer Daily Observations Record**

You can view a closed **Architect/Engineer Daily Observations** record in the **Architect/Engineer Daily Observations** business process log.

When the record is at the **End** step, the record is in terminal status which means that the record has been: **Approved**, **Rejected**, or **Canceled**.

You can also open a closed **Architect/Engineer Daily Observations** record to see who has reviewed the record and at which step.
1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Architect/Engineer Daily Observations**.
4) Select the appropriate line item (a closed Architect/Engineer Daily Observations record) from the list and open the record.
5) From the **Task Details**, click **Click here** to open the **BP Progress** window. The **BP Progress** window shows that the submittal is on the **End** step.
6) Click **View Graphic** to open the workflow graphic showing tasks steps and links. The current step (**End**) is highlighted.
7) Click **Close Window**, click **Close**, and click **Close Window** to finish viewing a closed record.
Architect's Supplemental Instructions Business Process

**Purpose**
Distribute instructions or design related changed to the project team.

**Characteristics**
This is a Project or Shell level with a workflow.

**Roles**
Architect/engineer creates, submits, and updates the record for review. The project manager can review, request clarification, and approve the Architect's Supplemental Instructions record.

---

**In This Section**
- Architect's Supplemental Instructions Business Process Workflow ........................................ 86
- Creating Architect's Supplemental Instructions Record .................................................. 86
- Revising Architect's Supplemental Instructions Record .................................................. 87
- Approving Architect's Supplemental Instructions Record .............................................. 87
- Viewing Closed Architect's Supplemental Instructions Record ........................................ 87
**Architect’s Supplemental Instructions Business Process Workflow**

The following diagram shows the four steps of the Architect's Supplemental Instructions workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select Resubmit for Approval, the record moves to the Approval step with a record status of Pending. Sending a record to either the Revision step or the Approval step creates a task for the record recipient.

![Architect's Supplemental Instructions Workflow Diagram]

**Creating Architect’s Supplemental Instructions Record**

Create an Architect’s Supplemental Instructions record in the Tasks log to initiate and accept/reject a new Architect’s Supplemental Instructions request.

In the Architect’s Supplemental Instructions form, provide detailed instructions and attach related documents. After completing the Architect’s Supplemental Instructions form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

**Note:** You must enter a value in all required fields (*) before you can save the form.

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** to create business process records and manage tasks.
4) Click **New**.
5) Click **Architect’s Supplemental Instructions**.
6) (Required) In the **Title** field, enter a title.
7) In the **Contract Reference** field, click **Select** and select a contract.
8) Click **Open** to open the contract and add details about the design change.
9) In the **Bulletin Number** field, enter a number.
10) From the **Schedule Impact** list, select an option (No).
11) From the **Cost Impact** list, select an option (No).
12) In the **Instructions** field, enter a description.
13) Click **Add Attachment**, select **Unifier Folder**, select a file, and click **OK**.
14) From the **Workflow Actions** list, select **Send for Approval**.
15) Click **Send** to route the record for approval and then click **OK**.

### Revising Architect's Supplemental Instructions Record

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** and open an **Architect's Supplemental Instructions** task.
4) Review the record and click **Accept Task**.
5) From the **Schedule Impact** list select an option (Yes).
6) From the **Cost Impact** list select an option (Yes).
7) From the **Workflow Actions** list, select **Resubmit for Approval**.
8) Click **Send** to route the record for approval and then click **OK**.

### Approving Architect's Supplemental Instructions Record

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** and open an **Architect's Supplemental Instructions** task record that was sent for approval.
4) Review the record and click **Accept Task**.
5) Click **Attachments**, select a file, click **Download** or **View**, and click **Close Window**.
6) From the **Workflow Actions** list select **Approve ASI**.
7) Click **Send** to conclude the approval process.

### Viewing Closed Architect's Supplemental Instructions Record

You can view a closed **Architect's Supplemental Instructions** record in the **Architect's Supplemental Instructions** business process log.

When the record is at the **End** step, the record is in terminal status which means that the record has been: **Approved**, **Rejected**, or **Canceled**.

You can also open a closed **Architect's Supplemental Instructions** record to see who has reviewed the record and at which step.

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Architect's Supplemental Instructions.**
4) Select the appropriate line item (a closed Architect's Supplemental Instructions record) from the list and open the record.
5) From the **Task Details**, click **Click here** to open the **BP Progress** window. The **BP Progress** window shows that the submittal is on the **End** step.
6) Click **View Graphic** to open the workflow graphic showing tasks steps and links. The current step (**End**) is highlighted.
7) Click **Close Window**, click **Close**, and click **Close Window** to finish viewing a closed record.
Correspondence Business Process

Purpose
Capture ad-hoc correspondence produced during the project, such as hard copy letters, phone conversations, and other general communication.

Characteristics
This is a Project or Shell level business process with a workflow. Correspondence log stores all correspondence records.

Roles
Any project participant can create, submit for review, and revise correspondence records for approval and cancel reviewed records. The role of the project manager is to review, approve, cancel or reject correspondence records.

In This Section
Correspondence Workflow ................................................................. 90
Creating a Correspondence Record ..................................................... 90
Revising a Correspondence Record ...................................................... 92
Approving a Correspondence Record .................................................. 92
Viewing a Closed Correspondence Record ........................................ 92
Correspondence Workflow

Below are the four steps of the Correspondence workflow. The action you take on a step determines the record status on the next step. For example, if on the Review step you select Send for Clarification, the record moves to the Revision step with a record status of Pending. Sending a record to either the Review step or the Revision step creates a task for the record recipient.

Creating a Correspondence Record

1) Go to your project and ensure that you are in User Mode.
2) Click Collaboration node to expand and click Tasks to open the Tasks log window.
3) Click New from the menu and click Correspondence to open the Create New Correspondence window for your project.
4) Complete the form according to the following information.

Note: You must enter a value in all required fields (*) before you can save the form.

Correspondence tab

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>In this field:</strong></td>
</tr>
<tr>
<td>Record Number</td>
</tr>
<tr>
<td>Title</td>
</tr>
<tr>
<td>Project Number</td>
</tr>
<tr>
<td>Project Name</td>
</tr>
<tr>
<td>In this field</td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
<tr>
<td>Creator</td>
</tr>
<tr>
<td>Creation Date</td>
</tr>
<tr>
<td>Due Date</td>
</tr>
<tr>
<td>Status</td>
</tr>
<tr>
<td>Contract Reference</td>
</tr>
</tbody>
</table>

**Correspondence Detail**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Name</td>
<td>Enter company name.</td>
</tr>
<tr>
<td>Correspondence Type</td>
<td>Use the list to select the preferred option.</td>
</tr>
<tr>
<td>Direction</td>
<td>Use the list to select a correspondence direction.</td>
</tr>
</tbody>
</table>

**Source Document**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Type</td>
<td>Use the list to select a document type.</td>
</tr>
<tr>
<td>Date</td>
<td>Click the calendar icon to determine the date.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the source document.</td>
</tr>
<tr>
<td>Cost</td>
<td>Enter the cost.</td>
</tr>
<tr>
<td>Item Status</td>
<td>Use the list to select a progress status.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>Use the list to select a section.</td>
</tr>
</tbody>
</table>

**Correspondence**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correspondence</td>
<td>Enter the message that was communicated during the correspondence.</td>
</tr>
</tbody>
</table>

5) Click **Save**, and click **OK**.
6) After completing the form, select **Send for Approval** from the **Workflow Actions**.
7) When the **Notification** window opens, review the content and click **OK**. The **Create New Correspondence** window opens.
8) Go to **Action Details** and click **To**. The **User/Group** Picker window opens.
9) Click to select users or group (use CTRL-click to select multiple names).
10) Click **Add** to add the selected names to the **Selected Users/Groups** field.
11) Click **OK**. The **Create New Correspondence** window opens.
12) Click the **Task Notes** icon to enter notes.
13) From the menu, click **Save**, follow the prompts, and click **Send**.
14) When the Notification window opens, review the content and click **OK**.

### Revising a Correspondence Record

1) Go to your project and ensure that you are in **User Mode**.
2) Click **Collaboration** node to expand and click **Tasks** to open the **Tasks** log window.
3) From the **Task** log window, double-click on the task to open the tasks that you want to revise.
4) Review the record and click **Accept Task**. The **Correspondence (Work Release)** window opens.
5) Review the form, click **Save**, follow the prompts, and click **OK**.
6) From the **Workflow Actions** list, select **Send for Clarification**.
7) Select and add recipients, follow the prompts, and click **Send**.

### Approving a Correspondence Record

1) Go to your project and ensure that you are in **User Mode**.
2) Click **Collaboration** node to expand and click **Tasks** to open the **Tasks** log window.
3) From the **Task** log window, double-click on the task to open the tasks that you want to revise.
4) Review the record and click **Accept Task**. The **Correspondence (Work Release)** window opens.
5) From the **Workflow Actions** list, select **Approve Correspondence**.
6) Click **Send** to route the task to the **End** step, and remove the task from the **Tasks** list.

### Viewing a Closed Correspondence Record

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Correspondence**.
4) Double-click a task to open.
5) From the **Task Details** tab, click **Click here** to open the **BP Progress (Workflow Progress)** window.
6) Ensure that the value for the **Current Step** is **End**.
7) Under the **Step Name** field, click **Review** to select.
8) Click **View Graphic** to open the **Workflow Designer** window. The **End** box is highlighted.
Daily Reports Business Process

Purpose
Record activities, progress, site visits, issues, resolutions, and other information related to a job site.

Characteristics
This is a Project or Shell level with line items and a workflow. The Daily Reports log stores all daily report records and their status.

Roles
Contractor creates, submits, and updates daily reports for review. Project manage reviews

In This Section
Daily Reports Business Process Workflow .............................................................. 94
Creating Daily Reports Record ................................................................................ 94
Routing a Vendors Evaluations Record from the Approval Step .............................. 95
Closing Daily Reports Record .................................................................................. 95
Viewing Closed Daily Reports Record ....................................................................... 95
Daily Reports Business Process Workflow

The following diagram shows the four steps of the Daily Reports workflow. The action you take on a step determines the record status on the next step. For example, if on the Revision step you select Close Daily Report, the record moves to the End step with a record status of Approved. Sending a record to either the Review step or the Revision step creates a task for the record recipient.

Creating Daily Reports Record

Create a Daily Reports record in the Tasks log to initiate and accept/reject a new Daily Reports. List the equipment, visitors, workforce, and materials used at the site during a time period. After completing the Daily Reports form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

Note: You must enter a value in all required fields (*) before you can save the form.

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks to create business process records and manage tasks.
4) Click New.
5) Click Daily Reports.
6) (Required) In the Title field, enter a title.
7) In the Contract Reference field click Select and select a contract to open.
8) Fill out the fields in each tab according to your needs.
9) When finished entering information in Workspace tab, from the Workflow Actions list, select Send for Review.
10) Click **Send** to route the record for approval and then click **OK**.

**Routing a Vendors Evaluations Record from the Approval Step**

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click Tasks and open the **Daily Reports** record that you want to revise.
4) Click **General Comments**, view the existing comment, and when finished click **Cancel**.
5) Click **Accept Task**.
6) Fill out the fields in each tab according to your needs and when finished, click **OK**.
7) From the Workflow Actions list, select **Resubmit for Approval**.
8) In the **Action Details** tab click **To**, select and add recipients, and click **OK**.
9) Click **Send** to route the record for approval and then click **OK**.

**Closing Daily Reports Record**

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** and open the **Daily Reports** record that you want to close.
4) Review the record and when finished click **Accept Task**.
5) From the **Workflow Actions** list, select **Close Daily Report**.
6) Click **Send**.

**Viewing Closed Daily Reports Record**

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Daily Reports**.
4) Select the appropriate line item (a closed Daily Reports record) from the list and open the record.
5) From the **Task Details**, click **Click here** to open the **BP Progress** window. The **BP Progress**
   window shows that the submittal is on the **End** step.
6) Click **View Graphic** to open the workflow graphic showing tasks steps and links. The current step (**End**) is highlighted.
7) Click **Close Window**, click **Close**, and click **Close Window** to finish viewing a closed record.
Design Change Request Business Process

Purpose
Record requests for adjustments during the design phase of a project.

Characteristics
This is a Project or Shell level with a workflow.

Roles
Contractor creates, submits, and updates documents for review, and cancels reviewed documents. The role of the project manager or architect/engineer is to review, approve, cancel, or reject the Design Change Request documents.

In This Section
Design Change Request Business Process Workflow ............................................. 98
Creating a Design Change Request Record ............................................................ 98
Revising a Design Change Request Record ............................................................ 99
Approving a Design Change Request Record ......................................................... 99
Viewing a Closed Design Change Request Record .................................................. 99
**Design Change Request Business Process Workflow**

The following diagram shows the four steps of the Design Change Request workflow. The action you take on a workflow step determines the business process record's status on the next step. For example, if you select Resubmit for Approval on the Revision step, the record moves to the Approval step with a record status of Pending. Sending a record to the next step creates a task for the assignee, except on the End step.

![Design Change Request Workflow Diagram](image)

**Creating a Design Change Request Record**

Create a Design Change Request record in the Tasks log to initiate and accept/reject a new design change request.

Provide a description, reason and impact of the proposed change.

After completing the Design Change Request form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

**Note:** You must enter a value in all required fields (*) before you can save the form.

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** to create business process records and manage tasks.
4) Click **New**.
5) Click **Design Change Requests**.
6) (Required) In the **Title** field, enter a title.
7) In the **Contract Reference** field, click **Select** and select a contract.
8) Click **Open** to open the contract and add details about the design change.
9) In the Change Description field, enter a description.
10) In the Justification field, enter a description.
11) In the Project Impact field, enter a description.
12) From the Document Type list, select Design Documents.
13) From the Workflow Actions list, select Send for Approval.
14) Click Send to route the record for approval and then click OK.

Revising a Design Change Request Record
1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks and open a Design Change Request task.
4) Click General Comments, review comments, and click Cancel.
5) Click Accept Task.
6) From the Workflow Actions list, select Resubmit for Approval.
7) Click Send to route the record for approval and then click OK.

Approving a Design Change Request Record
1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks and open the Design Change Request record that was sent for approval.
4) View the record status and click Accept Task.
5) From the Workflow Actions list select Approve Design Change.
6) Click Send to conclude the approval process.

Viewing a Closed Design Change Request Record
You can view a closed Design Change Request record in the Design Change Request business process log.

When the record is at the End step, the record is in terminal status which means that the record has been: Approved, Rejected, or Canceled.

You can also open a closed Design Change Request record to see who has reviewed the record and at which step.
1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Design Change Request tab to expand and review the contents.
4) Select the appropriate line item (a closed Design Change Request record) from the list and open the record.

5) From the Task Details, click Click here to open the BP Progress window. The BP Progress window shows that the submittal is on the End step.

6) Click View Graphic to open the workflow graphic showing tasks steps and links. The current step (End) is highlighted.

7) Click Close Window, click Close, and click Close Window to finish viewing a closed record.
Design Reviews Business Process

Purpose
Track design evaluations during the design phase.

Characteristics
This is a Project or Shell level business process with a workflow. The Design Reviews log stores all design review records.

Roles
Architect or engineer can create, revise, and submit design review records for approval and cancel reviewed records. The role of the project manager is to review, approve, cancel or reject the design review records.

In This Section
Design Reviews Workflow ................................................................. 102
Creating a Design Reviews Record ............................................... 102
Reviewing Design Reviews Record ................................................ 103
Approving Design Reviews Record .............................................. 103
Viewing Closed Design Reviews Record .................................... 104
Design Reviews Workflow

The following diagram shows the four steps of the Design Review workflow. The action you take on a workflow step determines the business process record’s status on the next step. For example, if you select Resubmit for Approval on the Revision step, the record moves to the Approval step with a record status of Pending. Sending a record to the next step creates a task for the assignee, except on the End step.

Creating a Design Reviews Record

Create a Design Reviews record in the Tasks log to initiate and accept/reject a new design reviews approval request.

Provide general information, such as the materials shipped and the delivery format, in the Design Reviews form. In the Line Items section, attach documents related to the design review. Documents may be reviewed during the approval process. After completing the Design Reviews form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

Note: You must enter a value in all required fields (*) before you can save the form.

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks to create business process records and manage tasks.
4) Click New.
5) Click Design Reviews.
6) (Required) In the Title field, enter a title.
7) Click the Design Review tab to expand it.
8) In the **Summary** field, enter a description and proceed to add attachments that need to be reviewed and approved (to be used) in the project.

9) Click the **Line Items** tab and click **Add**.
10) Click **Attachment** and then click **Add Attachment**.
11) Select the **Unifier Folder** source > folder > **Structural**.
12) Select a file and click **OK**.
13) From the **Discipline** list, select **Structural**.
14) From the **Line Item Status** list, select **Open**, and click **OK** to attach the file to your record.
15) From the **Workflow Actions** list, select **Send for Approval**.
16) On the **Action Details** tab, click **To**, select and add an assignee, click **Add**, and click **OK**.
17) Click **Send** to route the record for approval and then click **OK**.

---

**Reviewing Design Reviews Record**

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** and open the **Design Review** record that you want to review.
4) Click **Design Review** tab to expand and review the contents.
5) Select the appropriate line item from the list and click **Download**.
6) Click **Open** to open the document, review the content, and click **Save** to save the file.
7) Click **Accept Task**.
8) In the **Action Details** tab click the **Task Notes**, enter notes, and click **Ok** when finished.
9) From the **Workflow Actions** list select **Send for Revision** and click **Send** to finish reviewing the record.

**Note:** The **Design Reviews** record is no longer listed in the **Tasks log** because the record was forwarded to another assignee for revision.

---

**Approving Design Reviews Record**

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** and open the **Design Reviews** record that was sent for approval.
4) View the record status and click task status: **Not Started**.

**Note:** In the current workflow step, Approval is indicated in **bold**. You can select a step to view which assignees performed tasks for that step.

5) Click the **Revision** step and click **View Graphic** to open the workflow graphic showing tasks steps and links. The current step is highlighted.
6) Click Close Window.
7) Click Accept Task and view the line items related to your Design Reviews record.
8) Click the Line Items tab, select a file, and click Download.
9) Click Open to open the document, review the content, and click Save to save the file.
10) From the Workflow Actions list select Approve Design Review.
11) Review the changes in Action Details.

Note: The Action taken is Approve Design Review and the To option is disabled. No assignees are present because the system routed the record to the End step.

12) Click Send to conclude the approval process.

Viewing Closed Design Reviews Record

You can view a closed Design Reviews record in the Design Reviews business process log. When a record is at the End step, the record is in terminal status which means that the record has been: Approved, Rejected, or Canceled.

You can also open a closed Design Reviews record to see who has reviewed the record and at which step.

1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Design Review tab to expand and review the contents.
4) Select the appropriate line item (a closed Design Reviews record) from the list and open the record.
5) From the Task Details, click Click here to open the BP Progress window. The BP Progress window shows that the submittal is on the End step.
6) Click View Graphic to open the workflow graphic showing tasks steps and links. The current step (End) is highlighted.
7) Click Close Window, click Close, and click Close Window to finish viewing a closed record.
Incident Reports Business Process

Purpose
Initiate and accept/reject a new incident report request, capture and store information regarding a safety issue.

Characteristics
This is a Project or Shell level with line items and a workflow.

Roles
Contractor creates, submits, and updates records for review, and cancels reviewed records. Project manager reviews, approves, cancels, or rejects the incident reports record.

In This Section
Incident Reports Business Process Workflow ........................................................ 106
Creating Incident Reports Record ................................................................. 106
Revising Incident Reports Record ............................................................... 107
Approving Incident Reports Record ............................................................. 107
Viewing Closed Incident Reports Record .................................................... 107
Incident Reports Business Process Workflow

The following diagram shows the four steps of the Incident Reports workflow. The action you take on a step determines the record status on the next step. For example, if on the Revision step you select Resubmit for Approval, the record moves to the Approval step with a record status of Pending. Sending a record to either the Revision step or the Approval step creates a task for the record recipient.

Creating Incident Reports Record

Create an Incident Reports record in the Tasks log to initiate and accept/reject a new Incident Reports approval request.

In the Incident Reports form, describe the event and provide details of how the event occurred. Also, include information about injuries and illnesses related to the event.

After completing the Incident Reports form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks to create business process records and manage tasks.
4) Click New.
5) Click Incident Reports.
6) (Required) In the Title field, enter a title.
7) In the Location field enter the location that the incident occurred.
8) Click the Incident Report tab to expand the form.

Note: You must enter a value in all required fields (*) before you can save the form.
9) In the **Date of Event** field click the **Date/Time** icon, select the date of incident, and click **OK**.
10) Complete the fields in the form accordingly.
11) In the **Project Manager** field click **Select**, select the Project Manager’s name, and click **OK**.
12) Click the **Contacts** tab to expand the form, click **Add**, and complete the form.
13) From the **Line Item Status** list select **Open** and click **OK**.
14) From the **Workflow Actions** list, select **Send for Approval**.
15) Click **Send** to route the record for approval and then click **OK**.

### Revising Incident Reports Record

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** and open an **Incident Reports** task.
4) Click **Accept Task**.
5) In the **Contract Reference** field click **Select** to select the contract and open.
6) From the **Workflow Actions** list, select **Resubmit for Approval**.
7) Click **Send** to route the record for approval and then click **OK**.

### Approving Incident Reports Record

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** and open an **Incident Reports** record that was sent for approval.
4) Click the **Incident Reports** tab to review the information.
5) Click **Accept Task**.
6) From the **Workflow Actions** list select **Approve Incident Report**.
7) Click **Send** to conclude the approval process and remove the record from the **Tasks** list.

### Viewing Closed Incident Reports Record

You can view a closed **Incident Reports** record in the **Incident Reports** business process log.

When the record is at the **End** step, the record is in terminal status which means that the record has been: **Approved**, **Rejected**, or **Canceled**.

You can also open a closed **Design Change Request** record to see who has reviewed the record and at which step.

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Incident Reports**.
4) Select the appropriate line item (a closed Design Change Request record) from the list and open the record.

5) From the **Task Details**, click **Click here** to open the **BP Progress** window. The **BP Progress** window shows that the submittal is on the **End** step.

6) Click **View Graphic** to open the workflow graphic showing tasks steps and links. The current step (**End**) is highlighted.

7) Click **Close Window**, click **Close**, and click **Close Window** to finish viewing a closed record.
Lesson Learned Business Process

Purpose
Record experiences that positively and negatively affected a project to establish best practices for ongoing and future projects.

Characteristics
This is a Project or Shell level non-workflow business process.

Roles
Any user with project access can submit lessons learned.

In This Section
Creating a Lesson Learned Record ................................................................. 109
Viewing a Lesson Learned Record ................................................................. 110
Saving the Estimates Record ......................................................................... 110

Creating a Lesson Learned Record
1) Go to your project and ensure that you are in User Mode.
2) Click Collaboration node to expand and click Tasks to open the Tasks log.
3) Click New from the menu and click Lesson Learned.
4) Complete the form according to the following information.

Note: You must enter a value in all required fields (*) before you can save the form.

Lesson Learned tab
General

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Title</td>
<td>(Required) Enter a title.</td>
</tr>
<tr>
<td>Project Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Project Name</td>
<td>No action.</td>
</tr>
<tr>
<td>Creator</td>
<td>No action.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>No action.</td>
</tr>
<tr>
<td>Record Last Update Date</td>
<td>No action.</td>
</tr>
</tbody>
</table>
### In this field: Do this:

<table>
<thead>
<tr>
<th>Status</th>
<th>Select from the list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Reference</td>
<td>Click Select to open the Contracts window and select a related contract.</td>
</tr>
</tbody>
</table>

### Information

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issues</td>
<td>Enter description.</td>
</tr>
<tr>
<td>Reasons</td>
<td>Enter description.</td>
</tr>
<tr>
<td>Solution</td>
<td>Enter description.</td>
</tr>
<tr>
<td>Recommendations</td>
<td>Enter description.</td>
</tr>
</tbody>
</table>

5) Click **Finish Editing**.

### Viewing a Lesson Learned Record

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Lesson Learned**.
4) Open the record you want to view.

### Saving the Estimates Record

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Lesson Learned**.
4) Open the record you want to revise.
5) Click **Edit** and make the necessary changes.
6) Click **Finish Editing**.
Meeting Minutes Business Process

Use the Meeting Minutes form to create, review, or update a Meeting Minutes record.

You can create a Meeting Minutes record in the Tasks log to initiate and accept/reject a new Meeting Minutes approval request.

Record meeting details, such as a subject title, project name, agenda, and attendees.

You can:

- Attach files, link records, and add general comments to the record.
- Add and review line items associated with the meeting in the Line Items form.

Purpose

Document project-related meeting discussions, track unresolved items (line items), and launch follow-up action items and track their progress between meetings.

Characteristics

This is a Project or Shell level business process with line items and a workflow. The Meeting Minutes log stores Meeting Minute records and their status. Unifier generates action items for each line item in the Meeting Minutes record.

Roles

Project manager creates, submits, and updates the record for review. Participants of the meeting can review, request clarification, and post the meeting minutes record.

In This Section

Meeting Minutes Workflow .......................................................................................... 112
Creating a Meeting Minutes Record .......................................................................... 112
Reviewing a Meeting Minutes Record ....................................................................... 114
Updating and Posting a Meeting Minutes Record .................................................... 115
Viewing a Closed Meeting Minutes Record ............................................................... 115
Meeting Minutes Workflow

The following diagram shows the four steps of the Meeting Minutes workflow (Creating, Reviewing and Revising, Posting, and Closing). The action you take on a step determines the record status on the next step; for example, if on the Review step you select Request Clarification, the record moves to the Update step with a record status of Pending. Sending a record to either the Review step or the Update step creates a task for the record recipient.

Creating a Meeting Minutes Record

Use the Meeting Minutes log to create and manage Meeting Minutes business process records.

1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node, click to expand, and click Meeting Minutes.
3) Click New to open the Create New Meeting Minutes window for your project.
4) Complete the form according to the following information.

---

**Note:** You must enter a value in all required fields (*) before you can save the form.

Meeting Minutes tab

General

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Title</td>
<td>(Required) Enter title.</td>
</tr>
</tbody>
</table>
**Meeting Details**

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting Date</td>
<td>Click the Calendar icon and select a date.</td>
</tr>
<tr>
<td>Location</td>
<td>Enter a location.</td>
</tr>
<tr>
<td>Meeting Time</td>
<td>Enter a time.</td>
</tr>
<tr>
<td>Due Date Duration</td>
<td>Enter the duration.</td>
</tr>
</tbody>
</table>

**Summary**

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attendees</td>
<td>Enter the names of the attendees.</td>
</tr>
<tr>
<td>Purpose</td>
<td>Enter a description for the purpose.</td>
</tr>
<tr>
<td>Agenda</td>
<td>Enter the agenda.</td>
</tr>
</tbody>
</table>

**Notes**

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outcome Notes</td>
<td>Enter the meeting outcome.</td>
</tr>
</tbody>
</table>

**Line Items tab**

Click **Add** to open the Meeting Minutes Line Item window.

You can use the Meeting Minutes Line Item form to add details about the line item. Select a Primavera Unifier user as the assignee or specify an external assignee for the line item.
General

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Item Status</td>
<td>Select the status. The default is Open.</td>
</tr>
<tr>
<td>External Assignee?</td>
<td>Select an external assignee, if necessary. The default is Yes.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Select a user and click Select.</td>
</tr>
<tr>
<td>External Assignee Name</td>
<td>Enter the name of an external assignee.</td>
</tr>
<tr>
<td>Priority</td>
<td>Select a priority: High – Medium – Low</td>
</tr>
<tr>
<td>Short Description</td>
<td>(Required) Enter a short description in this field.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Click the Calendar icon and select a date.</td>
</tr>
<tr>
<td>Notes/Resolution</td>
<td>No action.</td>
</tr>
</tbody>
</table>

Action Item Info

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Action Item?</td>
<td>Select an option. The default is Yes.</td>
</tr>
<tr>
<td>Action Item Created</td>
<td>No action.</td>
</tr>
<tr>
<td>Title</td>
<td>No action.</td>
</tr>
<tr>
<td>Action Item Status</td>
<td>No action.</td>
</tr>
</tbody>
</table>

5) Click OK to close the Meeting Minutes Line Item window. The Create New Meeting Minutes window opens, with the Line Items tab showing. Under Current View: All, the details of the line item that you added appears.

6) From the Workflow Actions list, select Send for Review. The next assignee, in the workflow list, appears in the To field of the Action Details tab, automatically.

7) Click Save, follow the prompts, and click OK.

8) From the menu, click Send, follow the prompts, and click OK.

9) Click OK. The new record is listed in the Meeting Minutes log with a Pending status.

**Reviewing a Meeting Minutes Record**

To review, approve, or request clarification:

1) Go to your project and ensure that you are in User Mode.

2) Click Collaboration node to expand and click Tasks to open the Tasks log.

3) From the Task log, click to select the task that you want to review, approve, and post.

4) Click Open from the menu to open the Meeting Minutes record.

5) Review the contents and click Accept Task.
6) From the **Workflow Actions** list, select **Post Meeting Minute**.
7) Click **Send**.

Since the Meeting Minutes record is now sent back for clarification, the record is no longer listed in the **Tasks** log. In the Meeting Minutes log, the status for this record changes to **Pending**.

---

**Updating and Posting a Meeting Minutes Record**

To update or revise a Meeting Minutes record and send the record for review.

1) Go to **Home** tab and click the **Tasks** node.

   **Note:** You can access tasks from the **Items Requiring Your Attention** section > **Tasks**, also.

2) Double-click a task to open.
3) Click **Accept Task**.
4) Click **General Comments**, add comments, and click **Add**.
5) Enter comments in the **Hidden Comment** field, if needed.
6) Click **OK** and close the window.
7) From the **Workflow Actions** list, select **Post Meeting Minute**.
8) Click **Send**.

The record is no longer listed in the **Task** log. In the Meeting Minutes log, the status for this record changes to **Posted**.

---

**Viewing a Closed Meeting Minutes Record**

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Meeting Minutes**.
4) Double-click a task to open.
5) From the **Task Details** tab, click **Click here** to open the **BP Progress** (**Workflow Progress**) window.
6) Ensure that the value for the **Current Step** is **End**.
7) Under the **Step Name** field, click **Review** to select.
8) Click **View Graphic** to open the **Workflow Designer** window. The **End** box is highlighted.
Monthly Updates Business Process

Purpose
Initiate and confirm/deny a new monthly update record: Report status, trends and risks in project to project owners.

Characteristics
This is a Project or Shell level with a workflow.

Roles
Architect/engineer creates, submits, and updates documents for review, and cancels reviewed documents. Project manager reviews, approve, cancel or reject the monthly updates documents.

In This Section
Monthly Updates Business Process Workflow .......................................................... 118
Creating Monthly Updates Record ........................................................................ 118
Revising Monthly Updates Record ...................................................................... 119
Approving Monthly Updates Record ................................................................... 119
Viewing Closed Monthly Updates Record ............................................................ 119
Monthly Updates Business Process Workflow

The following diagram shows the four steps of the Daily Reports workflow. The action you take on a step determines the record status on the next step. For example, if on the Revision step you select Close Daily Report, the record moves to the End step with a record status of Approved. Sending a record to either the Review step or the Revision step creates a task for the record recipient.

Creating Monthly Updates Record

Create a Monthly Updates record in the Tasks log to initiate and accept/reject a new Monthly Updates approval request.

After completing the Daily Reports form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

Note: You must enter a value in all required fields (*) before you can save the form.

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks to create business process records and manage tasks.
4) Click New.
5) Click Monthly Updates.
6) (Required) In the Title field, enter a title.
7) From the Month list, select the month.
8) From the Year list, select the year.
9) From the Schedule Status list, select an option.
10) From the Budget Status list, select an option.
11) Specify the main points of the monthly report in the Summary field.
12) Provide detailed status information in the Scheduled Overview, Plans for next 30 days, and Design Status and Approval fields. You can provide additional status details on the Monthly Update tab.

13) Record issues in the Issues and Actions section.

14) From the Workflow Actions list, select Send for Approval.

15) In the Action Details tab click To, select and add recipients, and click OK.

16) Click Send to route the record for approval and then click OK.

Revising Monthly Updates Record

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks and open the Monthly Updates record that you want to revise.
4) In the Contract Reference field click Select and select a contract to open and fill out the fields.
5) From the Workflow Actions list, select Resubmit for Approval.
6) In the Action Details tab click To, select and add recipients, and click OK.
7) Click Send to route the record for approval and then click OK.

Approving Monthly Updates Record

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks and open the Monthly Updates record that you want to approve.
4) Click Accept Task.
5) From the Workflow Actions list, select Approval Monthly Update.
6) Click Send and then click OK.

Viewing Closed Monthly Updates Record

1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Monthly Updates.
4) Select the appropriate line item (a closed Daily Reports record) from the list and open the record.
5) From the Task Details, click Click here to open the BP Progress window. The BP Progress window shows that the submittal is on the End step.
6) Click View Graphic to open the workflow graphic showing tasks steps and links. The current step (End) is highlighted.
7) Click Close Window, click Close, and click Close Window to finish viewing a closed record.
**Notices to Proceed Business Process**

**Purpose**
Notify a vendor/contractor on when work can begin on a project, site, or item.

**Characteristics**
This is a Project or Shell level business process with a workflow. You can view all Notices to Proceed records in the Notices to Proceed business process log.

**Roles**
Project manager creates, submits, and updates the record. The contractor can review, send for revision, and approve the Notice to Proceed record.

**In This Section**
- Notices to Proceed Business Process Workflow.................................................... 122
- Creating Notices to Proceed Record ..................................................................... 122
- Revising Notices to Proceed Record ..................................................................... 123
- Approving Notices to Proceed Record ................................................................. 123
- Viewing Closed Notices to Proceed Record .......................................................... 123
**Notices to Proceed Business Process Workflow**

The following diagram shows the four steps of the Notices to Proceed workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select Resubmit for Approval, the record moves to the Approval step with a record status of Pending. Sending a record to either the Revision step or the Approval step creates a task for the record recipient.

![Diagram of Notices to Proceed Workflow]

**Creating Notices to Proceed Record**

Create a Notices to Proceed record in the Tasks log to initiate and accept/reject a new Notices to Proceed approval request.

In the Notice to Proceed form, provide detailed information about the work that can begin and select the vendor and contract associated with the work. After completing the Notices to Proceed form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

**Note:** You must enter a value in all required fields (*) before you can save the form.

1) Navigate to the **Tasks** log in your project.
2) In the Navigator, click **Collaboration**.
3) Click **Tasks** to create business process records and manage tasks.
4) Click **New**.
5) Click **Notices to Proceed**.
6) (Required) In the **Title** field, enter a title.
7) In the Contract field click Select, select a contract, and click Open. The Contract Summary section is auto-populated with the selected contract's information.

8) In the Vendor field click Select, select a vendor, and click Open.

9) In the Description field enter a description.

10) From the Workflow Actions list select Send for Approval.

11) On the Action Details tab, click To, select and add an assignee, click Add, and click OK.

12) Click Send to route the record for approval and then click OK.

Revising Notices to Proceed Record

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks and open a Notices to Proceed task.
4) Click the link next to the Task Notes to open the message. Read the message and click Close.
5) Click Accept Task.
6) In the Description field enter a description.
7) From the Workflow Actions list, select Resubmit for Approval.
8) On the Action Details tab, click To, select and add an assignee, click Add, and click OK.
9) Click Send to route the record for approval and then click OK.

Approving Notices to Proceed Record

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks and open the Notices to Proceed task that was sent for approval.
4) View the record and click Accept Task.
5) From the Workflow Actions list select Approve Notice to Proceed.
6) Click Send to conclude the approval process.

Viewing Closed Notices to Proceed Record

You can view a closed Notices to Proceed record in the Notices to Proceed business process log.

When the record is at the End step, the record is in terminal status which means that the record has been: Approved, Rejected, or Canceled.

You can also open a closed Notices to Proceed record to see who has reviewed the record and at which step.
1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Notices to Proceed.
4) Select the appropriate line item (a closed Notices to Proceed record) from the list and open the record.
5) From the Task Details, click Click here to open the BP Progress window. The BP Progress window shows that the submittal is on the End step.
6) Click View Graphic to open the workflow graphic showing tasks steps and links. The current step (End) is highlighted.
7) Click Close Window, click Close, and click Close Window to finish viewing a closed record.
Project Closeout Business Process

Purpose
Record project closeout information

Characteristics
This is a Project or Shell level non-workflow business process.

Roles
Project manager creates and updates the project closeout record.

In This Section
Creating Project Closeout Record ................................................................. 125
Adding Line Items to the Payment Record..................................................... 126
Saving the Payments Record ........................................................................ 126

Creating Project Closeout Record
Create a Project Closeout record in the Tasks log to log your project closeout information.
On the Project Closeout form, specify a title for the record. Select the items that have been completed and specify the date of completion. Click Finish Editing to save the record.

Note: You must enter a value in all required fields (*) before you can save the form.

1) Go to your project and ensure that you are in User Mode.
2) Click Collaboration node to expand.
3) Click Tasks to create business process records and manage tasks.
4) Click New.
5) Click Project Closeout.
6) (Required) In the Title field, enter a title.
7) (Required) From the Status list, select an option.
8) Select the Architectural Punchlist Signoff check box
9) Click the Date/Time icon, select a date to specify the signoff date, and click OK.
10) Select the Civil Punchlist Signoff check box
11) Click the Date/Time icon, select a date to specify the signoff date, and click OK.
12) Continue on with checking the completed items and specifying the date for each completed item.
13) When finished, click Finish Editing, and click OK to complete creating a Project Closeout record.
Adding Line Items to the Payment Record

1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Project Closeout to open the Tasks log.
4) Open a closed Project Closeout record.
5) Click Edit, change the record, and click Finish Editing when finished.

Saving the Payments Record

- To save the Payments record

Click either:

- Finish Editing to save the form in read-only mode.
  - If the record status is Pending, you can return the record to Edit mode and modify the Upper form and Line Items form fields.
  - If the record status is Closed, the record is permanently read-only.
- Save to leave the form in edit mode.
Project Requests Business Process

Purpose
You can use a Project Requests record to define basic project information and initiate the approval process for new projects.

Business process characteristics
The Project Requests business process is a company-level business process without line items but with workflow. An individual help file is available for this business process.

Groups associated with this business process
Company Administrator, Creator, Reviewer, All Company Users

Record Statuses
Pending (non-terminal status), Approved (terminal status), Rejected (terminal status), or Canceled (terminal status)

Additional Information
- Enabled for mobile devices.
- Step completion policy and resolving actions can differ between steps.
- Enabled for integration.
- Enabled for publish path.

Benefits
In Unifier, files that are attached to a business process form, or to its line items, from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
In This Section

Project Request Workflow ................................................................. 128
Creating a Project Requests Record .................................................. 128
Routing a Project Requests Record .................................................... 130

Project Request Workflow

Below are the four steps of the Project Requests workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Project Request" then the record moves to the End step with a record status of "Canceled." Sending a record to either the Approval step or the Revision step creates a task for the next record recipient.

Creating a Project Requests Record

To create a Project Requests Record:

1) Navigate to the Company Workspace tab and expand the Company Logs node.
2) Click Project Requests to open the log.
3) Click New and select Project Requests from the menu drop-down list. A new Project Requests form opens.
4) Complete the form according to the following information.

Notes:
- You must enter a value in all required fields (*) before you can save the form.
- You can save your business process at any time to create a draft. To access the draft, expand the Collaboration node and click Drafts to see your saved business process.

Project Request tab (General)

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>In this field:</td>
<td>Do this:</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates the first time you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter up to 16 characters to name the record.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you first send the form to the next step in the workflow.</td>
</tr>
<tr>
<td>Status</td>
<td>This is a read-only field that Unifier populates when you first send the form to the next step in the workflow.</td>
</tr>
</tbody>
</table>

**Project Request tab (Project Summary)**

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a brief description for the project.</td>
</tr>
<tr>
<td>Justification</td>
<td>Enter a brief justification for the project request.</td>
</tr>
</tbody>
</table>

**Project Request tab (Project Details)**

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>Enter a name for the project.</td>
</tr>
<tr>
<td>Project Type</td>
<td>Select from the list.</td>
</tr>
<tr>
<td>Project Manager</td>
<td>Select or enter the name of the project manager.</td>
</tr>
</tbody>
</table>

**Project Request tab (Schedule Information)**

*Note: Ensure that you scroll down.*

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Start Date*</td>
<td><em>(Required)</em> Enter the start date for the project.</td>
</tr>
<tr>
<td>Preferred Completion Date</td>
<td>Enter a date.</td>
</tr>
</tbody>
</table>

**Project Request tab (Location)**

*Note: Ensure that you scroll down.*
Enter the location details for your project.
5) From the top right-hand corner of the form, the Workflow Actions field, select the workflow action to take. In this case, your selection is **Send for Approval**. This action activates **Action Details**.

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Start Date*</td>
<td>(Required) Enter the start date for the project.</td>
</tr>
<tr>
<td>Preferred Completion Date</td>
<td>Enter a date.</td>
</tr>
</tbody>
</table>

6) Click **Action Details** tab and review the information for accuracy.

7) Click **Send** to route the record to the **Approval** step. Unifier displays a message stating that the record has been submitted successfully.

Upon sending the business process form forward to the **Approval** step, Unifier creates a permanent business process record and sends a task. An assignee can see the task in the **Tasks** log.

---

### Routing a Project Requests Record

After creating and sending the business process form forward to the **Approval** step, Unifier creates a permanent business process record and sends a task. An assignee can see the task in the **Tasks** log.

When working on the **Approval step**, first you accept the task, then when you are ready, route the record to either the **Revision** or the **End** step.

To route a Project Requests record:

1) Navigate to the **Company Workspace** tab, **Collaboration >Tasks**. The Tasks log opens.

2) In the Tasks log, double-click the record to open it.

   The business process form opens for viewing. The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.

   The **Task Status** link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

3) From the upper left-hand corner of the window click **Accept Task**.

   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.

4) In the Project Request tab, enter values for the following required (*) fields:

   **Note**: Ensure that you scroll down.

   - Project Name
In this case, your selection is **Send for Approval**. This action activates **Action Details**.

5) When ready, from the top right-hand corner of the form, the Workflow Actions field, select the workflow action to take. The choices are:

- **Approve** — this action sends the record to the End step in **Approved** status, which triggers auto-creation of the Vendor record.
- **Send for Revision** — this action sends the record back to the record creator in **Pending** status. The **To** field is preassigned and you can **Cc** anyone listed in Users/Groups.
  a. Click **Cc...**. The **User/Groups** picker opens and displays a list of available message recipients.
  b. Select the user or group who will receive the message when the record returns to the **Approval** step.
  c. Click **Add**.
  d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc...** field. Upon sending, the record copy will appear in the recipient's **Collaboration > Messages** log.
- **Reject** — this action sends the record to the End step in **Rejected** status.

6) Click **Send**.

7)
Punchlist Business Process

Purpose

Initiate and confirm/deny a new Punchlist, capture and store information regarding a Punchlist line item. For example, spec section, open and closed dates, issues, and resolution details.

Characteristics

This is a Project or Shell level line items and a workflow. You can create multiple Punchlist records for a project. Punchlist records are stored in the Punchlist business process log in a project.

Roles

Project manager creates, submits, and updates records for review, and cancels reviewed records. Contractor is to reviews, approves, cancels, or rejects the incident reports record.

In This Section

Punchlist Business Process ................................................................. 134
Creating Punchlist Record ............................................................... 134
Revising Punchlist Record .............................................................. 135
Approving Punchlist Record ........................................................... 135
Viewing Closed Punchlist Record .................................................. 135
**Punchlist Business Process**

The following diagram shows the four steps of the Punchlist workflow. The action you take on a step determines the record status on the next step. For example, if on the Revision step you select Resubmit for Approval, the record moves to the Approval step with a record status of Pending. Sending a record to either the Revision step or the Approval step creates a task for the record recipient.

![Punchlist Workflow Diagram](image)

**Creating Punchlist Record**

Create a Punchlist record in the Tasks log to initiate and accept/reject a new Punchlist record.

On the Punchlist form, specify a title for the record. Add line items for each punchlist item in the Line Item List section.

After completing the Design Change Request form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

**Note:** You must enter a value in all required fields (*) before you can save the form.

1. Navigate to the **Tasks** log in your project.
2. In the Navigator, click **Collaboration**.
3. Click **Tasks** to create business process records and manage tasks.
4. Click **New**.
5. Click **Punchlist**.
6. (Required) In the **Title** field, enter a title.
7. In the **Line Item List** section click **Add**.
8. Click the calendar icons to specify necessary dates and then choose a priority for the line item.
9. In the **Priority** list, select a value.
10) In the Spec Section list, select a section.
11) In the Issue Category list, select Open.
12) In the Location field, enter the location.
13) In the Description section provide details for the line item.
14) In the Short Description field, enter description.
15) In the Est. Schedule Impact (Days) field, enter a value.
16) In the Assignee field click Select to select and assignee, click Add, click OK, and click OK to save the line item.

Note: You can add multiple line items to a Punchlist record.

17) From the Workflow Actions list, select Send for Approval.
18) On the Action Details tab, click To, select and add an assignee, click Add, and click OK.
19) Click Send to route the record for approval and then click OK.

Revising Punchlist Record

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks and open Punchlist task.
4) Click Accept Task.
5) In the Contract field click Select to select the contract and open.
6) From the Workflow Actions list, select Resubmit for Approval.
7) On the Action Details tab, click To, select and add an assignee, click Add, and click OK.
8) Click Send to route the record for approval and then click OK.

Approving Punchlist Record

1) Navigate to the Tasks log in your project.
2) In the Navigator, click Collaboration.
3) Click Tasks and open Punchlist record that was sent for approval.
4) Review the information and click Accept Task.
5) From the Workflow Actions list select Approve Punchlist.
6) Click Send to conclude the approval process and remove the record from the Tasks list.

Viewing Closed Punchlist Record

You can view a closed Punchlist record in the Punchlist business process log.
When the record is at the End step, the record is in terminal status which means that the record has been: Approved, Rejected, or Canceled.

You can also open a closed Punchlist record to see who has reviewed the record and at which step.

1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Punchlist.
4) Select the appropriate line item (a closed Punchlist record) from the list and open the record.
5) From the Task Details, click Click here to open the BP Progress window. The BP Progress window shows that the submittal is on the End step.
6) Click View Graphic to open the workflow graphic showing tasks steps and links. The current step (End) is highlighted.
7) Click Close Window, click Close, and click Close Window to finish viewing a closed record.
Requests for Information (RFI) Business Process

Purpose
This business process is used for collaboration and exchange of information.

Characteristics
This is a Project or Shell level workflow business process

Roles
Members of the Creators group can create this business process.
Members of the Creators and Reviewers group can edit this business process.
All Project Users groups may receive copies of this business process.

In This Section
Requests for Information (RFI) Business Process Workflow................................. 138
Creating RFI........................................................................................................... 138
Coordinating RFI................................................................................................... 138
Clarifying RFI........................................................................................................ 138
Responding to RFI Clarification Request............................................................... 139
Sending for RFI for Technical Review ................................................................. 140
Requests for Information (RFI) Business Process Workflow

The following diagram shows the seven steps of the RFI business process workflow. Typical steps that can be taken are: Creating RFI > Coordinating RFI > Clarifying RFI > Responding to RFI Clarification Request > Sending for RFI Technical Review > Submitting RFI for Response > Accepting RFI (End)

Creating RFI
1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Request for Information (RFI).
4) Click New from the menu to open the Create New Requests for Information (RFI) window.
5) From Request for Information tab, in the Title field (Required), enter a name for the record.

   Note: You must enter a value in all required fields (*) before you can save the form.

6) Complete the form accordingly.
7) When finished, from Workflow Actions list select Send for Response.
8) Click Send. The names of the recipients appear in the To field automatically.

Coordinating RFI
1) Go to your project and ensure that you are in User Mode.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Request for Information (RFI)**.
4) From the **Tasks** log, open the RFI that you created. Note that
5) In the **Task Details** tab, Task Status, click **Not Started** to open the **BP Progress (Workflow Progress)** window. This window highlights the current step (**Coordination**) in the workflow process. In this window, you can also click **View Graphic** to see the workflow graphic of this record. The current step (**Coordination**) is highlighted. Note that the **Task Details** tab, Sent For, Coordination is highlighted.
6) Click **Close** to close the **BP Progress (Workflow Progress)** window to go back to the **Request for Information (RFI)** window with the **Task Details** tab.
7) Click **Accept Task** to open the **RFI** window with the **Action Details** tab and complete the form accordingly.
8) From **Workflow Actions** list select the required action. Your options are: **Submit Final Response**, **Send for Technical Review**, or **Send Back for Clarification**.
9) Click **Send Back for Clarification**. The names of the recipients appear in the **To** field automatically.
10) Click **Send** to send your clarification request.

---

**Clarifying RFI**

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Request for Information (RFI)**.
4) From the **Tasks** log, open the record that is sent for clarification.
5) From the **Task Details** tab, Task Status, click **Not Started** to open the **BP Progress (Workflow Progress)** window. This window highlights the current step (**Clarification**) in the workflow process. In this window, you can also click **View Graphic** to see the workflow graphic of this record. The current step (**Clarification**) is highlighted. Note that the **Task Details** tab, Sent For, Clarification is highlighted.
6) Click **Close** to close the **BP Progress (Workflow Progress)** window to go back to the **Request for Information (RFI)** window with the **Task Details** tab.
7) Click **Accept Task** to open the **RFI** window with the **Action Details** tab and complete the form accordingly.
8) From **Workflow Actions** list select the required action. Your options are: **Respond with Clarification** or **Cancel RFI**.
9) Click **Respond with Clarification**. The names of the recipients appear in the **To** field automatically.
10) Click **Send** to send your clarification response.

---

**Responding to RFI Clarification Request**

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.

3) Click **Request for Information (RFI)**.

4) From the **Tasks** log, open the record that is sent for clarification.

5) From the **Task Details** tab, Task Status, click **Not Started** to open the **BP Progress (Workflow Progress)** window. This window highlights the current step (**Coordination**) in the workflow process. In this window, you can also click View Graphic to see the workflow graphic of this record. The current step (**Coordination**) is highlighted. Note that in the **Task Details** tab (Sent For) **Coordination** is highlighted.

6) Click **Close** to close the **BP Progress (Workflow Progress)** window to go back to the **RFI** window with the **Task Details** tab.

7) Click **Accept Task** to open the **RFI** window with the **Action Details** tab and complete the form accordingly.

8) From **Workflow Actions** list select the required action. Your options are: **Submit Final Response**, **Send for Technical Review**, or **Send Back for Clarification**.

9) Click **Send for Technical Review**. The names of the recipients appear in the **To** field automatically. **Technical Review** is highlighted in the Send For field.

10) Click **Send** to send the RFI for Technical Review.

---

**Sending for RFI for Technical Review**

1) Go to your project and ensure that you are in **User Mode**.

2) Navigate to the **Project Delivery** node and click to expand.

3) Click **Request for Information (RFI)**.

4) From the **Tasks** log, open the record that is sent for technical review.

5) From the **Task Details** tab, Task Status, click **Not Started** to open the **BP Progress (Workflow Progress)** window. This window highlights the current step (**Technical Review**) in the workflow process. In this window, you can also click View Graphic to see the workflow graphic of this record. The current step (**Technical Review**) is highlighted. Note that in the **Task Details** tab (Sent For) **Technical Review** is highlighted.

6) Click **Close** to close the **BP Progress (Workflow Progress)** window to go back to the **RFI** window with the **Task Details** tab.

7) Click **Accept Task** to open the **RFI** window with the **Action Details** tab and complete the form accordingly.

8) From **Workflow Actions** list select the required action. Your options are: **Send Back for Clarification** or **Submit Response**.

9) Click **Submit Response**. The names of the recipients appear in the **To** field automatically. **Review** is highlighted in the Send For field.

10) Click **Send** to send the RFI for Review.
Submittal Register Business Process

Purpose
Group submittals into packages, monitor their status, and add and edit Submittal Register records.

Characteristics
This is a Project or Shell level business process with submittal line items and no workflow. When a submittal is linked to a Submittal Register record, a submittal line item is created in the Submittal Register record.

You can add a submittal line item to the Submittal Register to auto-create a Submittals business process record.

Roles
Project manager creates the Submittal Register records. The architect, engineer, and contractor can create a Submittals and link it to a Submittal Register record.

Additional Information
- Enabled for custom print.

Print using a custom layout
Custom printing can be used with templates created in Microsoft Word and PDF format. Depending on the template used for custom print, you can print the upper form, the current workflow step, comments and attachments of the record. The template may also allow printing of specific line items in their tabs. The printed output will list the name of the table with the line items following on separate lines.

Note: In Primavera Unifier 9.14 release, a specific Custom Print template has been added to the Submittal Register Business Process.

To print a business process form with a custom print layout, do the following:
1. Open the business record that you want to print.
2. From the File menu, select Print Preview > Custom.
3. Click Save.

Note: When opening a business process form that includes fields that are auto-populated, or automatically updated, the system considers these automatic updates as changes and requires that you Save the work.

In This Section
Submittal Register Workflow ................................................................. 142
Creating a Submittal Register Record ...................................................... 142
Adding a Submittals record to the Submittal Register Record .................. 144
Linking a Submittals record to the Submittal Register Record .................. 145
**Submittal Register Workflow**

The following diagram shows the six steps of the Submittals workflow. The action you take on a workflow step determines the business process record’s status on the next step. For example, if you select Cancel Submittal on the Update step, the record moves to the End step with a record status of Canceled. Sending a record to the next step creates a task for the assignee, except on the End step.

![Submittal Register Workflow Diagram]

**Creating a Submittal Register Record**

Use the Submittal Register log to create and copy Submittal Register records and to view their current status in a project. Each Submittal Register record has a unique record number.

*Note:* In the Submittal Register record form, you first need to complete the fields in the General tab and then move to the Submittal Register Line Items tab.

1. Go to your project and ensure that you are in User Mode.
2. Navigate to the Project Delivery node and click to expand.
3. Click Submittal Register.
4. Click New to open the Create New Submittal Register window for your project.
5. Complete the form according to the following information.

*Note:* You must enter a value in all required fields (*) before you can save the form.
General tab

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter a title.</td>
</tr>
<tr>
<td>Priority</td>
<td>Select a priority from the list.</td>
</tr>
<tr>
<td>Anticipated Submittal Start Date</td>
<td>Select a date, using the calendar.</td>
</tr>
<tr>
<td>Anticipated Submittal Finish Date</td>
<td>Select a date, using the calendar.</td>
</tr>
<tr>
<td>Record Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Creator</td>
<td>No action.</td>
</tr>
<tr>
<td>Status</td>
<td>(Required) Select a status.</td>
</tr>
</tbody>
</table>

Submittal Register Line Items tab

- Click Add to open the Line Item (Submittal Register Line Item) window.
- Complete the form according to the following information.

**Note:** You must enter a value in all required fields (*) before you can save the form.

Submittal Information

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>(Required) Enter a short description.</td>
</tr>
<tr>
<td>Submittal Type</td>
<td>Select a type from the list.</td>
</tr>
<tr>
<td>Anticipated Submittal Start Date</td>
<td>Select a date, using the calendar.</td>
</tr>
<tr>
<td>Anticipated Submittal Finish Date</td>
<td>Select a date, using the calendar.</td>
</tr>
<tr>
<td>Submittal for Closeout</td>
<td>Select an option from the list.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>Select a section from the list.</td>
</tr>
<tr>
<td>Discipline</td>
<td>Select an option from the list.</td>
</tr>
<tr>
<td>Contract</td>
<td>Click Select to open the Contract window. Click to select a contract and click Open to select the contract. The selected contract name appears in the Contract field.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter description.</td>
</tr>
</tbody>
</table>
Submittal Creation

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Assignee</td>
<td>Select from the list. The default value for this field is Yes.</td>
</tr>
<tr>
<td>External Assignee Name</td>
<td>Enter a name if you have selected an external assignee; otherwise, take no action.</td>
</tr>
<tr>
<td>Assignee</td>
<td>Click Select, select assignee, click Add, and click OK.</td>
</tr>
<tr>
<td>Owner</td>
<td>No action.</td>
</tr>
<tr>
<td>Submittal</td>
<td>No action.</td>
</tr>
</tbody>
</table>

Click OK. The Create New Submittal Register window opens. Ensure that the item has been added to the list.

6) Click Save, and from the menu click Finish Editing to complete creating a new Submittal Register record.

Adding a Submittals record to the Submittal Register Record

Note: You can access Submittals record added to Submittal Register records via Submittals log.

1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Submittal Register.
4) Double-click a Submittal Register record to open.
5) From the menu, click Edit. The Submittal Register record window opens.
6) From Submittals tab, click Add. The Submittal Register Line Items window opens.
7) Complete the form according to the following information.

Note: You must enter a value in all required fields (*) before you can save the form.

Submittal Information

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>(Required) Enter a short description.</td>
</tr>
<tr>
<td>Submittal Type</td>
<td>Select a type from the list.</td>
</tr>
<tr>
<td>Anticipated Submittal Start Date</td>
<td>Select a date, using the calendar.</td>
</tr>
</tbody>
</table>
In this field: | Do this:
---|---
Anticipated Submittal Finish Date | Select a date, using the calendar.
Submittal for Closeout | Select an option from the list.
Spec Section | Select a section from the list.
Discipline | Select an option from the list.
Contract | Click Select to open the Contract window. Click to select a contract and click Open to select the contract. The selected contract name appears in the Contract field.
Description | Enter description.

**Submittal Creation**

| In this field: | Do this: |
---|---
External Assignee | Select from the list. The default value for this field is Yes. |
External Assignee Name | Enter a name if you have selected an external assignee; otherwise, take no action. |
Assignee | Click Select, select assignee, click Add, and click OK. |
Owner | No action. |
Submittal | No action. |

**Linking a Submittals record to the Submittal Register Record**

In Submittals, you use the Submittal Register field to link a Submittal Register record to a Submittals record. When a Submittals record is linked to a Submittal Register record, a Submittal line item is created in the Submittal Register record.

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Submittals**. All records that you have created, sent, or copied, show in the **Submittals** log window.
4) Double-click a **Submittals** record from the list to open the **Submittals** window for that record.
5) Expand the **Submittal** tab.
6) Go to the **Submittal Information** box and click **Select** from **Submittal Register** field. The **Submittal Register** window opens.
7) Select and item and click **Open**. The **Submittals** window for the selected item opens.
8) Go to the **Submittal Information** box and do the following:
   a. Select a **Submittal Type**.
b. Select a **Discipline**.

c. Select a **Spec Section** from the list.

d. Select a **Spec Section** from the list.

9) Collapse the **Submittal** tab.

10) From the Workflow Actions list select **Resubmit for Submission Review**.

11) In **Action Details** tab, click **To**, select and add an assignee, click **OK**, and click **Send**.

**Verify the link**

1) From the navigator click **Submittal Register** business process

2) From the **Submittal Register** log select and open your **Submittal Register** item. The Submittal Register window of your item opens.

3) Inspect the record to see that the **Submittals** record is now assigned to your **Submittal Register** record.
Submittals Business Process

Purpose
Submittals are documents that track items that must be reviewed and approved before they are used in a project. Use the Submittals business process to submit project documents and track their progress from initial submission to final approval.

Characteristics
This is a Project or Shell level business process with documents and a workflow. Submittals log stores submittal documents and their status.

Roles
General contractor or architect/engineer creates, submits, and updates documents for review, and cancels reviewed documents. Project manager reviews, approves, cancels or rejects the submittal documents.

In This Section
Submittals Business Process Workflow ................................................................. 148
Creating a Submittals Record ................................................................................ 148
Reviewing a Submittals Record ............................................................................. 150
Approving a Submittals Record ............................................................................. 151
View and Close Submittals Record ...................................................................... 152
Submittals Business Process Workflow

The following diagram shows the six steps of the Submittals workflow. The action you take on a workflow step determines the business process record’s status on the next step. For example, if you select Cancel Submittal on the Update step, the record moves to the End step with a record status of Canceled. Sending a record to the next step creates a task for the assignee, except on the End step.

Creating a Submittals Record

Note: In the Submittals record form, you first need to complete the fields in the Submittal tab, then move to the Line Items tab, and finally to the Action Details tab.

1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Submittals.
4) Click New to open the Create New Submittals window for your project.
5) Complete the form according to the following information.

Note: You must enter a value in all required fields (*) before you can save the form.

Submittal tab
General
### In this field: Do this:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Title</td>
<td>(Required) Enter a title.</td>
</tr>
<tr>
<td>Project Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Creator</td>
<td>No action.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>No action.</td>
</tr>
<tr>
<td>Due Date</td>
<td>No action.</td>
</tr>
<tr>
<td>Status</td>
<td>No action.</td>
</tr>
</tbody>
</table>

### Submittal Information

**In this field:** Do this:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submittal Register</td>
<td>Note: Select Submittal Register that this Submittal belongs to.</td>
</tr>
<tr>
<td></td>
<td>Click Select to open Submittal Register window and follow the prompts.</td>
</tr>
<tr>
<td>Submittal For Closeout</td>
<td>Change the value if necessary. The default value is Yes.</td>
</tr>
<tr>
<td>Submittal Type</td>
<td>Select a type from the list.</td>
</tr>
<tr>
<td>Discipline</td>
<td>Select a discipline from the list.</td>
</tr>
<tr>
<td>Submittal Register Line</td>
<td>Note: If your submittal is a new line under selected Register then do not select Submittal Register Line. Click Select to open Submittal Register – Submittals window and follow the prompts.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>Select a section from the list.</td>
</tr>
<tr>
<td>Drawing No</td>
<td>Enter information if applicable.</td>
</tr>
<tr>
<td>Reference ID</td>
<td>Enter information if applicable.</td>
</tr>
</tbody>
</table>

### Description

**In this field:** Do this:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Describe the Submittal.</td>
</tr>
</tbody>
</table>

### Deliver Via

**In this field:** Do this:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliver Via</td>
<td>Select a delivery method from the list.</td>
</tr>
<tr>
<td>Date Shipped</td>
<td>Click the calendar icon and select the date.</td>
</tr>
<tr>
<td>In this field:</td>
<td>Do this:</td>
</tr>
<tr>
<td>--------------</td>
<td>----------</td>
</tr>
<tr>
<td>Tracking No</td>
<td>Enter information if applicable.</td>
</tr>
<tr>
<td>Expected Delivery</td>
<td>Click the calendar icon and select the date.</td>
</tr>
</tbody>
</table>

Remarks

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remarks</td>
<td>Enter notes.</td>
</tr>
</tbody>
</table>

Line Items tab

- Click Add to open the Line Item (Submittals Line Item) window.
- Complete the form according to the following information.

**Note:** You must enter a value in all required fields (*) before you can save the form.

General

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>(Required) Enter a name.</td>
</tr>
<tr>
<td>Document Type</td>
<td>Select a document type from the list.</td>
</tr>
<tr>
<td>Short Description</td>
<td>(Required) Enter a short description.</td>
</tr>
<tr>
<td>Line Item Status</td>
<td>Select a status from the list: Approved, Pending, or Rejected</td>
</tr>
</tbody>
</table>

- Click OK. The **Create New Submittals** window opens. Ensure that the item has been added to the list.

6) Click **Save**, and click OK.
7) From the **Workflow Actions** list select **Send for Submission Review**.
8) Go to **Action Details** tab, click **To**, select recipients, click **Add**, and click OK.
9) Click **Task Notes** icon and enter notes.
10) From the menu, click **Send**, and click OK.

The **Submittals** record moves to next workflow step, review.

**Reviewing a Submittals Record**

1) Go to your project and ensure that you are in **User Mode**.

**Note:** You can access tasks from the **Home** tab > **Tasks** node or from the **Home** tab > **Items Requiring Your Attention** section > **Tasks**.

2) Click **Collaboration** node to expand and click **Tasks** to open the **Tasks** log window.
3) Double-click to open the task that you want to approve.
4) In the Task Details tab, from the Task Status field, click Not Started to open the BP Progress (Workflow Progress) window.
5) Review the contents of this window and click to select the appropriate step from the list.
6) Click View Graphic to open the workflow diagram. The current step is highlighted.
7) Click Close and then click Close Window. The number in the parenthesis indicates the number of task notes.
8) Click the number in the parenthesis.
9) Review the record and click Accept Task to continue.
10) Click the Task Notes icon to open and review. Once you review the submittals, you can decide whether more information about the line item is necessary, or not. You can type a comment to send with the submittals record when it is routed to the next workflow step.
11) Review the form, click Save, follow the prompts, and click OK.
12) From the Workflow Actions list, select Return for Clarification. In the Action Details tab the To field is automatically populated with the names of the recipients (preselected assignees for the next step).
13) Click Send to route the record to assignees for updating.

**Approving a Submittals Record**

1) Go to your project and ensure that you are in User Mode.
2) Click Collaboration node to expand and click Tasks to open the Tasks log window.
3) Double-click to open the task that you want to approve.
4) In the Task Details tab, from the Task Status field, click Not Started to open the BP Progress (Workflow Progress) window.
5) Review the contents of this window and click to select the appropriate step from the list.
6) Click View Graphic to open the workflow diagram. The current step is highlighted.
7) Click Close and then click Close Window.
8) Proceed to accept the task:
9) Double-click to open the task that you want to approve.
10) Click Accept Task.
11) From the Line Items tab, click to select an item and then click Add to open the Submittals Line Item window.
12) Fill out the form as follows:
   - Name: Enter a name.
   - Document Type: Select a type from the list.
   - Short Description: Enter a short description.
   - Line Item Status: Approved.
13) Click OK.
14) From Workflow Actions list, select Approve Submittal, follow the prompts, select and add recipients, and click Send.
View and Close Submittals Record

1) Go to your project and ensure that you are in User Mode.
2) Navigate to the Project Delivery node and click to expand.
3) Click Submittals and open a record.
4) From the Task Details tab, click Click here to open the BP Progress(Workflow Progress) window.
5) Ensure that the value for the Current Step is End.
6) Click View Graphic to open the Workflow Designer window. The End box is highlighted.
7) Click Close and then click Close Window.
Transmittals Business Process

**Purpose**
Record transmittals and track their associated line items in a project.

**Characteristics**
This is a document type, Project or Shell level business process with a workflow and line items. The Transmittals log stores transmittals and their status.

**Roles**
Any project participant may create and submit a transmittal record to an assignee(s) for approval. The assignee(s) can approve, reject, cancel and send transmittals for revision.

### In This Section
- Transmittals Business Process Workflow .............................................................. 154
- Creating a Transmittals Record ............................................................................. 154
- Revising a Transmittals Record ............................................................................. 156
- Approving a Transmittals Record .......................................................................... 157
- Viewing a Closed Transmittals Record ................................................................. 157
Transmittals Business Process Workflow

The following diagram shows the four steps of the Transmittals workflow. The action you take on a step determines the record status on the next step. For example, if on the Revision step you select Cancel Transmittal, the record moves to the End step with a record status of Canceled. Sending a record to either the Approval step or the Revision step creates a task for the record recipient.

Creating a Transmittals Record

Create a Transmittal record in the Tasks log to initiate and accept/reject a new transmittal approval request.

Provide information about the transmittal, such as a description and the type of items you are sending, as well as the delivery format. Attach related files in the Line Items section. After completing the Submittals form, select an action in the Workflow Actions list to determine the next step in the workflow. Click Send to route the form to the next assignee.

1) Go to your project and ensure that you are in User Mode.
2) Click Collaboration node to expand and click Tasks to open the Tasks log window.
3) Click New to open the Create New Transmittals window for your project.
4) Complete the form according to the following information.

**Note:** You must enter a value in all required fields (*) before you can save the form.

**Transmittal tab**

**General**

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Title</td>
<td>(Required) Enter a title.</td>
</tr>
<tr>
<td><strong>In this field:</strong></td>
<td><strong>Do this:</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Project Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Project Name</td>
<td>No action.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>Select a section from the list.</td>
</tr>
<tr>
<td>Creator</td>
<td>No action.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>No action.</td>
</tr>
<tr>
<td>Due Date</td>
<td>No action.</td>
</tr>
<tr>
<td>Status</td>
<td>No action.</td>
</tr>
</tbody>
</table>
| Contract Reference| Click Select to open the Contract window.  
Select a contract and click Open. |

### Description

<table>
<thead>
<tr>
<th><strong>In this field:</strong></th>
<th><strong>Do this:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description.</td>
</tr>
</tbody>
</table>

### We are Sending

<table>
<thead>
<tr>
<th><strong>In this field:</strong></th>
<th><strong>Do this:</strong></th>
</tr>
</thead>
</table>
| We are Sending    | Click Select to open the Select We Are Sending window.  
Select the appropriate item and click OK. |
| Other (Specify)   | Enter information if necessary. |

### Submitted For

<table>
<thead>
<tr>
<th><strong>In this field:</strong></th>
<th><strong>Do this:</strong></th>
</tr>
</thead>
</table>
| Submitted For     | Click Select to open the Select Submitted For window.  
Select the appropriate item and click OK. |

### Delivered Via

<table>
<thead>
<tr>
<th><strong>In this field:</strong></th>
<th><strong>Do this:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivered Via</td>
<td>Select a method from the list.</td>
</tr>
<tr>
<td>Date Shipped</td>
<td>Use the calendar icon to enter date.</td>
</tr>
<tr>
<td>Tracking No.</td>
<td>Enter information if available.</td>
</tr>
<tr>
<td>Expected Delivery</td>
<td>Use the calendar icon to enter date.</td>
</tr>
</tbody>
</table>
Remarks

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remarks</td>
<td>Enter remarks if applicable.</td>
</tr>
</tbody>
</table>

5) Click on the Line Items tab.
6) Click Add to open the Transmittals Line Item.
7) From the menu, click Attachment, click Add Attachment, and select Unifier Folder to open the Select Files window.
8) Select a file, click OK to open the Transmittals Line Item window, and complete the form according to the following information.

General

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>(Required): The name of the select file appears automatically.</td>
</tr>
<tr>
<td>Line Item Status</td>
<td>Select from the list.</td>
</tr>
<tr>
<td>Document Type</td>
<td>Select from the list.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Enter description.</td>
</tr>
<tr>
<td>Issue Date</td>
<td>Use the calendar icon to enter date.</td>
</tr>
<tr>
<td>Copies</td>
<td>Enter a number</td>
</tr>
<tr>
<td>Action Required</td>
<td>Select from the list.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Use the calendar icon to enter date.</td>
</tr>
<tr>
<td>Regarding</td>
<td>Enter description.</td>
</tr>
</tbody>
</table>

9) Click OK to go back to the Create New Transmittals window for your project.
10) From Workflow Actions list, select an action.
11) Click on the Action Details tab, click To, select and add a recipient, click OK, and click Send.
12) When finished, click OK.

Revising a Transmittals Record

1) Go to your project and ensure that you are in User Mode.
2) Click Collaboration node to expand and click Tasks to open the Tasks log window.
3) Open a Transmittals Record, review the content and click Accept Task.
4) In the Contract Reference field, click Select to select a contract, and click Open.
5) From Workflow Actions list, select Resubmit for Approval.
6) From **Action Details** tab, click **To**, select and add a recipient, and click **Send** to forward the record to the next step in the workflow.

### Approving a Transmittals Record

1) Go to your project and ensure that you are in **User Mode**.
2) Click **Collaboration** node to expand and click **Tasks** to open the **Tasks** log window.
3) Open a **Transmittals Record**, click the **Line Items** tab, open the line item, open the document and review the content.
4) Close the window.
5) Click **Accept Task**.
6) From **Workflow Actions** list, select **Approve Transmittal**. The transmittal is routed to the **End** step, as indicated in Action Details.
7) Click **Send**.

### Viewing a Closed Transmittals Record

1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Transmittals**.
4) Double-click a record to open.
5) From Task Details tab click **Click here**.
6) Click a workflow step to see the task details.
7) Click **Approval**.
8) Click **View Graphic**. The current workflow step **End** is highlighted.
9) Click **Close Window**.
10) Click **Close**.
11) Click **Close Window**.
Warranties Business Process

Purpose
Record warranty information for equipment, installations, systems, and responsible parties.

Characteristics
This is a Project or Shell level non-workflow business process with line items.

Roles
Project manager creates and updates the warranties record.

In This Section
Creating a Warranties Record ............................................................... 159
Revising a Warranties Record ............................................................... 160
Saving the Risk & Issues Record .......................................................... 160

Creating a Warranties Record
1) Go to your project and ensure that you are in User Mode.
2) Click Collaboration node to expand and click Tasks to open the Tasks log.
3) Click New from the menu and click Warranties.
4) Complete the form according to the following information.

Note: You must enter a value in all required fields (*) before you can save the form.

Warranty tab
General

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Title</td>
<td>(Required) Enter a title.</td>
</tr>
<tr>
<td>Project Number</td>
<td>No action.</td>
</tr>
<tr>
<td>Creator</td>
<td>No action.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>No action.</td>
</tr>
<tr>
<td>Due Date</td>
<td>No action.</td>
</tr>
<tr>
<td>Status</td>
<td>Select from the list</td>
</tr>
</tbody>
</table>
Manufacturer
Enter information about the manufacturer in each field.

Installer
Enter information about the installer in each field.

Equipment Information
Enter information about the equipment in each field.

Warranty Information
Enter information about the warranty in each field.

**Line Item tab**
1) Click **Add**.
2) Click **Attachment**, click **Add Attachment**, select a source location, and select a document.
3) Complete the fields in the **Warranties Line Item** window.
4) Select a line item status and click **Close**.
5) Click **Finish Editing**.

**Revising a Warranties Record**
1) Go to your project and ensure that you are in **User Mode**.
2) Navigate to the **Project Delivery** node and click to expand.
3) Click **Warranties**.
4) Open the record you want to revise.
5) Click **Edit** and make the necessary changes.
6) Click **Finish Editing**.

**Saving the Risk & Issues Record**

- **To save the Risk & Issues record**

Click either:

- **Finish Editing** to save the form in read-only mode. Regardless of the record status, you can click the **Edit** button to return the record to edit mode.
- **Save** to leave the form in edit mode.
Primavera Cost Controls (PCC)

Primavera Cost Controls (PCC) provides a way to systematically manage budget, scope, and schedule.

PCC contains the tools you need to manage your project:

- **Budget** functions: Including budget approvals, transfers, and changes, as well as estimating, fund appropriations, and a cash flow graph
- **Procurement** functions: Including blanket POs, contracts, purchase orders, change orders, PO amendments, invoices, payment applications, payments, journal entries, and work authorizations
- **Vendor** functions: Including vendor evaluations, vendor approvals, contracts, and bidding

**Note:** Before you use the Project Controls base product, you need to prepare and configure the data that you need for using each component, in Unifier. Refer to the *Primavera Unifier User's Guide* for instructions on how to prepare and configure the necessary data.

The following sections provide details about PCC and is based on the default setup of Unifier.

### Accessing PCC

**Notes:**

- The following instructions are only applicable if you have prepared and configured the necessary data that you need for using this feature in Unifier.
- Before you continue, set your preferences in Unifier. Refer to the *Primavera Unifier User's Guide* for details.

To access Cost Controls business processes:

1) **Sign in** to Unifier. Refer to the *Primavera Unifier User's Guide* for additional information.

For Company-level business processes:

1) Go to **Company Workspace** (**User mode**)
2) Click the **Company Logs** node to expand and access the PCC business processes

For Project-level or Shell-level business processes:

1) Go to **Project** or **Shell** (**User mode**)
2) Click the **Logs** node to expand and access the Project-level or Shell-level PCC business processes.
Note: The administrator sets up the structure of the nodes and modules in the Navigator. Business processes could appear in folders that are placed in appropriate nodes.

The following sections provide details about using the PCC business processes and is based on the default setup of Unifier.

Using PCC

You can use PCC to:

- Establish and control the project budget
- Fund projects
- Record project commitments and any changes to those commitments
- Pay against these commitments
- Track spending
- Create a project schedule and monitor project progress
- Report on all aspects of the project
- Retain project documents
- Maintain an audit trail

PCC accomplishes this through:

- Business process relationships with other business processes
- Cost Rules that ensure the integrity of the cost system. For example: cannot "overdraw" a cost code budget.
- Cost sheets and schedules of value (SOVs) that track the value of each cost code
- Schedule sheets that track project activities
- Cash flow curves that plot baselines, actual spending, and spending forecasts
- Company and project reports

Before using PCC, you need to set up PCC in Unifier. The following sections contain the details on how to set up the PCC in Unifier.

Setting Up PCC (Administrators)

Your administrator needs to take the following actions before you can begin using PCC:

- Set up the module permissions, using the Access Control node. See Setting Up Module Permissions (on page 163) the section for details.
- Add users to the company. See Adding Users to the Company (on page 164) the section for details.
- Set up project templates by:
  a. Adding cost codes to cost sheet template. See Setting up project templates: Cost Sheets Templates (see "Setting Up Project Templates: Cost Sheet Template" on page 168) the section for details.
b. Adding activities to schedule sheet template. See Setting up project templates: Schedule Sheets Templates (see "Setting Up Project Templates: Schedule Sheet Template" on page 171) the section for details.

c. Adding fund codes to funding sheet. See Setting Up Project Templates: Funding Sheet (on page 180) the section for details.

Create a project from the project template. See Creating a Project From the Project Template (on page 164) the section for details.

Assign users to the project. See Assigning Users to Projects and Groups (on page 164, http://www.) the section for details.

The following sections explains each step.

Note: The following instructions are for the administrators who have the required permissions. See the Setting Up PCC (Users) (on page 200) section for information about users.

---

### Setting Up Module Permissions

The administrator can define access to company-level or project-level modules by setting permissions for users and groups in Access Control.

To set module permissions using Access Control:

1) Navigate to the Company Workspace tab and switch to Administration mode.

2) Click Access Control in the left Navigator. The Access Control window opens in the right pane of the Unifier window. The window displays a copy of the Navigator.

Select a module in the Access Control window. The Module Permission Settings window opens. It lists the users and groups that currently have access to the selected module and their permission settings. You can Add, Modify, or Remove users or groups, and grant permission levels.

3) From the Module Permission Settings window, click Add. The Permission/Access Control window opens.

4) Click Add Users/Groups. The User/Group Picker opens.

5) Select users and/or groups from the list, click Add to add them to the Selected Users/Groups list, and click OK.

6) In the Permission Settings window, select the level of permissions you want to assign to the Users/Groups. Click OK.

To remove a user/group and related module permissions:

In the Module Permission Settings window, select the checkbox next to the user or group and then click the Remove button.

To modify permission setting:

In the Module Permission Settings window, select the checkbox next to the user or group and then click the Modify button. Make changes to permission settings as needed and click OK.
Adding Users to the Company

The administrator's first task in setting up PCC is to add company users. There are three ways to add company users:

**Adding company users by way of the Oracle Identity Management (OIM):**
If you are set up to use OIM, it automatically provisions users to your Unifier company.

**Notes:**
- You cannot manually add users or add users via CSV file.
- You will have to manually add users to company-level groups.

**Adding company users manually:**
If you are not set up to use Oracle Identity Management, you can manually add company users.

*Best Practice:* Add users to company-level groups when you create them.

**Adding users by importing the list of existing company users via a CSV file:**
If you are not set up to use OIM, you can import users using a CSV file.

**Note:** The administrator has to *manually* add users to company-level groups.

For details about each option, refer to the following guides:
- *Primavera Unifier Administration Guide*
- *Primavera Unifier User's Guide*

Creating a Project From the Project Template

After adding users to the company, the administrator can create a project. See the *Adding Users to the Company* (on page 164) section for information about adding users to the company.

*Best practice:* Set up cost sheets with cost codes, funding sheets with funding codes, and schedule sheets with schedule activities before creating your project.

PCC displays a tab called "All Projects." You will need to create at least one project that is located in All Projects, and Unifier has a project template for this purpose. For details on how to create a project from the project template, refer to the *Primavera Unifier Administration Guide*.

The project template includes cost, funding, and schedule sheet templates. The template also contains the business processes (BPs) and reports that work with the sheets.

After you create your project you assign users to the project. See the *Assigning Users to Projects and Groups* (on page 164, http://www.) section for details.

Assigning Users to Projects and Groups

Once the administrator has added users to the company (see *Adding Users to the Company* (on page 164)) and created the project, you can assign them to the project.
**Best Practice:** Do not add users to the project template; users may change and once added to a project they cannot be removed, only inactivated.

For details on how to assign users to the project, refer to the following guides:

- *Primavera Unifier Administration Guide*
- *Primavera Unifier User's Guide*

### Setting Up Company-level and Project-level Cost Sheets

Cost sheets capture data from data sources, such as budget, business processes (BPs) by status, managers, and cost code data values.

You receive two types of cost sheets with PCC:

- Company Cost Sheet
- Project Cost Sheet Template

**Note:** You have the option of creating a Project Cost Sheet manually or by copying the template.

**Company Cost Sheet**

The Company cost sheet displays cost data across projects. This sheet resides in the user-mode Cost Manager; it needs no set up. When you create a Project Cost Sheet, Unifier automatically creates a row for the project in the Company Cost Sheet; the project-specific row contains a roll-up of that project's data. Projects are listed in order by project number; each project number is a hyperlink that opens that project cost sheet.

**Project Cost Sheet**

A project cost sheet captures a detailed accounting of its project budget and costs. It works much like a spreadsheet that calculates and maintains project cost information. The project cost sheet rows contain unique cost codes that you can use to link project costs to the general ledger. Cost information can be entered manually, pulled from work packages or worksheets, or rolled up automatically from business processes when transactions occur in Unifier.

The cost sheets contain predefined columns, which are listed in the following table.

**Note:** The rows work differently in Company and Project Cost Sheets.

The project cost sheet template resides in the PROJECTS template. You can create the project cost sheet from the PROJECTS template when you create your project, or you can add the cost sheet after project creation. After setting up a project cost sheet, it can capture project-level budget, spends, and forecast information for that project.

Both the company cost sheet and the project-level cost sheets contain the following columns:

<table>
<thead>
<tr>
<th>This column:</th>
<th>Shows the:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Number (Company level)</td>
<td>Project Number (Company level)</td>
</tr>
<tr>
<td>Cost Code (Project)</td>
<td>Cost code</td>
</tr>
<tr>
<td>This column:</td>
<td>Shows the:</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Project Name (Company level)</td>
<td>Project Name (Company level)</td>
</tr>
<tr>
<td>Cost Name (Project)</td>
<td>Cost name</td>
</tr>
<tr>
<td>Estimate</td>
<td>Sum of all the (closed) estimates for each cost code in the project.</td>
</tr>
<tr>
<td>Original Budget</td>
<td>Sum of all the costs for each cost code in the project.</td>
</tr>
<tr>
<td>Pending Budget Revisions</td>
<td>Sum of all pending budget changes, plus pending budget transfers for each cost code in the project.</td>
</tr>
<tr>
<td>Approved Budget Revisions</td>
<td>Sum of all approved budget changes, plus approved budget transfers for each cost code in the project.</td>
</tr>
<tr>
<td>Revised Budget</td>
<td>Sum of all the original budget and approved budget changes for each cost code in the project.</td>
</tr>
<tr>
<td>Original Commitments</td>
<td>Sum of all the approved contract and approved purchase orders for each cost code in the project.</td>
</tr>
<tr>
<td>Pending Commitment Changes</td>
<td>Sum of all the pending change orders and pending PO amendments for each cost code in the project.</td>
</tr>
<tr>
<td>Approved Commitment Changes</td>
<td>Sum of all the approved change orders and approved PO amendments for each cost code in the project.</td>
</tr>
<tr>
<td>Revised Commitments</td>
<td>Sum of all the original commitments and approved commitment changes for each cost code in the project.</td>
</tr>
<tr>
<td>Pending Spends</td>
<td>Sum of all the pending payment applications and pending invoices for each cost code in the project.</td>
</tr>
<tr>
<td>Approved Spends</td>
<td>Sum of all the approved payment applications and approved invoices for each cost code in the project.</td>
</tr>
<tr>
<td>Risks &amp; Issues</td>
<td>Sum of all closed “Risk and Issues” business process records in each project.</td>
</tr>
<tr>
<td>Original Commitments</td>
<td>Sum of approved contracts and approved purchase orders.</td>
</tr>
<tr>
<td>Forecast Adjustments</td>
<td>Sum of all approved Forecast Adjustment business process records.</td>
</tr>
<tr>
<td>Forecast</td>
<td>Sum of all the revised budget numbers, plus forecast adjustments, plus open risks and issues for each cost code in the project.</td>
</tr>
<tr>
<td>Budget Variance</td>
<td>Difference between the original budget and the original commitments for each cost code in the project.</td>
</tr>
<tr>
<td>Remaining Budget</td>
<td>Difference between the revised budget and the revised commitments for each cost code in the project.</td>
</tr>
</tbody>
</table>
This column: Shows the:

<table>
<thead>
<tr>
<th>Budget Percent</th>
<th>Revised budget, divided by the total of the revised budget.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commitment Percent</td>
<td>Data format is percentage. Each cost code in the project uses the formula (Revised Commitments/Total: Revised Comments).</td>
</tr>
</tbody>
</table>

**Defining Cost Code Structure**

Although PCC does no provide cost codes, it defines the structure of the cost codes that you can make. The cost codes that you build from this structure are used throughout the project, for example in cost-type business processes, and schedule sheet activity properties.

This structure remains editable in cost templates, allowing you to make adjustments to the structure as needed. In project cost sheets, once the structure has been defined, it cannot be edited.

To define the cost code structure:

1. Navigate to the **Company Workspace** tab, and switch to Administration Mode.
2. In the left Navigator, click **Templates > Shells > Projects**. The Projects Template logs opens.
3. Open the **Projects** template.
4. Click **Cost Manager > Cost Sheet**. The Cost Sheet log opens.
5. Select the **Project Cost Sheet** and click the **Properties** button. The Properties window opens.
6. Click the **Structure** tab.
7. In the Structure field at the top of the window, select **Flat** or **Tree**.
   - If you choose Flat, the cost sheet will display the WBS codes (rows) in a flat structure, with no indented rows. This is useful if you want to display all WBS codes at once.
   - If you choose Tree, you have the option of creating indented, nested rows, which can be collapsed into summary, or grouping, rows. This is useful if you will be creating a large amount of rows that can be grouped into categories. Summary rows act only as grouping rows for their indented child, or leaf, rows. Data cannot be entered directly into a summary row.

<table>
<thead>
<tr>
<th>In this Field:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>This defines the structure of the WBS Code rows and how they will appear on the cost template and sheets. Choose Flat or Tree:</td>
</tr>
<tr>
<td></td>
<td>➢ Flat: no indenting of rows</td>
</tr>
<tr>
<td></td>
<td>➢ Tree: allows indented, nested rows, and summary rows</td>
</tr>
<tr>
<td>Sort WBS</td>
<td>If you select the Sort WBS checkbox, the rows will be sorted in ascending order by WBS Code automatically when new cost codes are added (flat structure only)</td>
</tr>
</tbody>
</table>
**Setting Up Project Templates: Cost Sheet Template**

Before you can use the project cost sheet, you must add cost codes. You can add cost codes manually, or import cost codes from a CSV file.

PCC provides a predefined structure for your cost codes (one segment that can be up to 32 characters in length), but it does not give you predefined cost codes. You must define the cost codes yourself.

*Best practice:* Add your cost codes to the template before you create your project.

When you create the project-level cost sheet from the template, it will contain the cost codes you included in the template. If you create the project without first adding the cost codes to the template, you can add cost codes to your individual project cost sheet.

You can structure the cost sheet as Flat, which allows you to sort by code and disallows addition of duplicate cost codes, or as Tree, which has subordinate lines that roll up to summary lines. Once you add data to the cost sheet, the structure is locked.

The following sections explains how to:

- Define cost codes structure
- Add cost codes manually
  - Add rows to a project cost sheet template manually
  - Insert a row between existing rows
- Add cost codes by importing
  - Import project (or shell) cost sheet information
  - Export project cost sheet data

For more information about Cost Sheets, refer to the *Primavera Unifier User’s Guide*.

---

**Adding Cost Codes to Cost Sheet Templates Manually**

To add rows to a project cost sheet template manually:

1) On the **Company Workspace** tab select **Administration Mode**.
2) Navigate to **Templates > Shells > Projects** in the left Navigator.
3) Open **PROJECT TEMPLATE** located in the Project Templates log.
4) Navigate to **Cost Manager > Cost Sheet**.
5) Open **Project Cost Sheet** in the Cost Sheet log.
6) Click **Rows**. The Rows window opens.
7) Click **Add Row**. The WBS Detail window opens.
8) Enter the Cost Attributes as described in the table below.
9) Click **OK** to save Cost Attributes.
   Repeat steps 7 - 9 to add additional rows.
   For additional information, See the Unifier Help topic About the WBS Details Window.
10) Click **OK** to save the cost codes in the project cost sheet.

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>WBS Code</td>
<td>Enter the cost code, which comprises</td>
</tr>
<tr>
<td></td>
<td>▶ One segment</td>
</tr>
<tr>
<td></td>
<td>▶ Alpha-numeric text, up to 32 characters in length</td>
</tr>
<tr>
<td></td>
<td>▶ No separator characters, such as a hyphen</td>
</tr>
<tr>
<td>WBS Item</td>
<td>Enter a label that will display on the cost sheet next to the WBS Code,</td>
</tr>
<tr>
<td></td>
<td>this can help other users to identify what the code represents.</td>
</tr>
<tr>
<td>Cost Type</td>
<td>Select either Capital or Expense</td>
</tr>
<tr>
<td>Status</td>
<td>Select either Active or Inactive</td>
</tr>
<tr>
<td>Owner</td>
<td>Optional - select a cost code owner</td>
</tr>
<tr>
<td>Cost Attribute</td>
<td>Optional - select a cost attribute</td>
</tr>
<tr>
<td>External Ref. ID</td>
<td>Enter a reference ID for the cost code</td>
</tr>
<tr>
<td>Description</td>
<td>Enter an optional description to describe the row.</td>
</tr>
</tbody>
</table>

To insert a row between existing rows:
1) In the Rows window, select the checkbox next to the row after which you want to insert the new row.
2) Click **Add Row** and follow the procedure to add a new row. The new row will be added after the selected row.

**Adding Cost Codes to Cost Sheet Templates by Importing**

Importing cost codes to a cost sheet template involves:
- Exporting the cost sheet to a CSV file
- Adding cost codes to the cost sheet CSV file
- Importing the CSV file

To export project cost sheet data:
1) In the project template cost sheet, select **File > Export** and then choose one of the following options.
   - **Summary Cost Sheet**: Creates a summary of all rows, columns, and data on the cost sheet.
Summary Budget: Creates a summary of the budget window information.

WBS Details: Lists all of the cost codes on the cost sheet and the cost code details information for each.

Column Details: Creates a summary of column details for the selected column (formula and manual entry columns only).

The Summary Cost Sheet option only supports saving the structure for reference purposes. The other three exported files can be modified and then imported into a new or existing project cost sheet.

2) Read the confirmation message and click Yes to continue.

You can open the file in a compatible program, such as Microsoft Excel, to review it before saving.

3) Click Save and specify the location in which to save the CSV file.

Note: If you open the CSV file, you will see that it contains notes regarding modifying the columns and data in the exported file for re-importing into a cost sheet. Follow the notes embedded in the CSV file for modifying columns and data in the exported file.

You can import WBS detail information into a cost sheet manual-entry column from a comma-delimited-value (CSV) file, such as a Microsoft Excel spreadsheet saved in CSV format.

To import project (or shell) cost sheet information:

1) In the project or shell cost sheet, click File > Import and then choose one of the following:

   - Summary Budget: Summarizes the budget information.
   - WBS Details: Lists WBS codes and WBS details information for each.
   - Column Details: Summarizes column details for specific columns (formula and manual entry columns only).

2) Browse to the CSV file to import, select it, and click OK. Note the following:

<table>
<thead>
<tr>
<th>Import Option</th>
<th>Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary Budget</td>
<td>The following rules apply when importing into the cost sheet:</td>
</tr>
<tr>
<td></td>
<td>- Negative numbers are not allowed for budget distribution amount.</td>
</tr>
<tr>
<td></td>
<td>- There is no check on import whether the total capital or</td>
</tr>
<tr>
<td></td>
<td>expense budget was exceeded.</td>
</tr>
<tr>
<td></td>
<td>After the import is completed, return to the Budget Distribution</td>
</tr>
<tr>
<td></td>
<td>page and save and lock the budget. Once the budget is locked,</td>
</tr>
<tr>
<td></td>
<td>the system performs the necessary check to determine if the total</td>
</tr>
<tr>
<td></td>
<td>capital or expense budget has exceeded the original budget.</td>
</tr>
</tbody>
</table>
Import Option | Rules
--- | ---
WBS Details | The following rules apply to the WBS details when importing into the cost sheet:
- WBS details are updated, and new, valid WBS details are added in the order specified in the CSV file.
- The complete WBS code, including the parent code, must be valid and in the correct order in the CSV file.
Column Details | The following rules apply to the column details when importing into the cost sheet:
- This selection adds a column to the cost sheet and is usually done as part of the administration of the cost sheet.
- Values in the Distributed Budget column are for reference only.

Setting Up Project Templates: Schedule Sheet Template

With PCC, you receive a Project Schedule Sheet in the Projects template.

Each project can have multiple schedule sheets, and one Master Schedule Sheet. The Master Schedule Sheet drives project start and end dates, tracks the project’s progress, and serves as the interface between the Schedule Manager and other Unifier modules. For example: The Master Schedule Sheet integrates cost items on the schedule with the Cost Manager.

The project-level schedule sheet template contains the following columns:

<table>
<thead>
<tr>
<th>This column:</th>
<th>Shows the:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row ID</td>
<td>Row ID</td>
</tr>
<tr>
<td>Activity Name</td>
<td>Activity name</td>
</tr>
<tr>
<td>Start Date</td>
<td>Starting date for the activity.</td>
</tr>
<tr>
<td>Finish date</td>
<td>Finish date of the activity</td>
</tr>
<tr>
<td>Duration</td>
<td>Amount of time (usually in days) the activity should take.</td>
</tr>
<tr>
<td>week columns</td>
<td>Progress of the activity by day</td>
</tr>
</tbody>
</table>

The following sections explains how to:
- Add an Activity to a Schedule Sheet Template. See the Adding an Activity to a Schedule Sheet Template (on page 172) section for details.
- Associate a Dependency with an Activity. See the Associating a Dependency with an Activity (on page 173) section for details.
Adding an Activity to a Schedule Sheet Template

Each activity that you create has its own set of properties. In a Schedule Sheet template, you can assign general properties and dependencies.

- The **General** tab is where you can define basic activity information, for example, Activity Name, Activity Constraint, and Start Date and Finish Dates.
- The **Dependencies** tab is where you can define a relationship and lag between activities.

To add an activity to a schedule sheet template:

1) On the **Company Workspace** tab select **Administration Mode**.
2) Navigate to Templates > Shells > Projects in the left Navigator.
3) Open **PROJECT TEMPLATE** located in the Project Templates log.
4) Navigate to Schedule Manager > Schedule Sheets.
5) Open **Project Schedule Sheet** in the Schedule Sheet log.
6) From the Edit menu, or from the toolbar, click **Add** and select **Manual**. The Activity Properties window opens.
7) Complete the **General** tab of the Activity Properties as described in the table below.

About the **General** tab:

The General tab shows fields from the schedule sheet. The fields may vary depending upon how the designer created the schedule sheet attribute form. The table below shows mandatory fields.

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity ID</td>
<td>The Activity ID reflects the list order of activities on the schedule sheet. This field is automatically populated and can change if activities are added or removed.</td>
</tr>
<tr>
<td>Activity name</td>
<td>The activity name reflects the activity on the schedule sheet. This is an editable field; any changes in the attribute form will show up on the schedule sheet.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Enter or edit the date an activity will start. role-related calculation</td>
</tr>
<tr>
<td>Finish Date</td>
<td>Enter or edit the date an activity will end. Any changes to the finish date, either in Activity Properties or directly in a schedule sheet column, will trigger Unifier to recalculate the role amount of the role assigned to the activity. This helps you understand the cost impact of a schedule change.</td>
</tr>
<tr>
<td>Task Duration</td>
<td>The task duration is automatically calculated from the start and finish</td>
</tr>
</tbody>
</table>
**Associating a Dependency with an Activity**

To add or edit a dependency:

1) Click the **Add** button located on the bottom left of the window. The Add Dependency window opens.

2) In the **Activity Name** field, select the activity to make dependent upon the current activity.

3) In the **Relationship** field, select from one of the following options:
   - **Finish to Start**: the dependency must finish before the Activity can start.
   - **Start to Finish**: the dependency must start before the Activity can finish.
   - **Start to Start**: the dependency must start before the Activity can start.
   - **Finish to Finish**: the dependency must finish before the Activity can finish.

4) In the **Lag** field, enter the number of days for a gap or overlap between the selected activity and the current activity. A positive lag indicates a gap. A negative number indicates an overlap.

To remove a dependency:

1) Select the dependency to remove.

2) Click the **Remove** button located on the bottom left of the window.

**About the Dependencies tab:**

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity ID</td>
<td>The Activity ID reflects the list order of activities on the schedule sheet. This field is automatically populated and can change if activities are added or removed.</td>
</tr>
<tr>
<td></td>
<td>dates. If you enter a value that is larger than the difference between the start and finish dates, then the duration is re-calculated from the start date.</td>
</tr>
</tbody>
</table>
Here you can add dependencies between the current activity and other activities from the schedule sheet. You can select another activity on the schedule sheet, determine the relationship, (e.g. Finish to Start, Start to Finish, Start to Start, or Finish to Finish), and add a Lag.

**Note**: Unifier disregards predecessor/successor dependency relationships when you manually start an activity, even if auto-control is set to On in the schedule sheet properties.

---

### Exporting Schedule Files

You can export a schedule sheet to obtain the column schema.

To export a schedule sheet:

1) In User Mode, go to your project and open your schedule sheet.
2) Click File > Export and select one of the following three options:
   - To CSV
   - To XML
   - Activity Progress Template
3) If there is no default mapping, select the Data Mapping you want to use.
4) Click OK.

---

### Importing Schedule Files

This section explains how to create or modify sheet activities.

Once you have saved the schedule files in an importable format (CSV, XML, or MPP) and defined the data mapping, you are ready to import the files into the Unifier schedule sheet template.

**Note**: These directions are for importing files into a project template. The basic process is the same for importing files into an existing project schedule sheet except rather than navigating in Administration Mode to a project template, navigate directly in User Mode to an existing project.

To import a CSV file:

1) Go to the **Company Workspace** tab and switch to Administration mode.
2) Click Templates > Shells > [shell type] > [shell template] > Schedule Manager > Schedule Sheets.
3) From the Schedule Sheets log, open the schedule sheet template into which you want to import the schedule. The Schedule Sheet template opens.
4) Choose File > Import > From CSV.
   - When you import the file, you can select the Data Mapping you want to use for the import files. See the Defining Data Mapping section for more information.
   - If a default mapping was created, you will not have to select a mapping.
If a default data mapping was not created, Unifier will display a Select Data Mapping window.

5) Select the data mapping you want to use for this import, if required, and click OK. The File Upload window opens.

6) Browse to select the CSV file to upload.

7) Click OK.

**To import external source files**

1) Go to the **Company Workspace** tab and switch to Administration mode.

2) Click the **Templates** node in the left Navigator, then click **Shells > [shell name] > Schedule Manager > Schedule Sheets**. The Schedule Sheets log opens.

3) From the Schedule Sheets log, open the schedule sheet template into which you want to import the schedule. The schedule sheet template opens.

4) Choose **File > Import > From External Source**.
   - When you import the file, you can select the Data Mapping you want to use for the import files.
     - If a default mapping was created, you will not have to select a mapping.
     - If a default data mapping was not created, Unifier will display a Select Data Mapping window.

5) Click OK.

6) Click OK. The File Upload window opens.

7) Browse to select the file to upload.

8) Click OK.

**Defining Data Mapping**

Data mapping establishes a 1:1 association between the fields in a Unifier schedule sheet and the fields in a schedule sheet of another application such as Primavera P6.

The data mapping creates a CSV or XML file into which the data from the external schedule can be loaded. Once loaded with data values, these files can then be imported into a Unifier schedule.

---

**Note:** Unifier Cost Controls includes Primavera P6 Integration as the default data mapping which means that there must be at least one data mapping.

If you want to see a specific field from an external source in Unifier, you must map to that specific field.

Unifier supports multiple data formats. The following shows each supported data format and explains the data mapping requirements:

- **CSV**: Requires mapping; you can select the mapping when you upload the file.
- **MPP**: Mapping is not required. Imported fields are limited to Start Date, Finish Date, and Duration. Do not select a default data mapping if you will be asking Unifier to consider an activity calendar.
- **Primavera XML**: Requires default data mapping.
Microsoft Project SML: Requires mapping; you can select the mapping when you upload the file.

- **Note:** Unifier also supports the MPP XML data format.

To define data mapping:

- **Note:** After navigating to a project schedule sheet template or a project schedule sheet, the directions are the same.

1. Open the schedule sheet in which you want to import a schedule.
2. Choose **File > Data Mapping**. The Data Mappings window opens.
   - The Data Mappings window lists any mappings created for schedules such as Primavera P6. If a mapping on this list is marked as the default mapping, Unifier will use this mapping when the schedule is imported. If you do not mark a mapping as the default, Unifier will prompt the users to select a mapping whenever they import a schedule.
3. Click **Add**. The Data Mapping window opens.
4. On the **General** tab, enter the name and the description for the data mapping and click **Apply**.
5. Click the **Activity** tab.
   - Use this tab to create the structure of the file for the export and import operations. On this tab, you can map Unifier schedule sheet columns to external CSV headers and XML tags in order to import or export activity information.
   - a. Click the **Add** button. Another data mapping window opens.
   - b. Use the following information to complete the fields on this window.
     - **Column**: Select the data elements you want to import. Minimum required fields for XML import are Activity ID, Activity Name, Start date, Finish date, and Duration.
     - **CSV Header**: Enter the CSV header from the external source.
     - **XML Element**: Enter the XML from the external source.
6. (Optional) On the **Resource** tab, you can map resource information through XML integration. Enter the header in the XML element that corresponds to the column.
   - **Note**: Mapping resources is mandatory only if you select Import Resource Assignments on the Options tab.
   - a. Click the **Add** button. Another data mapping window opens.
   - b. Select the column and enter the header in the XML element that corresponds to the column.
7. Click **Apply** on the Resources tab.
8. Click the **Options** tab. On this tab, you can configure XML options that are used by Unifier when importing data.
9. Use the following information to complete the fields on the Options tab and click **OK** when finished.
   - **XML Import**: Define options for importing XML activity schedules into Unifier. Mapping options are the same for Primavera XML and Microsoft Project XML.
**Options:** You can either retain existing schedule information in Unifier, or overwrite it complete upon importing an external XML file.

- Merge into existing schedule. With this selection, you have a sub-option to Delete Activities removed from the source schedule.
- Overwrite existing schedule replaces the existing schedule.

**XML Export:** Define options for exporting through XML into another software application

**Data Elements:** Select the appropriate checkboxes if you want to export activities (rows), and whether to include dependencies, resource assignments, and/or WBS codes.

See the following for more information.

The following lists the Data Elements options:

**Activity Dependencies:** Select this checkbox to retain activities from the XML source file.

**Activity Calendar:** Select this checkbox to retain the activity calendar from the XML source file. If imported, the activity calendar will trigger the recalculation of activity dates as needed, and will override any existing activity calendar association. If a calendar is not imported, the activity will use the existing calendar defined in the Schedule Sheet properties. *Note that* there must be a calendar in Unifier with the same name as the calendar in the import file.

**Resource Assignments:** Select this checkbox to retain the resource assignments from the XML source file. If you want to import resources, define the resource types for the data definition SYS Resource Type. For Microsoft Project files, use standard resource types: Work, Material, and Cost. Upon import, these resource types will soft book.

**WBS Codes:** Select this checkbox to import WBS codes. See the information under "WBS code options for Primavera XML and Microsoft Project XML" on page 552.

**Number of Levels:** (for Primavera XML only) Specify the segments that should be considered in the Primavera XML file for the codes (from 1 to 9) and the WBS code suffix mask.

**Suffix Mask:** (for Primavera XML only) You can use a constant or a data element value in the Suffix Mask.

- To use a constant in the Suffix Mask, click the Constant radio button, and enter the suffix you want to have appended to the WBS code.
- To use the value from a data element in the Suffix Mask, click the Data Element radio button and select a data element.

The following lists the WBS Code Options for Primavera XML and Microsoft Project XML:

Unifier can recognize the WBS codes imported through XML files and match these codes to equivalent codes in a project/shell cost sheet. For Primavera XML files, you need to specify the Number of Levels and a Suffix Mask. (The codes in Microsoft Project XML files are automatically resolved by Unifier when the file is imported.)

The number of levels specifies the number of segments that should be included to build WBS codes based on data from the Primavera XML file. The number of segments considered starts from the top of the imported XML file. If you specify a number of segments and the data in the XML file has fewer segments than that number, then all segments are processed.

The Suffix Mask you enter is added to the WBS code elements that Integration derives from the XML file. The WBS code derived from the XML file with the mask is validated against the WBS codes (leaf level) created for the project/shell Cost Sheet.
While deriving the WBS codes from the XML file, Integration separates segments retrieved from the XML file with the cost code separator (specified in uDesigner). When specifying the Suffix Mask, be sure to use the same cost code separator if the mask contains more than one segment.

### Copying an Activity from another Schedule Sheet

To copy an activity from another sheet:

1) Open the project where the schedule sheet resides, and click **Schedule Manager** in the left navigator.
2) Select **Schedule Sheets**. The Schedule Sheets log opens.
3) Open the sheet into which you want to copy an activity.
   - The default order for a new row is at the end of the activities list. You can insert a row where you want it by selecting a row on the sheet. Unifier adds the new row above the selected row.
4) From the **Edit** menu, or from the toolbar, click **Add** and select **Copy Activity From**. The Schedule Manager Picker window opens.
5) Select a schedule sheet from the **Schedule Sheet** drop-down menu, which lists all the active schedule sheets in the current project.
6) Select an activity from that sheet and click **Copy**.
   - The role amount is recalculated for the added activity and for any activity that has its start or finish dates changed as a result of the addition.
7) If you want to make changes to the activity properties, click the activity to open it.

For the purpose of populating activities on the Schedule Sheet with roles for the work to be done on the project, the Resource Manager is set up with a role attribute form that is linked to the Schedule Manager. See the *Configuring the Resource Manager and Creating a Role* (on page 178) section for details.

### Configuring the Resource Manager and Creating a Role

Before you can use the Resource Manager, you must first configure or activate the module.

To configure the Resource Manager:

1) Go to the **Company Workspace** tab and switch to Administration mode.
2) Click **Configuration > Resource Manager** in the left Navigator. The Resource Manager log opens.
3) Select **Resource Manager** and click **Open**.
4) Complete the Resource Manager General Configuration window as described in the following table and then click **OK**.

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Code</td>
<td>Choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>▶ <strong>Manual</strong>: Allows you to enter a resource code manually while defining resources. Validation is performed to ensure resource codes are unique.</td>
</tr>
<tr>
<td></td>
<td>▶ <strong>Automatic</strong>: Automatic numbering generates unique resource codes using a sequence.</td>
</tr>
</tbody>
</table>
Sequence Format: For automatic numbering, enter an alpha-numeric prefix for the resource code (e.g., RES).

Start: Enter a number to start the sequence. Numbers are generated from the start number in increments of 1.

These define default values for resource sheets. These values can be changed any time. Choose options for:

- **Timescale Unit**: Options are day, week, month. Defines the default granularity for the display on all resource sheets at the company and project level.
- **Date From**: Enter a default start date for the timeline display on all resource sheets at the company level. This default does not prevent entering transactions before this date. Actual start date of the timeline will be driven by the earliest applicable transaction date (for booking, assignment, allocation, etc.).
- **Date To**: The latest applicable transaction date.

**Resource Booking**

- **Allow over-booking of resources**: The resource booking process will be allowed to over book a resource (beyond the resource’s daily capacity).
- **Maximum Over-booking Percent**: This field is enabled if the over-booking checkbox is selected. Enter any positive integer amount. If a value is not specified, there is no limit on over-booking.

This information can be edited at any time. Changes will be reflected on subsequent bookings.

Note: A resource can never be booked more than 24 hours on any day.

In the Resource Manager you can create and manage roles that you can assign to schedule sheet activities. A role can be virtually anything, for example, a role can be a job title, or it can be a piece of machinery. Each role can have its own role rate.

To create a role:

1) Go to the **Company Workspace** tab and switch to Admin mode.
2) Click **Resource Manager > Roles** in the left Navigator. The Roles log opens.
3) Click **New**. The Create Role window opens on the **General** tab.
4) Complete the **General** tab.
   a. Enter a name for the role in the **Role Name** text box.
   b. Click **Active** when you are ready to activate the role and make it available to assign to a resource.

   You cannot save the role until you select a currency on the **Rates** tab.
5) Click the **Rates** tab. This is where you associate billable rates to a role.
   a. Select a currency.
   b. Add a Role Rate.
      - Click **Add**. The Role Rates window opens.
Select the **Effective Date**.
- Enter a **Standard Rate**. This entry automatically populates the **Overtime Rate** text box, but you can edit the Overtime Rate entry.
- Edit the **Overtime Rate**, if desired.

6) Click the **Resources** tab. This is where you can add or remove a resource, and view resource properties.

You may have to add Resources before you can complete this step.

a. Add a Resource
   - Click **Add**. The Select Resources window opens. Here you can add or remove
   - Select a resource from available resources.
   - Enter a **Standard Rate**. This entry automatically populates the **Overtime Rate** text box, but you can edit the Overtime Rate entry.
   - Edit the **Overtime Rate**, if desired

7) Click **OK**.

---

**Setting Up Project Templates: Funding Sheet**

Funding sheets reside at both the company and project level. You define funding sources in the Company Funding Sheet and track allocation and consumption at the company and project-levels.

**Company Funding Sheet**

The company funding sheet tracks all sources of funding across all projects or shells and programs. You create only one sheet per company. Funding sources that are made available at project or shell sheet level are rolled up to the company sheet, which maintains the overall fund information. Once created, the company funding sheet can be edited, but not deleted. The company funding sheet must be created before creating individual project or shell funding sheets.

Funding sources at project sheet-level are rolled up to the company sheet, which maintains the overall fund information. The columns on the company funding sheet are used to track project-level funding and to track fund balances.

Fund assignments are added to this sheet via a Fund Appropriations business process. For each project or shell, fund assignments are totaled on the project/shell sheet and rolled up to the company sheet. Each row in the company funding sheet corresponds to one fund.

The company-level funding sheet contains the following columns:

<table>
<thead>
<tr>
<th>This column</th>
<th>Shows the:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fund Code</td>
<td>Fund code</td>
</tr>
<tr>
<td>Fund Name</td>
<td>Fund name</td>
</tr>
</tbody>
</table>
This column: Shows the:

<table>
<thead>
<tr>
<th>Project Funding</th>
<th>Each project’s funding transactions and total.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Funding by Project</td>
<td>Manual entry of each project’s funding transactions and total.</td>
</tr>
<tr>
<td>Transient Records Funded at Project Level</td>
<td>“Fund Appropriations” that are in process (have not yet reached approved terminal status).</td>
</tr>
<tr>
<td>Records Funded at Project Level</td>
<td>Records that have been approved for funding.</td>
</tr>
<tr>
<td>Fund Remaining Balance</td>
<td>Project funding, minus the total Transient Records Funded at Project Level and total Records Funded at Project level</td>
</tr>
</tbody>
</table>

**Project Funding Sheet**

The project funding sheet tracks how funding is being allocated and consumed in the project. Project fund sheets work in conjunction with the company funding sheet to track individual transactions, which are rolled up to the company funding sheet. Project-level fund allocation, assignment, and credits can be done manually, or through business processes. A funding template and company funding sheet must be complete before you can create a project funding sheet.

Each row in the project funding sheet corresponds to a fund that has been allocated for use on this project.

The project/shell-level funding sheet contains the following columns:

<table>
<thead>
<tr>
<th>This column:</th>
<th>Shows the:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fund Code</td>
<td>Fund code</td>
</tr>
<tr>
<td>Fund Name</td>
<td>Fund name</td>
</tr>
<tr>
<td>Project Funding</td>
<td>Allocation amount of each fund for the project</td>
</tr>
<tr>
<td>Manual Funding by Project</td>
<td>Manual entry of each project’s funding transactions and total.</td>
</tr>
<tr>
<td>Transient Records Funded at Project Level</td>
<td>&quot;Fund Appropriations&quot; that are in process (have not yet reached approved terminal status).</td>
</tr>
<tr>
<td>Records Funded at Project Level</td>
<td>Records that have been approved for funding.</td>
</tr>
<tr>
<td>This column:</td>
<td>Shows the:</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fund Remaining Balance</td>
<td>Project funding, minus the total Transient Records Funded at Project Level and total Records Funded at Project level</td>
</tr>
</tbody>
</table>

**Adding Funding Codes to Funding Sheet**

Unifier provides the basic structure for funding sheets. These are the columns of information you are most likely to need on the sheets. You will need to add funding codes to the company funding sheet and funding sources to those codes. Then you can use funding business processes to distribute funds to projects, or manually add funds to projects.

To add funding codes to the company-level funding sheet:

1) Click the **Company Workspace** tab. Switch User Mode.
2) In the left Navigator, click the **Cost Manager** node, and click **Funding**. The company-level Funding log opens.
3) Open the company-level Funding Sheet.
4) Click **Rows**, and then click **Add Row**. The Fund Detail window opens.
5) Complete the fields in the Fund Detail window. This entry becomes a funding source.

To add funding codes to a project-level funding sheet:

1) Open the project-level funding sheet or template.
2) Click **Rows**, and then click **Add Row**. The Fund Detail window opens.
3) Select a fund. You can search for a specific fund in the fund picker:
   a. Click the **Find** button. The Find window opens. The window that opens will depend on the design in uDesigner. You can search by Fund Code or Fund Name.
   b. Enter search criteria and click **Search**. This limits the number of funds that are displayed to those that match the search criteria.
4) Click **OK**. The fund appears as a row on the Funding Sheet. Funds are displayed in alphabetical order on funding sheet.

To view fund details click on a fund under fund code column.

**Importing Fund Details via CSV Files**

The steps to import funding details into a funding sheet via CSV entail:

- Exporting the funding sheet to a CSV file
- Adding funding details to the funding sheet CSV file
- Importing the CSV file
You can export fund detail information from a company or project funding sheet to a CSV file. The file contains all of the information captured in the Fund Details form when the funds were added to the company funding sheet. When you export the fund details from the company funding sheet, the details of all funds are exported; exporting from a project funding sheet gives the details of those funds added to that sheet.

When adding funds to a company funding sheet, you can use the export file as a template, add fund details to the CSV file, then re-import the file to add funds to the company funding sheet.

**Note:** You cannot use import to add funds to a project funding sheet.

To export fund details from a funding sheet:

1) Open the company or project funding sheet.
2) Click the **Export** button and then choose **Fund Details**.
3) Read the confirmation message and then click **Yes** to continue.
   - You may choose to open the file in a compatible program such as Microsoft® Excel to review it before saving.
4) Click **Save** and specify the location in which to save the CSV file.

To edit the CSV file:

1) After you export the company funding details remove any existing funds that may be listed in the export file, so that only the column headings remain. Note the instructions at the top of the file; they can remain in the file.
   - Do not add fund codes that already exist on the funding sheet.
   - Do not change the column order or the column headings.
2) Enter your funding data. Be sure to complete all required fields.
3) Save the CSV file.

To import fund details into a company funding sheet:

1) Open the company funding sheet.
2) Click the **Import Fund Details** button.
3) Browse to the CSV file and click **Ok**. The funds you added to the import file will be added to the company funding sheet.

**Note:** If any errors occur, download and open the error file, and correct the CSV file before reimporting. Common errors include trying to import fund codes that already exist on the sheet, or not completing required fields.

### Changing the Set Up of PCC Business Processes (BPs)

The setup of the PCC business processes are predefined; however, you (Company or Project Administrator) can modify the predefined setups as needed to suit your business model. (For example: you may wish to change who can act as an Editor on a business process.)

When you want to set up a business process for either a workflow or non-workflow business process you can use the business process:
- **General** tab to add a business process-specific Help PDF (see the **BP General Tab** on page 184).
- **Settings** tab to select who can edit business process records (see **BP Settings Tab** on page 184).
- **Notification** tab to define record notification settings (see **BP Notification Tab** on page 185).
- **Auto Creation** tab to define auto-creation settings (see **BP Auto Creation Tab** on page 186).
- **Record Copy** tab to define Record Copy settings for workflow BPs, only (see **BP Record Copy Tab** on page 190).

When you set up a business process that has workflow you must define workflow settings for each step in the workflow. Workflow business processes can have multiple workflow schema that must be set up independently from each other. At run time, the first step in the record creation process, users must select which workflow the record will follow.

### BP General Tab

Use the General tab to add a business process-specific Help PDF.

1) Go to the **Company Workspace** tab and switch to **Administration Mode**.
2) In the left Navigator, open the business process that you want to set up. Business processes may reside in the Company Workspace, a Template, or in Company Sponsored Shells.
   - Company Workspace > Business Process Setup > *BP name*
   - Templates > Shells > Projects > Project Template > Setup > Business Processes > *BP name*
   - Company Sponsored Shells > [project name] > Setup > Business Processes > *BP name*
1) In the BP Setup log either double click the BP or highlight it and click the **Open** button.
2) Use the information in the table below to complete the fields of the **General** tab.
3) Click **Apply** to save your changes and **OK** to exit.

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Name</td>
<td>Enter a unique name for the setup. This is a required field.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the setup.</td>
</tr>
<tr>
<td>Help File</td>
<td>This is where you can add an individualized business process help PDF. Unifier makes the Help file available in the business process log and in the business process.</td>
</tr>
<tr>
<td>Send error notification to</td>
<td>Select who should receive any error notifications.</td>
</tr>
</tbody>
</table>

### BP Settings Tab

Use the Settings tab to select who can edit business process records. Also, the Settings tab is where you can add a Record Editor, provided the Record Editor option was defined in uDesigner.
Record Editors can edit a record even if not selected as an assignee.

1) Go to the **Company Workspace** tab and switch to **Administration Mode**.

2) In the left Navigator, open the BP that you want to set up. Click the Setting tab.

   The BP may reside in the Company Workspace, a Template, or in Company Sponsored Shells.
   - **Company Workspace > Business Process Setup** > **BP name**
   - **Templates > Shells > Projects > Project Template > Setup > Business Processes** > **BP name**
   - **Company Sponsored Shells > [project name] > BP name**

3) In the BP Setup log either double click the BP or highlight it and click **Open**.

4) Click the Select button. The User/Group picker opens.

5) Select who you want to edit the record and click **Add**.

6) Click **Apply** to save your changes and **OK** to exit.

**BP Notification Tab**

Use the Notification tab to define record notification settings. The Notification tab to set up automatic email notifications to users and groups whenever a workflow or non-workflow BP is created or modified, either manually, or via auto-creation, reverse auto-population, CSV, or integration.

**Note**: If the BP has been designed to allow users to include additional users or groups in the email, the email notification will be sent to them as well.

1) Go to the **Company Workspace** tab and switch to **Administration Mode**.

2) In the left Navigator, open the business process that you want to set up. BPs may reside in the Company Workspace, a Project Template, or in Company Sponsored Shells.
   - **Company Workspace > Business Process Setup** > **BP name**
   - **Templates > Shells > Projects > Project Template > Setup > Business Processes** > **BP name**
   - **Company Sponsored Shells > [project name] > BP name**

3) In the BP Setup log either double click the BP or highlight it and click **Open**.

4) Use the information in the table below to complete the fields of the **Notification** tab.

5) Click **Apply** to save your changes and **OK** to exit.

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Notifications to:</td>
<td>Use the <strong>Select</strong> button to add notification recipients.</td>
</tr>
<tr>
<td>Notify Creator on Record Modification</td>
<td>By default, this check box is marked. If you do not want the business process creator to be notified when the business process is modified, de-select this box.</td>
</tr>
</tbody>
</table>
### BP Auto Creation Tab

Use the Auto Creation tab to define auto-creation settings for Upper and Detail Forms. On the Auto-Creation tab, you can set up the auto-creation of another record or line item for the BP you are setting up. You can also set up the auto-creation for other BPs that this BP will generate.

1) Go to the **Company Workspace** tab and switch to **Administration Mode**.
2) In the left Navigator, open the business process for which you want to set up Auto Creation. BPs may reside in the Company Workspace, a Project Template, or in Company Sponsored Shells.
   - Company Workspace > Business Process Setup> **BP name**
   - Templates > Shells > Projects > Project Template > Setup > Business Processes > **BP name**
   - Company Sponsored Shells > [project name] > **BP name**
3) In the BP Setup log either double click the BP or highlight it and click **Open**.
4) Use the information in the table below to complete the fields of the **Auto Creation** tab.
5) Click **Apply** to save your changes and **OK** to exit.

#### Table: Auto Creation Tab

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Assignee on Record Modification</td>
<td>Mark this box if you want the Assignee to receive notification when the record is modified.</td>
</tr>
<tr>
<td>Notify Cc on Record Modification</td>
<td>Mark this box if you want the message recipient to receive notification when the record is modified.</td>
</tr>
<tr>
<td>Notification Triggering Events:</td>
<td></td>
</tr>
<tr>
<td>Edit Upper Form</td>
<td>Mark this box if you want a notification when the upper form is edited.</td>
</tr>
<tr>
<td>Add/Edit/Delete Line Items</td>
<td>Mark this box if you want a notification when line items are added, edited, or deleted.</td>
</tr>
<tr>
<td>Add General Comments</td>
<td>Mark this box if you want a notification when general comments are added.</td>
</tr>
<tr>
<td>Add/Remove Attachments</td>
<td>Mark this box if you want a notification when the upper form is edited.</td>
</tr>
<tr>
<td>Attachments:</td>
<td></td>
</tr>
<tr>
<td>Include both record and line item attachments</td>
<td>Mark this box if you want to include both record and line item attachments. Unifier will include this information as PDFs in the notification.</td>
</tr>
<tr>
<td>Include record information as attachment</td>
<td>Mark this box if you want to include record information in the notification. Unifier will include a PDF of the record in the notification.</td>
</tr>
</tbody>
</table>
In this field: | Do this:
---|---
**Setting for auto creation of business process name**
Setup | Use the drop-down arrow to select the setup you want to configure.
Creator | Use the **Select** button to choose a Creator for this business process.
Action | Use the drop-down arrow to select an action for the auto-created business process.

**Settings for auto creation of other Business Process records or line items (left column)**

| Creator Elements - Upper Form | 
| BP Creator X | If the BP Creator is on the Upper Form, select this element.
| Creator Elements - Detail Form | 
| BP Creator Y | If the BP Creator is on the Detail Form, select this element.

**Auto creation of business process name (right column)**

| Assignee/Creator | Select the user who will auto-create this business process.
| Duration | Enter the length of time the record has to complete routing, after which time the record will be considered late.
| Enable condition based auto creation | Selecting this box activates the Add Condition dialog box. Click the **Add** button. The Add Condition dialog box opens On the **General** tab enter the **Name** (required) and a **Description** for the condition. On the **Query** tab enter:
- Auto Creation Conditions
- Date Trigger Conditions
See the **Setting Up Queries for Auto Creation** (on page 188) section for details about the Query tab.
### In this field:  | Do this:
---|---
Include Attachments | If you want the auto-created record to include attachments from the original (source) record, select the **Include Attachments** check box. If you select this option:
- Any record-level attachments made to the source record will appear at the record level of the destination record.
- Any attachments made to the line items of the source record will appear at the line item level of the destination record.
**Note**: This step is not applicable for Document type business processes.

Bypass initiation step during auto creation | Select this option if you want to bypass the Initiation (I) step that record auto-creation normally creates, the auto-created business process
- Skips the initiation step
- Appear in the user’s business process log at the appropriate step in the workflow.

Copy Linked Records | Select the **Copy Linked Records** option if you want to copy any records that are linked to the original record.

Enable grouping of line items when auto-creating records from line item tabs | This option allows you to set up the line item grouping you want on a business process record that will contain each line item of a selected data type.

Group By | In the **Group By** field, click **Select**, then choose the data elements by which you want to group line items. If you leave the **Group By** field blank, Unifier will auto-create a single record containing all the line items on the source record.

### Setting Up Queries for Auto Creation

You will be using queries to extract data from the database for reports and data pickers, and to set up auto-creation with creator elements.

A query is a data mining tool—a means of retrieving information from a database. A query filters the information returned from the database according to restrictions or conditions you specify. Unifier queries can:
- Filter or narrow the data being retrieved for use in reports and manager sheets
- Set up conditions or triggers to make something happen automatically in Unifier
- Filter or narrow the data being retrieved for use in a data picker element
In a query, you mine down to the information you want by choosing an element (field) in the database on which to base the query. Then you can test the data against conditions and values you specify.

**About Conditions**

A condition is a state or restriction the value in the data element (field) must meet.

A condition of the value might be that it must be equal to a certain number (maybe 10) or that it must contain a certain string of letters (such as "due date of").

When (or if) the data meets the condition you specify, Unifier retrieves it from the database for use in a report, manager sheet, auto-creation, data picker, etc.

To create the conditions that will trigger auto-creation, select the **Enable condition based auto creation** check box and continue as follows:

**Note:** If you leave this check box un-checked, the business process, planning item, or line item will be available for manual creation only.

1) To add a trigger condition, click the **Add** button. The Add Condition window opens.
2) On the **General** tab, enter a name for the trigger and a description.
3) Click the **Query** tab. The Query tab is where you will define the conditions the data must meet before Unifier will auto-create the new business process record.
4) In the upper section of the window, you can specify that a field on the business process form:
5) Must meet a certain criteria or value.
6) Must meet a certain value based on a formula using the numeric fields on the form.
7) Click the **Add** button to specify a condition for a field on the business process form.
8) Click the **Add Formula** button to create a formula that the value of the field must meet. Use the information under About Queries to complete the query.
9) In the lower section of the window, you can specify a date condition that will trigger the auto-creation. Use the information under About Queries to complete the query.
10) Click **OK**.
11) Click **Apply** to save your changes, or **OK** to save and exit the window.

**About Date Triggers**

- Date Trigger Conditions are not available for line item auto-creations.

- If you want to create a continual date trigger condition, make sure you use the Date Trigger Condition section of the window to create it. Although you can also create a date trigger using a formula in the upper section of the window, Unifier will process the triggers differently.

- The conditions you specify in the upper section of the window will be processed only once, when the user clicks the Send button on the form to send the form to the next step in the workflow. However, the date conditions you specify in the Date Trigger Condition section will be processed daily.

- This behavior is important to consider when you are creating a date condition that occurs in the future. A date trigger specified under the Date Trigger Condition section will be processed daily, and will, therefore, "catch" the trigger condition when the future date occurs.
BP Record Copy Tab

Use the Record Copy tab to define Record Copy settings for workflow BPs, only.

The Record Copy tab allows you to set up copy options for Unifier users when they copy a record with line items and references.

The options you specify here will give the user the ability to copy specific (rather than all) line items, as well as the ability to include attachments and linked records, and retain or remove references to auto-created records.

To set up these options, you must create a condition the data element must meet in order for the line item to be included for these copy options.

Example

You can create a set of options specifying that all line items with a status of "open" be copied, and their attachments be included in the copy. Using this example, you could set up a weekly meeting minutes business process that automatically generates action item business processes for each task that arises from the meeting. Using these copy options, you could roll over action items that are still open to the next week’s meeting minutes.

At the runtime, users can choose the options that you set in the Record Copy tab to copy records.

To set up copy options:

**Note:** These options are not available for Payment Applications.

1) Open the BP for which you want to set up the copy options.
2) Click the **Record Copy** tab. The Record Copy Setup window opens.
3) Click **Add** to open the Copy Condition Setup window.
4) In the **Name** field, enter a name for this copy setup. The name should be unique, and can be up to 250 characters long.
   This is the name that will appear on the list of copy options the user will see when they copy a record or line item.
5) (Optional) In the **Description** field, enter a description of what this setup does.
   **Tip:** It’s a good idea to include a precise description of what the copy options are for the setup. This description will appear on the list of copy options the user will see when they copy the record, and a good description will tell them exactly what will be copied. You can enter up to 4000 characters.
6) Under the **Condition** area of the window, click **Add** to open the Query Condition window.
7) In the **Data Element** field, select the of the field on the line item form that you want to use to identify which lines items can be copied.
8) In the **Condition** field, select the operator Unifier should use to test the data element you selected.
   A condition is a state or restriction the value in the data element (field) must meet. A condition of the value might be that it must be equal to a certain number (maybe 10) or that it must contain a certain string of letters (such as "due date of").
If the data element meets the condition you specify, Unifier will include this line item on the list the user can choose from. (For more information on conditions and queries, see About Queries.)

9) Click OK.

10) On the Copy Condition Setup window, specify these additional copy options as shown in the table below.

11) Click OK.

<table>
<thead>
<tr>
<th>Select this checkbox</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Attachments</td>
<td>Include attachments in the copy operation.</td>
</tr>
<tr>
<td>Copy Linked Records</td>
<td>Include any linked records in the copy operation.</td>
</tr>
<tr>
<td>Retain reference to auto-created business process records on record upper form</td>
<td>Keep the references to business processes that were auto-created from the upper form.</td>
</tr>
<tr>
<td>Retain reference to auto-created business process records on line items across all tabs</td>
<td>Keep the references to business processes that were auto-created from the line item (detail) form. This applies to all line items from all tabs.</td>
</tr>
</tbody>
</table>

Changing the Set Up of PCC Business Processes (BPs) Workflows

**Note:** The following setup applies to both Company-level and Project-level BPs.

The setup of the PCC business processes are predefined; however, you (Company or Project Administrator) can modify the predefined setups as needed to suit your business model.

The following sections describe how to change the Workflow setup of a BP.

**BP Workflow General Tab**

Use the BP Workflow General tab to change the set up of the BP workflow.

1) Go to the **Company Workspace** tab and switch to **Administration Mode**.

2) In the left Navigator, open the business process that you want to set up. Business processes may reside in the Company Workspace, a Template, or in Company Sponsored Shells.
   - Company Workspace > Business Process Setup > BP name > Workflow Setup
   - Templates > Shells > Projects > Project Template > Setup > Business Processes > BP name > Workflow Setup
   - Company Sponsored Shells > [project name] > Setup > Business Processes > BP name > Workflow Setup

The **BP name** Setup log opens.
3) Open a workflow in the log. The Workflow Setup window opens. Use the information in the table below to complete the fields of the **General** tab.

4) Click **Apply** to save and continue working or **OK** to save and close the window.

5) Click the **Settings** tab. **Workflow Configuration** opens. Follow the directions in the Settings Tab Settings - Workflow Configuration Settings table below.

   On the Settings tab, the workflow steps are arranged in a tree structure. From here you can set up the overall workflow setup, individual step setting, steps that lead to conditional routing, links with auto-creation of business process, and sub-workflow settings.

6) Click each step and complete its Step Configuration settings. See the Settings Tab Settings - Step Configuration Settings table below.

7) Click **Apply** to save and continue working or **OK** to save and close the window.

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Name</td>
<td>Enter a unique name for the workflow setup. You may have more than one setup in a business process so it is best to name the setup to reflect how it works.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the workflow.</td>
</tr>
<tr>
<td>Status</td>
<td>Click either the <strong>Active</strong> radio button or <strong>Inactive</strong> radio button to set the workflow status.</td>
</tr>
<tr>
<td>Error Check</td>
<td>Click the <strong>Error Check</strong> button to determine if the workflow is free from errors.</td>
</tr>
<tr>
<td>Default Record format for Notification and Document Manager</td>
<td>Select PDF or Custom.</td>
</tr>
</tbody>
</table>

**BP Workflow Settings Tab (Workflow)**

1) Click the **Settings** tab to open the Workflow Configuration window.

2) Follow the directions in the Settings Tab Settings - Workflow Configuration Settings table below.

   On the Settings tab, the workflow steps are arranged in a tree structure. From here you can set up the overall workflow setup, individual step setting, steps that lead to conditional routing, links with auto-creation of business process, and sub-workflow settings.

3) Click **Apply** to save and continue working or **OK** to save and close the window.

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Configuration</td>
<td></td>
</tr>
<tr>
<td>Enable Workflow Duration</td>
<td>When <strong>Yes</strong> is selected, records created with this instance will be marked as late when the defined amount of time passes.</td>
</tr>
<tr>
<td>Workflow Duration</td>
<td>You can optionally set the duration of the workflow.</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Override Workflow Due Date</td>
<td>User can override the due date for the workflow. Be sure to select Yes for this option if you are using Scope Management and have selected Enforce Activity Finish Date for the Record Due Date for the activity business process.</td>
</tr>
</tbody>
</table>

### Phases

<table>
<thead>
<tr>
<th>Allowed in all phases</th>
<th>Setup is valid in any project phase.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow only in phases</td>
<td>Setup is valid only during the specified project phase. This is not applicable for company level BPs.</td>
</tr>
<tr>
<td></td>
<td>▶ Click <strong>Add</strong> to open the Project Phases dialog box.</td>
</tr>
<tr>
<td></td>
<td>▶ Select a Project Phase.</td>
</tr>
<tr>
<td></td>
<td>▶ Click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

### Additional Information

| Notify users or groups on workflow completion | Selected users or groups will be notified once the workflow is complete. |

### BP Workflow Settings Tab (Step Configuration)

1) Click the **Settings** tab to open the Workflow Configuration window.

2) Click each step and complete its Step Configuration settings. See the Settings Tab Settings - Step Configuration Settings table below.

3) Click **Apply** to save and continue working or **OK** to save and close the window.

<table>
<thead>
<tr>
<th>In this field:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step</strong></td>
<td></td>
</tr>
<tr>
<td>Step Name</td>
<td>You can click the link to view a graphical representation of the workflow, with the current step highlighted. Be aware that workflows can often be very large. If you are viewing a large workflow, you can enlarge the canvas screen to make it easier to see all the steps to the workflow progression.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter an optional description to help identify the workflow.</td>
</tr>
<tr>
<td>Duration</td>
<td>Choose the time length for this step.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Override Task Due Date</td>
<td>Allows user to override due date for an individual task.</td>
</tr>
<tr>
<td>Allow Decline Step Task</td>
<td>Click <strong>Yes</strong> if you want the assignees to have the ability to decline an action on an assigned task.</td>
</tr>
<tr>
<td>Enable Step for Integration</td>
<td>Click the radio button if you want this step to be available for integration with an external system, such as Web Services. If you make the step available for integration, the user can use the external system to view a read-only copy of the BP at that step. Note: If you select this option, the Completion Policy field (see below) will be set to &quot;Single,&quot; and the Assignment Policy field for the following step must be set to &quot;Preassigned.&quot;</td>
</tr>
<tr>
<td>Assignees</td>
<td><strong>Assignment Policy</strong> For <strong>User Select</strong> (default), the individual who creates a record (such as an invoice) from this workflow instance can choose the users to assign to this task from the list of assignees for this step. For <strong>Preassigned</strong>, every user on the assignee list is automatically assigned to the step when the record is created. Select the users to assign to this step. These users will receive task notifications, instructing them to take action at this step. When you click the <strong>Select</strong> button, you can choose one of these options: <strong>User Picker</strong>: Unifier displays the User/Group Picker window. Choose one or more users or groups to add as assignees. <strong>Dynamic</strong>: Choose a step in the workflow from the Select Step pop-up window. The assignees from that step become the assignees used on this step. You cannot choose <strong>Dynamic</strong> when adding assignees to the first step (Creation) in the workflow. You can constrain the list of assignees for this step by selecting the Additional conditions to filter assignees check box. To constrain the list of assignees, you need to create a query to filter the assignees using criteria you specify. To do this, click the Define button and specify a field comparison. For information on creating this type of query, see About Queries.</td>
</tr>
<tr>
<td>Allow Cc</td>
<td>Allows assignees to add cc users who will receive a view-only copy of the BP record. Choose one of the options: <strong>No</strong>: Does not allow sending copies to other users.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Yes:</strong></td>
<td>Click <strong>Select</strong> to create the list of users or groups from whom the BP users can choose to Cc. (This option also activates the Allow Add Cc functionality.)</td>
</tr>
<tr>
<td><strong>Preassigned:</strong></td>
<td>Click <strong>Select</strong> to choose the users who will be automatically cc’d. No other users can be copied.</td>
</tr>
<tr>
<td><strong>Preassigned and Allow Add Cc:</strong></td>
<td>Click <strong>Select</strong> to choose the users who will be automatically cc’d. The Allow Add Cc option is set to Yes. Note: You cannot allow Ccs on the Create step.</td>
</tr>
<tr>
<td><strong>Allow Add Assignees</strong></td>
<td>Allows assignees to add additional assignees in addition to those defined in the Assignees field to the current step. Assignees can add the additional assignees before accepting the task. This is done by clicking the <strong>Edit</strong> menu and choosing <strong>Add Assignees to Current Step</strong>. For example, user A has been sent a BP for review. User A wishes to add user B as an assignee to the review step as well. Before clicking Accept Task, user A chooses Edit &gt; Add Assignees to Current Step and adds user B. User B is notified (depending on e-mail preferences) of the new task. Both user A and user B can accept the task and participate in the review step of the workflow. Note: You cannot add assignees on the Create step.</td>
</tr>
</tbody>
</table>
| **Allow Add Cc** | This option has two functions: 1. When the Allow Cc field is set to Preassigned and Allow Add Cc, this option is set to Yes automatically. It enables BP users at runtime to copy additional users on a BP step that already has a preassigned cc user. This is done on the action form of the BP during the regular workflow step by selecting the Cc button. Click **Select** and choose the users/ or groups that can be copied. 2. This option becomes available (choose Yes or No) if Allow Cc is set to Yes. Similar to Allow Add Assignees, this option allows assignees to send a copy of the current step of the BP to additional users in addition to those defined in the Add Cc field. Assignees can add the additional cc users before accepting the task. This is done by clicking the **Edit** menu and choosing **Copy Users to Current Step**. For example, user A has been sent a BP for review. User A wishes to add user B as an assignee to the review step as well. Before clicking Accept Task, user A chooses Edit > Add Assignees to Current Step and adds user B. User B is notified (depending on e-mail preferences) of the new task. User A can accept the task and participate in the review step of the workflow. User B can review the
| Step Editors | view-only copy.  
Note: You cannot add Ccs on the Create step. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Optionally, you can define one or more editors per each defined step in the business process workflow setup. Editors are users who can edit the business process without being granted explicit record-level permission or as assignees of the step. This allows users other than the assignee to edit the business process record. If you are an Editor on a business process step, you can open and edit any record on the step.</td>
</tr>
</tbody>
</table>
|              | Editors can be added on these BP types:  
- Line Item  
- Cost (all types, including Lease and Line Item with Multiple Codes)  
- Document  
- Simple  
- RFB  
- Text |
The Editor functionality has these attributes:

- The user who is designated as an editor must have a minimum of View User Records to the BP log in question.
- All edits are done through the BP Log.
- Editors cannot edit a workflow record until the task assignee accepts the task, and saves the draft.
- Editors cannot be defined on the creation step of a business process.
- Editors can be defined on the end step.
- Editors can be defined on a workflow step only if the Completion Policy is Single. (Unifier will generate an error if Completion Policy is set to All Majority or Consensus.)
- Editor on a task receive notification each time a draft is created.
- If multiple editors and the assignee are editing the business process record draft, the data saved by the last update will overwrite all previous updates.
- Edits performed on the End step of a workflow business process affect the record directly, as no draft exists.
- Edits that occur on the end step are captured in the audit listing the editor who performed the edit.
- Edits performed by record editors appear in the Audit log.

Note: You cannot assign editors on the Create step.

<table>
<thead>
<tr>
<th>Discussion Group</th>
<th>Specify assignees for discussion groups on the BP. Note: You cannot assign discussion groups on the Create step.</th>
</tr>
</thead>
</table>

| Step Revisiting | If a step is rejected and sent back for clarification or editing, this option determines to whom the BP can be sent back (which assignees will be available for selection):

**Include only previous action takers:** Only the assignee users who were selected when the workflow moved into that step originally are eligible to be reselected.

**Include all step assignees:** All assignee users are eligible to be selected.

Note: You cannot specify step revisiting on the Create step. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Policy</strong></td>
<td>Completion Policy</td>
</tr>
<tr>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td><strong>Choose one of the following:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Single:</strong> If any assignee completes the task, no matter which action is taken, the record moves forward to the next step.</td>
<td></td>
</tr>
<tr>
<td><strong>All-Majority:</strong> All assignees are required to respond. If there is no clear majority, Unifier uses the resolving action to determine what path through the workflow to take.</td>
<td></td>
</tr>
<tr>
<td><strong>All-Consensus:</strong> All assignees are required to respond. If there is no consensus (all must agree on the action), Unifier uses the resolving action to determine what path through the workflow to take.</td>
<td></td>
</tr>
<tr>
<td>Note: You cannot assign a completion policy on the Create step.</td>
<td></td>
</tr>
</tbody>
</table>

| **Resolving Action** | This moves the step to either a following step, a previous step, or a conditional step that essentially "re-addresses" the task. This step must be completed before the workflow can continue. The assignees on this resolving action step can include the original task assignees and can also include new assignees. |
| Note: You cannot assign a resolving action on the Create step. |

| **Overdue Policy** | You can choose to send late notifications to all assignees if the step passes its duration. |
| Note: You cannot assign an overdue policy on the Create step. |

| **Comments** | You may select either of these options regarding commenting. These refer to the general comments on BP forms, as well as comments regarding individual file attachments on document-type BPs. |
| **Allow hiding of comments:** Allows users to hide comments. The comments will remain as part of the record, and administrators and others with permissions can view the comments, which are not visible to others without the view permission. |
| **Allow deletion of comments:** Allows users with permission to delete comments previously added to the BP record. |
| **Allow cc users to add general comments:** Allows users copied on a step to add general comments without accepting the task. Not available on the end step. |
Note: You cannot include comments on the Create step. Note: Task assignees can also add general comments without accepting the task if they have been given the **Add General Comments** permission on the business process. With this permission, they can add a general comment to any BP record they can view (workflow or non-workflow), regardless of the workflow step (including the End step), and regardless of the assignee or Cc settings. For more information on this permission, see the Permissions chapter in the *Primavera Unifier Reference Guide*.

<table>
<thead>
<tr>
<th>Email Notification</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email Response: Enable response via email</strong></td>
<td>By default, this checkbox is unchecked. When enabled, this allows users who receive e-mail that is sent out when a workflow reaches the current step to respond and take actions in Unifier via e-mail. The checkbox appears on all workflow steps other than the creation step. The e-mail that the user receives includes hyperlinks to workflow actions. Note: You cannot enable email response on the Create step. Note: To enable the attachment of files to e-mail responses to workflow actions, this option must be selected as well as the Add Attachments option on the Options tab in the Action Form design in Primavera uDesigner.</td>
</tr>
<tr>
<td><strong>Email Attachments:</strong></td>
<td>Select to specify the content and format of e-mail attachments. You can include business process record and line item attachments, as well as business process record information. Also, you can override the attachment format set in the General tab if necessary. Note: You cannot enable email attachments on the Create step.</td>
</tr>
<tr>
<td>Include both record and line item attachments</td>
<td></td>
</tr>
<tr>
<td>Include record information as attachment</td>
<td></td>
</tr>
</tbody>
</table>

| Override default format | If you have specified a default record format on the General tab, you can use this check box to override the default format. For example, you can use the General tab to specify that the default record format for both email notifications and records saved in the Document Manager be in PDF format. If necessary, you could then use the Override default format check box to override the format and choose Custom for the notification only. |
| Email Content | You can add additional information that will be sent out as part of task notification. Note: You cannot add additional information on the |
Create step.

<table>
<thead>
<tr>
<th>Cash Flow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Template</td>
</tr>
<tr>
<td>This option only appears in WBS code-based Base Commit business processes. It allows you to enable the auto-creation of a commitment-level cash flow curve at runtime for the business process record. The curve is based on the selected commitment-level cash flow template, and is created upon being sent from the step. Click Add and choose a template.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Record information to Document Manager</td>
</tr>
<tr>
<td>Select this check box if the record information (including BP comments and attachments) should be automatically saved at this step in the Document Manager.</td>
</tr>
</tbody>
</table>

### Setting Up PCC (Users)

Set up the following preferences in Unifier before working with PCC:

- Password
- Time zone
- Date format
- Default viewer
- File transfer option
- Default sign-in view
- Email subscriptions

For details, refer to the *Primavera Unifier User's Guide*. 

200
PCC Business Processes

Business processes (BPs) that are included in PCC are designed to work together in supportive ways. For example, a Vendor Prequal Requests record will auto-create a Vendors record when the Vendor Prequal Requests record reaches Approved status. This relationship avoids duplicate data entry efforts, minimizes record errors, and ensures that contracts and purchase orders use approved vendors.

The following shows the relationship between the PCC BPs:

**Vendor-related BPs:**
- Vendor Prequal Request
- Vendors
- Vendors Evaluations

**Budget-related BPs:**
- Budget Approvals
- Budget Changes
- Budget Transfers

**Procurement-related BPs:**
- Commitment BPs that use a Payment Application SOV:
  - Contracts
  - Potential Change Orders
  - Contract Change Orders
  - Payment Applications
- Commitment BPs that use a General Spends SOV:
  - Purchase Orders
  - PO Amendments
  - Invoices

The following is a list of all PCC BPs:
- Blanket Purchase Orders
- Budget Approvals
- Budget Changes
- Budget Transfers
- Change Orders
- Contracts
- Estimates
- Fund Appropriations
- Invoices
- Journal Entries
- New User Requests
- Payment Applications
Payments
PO Amendments
Potential Change Orders
Purchase Orders
Requests for Bid
Requests for Substitution
Risks & Issues
Timesheets
Vendors
Vendors Evaluations
Vendor Prequal Requests
Work Releases

Each business process is explained in the proceeding sections. For more details about BPs, refer to the *Primavera Unifier User's Guide*.

**In This Section**

Blanket Purchase Orders (BPO) Business Process................................................. 203
Budget Approvals Business Process.................................................................... 209
Budget Changes Business Process........................................................................ 217
Budget Transfers Business Process........................................................................ 225
Change Orders Business Process.......................................................................... 233
Contracts Business Process.................................................................................. 243
Estimates Business Process................................................................................... 253
Fund Appropriations Business Process................................................................. 257
Invoices Business Process........................................................................................ 265
Journal Entries Business Process .......................................................................... 275
New User Requests Business Process................................................................. 283
Payment Applications Business Process............................................................... 289
Payments Business Process.................................................................................... 301
PO Amendments Business Process........................................................................ 307
Potential Change Orders Business Process............................................................ 317
Purchase Orders Business Process........................................................................... 325
Requests for Bid Business Process......................................................................... 335
Requests for Substitution Business Process.......................................................... 349
Risks & Issues Business Process............................................................................ 357
Timesheets Business Process.................................................................................. 363
Vendor Prequal Requests Business Process........................................................... 371
Vendors Business Process....................................................................................... 379
Vendors Evaluations Business Process................................................................. 385
Work Releases Business Process.............................................................................. 393
Blanket Purchase Orders (BPO) Business Process

**Purpose**
Depending on your business model, you may want to use a Blanket Purchase Order and create an umbrella agreement with a vendor who will provide services across multiple projects. You can have one vendor per Blanket Purchase Order. The Blanket Purchase Order is released on a per-project-period basis; work authorizations are billed against a set maximum cost amount.

**Business process characteristics**
The Blanket Purchase Order is a non-workflow, company-level, cost-type business process. Each Blanket Purchase Order refers to one Vendor. You can create more than one Blanket Purchase Order for your company. The item logs section of the Blanket Purchase Orders (BPO) record displays a query tab, Work Releases. An individual help file is available for this business process.

**Groups associated with this business process**
Members of the **Company Administrators** group can create and edit this business process.

**Statuses**
Pending or Approved, neither of which are terminal statuses.

**Additional Information**
- You can add and remove attachments to this business process. You can add, remove, or copy line items, as well as add attachments to line items.
- Enabled for integration.
- Enabled for publish path.
  Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

**Benefits**
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

**Location**
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**Creating a Blanket Purchase Order Record**

1) Navigate to the **Company Workspace** tab, **Company Logs > Blanket Purchase Orders**. The Blanket Purchase Order log opens.

2) In the toolbar click **New** and select **Blanket Purchase Orders** from the drop-down menu. A new Blanket Purchase Orders form opens.

3) Complete the **Upper form** according to the **Upper form table** below. You must enter a value in all required fields before you can save the form or add line items. See **Adding Line Items** (on page 205)

**Upper Form**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates the first time you save the form.</td>
</tr>
<tr>
<td>Title</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Record Last Update</td>
<td>This is a read-only field that Unifier populates when you save a record.</td>
</tr>
<tr>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you initially saved the form and it became a record.</td>
</tr>
<tr>
<td>Status</td>
<td>This is a required field - Select the status of the record - Pending or Approved - neither of which is a terminal status.</td>
</tr>
<tr>
<td><strong>Summary block</strong></td>
<td></td>
</tr>
<tr>
<td>Contract Number</td>
<td>Enter the contract number.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items.</td>
</tr>
<tr>
<td>Contract Type</td>
<td>Select the contract type from the drop-down menu.</td>
</tr>
<tr>
<td><strong>Vendor Details block</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>This is a required field - Click Select and choose a Vendor from the Vendors log. You can only pick one vendor. This selection becomes the vendor reference.</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>This field is auto-populated with the vendor selection. It is an editable field in which you may change the vendor name. Changing the vendor name does not change the vendor reference.</td>
</tr>
<tr>
<td>Address 1</td>
<td>Enter the vendor's address.</td>
</tr>
<tr>
<td>Address 2</td>
<td>Use this field as needed.</td>
</tr>
<tr>
<td>Address 3</td>
<td>Use this field as needed.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the vendor's city.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Select the vendor's state or province.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the vendor's zip or postal code.</td>
</tr>
<tr>
<td>Country</td>
<td>Select the vendor's country</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>Enter the name of the vendor contact.</td>
</tr>
<tr>
<td>Email</td>
<td>Enter the vendor contact's email.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the vendor contact's phone number.</td>
</tr>
<tr>
<td>Fax</td>
<td>Enter the vendor contact's fax number.</td>
</tr>
<tr>
<td><strong>Description block</strong></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Enter up to 4000 characters in this text box.</td>
</tr>
</tbody>
</table>

**Item Logs**

**Line Items Tab**
Provides general information about the record.

**Work Releases Tab**
Use to create a new record as well as view, copy, or find existing records.

**Adding Line Items**
1) In the Line Items section click Add or Grid. The Line Item form opens.
2) Complete the Line Item form according to the Line Item table below. You must complete all required fields on each line that you entered before you can save the Line Item.

3) Click **OK** (if using the Line Item form), or **Save** (if using the grid) to save the form. The Line Items form closes.

   If you are using the grid and do not click Save before closing it, you will lose your line item changes.

### Line Item Table

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab Name</td>
<td>You can enter a name for the tab.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter a title for the line item.</td>
</tr>
<tr>
<td>Short Description</td>
<td>This is a required field - Enter a brief description of the item specified on the line item</td>
</tr>
<tr>
<td>Item Quantity</td>
<td>This is a required field - Enter the number of items specified on the line item</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Select the Unit of Measure for the item specified on the line item</td>
</tr>
<tr>
<td>Item Unit Cost</td>
<td>This is a required field - Enter the price of the item specified on the line item</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field (Item Quantity X Item Unit Cost)</td>
</tr>
</tbody>
</table>

### Saving the BPO Record

- **To save the Blanket Purchase Order**

  Click either:

  - **Finish Editing** to save the form in read-only mode.
    - You can return the record to Edit mode by clicking **Edit** on the Blanket Purchase Order record tool bar.
  - **Save** to leave the form in edit mode.

### Viewing the Blanket Purchase Order Record Summary Sheet

The Blanket Purchase Order record contains a Summary Sheet. This sheet shows line items and the line item's original amount. It also shows what has been allocated to projects. You should then be able to drill in to see what has been assigned to individual projects.

This should also show what has been allocated to projects. You should then be able to drill in to see what has been assigned to individual projects.
To access the Blanket PO Sheet
1) Complete all required fields in the Upper form.
2) Add line items.
3) Click Finish Editing.
4) Close the record.
5) The next time you open the record click the Summary Sheet button in the record tool bar. The Blanket PO Sheet opens.
6) Line items and their original amounts appear in the sheet.
Purpose
Use this business process to approve and assign budget to a project; project data is broken down by cost codes. You must assign budget to a cost code before you can write a contract against that cost code.

Business process characteristics
This is a project-level, Cost-type business process with line items and workflow. An individual help file is available for this business process.

Record Statuses
- Pending, a non-terminal status.
- Approved, a terminal status
- Rejected, a terminal status.
- Canceled, a terminal status.

Groups associated with this business process
- Creators create the Budget Approval business process and send it for approval.
- Members of the Reviewers group can approve the business process 'as is,' send it to the Revision step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the budget.
- Members of the All Project Users group can be copied on this business process.

Additional Information
- Step completion policy and resolving actions can differ between steps.
- Enabled for mobile devices.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section

- Budget Approvals Workflow ................................................................. 210
- Creating a Budget Approvals Record .................................................... 211
- Routing a Budget Approvals Record from the Approval Step .................. 213
- Routing a Budget Approvals Record from the Revision Step ................... 214
- Viewing a Budget Approvals Record on the End Step ......................... 215

Budget Approvals Workflow

Below are the four steps of the Budget Approvals workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Budget Approval" then the record moves to the End step with a record status of "Canceled." For all steps, except the **End** step, sending a record to the next step creates a task for the record recipient.
Creating a Budget Approvals Record

- **To create a Budget Approvals record**

1) Navigate to the **All Projects** tab and select your project from the Projects log near the bottom of the landing page.

2) Double-click your project to open it.

3) On your project landing page, navigate to the **Collaboration > Tasks** log

4) Click **New** in the **Tasks** log.

5) Select **Budget Approvals** from the drop-down menu. The **Create New Budget Approvals** form opens.

6) Complete, at minimum, the required fields according to the Upper form table below. You can save the form as a draft at any time. Unifier stores the draft in the **Collaboration > Drafts** folder.

7) In the **Line Items** section click **Add** or **Grid**. The Line Items form opens.

8) Complete the Line Items form according to the Line Items table below. You must complete all required fields on each line that you entered before you can save the Line Items form.

9) Click **OK** (if using the Line Item form), or **Save** (if using the grid) to save the form. The Line Items form closes.

   If you are using the grid and do not click Save before closing it, you will lose your line item changes.

   Unifier automatically calculates the aggregate value of the line items and displays the amount in the Budget Information block, **Amount** field and in the Line Items section **Total Amount** field.

10) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This action activates **Action Details**.

11) In **Action Details**, select who should receive the record.

   a. Click **To**... The **User/Groups** picker opens and displays a list of available task recipients.

   b. Select the user or group who will receive the task on the **Approval** step.

   c. Click **Add**.

   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipient's **Collaboration > Tasks** log.

   e. (Optional) Click **Cc**... and follow steps a - d. The record will appear in the recipient's **Collaboration > Messages** log.

12) Click **Send** to route the record to the **Approval** step. Unifier displays a message stating that the record has been submitted successfully.

---

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
</tbody>
</table>
### In this field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person who created the record. The field appears as a link to the record creator’s contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates with the record creation date.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>Contract Reference</td>
<td>This in not a required field - Enter a contract reference.</td>
</tr>
</tbody>
</table>

**Budget Information block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>This value is auto-populated from the aggregate value of line items.</td>
</tr>
</tbody>
</table>

**Description block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This in not a required field - Enter a description of the budget change.</td>
</tr>
</tbody>
</table>

### Item Logs

**Line Items Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Cost Code</em></td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
<tr>
<td>Code Name</td>
<td>This read-only field is auto-populated from the cost code name.</td>
</tr>
<tr>
<td><em>Short Description</em></td>
<td>This is a required field - Enter a brief description of the item specified on the line item</td>
</tr>
<tr>
<td>Description</td>
<td>This in not a required field - Enter a description for the line item.</td>
</tr>
</tbody>
</table>

**Budget Details Block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spend Category</td>
<td>Select the category from the drop-down menu.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work Package</td>
<td>You can select a Work Package.</td>
</tr>
<tr>
<td>Item Quantity*</td>
<td>This is a required field - Enter the number of items specified on the line item</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Select the Unit of Measure for the item specified on the line item</td>
</tr>
<tr>
<td>Item Unit Cost*</td>
<td>This is a required field - Enter the price of the item specified on the line item</td>
</tr>
<tr>
<td>Amount</td>
<td>This read-only field is auto-calculated using the formula Item Quantity X Item Unit Cost.</td>
</tr>
</tbody>
</table>

**Routing a Budget Approvals Record from the Approval Step**

*To route a Budget Approvals record from the Approval step*

1) Navigate to the **All Projects** tab and select your project from the list located near the bottom of the landing page.

2) Double-click your project to open it.

3) On your project landing page, navigate to the **Collaboration** > **Tasks** log

4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in red are late.

5) Double click on the **Budget Approvals** task, as shown in the Tasks log **Type** column. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.

6) When ready, click **Accept Task**. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions** > **Undo Accept Task**.

7) Review the Budget Approvals record and determine the appropriate course of action. You cannot make changes to the record on the Approval step.

8) In the toolbar at the top right of the form, click the **Workflow Actions** drop-down menu. The choices are:
   - **Approve Budget Approval** — this selection will send the record to the End step in **Approved** status.
   - **Send for Revision** — this action keeps the workflow in flight and in **Pending** status.
     a. In the **Action Details** section **To...** is preassigned, but you can select message recipients in the **Cc** field.
b. Click Cc... Select the user or group who will receive the record on the next step.
c. Click Add.
d. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   ‣ Reject PCO — this selection will send the record to the End step in Rejected status.

9) (Optional) Add comments to the record through General Comments or Task Notes.
   ▪ To add General Comments click the link at the bottom center of the form. These comments are permanent.
   ▪ To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.

10) Click Send to route the record to the next step, either Revision or End.

Routing a Budget Approvals Record from the Revision Step
Upon sending the business process form forward to the Revision step, Unifier sends a task to the record creator and a message to those selected in the Cc field. You can see your active tasks in your Tasks log. When your task is complete, you can select one of two Workflow Action options, as described on step 8.

   ‣ To route a Budget Approvals record from the Revision step
1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Unifier shows tasks that you have not yet accepted in bold.
4) In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
5) Click the Accept Task button. The form dynamically changes to an Action Form with most fields editable. You can revise:
   ‣ Title
   ‣ Contract Reference
   ‣ Description
   ‣ Line Items
6) In the Line Items section you can Modify/Add/Delete Line Items as needed. You must complete all required fields on each line before you can save the Line Items form.
7) Click OK to save the Line Items.
8) When ready, select a workflow action. The choices are:
Resubmit for Approval — This action sends the record back to the Approval step in Pending status.
   a. Click To... The User/Groups picker opens and displays a list of available task recipients.
   b. Select the user or group who will receive the task when the record returns to the Approval step.
   c. Click Add.
   d. Click OK. The User/Group picker closes and the selection appears in the To field.
   e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
   f. Click Add.
   g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient’s Collaboration > Messages log.

Cancel Budget Approval — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.

This action activates Action Details.

9) In Action Details, select who should receive the task and who should receive a copy of the record in Collaboration > Messages.

10) When ready, click Send.

Viewing a Budget Approvals Record on the End Step

This is the last step in the workflow. You cannot take action on this step. All form fields are read-only and the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.

To view a Budget Approvals record on the End step

1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.

2) Navigate to Cost Controls > Budget Approvals. The Budget Approval log opens.

3) Double-click a record to open it. In the business process you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."

4) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record’s progress through the workflow.

5) Click View Graphic to see an image of the workflow.
Budget Changes Business Process

Purpose

Use this business process to request a budget increase or reduction after establishing the original budget.

Business process characteristics

This is a project-level, Cost-type business process with line items and workflow. An individual help file is available for this business process.

Record Statuses

- Pending, a non-terminal status
- Approved, a terminal status
- Rejected, a terminal status
- Canceled, a terminal status

Groups associated with this business process

- Members of the Creators group can create the Budget Changes business process and send it for approval.
- Members of the Reviewers group can approve the business process 'as is,' send it to the Revision step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the budget.
- Members of the All Project Users group can be copied on this business process.

Additional Information

- Enabled for mobile devices.
- Step completion policy and resolving actions can differ between steps.
- Allows association of a budget change with a specific contract.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits

In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**Budget Changes Workflow**

Below are the four steps of the Budget Changes workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Budget Changes" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the record recipient.

**Creating a Budget Changes Record**

- **To create a Budget Changes record**
  1. Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the **Collaboration > Tasks** log.
4) Click **New** in the **Tasks** log.
5) Select **Budget Changes** from the drop-down menu. The **Create New Budget Changes** form opens.
6) Complete, at minimum, the required fields according to the Upper form table below. You can save the form as a draft at any time. Unifier stores the draft in the **Collaboration > Drafts** folder.
7) In the **Line Items** section click **Add** or **Grid**. The Line Items form opens.
8) Complete the Line Items form according to the Line Items table below. You must complete all required fields on each line that you entered before you can save the Line Items form.
9) Click **OK** to save the Line Items.
   Unifier automatically calculates the aggregate value of the line items and displays the amount in **Total Amount** at the bottom of the record.
10) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This action activates **Action Details**.
11) In **Action Details**, select who should receive the record.
   a. Click **To**... The **User/Groups** picker opens and displays a list of available task recipients.
   b. Select the user or group who will receive the task on the **Approval** step.
   c. Click **Add**.
   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipient's **Collaboration > Tasks** log.
   e. (Optional) Click **Cc**... and follow steps a - d. The record will appear in the recipient's **Collaboration > Messages** log.
12) Click **Send** to route the record to the **Approval** step. Unifier displays a message stating that the record has been submitted successfully.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person who created the record. The field appears as a link to the creator’s contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates with the record creation date.</td>
</tr>
</tbody>
</table>
### In this field | Do this
---|---
**Due Date** | This is a read-only field. Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record title in bold red.

**Status** | This read-only field is blank. The status will change when the task is accepted on the next step in the workflow.

**Contract Reference** | This is not a required field - Enter a contract reference.

#### Budget Information block

**Type of Change**

**A. Original Budget** | This value comes from the project cost sheet.

**B. Prior Changes** | This value comes from the project cost sheet.

**C. Pending Changes** | This value comes from the project cost sheet.

**D. Current Request** | This value comes from the Budget Changes record.

**E. Total Budget (A+B+C+D)** | This read-only field is auto-calculated based on the formula (A. Original Budget + B. Prior Changes + C. Pending Changes + D. Current Request)

#### Description block

**Description** | This is not a required field - Enter a description of the budget change.

---

#### Item Logs

**Line Items Tab**

| In this field | Do this |
---|---|
**General Block**

**Cost Code*** | This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker. |

**Code Name** | This read-only field is auto-populated from the cost code name. |

**Short Description*** | This is a required field - Enter a brief description of the item specified on the line item |

**Description** | This is not a required field - Enter a description for the line item. |

**Budget Details Block**

**Spend Category** | Select the category from the drop-down menu. |
Primavera Cost Controls (PCC)

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Package</td>
<td>You can select a Work Package.</td>
</tr>
<tr>
<td>Item Quantity*</td>
<td>This is a required field - Enter the number of items specified on the line item</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Select the Unit of Measure for the item specified on the line item</td>
</tr>
<tr>
<td>Item Unit Cost*</td>
<td>This is a required field - Enter the price of the item specified on the line item</td>
</tr>
<tr>
<td>Amount</td>
<td>This read-only field is auto-calculated using the formula Item Quantity Quantity X Item Unit Cost.</td>
</tr>
</tbody>
</table>

Routing a Budget Changes Record from the Approval Step

To route a Budget Changes record from the Approval step

1) Navigate to the All Projects tab and select your project from the Projects log, located near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log
4) The Tasks log lists all of your open tasks. Tasks in bold are new; tasks in red are late.
5) Double click on the Budget Changes task. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.
6) When ready, click Accept Task. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add Task Notes for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.
7) Review the Budget Changes record and determine the appropriate course of action.
8) In the toolbar at the top right of the form, click the Workflow Actions drop-down menu. The choices are:
   - Approve Budget Change — this selection will send the record to the End step in Approved status.
   - Send for Revision — this action keeps the workflow in flight and in Pending status.
     a. In the Action Details section To... is preassigned, but you can select message recipients in the Cc field.
     b. Click Cc... Select the user or group who will receive the record on the next step.
c. Click **Add**.
d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.
   - **Reject PCO** — this selection will send the record to the End step in **Rejected** status.

9) (Optional) Add comments to the record through **General Comments** or **Task Notes**.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.

10) Click **Send** to route the record to the next step.

---

**Routing a Budget Changes Record from the Revision Step**

Upon sending the business process form forward to the Revision step, Unifier sends a task to the assignee. You can see your active tasks in your **Tasks log**. When your task is complete, you can select one of two Workflow Action options, as described on step 8.

- **To route a Budget Changes record from the Revision step**

1) Navigate to the **All Projects** tab and select your project from the Projects log near the bottom of the landing page.

2) Double-click your project to open it.

3) On your project landing page, navigate to the **Collaboration > Tasks** log. The **Tasks log** opens. Unifier shows the tasks that you have not yet accepted in bold.

4) In the **Tasks log**, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   
   The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.
   
   The **Task Status** link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

5) Click the **Accept Task** button. The form dynamically changes to an Action Form where you can revise:
   - **Title**
   - **Contract Reference**
   - **Type of Change**
   - **Description**

6) In the **Line Items** section you can Modify/Add/Delete Line Items as needed. You must complete all required fields on each line before you can save the Line Items form.

7) Click **OK** to save the Line Items.

8) When ready, select a workflow action. The choices are:
   - **Resubmit for Approval** — This action sends the record back to the Approval step in Pending status.
     
     a. Click **To...** The **User/Groups** picker opens and displays a list of available task recipients.
b. Select the user or group who will receive the task when the record returns to the Approval step.

c. Click Add.

d. Click OK. The User/Group picker closes and the selection appears in the To field.

e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.

f. Click Add.

g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.

   - **Cancel Budget Change** — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.

   This action activates **Action Details**.

9) In **Action Details**, select who should receive the task and who should receive a copy of the record in **Collaboration > Messages**.

10) When ready, click **Send**.

---

**Viewing a Budget Changes Record on the End Step**

This is the last step in the workflow. You cannot take action on this step. All form fields are read-only and the record is in a terminal status: Approved, Rejected, or Canceled. Once on the **End** step the record is viewable only in the business process log.

- **To view a Budget Changes record on the End step**

1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.

2) Navigate to **Cost Controls > Budget Changes**. The Budget Changes log opens.

3) Double-click a record to open it. In the business process you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."

4) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record’s progress through the workflow.

5) Click **View Graphic** to see an image of the workflow.
Budget Transfers Business Process

Purpose
Use this business process to transfer budget from one cost code to another. Most typically used to release budget contingency to other cost items.

Business process characteristics
This is a project-level, Cost-type business process with line items and workflow. An individual help file is available for this business process.

Record Statuses
- Pending, a non-terminal status
- Approved, a terminal status
- Rejected, a terminal status
- Canceled, a terminal status

Groups associated with this business process
- Members of the Creators group can create the Budget Transfers business process and send it for approval.
- Members of the Reviewers group can approve the business process 'as is,' send it to the Revision step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the budget transfer.
- Members of the All Project Users group can be copied on this business process.

Relationships associated with this business process
The Creation form includes a Contract business process picker that allows you to associate this budget transfer with a specific contract.

Additional Information
- Enabled for mobile devices.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.
Location

To view the published file attachments of a project-level business process record: In a project’s Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section

Budget Transfers Workflow ................................................................................... 226
Creating a Budget Transfers Record ..................................................................... 226
Routing a Budget Transfers Record from the Approval Step ................................. 229
Routing a Budget Transfers Record from the Revision Step ................................. 230
Viewing a Budget Transfers Record on the End Step ........................................... 231

Budget Transfers Workflow

Below are the four steps of the Budget Transfers workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Budget Changes" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the record recipient.

Creating a Budget Transfers Record

To create a Budget Transfers record

1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the **Collaboration > Tasks** log
4) Click **New** in the **Tasks** log.
5) Select **Budget Transfers** from the drop-down menu. The **Create New Budget Transfers** form opens.
6) Complete, at minimum, the required fields according to the Upper form table below. You can save the form as a draft at any time. Unifier stores the draft in the **Collaboration > Drafts** folder.
7) In the **Line Items** section click **Add** or **Grid**. The Line Items form opens
8) Complete the Line Items form according to the Line Items table below. You must complete all required fields on each line that you entered before you can save the Line Items form.

In this step you are transferring budget from a source cost code to at least one destination cost code, so you need at least two entries. Total Amount of Line Items must equal zero or you will not be able to send the record to the next step.

9) Click **OK** (if using the Line Item form), or **Save** (if using the grid) to save the form. The Line Items form closes.
   If you are using the grid and do not click **Save** before closing it, you will lose your line item changes.
   Unifier automatically calculates the aggregate value of the line items and displays the amount in **Total Amount** at the bottom of the record.
10) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This action activates **Action Details**.
11) In **Action Details**, select who should receive the record.
   a. Click **To...** The **User/Groups** picker opens and displays a list of available task recipients.
   b. Select the user or group who will receive the task on the **Approval** step.
   c. Click **Add**.
   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipient's **Collaboration > Tasks** log.
   e. (Optional) Click **Cc...** and follow steps a - d. The record will appear in the recipient's **Collaboration > Messages** log.
12) Click **Send** to route the record to the **Approval** step. Unifier displays a message stating that the record has been submitted successfully.
### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Amount</td>
<td>This value is auto-calculated from line item entries.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person who created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates with the record creation date.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>Contract Reference</td>
<td>This is not a required field - Enter a contract reference.</td>
</tr>
</tbody>
</table>

#### Budget Information block

**Type of Change**

- **A. Original Budget**
  - This value comes from the project cost sheet.
- **B. Prior Changes**
  - This value comes from the project cost sheet.
- **C. Total Budget (A+B)**
  - This value is auto-calculated.

#### Description block

**Description**

This is not a required field - Enter a description of the budget change.

### Item Logs

#### Line Items Tab

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Block</strong></td>
<td></td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
<tr>
<td>Code Name</td>
<td>This read-only field is auto-populated from the cost code name.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item</td>
</tr>
<tr>
<td>Description</td>
<td>This is not a required field - Enter a description for the line item.</td>
</tr>
<tr>
<td>Cost Type</td>
<td>This read-only field is auto-populated from the cost code attributes.</td>
</tr>
</tbody>
</table>

**Budget Details Block**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Spend Category</td>
<td>Select the category from the drop-down menu.</td>
</tr>
<tr>
<td>Work Package</td>
<td>You can select a Work Package.</td>
</tr>
<tr>
<td>Item Quantity*</td>
<td>This is a required field - Enter the number of items specified on the line item</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Select the Unit of Measure for the item specified on the line item</td>
</tr>
<tr>
<td>Item Unit Cost*</td>
<td>This is a required field - Enter the price of the item specified on the line item</td>
</tr>
<tr>
<td>Amount</td>
<td>This read-only field is auto-calculated using the formula Item Quantity X Item Unit Cost.</td>
</tr>
</tbody>
</table>

**Routing a Budget Transfers Record from the Approval Step**

- To route a Budget Transfers record from the Approval step
  1) Navigate to the All Projects tab and select your project from the Projects log, located near the bottom of the landing page.
  2) Double-click your project to open it.
  3) On your project landing page, navigate to the Collaboration > Tasks log
  4) The Tasks log lists all of your open tasks. Tasks in bold are new; tasks in red are late.
  5) Double click on the Budget Transfers task. The view-only form displays all fields on the record.
     - The Upper Form contains project information, including the record number and title.
     - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.
6) In the toolbar at the top left of the form, click **Accept Task**. The View form dynamically changes to an Action form where you can make changes to the budget transfer line items.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.
7) Review the Budget Transfers record and determine the appropriate course of action.
8) In the toolbar at the top right of the form, click the **Workflow Actions** drop-down menu. The choices are:
   - **Approve Budget Transfer** — this selection will send the record to the End step in Approved status.
   - **Send for Revision** — this action keeps the workflow in flight and in Pending status.
     a. In the **Action Details** section **To**... is preassigned, but you can select message recipients in the **Cc** field.
     b. Click **Cc**... Select the user or group who will receive the record on the next step.
     c. Click **Add**.
     d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.
   - **Reject Budget Transfer** — this selection will send the record to the End step in Rejected status.
9) (Optional) Add comments to the record through **General Comments** or **Task Notes**.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.
10) Click **Send**.

**Routing a Budget Transfers Record from the Revision Step**
Upon sending the business process form forward to the **Revision** step, Unifier sends a task to the record creator and a message to those selected in the **Cc** field. You can see your active tasks in your **Tasks** log.

- **To route a Budget Transfers record from the Revision step**
  1) Navigate to the **All Projects** tab and select your project from the Projects log near the bottom of the landing page.
  2) Double-click your project to open it.
  3) On your project landing page, navigate to the **Collaboration > Tasks** log. The Tasks log opens. Unifier shows the tasks that you have not yet accepted in bold.
  4) In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
     The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.
The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

5) Click the Accept Task button. The form dynamically changes to an Action Form where you can revise:
   - Title
   - Contract Reference
   - Description
   - Line Items (Total Amount, additions and reductions, must equal zero)

In the Line Items section you can Modify/Add/Delete Line Items as needed. See the Line Item Table in Creating a Budget Transfers Record (on page 226)

6) Click OK to save the Line Items.

7) When ready, select a workflow action. The choices are:
   - Resubmit for Approval — This action sends the record back to the Approval step in Pending status.
     a. Click To... The User/Groups picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the Approval step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the To field.
     e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
     f. Click Add.
     g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - Cancel Budget Transfer — This action sends the record to the End step in Canceled status. The To field is unavailable but you can add a Cc.
     - This action activates Action Details.

8) In Action Details, select who should receive the task and who should receive a copy of the record in Collaboration > Messages.

9) When ready, click Send.

Viewing a Budget Transfers Record on the End Step

This is the last step in the workflow. You cannot take action on this step. All form fields are read-only and the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.

- To view a Budget Transfers record on the End step
  1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
  2) Navigate to Cost Controls > Budget Transfers. The Budget Transfers log opens.
  3) Double-click a Budget Transfers record to open it. In the record you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."
  4) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.
5) Click **View Graphic** to see an image of the workflow.
Change Orders Business Process

Purpose
You can use the Change Order business process to make a formal commitment change to a contract. You can see the change impact in the project's cost sheet.

Business process characteristics
This is a project-level, Cost-type business process with line items and workflow. The Change Order business process uses the Payment Application schedule of values. An individual help file is available for this business process.

Record Statuses
- Pending, a non-terminal status.
- Approved, a terminal status
- Rejected, a terminal status.
- Canceled, a terminal status.

Groups associated with this business process
- Members of the **Creators** group can create the Budget Changes business process and send it for approval.
- Members of the **Reviewers** group can approve the business process 'as is,' send it to the **Revision** step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the change order.
- Members of **All Project Users** can receive Cc records and be added as assignees

Relationships associated with this business process
- The creator must select a contract.
- The business process auto-populates vendor information from the contract vendor selection.

Additional Information
- The Payment Application SOV becomes available upon association with a contract during record creation.
- The Change Order business process is enabled for integration.
- Enabled for integration.
- Enabled for publish path.
  Files attached to base products' business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section
Change Orders Workflow ................................................................. 235
Creating a Change Orders Record ..................................................... 235
Routing a Change Orders Record from the Approval Step ................. 239
Routing a Change Orders Record from the Revision Step ................. 240
Viewing a Change Orders Record on the End Step ............................ 241
Change Orders Workflow

Below are the four steps of the Change Orders workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Change Orders" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the assignee.

Creating a Change Orders Record

The first step in the Contracts business process workflow is the Creation step. Members of the Creator group can create this business process.

- **To create a new Change Orders record**
  1. Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.
  2. Double-click your project to open it.
  3. On your project landing page, navigate to the Collaboration > Tasks log
  5. Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in the Collaboration > Drafts folder.
  6. In the Line Items section click Add or Grid. The Line Items form or grid opens.
  7. Enter Line Items according to the Line Items table below. You must complete all required fields before you can save the Line Items form.
  8. Click OK (if using the Line Item form), or Save (if using the grid) to save the form. The Line Items form closes.
If you are using the grid and do not click Save before closing it, you will lose your line item changes.

9) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This selection activates **Action Details**.

10) In **Action Details**, select who should receive the record.
   a. Click **To**... The **User/Groups** picker opens that shows a list of available task recipients.
   b. Select the user or group who will receive the task on the Approval step.
   c. Click **Add**.
   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipients **Collaboration > Tasks** log.
   e. (Optional) Click **Cc**... and follow steps a - d. The record will appear in the recipients **Collaboration > Messages** log.

11) Click **Send** to route the record to the **Approval** step.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a title for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Transaction Currency</td>
<td>This is a read-only field that is auto-populated when you select the contract.</td>
</tr>
<tr>
<td>Rate in Project Currency</td>
<td>Currency conversions use the exchange rate defined in the active Exchange Rates set in Unifier's Standards &amp; Libraries. Until you modify a currency rate, Unifier uses the last active rate for that currency.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the record to the next step in the routing.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items.</td>
</tr>
<tr>
<td>Project Currency Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in project currency.</td>
</tr>
</tbody>
</table>

**CO Information block**

| Contract/PO*                  | This is a required field - Select the contract for the change order from the drop-down menu. Selecting a contract activates the SOV button in the record tool bar. |
| Spec Section                  | This value is auto-populated from the contract.                                                                                      |
| Current Contract Completion Date* | This value is auto-populated from the contract.                                                                                     |
| Schedule Impact (Days)*       | This is a required field - Enter the number of days this potential change order could affect the schedule.                            |
| Contract No                   | This is a read-only field - The contract number is auto-populated from the selected contract.                                        |
| Priority                      | This value is auto-populated from the contract.                                                                                      |
| Description                   | Enter a description for the potential change order.                                                                                   |
| Required Date                 | Either enter a date (dd/mm/yyyy) or use the calendar icon to select a date.                                                           |
| Revised Contract Completion Date | This field is auto-calculated based on the current contract completion date + the schedule impact days.                             |

**Scope of Change block**

| Reason*                       | This is a required field - Select a reason for the change from the drop-down menu.                                                   |
| Change Reason*                | This is a required field - Enter a detailed reason, up to 4000 characters, for the potential change order.                           |
| Scope of Work*                | This is a required field - Enter a detailed scope of work, up to 4000 characters, for the potential change order.                 |

**Vendor Information block**

<p>| Vendor ID                     | This field is auto-populated from the Vendor record associated with the Contract record.                                         |
| Vendor Name                   | This field is auto-populated from the Vendor record associated with the Contract record.                                         |</p>
<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 1</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Address 3</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>State/Province</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Email</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Phone</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Fax</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Minority-owned Business</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Woman-owned Business</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
<tr>
<td>Disadvantage-owned Business</td>
<td>This field is auto-populated from the Vendor record associated with the Contract record.</td>
</tr>
</tbody>
</table>

**Item Logs**

**Line Items Tab**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Block</td>
<td></td>
</tr>
<tr>
<td>PCO Reference</td>
<td></td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
</tbody>
</table>
In this field | Do this
---|---
Code Name | This read-only field is auto-populated from the cost code name.
Short Description* | This is a required field - Enter a brief description of the item specified on the line item.
Description | This is not a required field - Enter a description for the line item.

Spend Category block
Spend Category | Select the category from the drop-down menu.
Work Package | You can select a Work Package.
Item Quantity | This is a required field - Enter the number of items specified on the line item.
Unit of Measure | Select the Unit of Measure for the item specified on the line item.
Item Unit Cost | This is a required field - Enter the price of the item specified on the line item.
Amount | This read-only field is auto-calculated using the formula Item Quantity X Item Unit Cost.

Routing a Change Orders Record from the Approval Step

To route a record from the Approval step

1) Navigate to the All Projects tab and select your project from the log located near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log.
4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in bold red font are late.
5) Double click on the Change Orders task in the Tasks log. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.
6) When ready, click Accept Task. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
You can add Task Notes for the next step, but you cannot view previous Task Notes.
If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.

7) Review the Change Orders record and determine the appropriate course of action.
8) In the toolbar at the top right of the form, click the Workflow Actions drop-down menu. You may select:
   - Approve Change Order — this selection will send the record to the End step in Approved status.
   - Send for Revision — this action keeps the workflow in flight and in Pending status.
     a. In the Action Details section To... is preassigned, but you can select message recipients in the Cc field.
     b. Click Cc... Select the user or group who will receive the record on the next step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - Reject Change Order — this selection will send the record to the End step in Rejected status.
9) (Optional) Add comments to the record through General Comments or Task Notes.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.
10) Click Send.

Routing a Change Orders Record from the Revision Step

Upon sending the business process form forward to the Revision step, Unifier sends a task to the record creator and a message to those selected in the Cc field. You can see your active tasks in your Tasks log.

To route a record from the Revision step
1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold.
4) In your Tasks log, double-click the task to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

5) Click the Accept Task button. The form dynamically changes to an Action Form.

6) In the Upper form section you can change the following record details.
   - In the General block, you can revise the record Title.
   - In the CO Information block, most fields are editable except Contract No and Revised Contract Completion Date (auto-calculated based on the number of days of the schedule impact).
   - In the Contract Summary block, all fields are read-only and come from the contract or line items in this change order.
   - In the Vendor Information block, all fields are read-only and come from the vendor selected on the contract.

7) In the Line Items section you can Modify/Add/Delete Line Items as needed. You must complete all required fields on each line before you can save the Line Items form. Follow the same directions as adding line items during record creation. Changes to line items are reflected in the Contract Summary block of the Upper form.

8) Click OK to save the Line Items.

9) When ready, select a workflow action. This action activates Action Details. The choices are:
   - Resubmit for Approval — This action sends the record back to the Approval step in Pending status.
     a. Click To... The User/Groups picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the Approval step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the To field.
     e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
     f. Click Add.
     g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - Cancel Change Order — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.

10) In Action Details, depending upon the workflow action selection, select who should receive the task and who should be copied on the action.

11) When ready, click Send.

**Viewing a Change Orders Record on the End Step**

This is the last step in the workflow. You cannot take action on this step because the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.

- **To view a record on the End step**
  1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
2) Navigate to **Cost Controls > Change Orders**. The Change Orders log opens.

3) Double-click a record to open it. In the record you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."

4) Click the "**Click here**" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.

5) Click **View Graphic** to see an image of the workflow.

6) Click **SOV** to see the schedule of values.
Contracts Business Process

Prerequisite
You must have budget assigned to a WBS/Cost Code in the project's cost sheet prior to creating a Contracts record line item. Use a Budget Approvals business process record to allocate budget to the code. See Budget Approvals Business Process (on page 209)

Purpose
The Contracts business process is used in procurement workflows. You can use a Contracts record to gather key contractual information, such as vendor and type of contract. You can use a Contracts business process record to approve or deny approval for a commitment.

Business process characteristics
The Contracts business process is a cost-type business process that includes a workflow and requires you to select a Vendor. In turn, Change Orders and Payment Applications require you to select a Contract. You can create more than one Contracts record in a project. The item logs section of the Contracts record displays two query tabs, Change Orders and Payment Applications. An individual help file is available for this business process.

Record Statuses
- Pending, a non-terminal status
- Approved, a terminal status
- Rejected, a terminal status
- Canceled, a terminal status

Groups associated with this business process
- Members of the Creators group can create and edit this business process.
- Members of the Reviewer group can review and approve this business process
- Members of the All Project Users group can receive a copy of the business process record in their Collaboration > Messages logs.

Relationships associated with this business process
The record creator must select a vendor.

Additional Information
- The Contracts business process uses the Payment Application schedule of values, which becomes available on the End step.
- Enabled for smart phones and other hand held devices.
- Enabled for integration.
- Enabled for publish path.
  Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.
Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

Enabled for custom print.

Print using a custom layout
Custom printing can be used with templates created in Microsoft Word and PDF format. Depending on the template used for custom print, you can print the upper form, the current workflow step, comments and attachments of the record. The template may also allow printing of specific line items in their tabs. The printed output will list the name of the table with the line items following on separate lines.

Note: In Unifier 9.14 release, a specific Custom Print template has been added to the Contracts Business Process.

To print a business process form with a custom print layout, do the following:
1. Open the business record that you want to print.
2. From the File menu, select Print Preview > Custom.
3. Click Save.

Note: When opening a business process form that includes fields that are auto-populated, or automatically updated, the system considers these automatic updates as changes and requires that you Save the work.

In This Section
Contracts Workflow............................................................................................... 245
Creating a Contracts Record.................................................................................. 245
Routing a Contracts Record from the Approval Step............................................. 249
Routing a Contracts Record from the Revision Step............................................. 250
Viewing a Contracts Record on the End Step .................................................... 251
**Contracts Workflow**

Below are the four steps of the Contracts workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Contract" then the record moves to the **End** step with a record status of "Canceled." For all steps, except the **End** step, sending a record to the next step creates a task for the assignee.

![Contracts Workflow Diagram]

**Creating a Contracts Record**

The first step in the Contracts business process workflow is the Creation step. Members of the **Creator** group can create this business process.

- **To create a new Contracts record**
  1. Navigate to the **All Projects** tab and select your project from the list located on the bottom of the landing page.
  2. Double-click your project to open it.
  3. On your project landing page, navigate to the **Collaboration > Tasks** log
  4. Click **New** and select **Contracts** from the drop-down menu. A new Contracts business process form opens.
  5. Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in the **Collaboration > Drafts** folder.
  6. In the **Line Items** section click **Add** or **Grid**. The Line Items List opens.
  7. Complete the Line Items list according to the Line Items table below. You must complete all required fields before you can save the Line Items form.
  8. Click **OK** (if using the Line Item form), or **Save** (if using the grid) to save the form. The Line Items form closes.

If you are using the grid and do not click Save before closing it, you will lose your line item changes.
9) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This selection activates **Action Details**.

10) In **Action Details**, select who should receive the record.

   a. Click **To...** The **User/Groups** picker opens that shows a list of available task recipients.
   b. Select the user or group who will receive the task on the Approval step.
   c. Click **Add**.
   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipients **Collaboration > Tasks** log.
   e. (Optional) Click **Cc...** and follow steps a - d. The record will appear in the recipients **Collaboration > Messages** log.

11) Click **Send** to route the record to the **Approval** step.

---

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Transaction Currency</td>
<td>You can select the currency for the transaction if it is different from the project currency. The transaction currency must be active in the project.</td>
</tr>
<tr>
<td>Rate in Project Currency</td>
<td>Unifier auto-calculates this value and displays it on the next step after the task is accepted. Currency conversions use the exchange rate defined in the active Exchange Rates set in Unifier's Standards &amp; Libraries. Until you modify a currency rate, Unifier uses the last active rate for that currency.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the record to the next step in the routing.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in transaction currency.</td>
</tr>
<tr>
<td>Project Currency Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in project currency.</td>
</tr>
</tbody>
</table>

**Contract Information block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract No*</td>
<td>This is a required field - Enter the contract number.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>Select a value from the field drop-down menu.</td>
</tr>
<tr>
<td>Contract Description</td>
<td>Enter a description for the contract.</td>
</tr>
<tr>
<td>Priority</td>
<td>Select the priority from the drop-down menu.</td>
</tr>
<tr>
<td>Work Retainage%</td>
<td>Enter the percentage that should be retained from contract payments.</td>
</tr>
<tr>
<td>Effective Date*</td>
<td>This is a required field - Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the business process allows changes, then you can change this date. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>Contract Type*</td>
<td>This is a require field - Select the contract type from the drop-down menu.</td>
</tr>
<tr>
<td>Contract Terms*</td>
<td>This is a required field - Enter the terms of the contract.</td>
</tr>
<tr>
<td>Expiry Date</td>
<td>Enter the day the contract expires <code>dd/mm/yyyy</code> or click the calendar icon to select the date.</td>
</tr>
</tbody>
</table>

**Contract Summary block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Contract Amount</td>
<td>The amount is auto-populated by the line items on this form.</td>
</tr>
<tr>
<td>Net Changes by Change Orders</td>
<td>This value comes from the project cost sheet.</td>
</tr>
<tr>
<td>Revised Contract Amount</td>
<td>This value comes from the project cost sheet.</td>
</tr>
<tr>
<td>Actuals to Date</td>
<td>This value comes from the project cost sheet.</td>
</tr>
<tr>
<td>Contract Balance</td>
<td>This value comes from the project cost sheet.</td>
</tr>
</tbody>
</table>

**Vendor Information block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor*</td>
<td>This is a required field - Select a Vendor from the drop-down menu.</td>
</tr>
</tbody>
</table>
### In this field

<table>
<thead>
<tr>
<th>Vendor Name</th>
<th>This field is auto-populated from the Vendor record.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 1</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Address 3</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>State/Province</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Email</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Phone</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Fax</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Minority-owned Business</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Woman-owned Business</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Disadvantage-owned Business</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
</tbody>
</table>

### Item Logs

#### Line Items Tab

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Block</strong></td>
<td></td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item</td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
<tr>
<td>Code Name</td>
<td>This read-only field is auto-populated from the cost code name.</td>
</tr>
<tr>
<td>Description</td>
<td>This is not a required field - Enter a description for the line item.</td>
</tr>
<tr>
<td><strong>Spend Category block</strong></td>
<td></td>
</tr>
<tr>
<td>Spend Category</td>
<td>Select the category from the drop-down menu.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work Package</td>
<td>You can select a Work Package.</td>
</tr>
<tr>
<td>Item Quantity*</td>
<td>This is a required field - Enter the number of items specified on the line item</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Select the Unit of Measure for the item specified on the line item</td>
</tr>
<tr>
<td>Item Unit Cost*</td>
<td>This is a required field - Enter the price of the item specified on the line item</td>
</tr>
<tr>
<td>Amount</td>
<td>This read-only field is auto-calculated using the formula Item Quantity X Item Unit Cost.</td>
</tr>
</tbody>
</table>

**Change Orders Tab**

Use to create a new record as well as view, copy, or find existing records.

**Payment Applications Tab**

Use to create a new record as well as view, copy, or find existing records.

**Routing a Contracts Record from the Approval Step**

- *To route a record from the Approval step*
  1) Navigate to the All Projects tab and select your project from the log located near the bottom of the landing page.
  2) Double-click your project to open it.
  3) On your project landing page, navigate to the Collaboration > Tasks log
  4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in bold red font are late.
  5) Double click on the Contracts task in the Tasks log. The view-only form displays all fields on the record.
    - The Upper Form contains project information, including the record number and title.
    - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.
  6) When ready, click Accept Task. The View form dynamically changes to an Action form.
    - You cannot make changes to the Action form when you are on the Approval step.
    - You can add Task Notes for the next step, but you cannot view previous Task Notes.
    - If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.
  7) Review the Contracts record and determine the appropriate course of action.
  8) In the toolbar at the top right of the form, click the Workflow Actions drop-down menu. You may select:
    - Approve Contract — this selection will send the record to the End step in Approved status.
Send for Revision — this action keeps the workflow in flight and in Pending status.
a. In the Action Details section To... is preassigned, but you can select message recipients in the Cc field.
b. Click Cc... Select the user or group who will receive the record on the next step.
c. Click Add.
d. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.

Reject Contract — this selection will send the record to the End step in Rejected status.

9) (Optional) Add comments to the record through General Comments or Task Notes.
   a. To add General Comments click the link at the bottom center of the form. These comments are permanent.
   b. To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.

10) Click Send.

Routing a Contracts Record from the Revision Step

Upon sending the business process record forward to the Revision step, Unifier sends a task to the record creator and a message to those selected in the Cc field. You can see your active tasks in your Tasks log.

To route a record from the Revision step

1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold.
4) In your Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
5) Click the Accept Task button. The form dynamically changes to an Action Form. In the Upper form you can:
   a. Change the record Title in the General block
   b. Edit any field in the Contract Information bloc
   c. Change the vendor selection in the Contract Summary block
   In Line Items you can:
Modify any existing line items
Add additional line items
Remove Line Items.
Follow the same directions as adding line items during record creation, then click OK to save any line item changes.

6) When ready, select a workflow action. This action activates Action Details. The choices are:
   - **Resubmit for Approval** — This action sends the record back to the Approval step in Pending status.
     a. Click To... The User/Groups picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the Approval step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the To field.
     e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
     f. Click Add.
     g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - **Cancel Contract** — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.

7) In Action Details, select who should receive the task and who should receive a copy of the record in Collaboration > Messages.
8) When ready, click Send.

### Viewing a Contracts Record on the End Step

This is the last step in the workflow. You cannot take action on this step because the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.

- **To view a record on the End step**
  1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
  2) Navigate to Cost Controls > Contracts. The Contracts log opens.
  3) Double-click a record to open it. In the record you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."
  4) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.
  5) Click View Graphic to see an image of the workflow.
  6) Click SOV in the record toolbar to view the schedule of values for this record.
Estimates Business Process

Purpose
You can have different types of estimates that are generated at different points in the project. You may have an initial estimate, and as you go through design, you will get more detailed estimates. Consider the following paragraph:

The required levels of accuracy of construction cost estimates vary at different stages of project development, ranging from ball park figures in the early stage to fairly reliable figures for budget control prior to construction. Since design decisions made at the beginning stage of a project life cycle are more tentative than those made at a later stage, the cost estimates made at the earlier stage are expected to be less accurate. Generally, the accuracy of a cost estimate will reflect the information available at the time of estimation.

Business process characteristics
Estimates is a non-workflow, project-level, cost-type business process with line items. You can create more than one Estimates record for your projects. An individual help file is available for this business process.

Groups associated with this business process
- Members of the Creators group can create this business process.
- Members of the Creators and Reviewers group can edit this business process.

Statuses
Open and Closed, neither of which are terminal statuses.

Additional Information
- Closed estimates will roll up to the cost sheet.
- Enabled for mobile and hand-held devices.
- Project Name and Project Number are auto-populated from the shell attribute form.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.
Location
To view the published file attachments of a project-level business process record: In a project’s Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section
Creating an Estimates Record ................................................................. 254
Adding Line Items to the Estimates Record........................................... 255
Saving the Estimates Record.................................................................. 256

Creating an Estimates Record

To create a new Estimates record
1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log
4) Click New in the Tasks log.
5) Select Estimates from the drop-down menu. The Create New Estimates form opens.
6) Complete, at minimum, the required fields according to the Upper form table below. You can save the form as a draft at any time. Unifier stores the draft in the Collaboration > Drafts folder.
7) In the Line Items section click Add or Grid. The Line Items form opens.
8) Complete the Line Items form according to the Line Items table below. You must complete all required fields on each line that you entered before you can save the Line Items form.
9) Click OK (if using the Line Item form), or Save (if using the grid) to save the form. The Line Items form closes.
   If you are using the grid and do not click Save before closing it, you will lose your line item changes.

Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>General block</td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates the first time you</td>
</tr>
<tr>
<td></td>
<td>save the form.</td>
</tr>
<tr>
<td>Title</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
</tbody>
</table>
Adding Line Items to the Estimates Record

To add line items to the Estimates record.

The record must be in Edit mode to add line items.

1) In the **Line Items** section click **Add** or **Grid**. The Line Item form opens.
2) Complete the Line Item form according to the Line Item table below. You must complete all required fields on each line that you entered before you can save the Line Item.
3) Click **Save** to save the form.

### Line Item Table

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab Name</td>
<td>You can enter a name for the tab.</td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
</tbody>
</table>
## In this field Use

<table>
<thead>
<tr>
<th>In this field Use</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code Name</td>
<td>This read-only field is auto-populated from the cost code.</td>
</tr>
<tr>
<td>Cost Type</td>
<td>This read-only field is auto-populated from the cost code.</td>
</tr>
<tr>
<td>Spend Category</td>
<td>Select the category from the drop-down menu.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item.</td>
</tr>
<tr>
<td>Work Package</td>
<td>You can select a Work Package.</td>
</tr>
<tr>
<td>Description</td>
<td>This in not a required field - Enter a description for the line item.</td>
</tr>
<tr>
<td>Item Quantity*</td>
<td>This is a required field - Enter the number of items specified on the line item.</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Select the Unit of Measure for the item specified on the line item line item.</td>
</tr>
<tr>
<td>Item Unit Cost*</td>
<td>This is a required field - Enter the price of the item specified on the line item.</td>
</tr>
<tr>
<td>Amount</td>
<td>This read-only field is auto-calculated using the formula Item Quantity X Item Unit Cost.</td>
</tr>
</tbody>
</table>

### Saving the Estimates Record

**To save the Estimates record**

Click either:

- **Finish Editing** to save the form in read-only mode
  - You can return the record to Edit mode by clicking **Edit** on the business process tool bar.
- **Save** to leave the form in edit mode
Fund Appropriations Business Process

Purpose
Use this business process to approve and assign Fund accounts to projects.

Business process characteristics
- This is a project-level, Cost-type business process subtype line items with fund code, classification generic, for use with general spends or payment application. An individual help file is available for this business process.

Record Statuses
- Pending, a non-terminal status
- Approved, a terminal status
- Rejected, a terminal status
- Canceled, a terminal status

Groups associated with this business process
- Creators create the Fund Appropriations business process and send it for approval.
- Members of the Reviewers group can approve the business process ‘as is,’ send it to the Revision step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the budget.
- Members of the All Project Users group can be copied on this business process.

Additional Information
- You must have a Funding Sheet defined for your project before you can use the Fund Appropriations business process.
  Note: The funding sheet comes pre-defined in the project template.
- Fund Appropriations is enabled for mobile phones and hand-held devices.
- Enabled for integration.
- Enabled for publish path.
  Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project’s Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**In This Section**

- Fund Appropriations Workflow ........................................ 258
- Creating a Fund Appropriations Records ......................... 258
- Routing a Fund Appropriations Record from the Approval Step ... 260
- Routing a Fund Appropriations Record from the Revision Step .... 261
- To view a Fund Appropriations record on the End step .......... 263

**Fund Appropriations Workflow**

Below are the four steps of the Fund Appropriations workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Fund Appropriation" then the record moves to the End step with a record status of "Canceled." For all steps, except the **End** step, sending a record to the next step creates a task for the record recipient.

**Creating a Fund Appropriations Records**

- *To create a Fund Appropriations record*

  1) Navigate to the **All Projects** tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the **Collaboration > Tasks** log
4) Click **New** in the **Tasks** log.
5) Select **Fund Appropriations** from the drop-down menu. The **Create New Fund Appropriations** form opens.
6) Complete, at minimum, the required fields according to the **Upper form** table below. You can save the form as a draft at any time. Unifier stores the draft in the **Collaboration > Drafts** folder.
7) In the **Line Items** section click **Add** or **Grid**. The **Line Items** form opens.
8) Complete the **Line Items** form according to the **Line Items** table below. You must complete all required fields before you can save the **Line Items** form.
9) Click **Save** (if using the grid) or **OK** (if using the **Line Item** form) to save the form. The **Line Items** form closes.
   - If you close the grid before you save it, you will lose your entries.
   - Unifier automatically calculates the aggregate value of the line items and displays the sum in the **Amount** field in the **Upper form**, and in the **Total Amount** field in **Line Items**.
10) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This action activates **Action Details**.
11) In **Action Details**, select who should receive the record.
   a. Click **To**... The **User/Groups** picker opens and displays a list of available task recipients.
   b. Select the user or group who will receive the task on the **Approval** step.
   c. Click **Add**.
   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipient's **Collaboration > Tasks** log.
   e. (Optional) Click **Cc**... and follow steps a - d. The record will appear in the recipient's **Collaboration > Messages** log.
12) Click **Send** to route the record to the **Approval** step. Unifier displays a message stating that the record has been submitted successfully.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Record Number</strong></td>
<td>This is a read-only field that Unifier populates.</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td><strong>Project Number</strong></td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td><strong>Project Name</strong></td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td><strong>Creator</strong></td>
<td>This is a read-only field that identifies the person who created the record. The field appears as a link to the record creator's contact information.</td>
</tr>
</tbody>
</table>
In this field | Do this
--- | ---
Creation Date | This is a read-only field that Unifier populates with the record creation date.
Due Date | This is a read-only field. Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.
Status* | This is a required field - Enter the record status.
Contract Reference | This in not a required field - Enter a contract reference.

**Budget Information block**
Amount | This value is auto-populated from the aggregate value of line items.

**Description block**
Description | This in not a required field - Enter a description of the budget change.

**Item Logs**

**Line Items Tab**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Block</strong></td>
<td></td>
</tr>
<tr>
<td>Funding Source*</td>
<td>This is a required field - Use the Fund Picker to select a funding source.</td>
</tr>
<tr>
<td>Fund Name</td>
<td>Enter the name of the fund.</td>
</tr>
<tr>
<td>Fund Description</td>
<td>Enter a description for the fund.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description for the line item.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter a value for the Amount.</td>
</tr>
</tbody>
</table>

**Routing a Fund Appropriations Record from the Approval Step**

- **To route a Fund Appropriations Record record from the Approval step**
  1. Navigate to the All Projects tab and select your project from the list located near the bottom of the landing page.
  2. Double-click your project to open it.
  3. On your project landing page, navigate to the Collaboration > Tasks log.
  4. The Tasks log lists all of your open tasks. Unifier displays new tasks in bold black font and late tasks in red font.
5) Double click the **Fund Appropriations** task, as shown in the Tasks log **Type** column. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.

6) When ready, click **Accept Task**. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.

7) Review the Budget Approvals record and determine the appropriate course of action. You cannot make changes to the record on the Approval step.

8) In the toolbar at the top right of the form, click the **Workflow Actions** drop-down menu. The choices are:
   - **Approve Fund Appropriation** — this selection will send the record to the End step in **Approved** status.
   - **Send for Revision** — this action keeps the workflow in flight and in **Pending** status.
     a. In the **Action Details** section **To**... is preassigned, but you can select message recipients in the **Cc** field.
     b. Click **Cc**... Select the user or group who will receive the record on the next step.
     c. Click **Add**.
     d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.
   - **Reject Fund Appropriation** — this selection will send the record to the End step in **Rejected** status.

9) (Optional) Add comments to the record through **General Comments** or **Task Notes**.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.

10) Click **Send** to route the record to the next step, either **Revision** or **End**.

---

**Routing a Fund Appropriations Record from the Revision Step**

Upon sending the business process form forward to the **Revision** step, Unifier sends a task to the record creator and a message to those selected in the **Cc** field. You can see your active tasks in your **Tasks** log. When your task is complete, you can select one of two Workflow Action options, as described on step 8.
To route a Fund Appropriations record from the Revision step

1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.

2) Double-click your project to open it.

3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold.

4) In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.

   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.

   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

5) Click the Accept Task button. The form dynamically changes to an Action Form with most fields editable. You can revise:
   - Title
   - Contract Reference
   - Description
   - Line Items

6) In the Line Items section you can Modify/Add/Delete Line Items as needed. You must complete all required fields on each line before you can save the Line Items form.

7) Click OK to save the Line Items.

8) When ready, select a workflow action. The choices are:
   - Resubmit for Approval — This action sends the record back to the Approval step in Pending status.
     a. Click To... The User/Groups picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the Approval step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the To field.
     e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
     f. Click Add.
     g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - Cancel Fund Appropriation — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.
     - This action activates Action Details.

9) In Action Details, select who should receive the task and who should receive a copy of the record in Collaboration > Messages.

10) When ready, click Send.
To view a Fund Appropriations record on the End step

This is the last step in the workflow. You cannot take action on this step. All form fields are read-only and the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.

1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.


3) Double-click a record to open it. In the business process you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."

4) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.

5) Click View Graphic to see an image of the workflow.
Invoices Business Process

Purpose
The Invoices business process is used in procurement processes to request payment on Total Commitments (Purchase Orders + PO Amendments). Each Invoices record:

- References a specific Purchase Orders record
- Updates that Purchase Order's General Spends schedule of values (SOV)

Business process characteristics
The Invoices business process is a cost-type business process that includes an approval workflow. Approved data from this business process rolls up to the project cost sheet, updates the schedule of values, and triggers funding consumption. An individual help file is available for this business process.

Record Statuses
- Pending, a non-terminal status.
- Approved, a terminal status
- Rejected, a terminal status.
- Canceled, a terminal status.

Groups associated with this business process:
- Members of the Creators group can create and edit this business process.
- Members of the Reviewer group can review and approve this business process.
- Members of the All Project Users group can receive a copy of the business process record in their Collaboration > Messages logs.

Relationships associated with this business process
The record creator must associate it with a contract.

Additional Information
- The General Spends SOV becomes available after association with a contract.
- Enabled for smart phones and other hand held devices.
- Enabled for integration.
- Enabled for publish path.
  Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section

- Invoices Workflow ................................................................. 267
- Creating an Invoices Record .................................................. 267
- Routing an Invoices Record from the Approval Step ............. 271
- Routing an Invoices Record from the Revision Step ............... 272
- Viewing an Invoices Record from the End Step .................... 273
Invoices Workflow

Below are the four steps of the Invoices workflow. The workflow action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Invoice" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the assignee.

Creating an Invoices Record

The first step in the Invoices business process workflow is the Creation step. Members of the Creator group can create this business process.

- To create a new Invoices record
  1) Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.
  2) Double-click your project to open it.
  3) On your project landing page, navigate to the Collaboration > Tasks log
  4) Click New and select Invoices from the drop-down menu. A new Invoices business process form opens.
  5) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in your Collaboration > Drafts folder.
  6) In the Line Items section click Add or Grid. The Line Items form opens.
  7) Complete the Line Items form according to the Line Items table below. You must complete all required fields before you can save the Line Items form.
     - Click OK (if using the Line Item form), or Save (if using the grid) to save the form. The Line Items form closes.
If you are using the grid and do not click Save before closing it, you will lose your line item changes.

8) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This selection activates **Action Details**.

9) In **Action Details**, select who should receive the record.
   a. Click **To**... The **User/Groups** picker opens that shows a list of available task recipients.
   b. Select the user or group who will receive the task on the **Approval** step.
   c. Click **Add**.
   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipients **Collaboration > Tasks** log.
   e. (Optional) Click **Cc**... and follow steps a - d. The record will appear in the recipients **Collaboration > Messages** log.

10) Click **Send** to route the record to the **Approval** step.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you click Send.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Contract/PO*</td>
<td>This is a required field - Select the reference purchase order.</td>
</tr>
<tr>
<td></td>
<td>Click Select. The Purchase Orders log opens.</td>
</tr>
<tr>
<td></td>
<td>Pick a Purchase Order from the log and click Open.</td>
</tr>
<tr>
<td>Transaction Currency</td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td>Rate in Project Currency</td>
<td>Unifier auto-calculates this value and displays it after the task</td>
</tr>
<tr>
<td></td>
<td>is accepted on the next step.</td>
</tr>
<tr>
<td></td>
<td>Currency conversions use the exchange rate defined in the</td>
</tr>
<tr>
<td></td>
<td>active Exchange Rates set in Unifier's Standards &amp; Libraries.</td>
</tr>
<tr>
<td></td>
<td>Until you modify a currency rate, Unifier uses the last active</td>
</tr>
<tr>
<td></td>
<td>rate for that currency.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the</td>
</tr>
<tr>
<td></td>
<td>record. The field appears as a link to the creator’s contact</td>
</tr>
<tr>
<td></td>
<td>information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the</td>
</tr>
<tr>
<td></td>
<td>record to the next step in the routing.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date shows when the record is due, based on the business process setup. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items.</td>
</tr>
<tr>
<td>Project Currency Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in project currency. Currency conversions use the exchange rate defined in the active Exchange Rates set in Unifier's Standards &amp; Libraries. Until you modify a currency rate, Unifier uses the last active rate for that currency.</td>
</tr>
</tbody>
</table>

**PO Information block**

<table>
<thead>
<tr>
<th>PO Number</th>
<th>This field is auto-populated from the Purchase Order.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effective Date</td>
<td>This field is auto-populated from the Purchase Order.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>This field is auto-populated from the Purchase Order.</td>
</tr>
<tr>
<td>Contract Description</td>
<td>This field is auto-populated from the Purchase Order.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>This field is auto-populated from the Purchase Order.</td>
</tr>
</tbody>
</table>

**Invoice Information block**

<table>
<thead>
<tr>
<th>Invoice Date*</th>
<th>This is a required field - Use the calendar icon to select the date of the invoice.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Select the priority from the drop-down menu.</td>
</tr>
<tr>
<td>Check No</td>
<td>This field is read only until the record reaches the End step.</td>
</tr>
<tr>
<td>Check Processed Date</td>
<td>This field is read only until the record reaches the End step.</td>
</tr>
<tr>
<td>Check Date</td>
<td>This field is read only until the record reaches the End step.</td>
</tr>
</tbody>
</table>

**Vendor Information block**

<table>
<thead>
<tr>
<th>Vendor ID</th>
<th>This field is auto-populated from the Vendor record associated with the Purchase Order.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Name</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>Address 1</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
</tbody>
</table>
### In this field

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 2</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>Address 3</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>State/Province</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>Email</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>Phone</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
<tr>
<td>Fax</td>
<td>This field is auto-populated from the Vendor record associated with the Purchase Order.</td>
</tr>
</tbody>
</table>

### Item Logs

**Line Items Tab**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
<tr>
<td>Code Name</td>
<td>This field is auto-populated from the cost code/</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item</td>
</tr>
<tr>
<td>Description</td>
<td>This is not a required field - Enter a description for the line item.</td>
</tr>
<tr>
<td><strong>Spend Category block</strong></td>
<td></td>
</tr>
<tr>
<td>Effective Date</td>
<td>You can edit the Effective Date</td>
</tr>
<tr>
<td>Spend Category</td>
<td></td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work Package</td>
<td>You can select a Work Package.</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Select the Unit of Measure for the item specified on the line item</td>
</tr>
<tr>
<td>Item Quantity *</td>
<td>This is a required field - Enter the number of items specified on the line item</td>
</tr>
<tr>
<td>Item Unit Price *</td>
<td>This is a required field - Enter the price of the item specified on the line item</td>
</tr>
<tr>
<td>Amount</td>
<td>This value is auto-calculated (Item Quantity x Item Unit Price)</td>
</tr>
</tbody>
</table>

Routing an Invoices Record from the Approval Step

To route a record from the Approval step

1) Navigate to the All Projects tab and select your project from the Projects log located near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log
4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in bold red font are late.
5) Double click on the Invoices task in the Tasks log. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section indicates who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.
6) When ready, click Accept Task. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add Task Notes for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.
7) Review the Invoices record and determine the appropriate course of action.
8) In the toolbar at the top right of the form, click the Workflow Actions drop-down menu. You may select:
   - Approve Invoice — this selection will send the record to the End step in Approved status.
   - Send for Revision — this action keeps the workflow in flight and in Pending status.
     a. In the Action Details section To... is preassigned, but you can select message recipients in the Cc field.
     b. Click Cc... Select the user or group who will receive the record on the next step.
Routing an Invoices Record from the Revision Step

Upon sending the business process form forward to the Revision step, Unifier sends a task to the record creator and a message to those selected in the Cc field. You can see your active tasks in your Tasks log.

To route a record from the Revision step

1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Tasks that you have not yet accepted are bold.
4) In your Tasks log, double-click the task to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
5) Click the Accept Task button. The form dynamically changes to an Action Form.
6) In the Upper form section you can change the following record details.
   ⊲ In the General block, you can revise the record Title.
   ⊲ In the PO Information block, fields are read only.
   ⊲ In the Invoice Information block, you can edit Invoice Date, and Priority.
      ⊲ Check No, Check Processed Date, and Check Date fields become available on the End step.
   ⊲ In the Vendor Information block, all fields are read-only and entries come from the vendor selected on the contract.
7) In the Line Items section you can modify or delete line items. Changes to line items dynamically update the Amount and Project Currency Amount fields in the Upper form's General block and the Purchase Order SOV.
8) When ready, select a workflow action. This action activates Action Details. The choices are:
- **Resubmit for Approval** — This action sends the record back to the Approval step in Pending status.
  a. Click **To**... The **User/Groups** picker opens and displays a list of available task recipients.
  b. Select the user or group who will receive the task when the record returns to the **Approval** step.
  c. Click **Add**.
  d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field.
  e. (Optional) Click **Cc**... Select the user or group who will receive the record on the next step.
  f. Click **Add**.
  g. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.

- **Cancel Invoice** — This action sends the record to the **End** step in Canceled status. The **To** and **Cc** field are unavailable.

9) In **Action Details**, depending upon the workflow action selection, select who should receive the task and who should be copied on the action.

10) When ready, click **Send**.

---

**Viewing an Invoices Record from the End Step**

This is the last step in the workflow. Once on the **End** step the record is viewable only in the business process log.

- **To view a record on the End step**
  1) Navigate to the **All Projects** tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
  2) Navigate to **Cost Controls > Invoices**. The **Invoices** log opens.
  3) Double-click a record to open it. From the End step you can:
     a. Enter the Check No.
     b. Select the Check Processed Date using the calendar icon or manually in dd/mm/yyyy format.
     c. Select the Check Date using the calendar icon or manually in dd/mm/yyyy format.
     d. Click **Save** to retain check information in the form.
  4) In Task Details you can see the record status and the text "Record has been closed."
  5) Click the "**Click here**" link. The Workflow Progress window opens. This is where you can trace the record’s progress through the workflow.
  6) Click **View Graphic** to see an image of the workflow.
  7) Click **SOV** to see the schedule of values.
Journal Entries Business Process

Purpose
This is a business process for adjusting spending line items. It is usually used to reassign costs to alternate cost centers or General Ledger codes.

Business process characteristics
Journal Entries is a workflow, project-level, line item-type business process. You can create multiple Journal Entries records. Because Integration is defined for Upper and Detail forms, you can create a Journal Entries integration file to upload your records. An individual help file is available for this business process.

Record Statuses
- Pending, non-terminal status.
- Approved, terminal status.
- Canceled, terminal status.
- Rejected, terminal status.

Groups associated with this business process
Members of the Creator group can create this business process.

Additional Information
- Enabled for mobile and hand-held devices.
- The Administrator can upload the business process help file.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier’s Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project’s Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project’s Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section

Journal Entries Workflow ................................................................. 276
Creating a Journal Entries Record .................................................. 276
Routing a Journal Entries Record from the Approval Step ............ 278
Routing a Journal Entries Record from the Revision Step ............. 279
Viewing a Journal Entries Record on the End Step ....................... 281

Journal Entries Workflow

Below are the four steps of the Journal Entries workflow. The workflow action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Journal Entry" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the assignee.

Creating a Journal Entries Record

The first step in the Journal Entries business process workflow is the Creation step. Members of the Creator group can create this business process.

To create a new Journal Entries record
1) Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log
4) Click **New** and select **Journal Entries** from the drop-down menu. A new Journal Entries business process form opens.

5) Complete the **Upper form** according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in your **Collaboration > Drafts** folder.

6) In the **Line Items** section click **Add** or **Grid**. The Line Items form opens.

7) Complete the Line Items form according to the Line Items table below. For each line that you enter, you must complete all required fields before you can save the Line Items form.

8) Click **OK** (if using the Line Item form), or **Save** (if using the grid) to save the form. The Line Items form closes.

   If you are using the grid and do not click **Save** before closing it, you will lose your line item changes.

9) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This selection activates **Action Details**.

10) In **Action Details**, select who should receive the record.

   a. Click **To**... The **User/Groups** picker opens showing a list of available task recipients.

   b. Select the user or group who will receive the task on the **Approval** step.

   c. Click **Add**.

   d. Click **OK**. The **User/Groups** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipients **Collaboration > Tasks** log.

   e. (Optional) Click **Cc**... and follow steps a - d. The record will appear in the recipients **Collaboration > Messages** log.

11) Click **Send** to route the record to the **Approval** step.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator’s contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the record to the next step in the routing.</td>
</tr>
</tbody>
</table>
In this field | Do this
--- | ---
Due Date | This is a read-only field. Due Date shows when the record is due, based on the business process setup. If the record becomes late, Unifier displays the record Title in bold red.
Status | This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.

**Journal Entry Summary**

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Number</td>
<td>If the Journal Entry is for a Purchase Order select the Purchase Order from the Select drop-down menu.</td>
</tr>
<tr>
<td>Contract Reference</td>
<td>If the Journal Entry is for a Contract select the Contract from the Select drop-down menu.</td>
</tr>
</tbody>
</table>

**Retainage Information block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retainage Adjustments</td>
<td>Select either Yes or No.</td>
</tr>
<tr>
<td>Retainage</td>
<td>Enter the retainage percentage.</td>
</tr>
</tbody>
</table>

**Description block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the journal entry.</td>
</tr>
</tbody>
</table>

**Item Logs**

**Line Items Tab**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>General block</td>
<td></td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field -Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
<tr>
<td>Code Name</td>
<td>This field is auto-populated from the cost code.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the amount of the journal entry.</td>
</tr>
</tbody>
</table>

**Routing a Journal Entries Record from the Approval Step**

- To route a record from the Approval step

1) Navigate to the All Projects tab and select your project from the Projects log located near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the **Collaboration > Tasks** log
4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in bold red font are late.
5) Double click on the **Journal Entries** task in the Tasks log. The view-only form displays all fields on the record.
   - The Upper Form contains general information, including the record number and title.
   - The Task Details section indicates who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.
6) When ready, click **Accept Task**. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.
7) Review the Journal Entries record and determine the appropriate course of action.
8) In the toolbar at the top right of the form, click the **Workflow Actions** drop-down menu. You may select:
   - **Approve Journal Entry** — this selection will send the record to the End step in **Approved** status.
   - **Send for Revision** — this action keeps the workflow in flight and in **Pending** status.
     a. In the **Action Details** section **To**... is preassigned, but you can select message recipients in the **Cc** field.
     b. Click **Cc...** Select the user or group who will receive the record on the next step.
     c. Click **Add**.
     d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.
   - **Reject Journal Entry** — this selection will send the record to the End step in **Rejected** status.
9) (Optional) Add comments to the record through **General Comments** or **Task Notes**.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.
10) Click **Send**.

---

**Routing a Journal Entries Record from the Revision Step**

Upon sending the business process form forward to the **Revision** step, Unifier sends a task to the record creator and a message to those selected in the **Cc** field. You can see your active tasks in your **Tasks** log. When your task is complete, you can select one of two Workflow Action options, as described on step 8.
To route a Journal Entries record from the Revision step

1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold.
4) In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
5) Click the Accept Task button. The form dynamically changes to an Action Form with most fields editable. You can revise:
   ▶ Title
   ▶ Contract Reference
   ▶ Description
   ▶ Line Items
6) In the Line Items section you can Modify, Add, or Delete Line Items as needed. You must complete all required fields before you can save the Line Items form.
7) Click Save to save the Line Items.
8) When ready, select a workflow action. The choices are:
   ▶ Resubmit for Approval — This action sends the record back to the Approval step in Pending status.
     a. Click To... The User/Groups picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the Approval step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the To field.
     e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
     f. Click Add.
     g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   ▶ Cancel Journal Entry — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.
     This action activates Action Details.
9) In Action Details, select who should receive the task and who should receive a copy of the record in Collaboration > Messages.
10) When ready, click Send.
Viewing a Journal Entries Record on the End Step

This is the last step in the workflow. Once on the **End** step the record is viewable only in the business process log.

- **To view a record on the End step**
  1) Navigate to the **All Projects** tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
  2) Navigate to **Cost Controls > Journal Entries**. The **Journal Entries** log opens.
  3) Double-click a record to open it. Here you can:
     a. Enter the Check No.
     b. Select the Check Processed Date using the calendar icon or manually in dd/mm/yyyy format.
     c. Select the Check Date using the calendar icon or manually in dd/mm/yyyy format.
  4) In Task Details you can see the record status and the text "Record has been closed."
  5) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.
  6) Click **View Graphic** to see an image of the workflow.
New User Requests Business Process

Purpose
You can use a New User Requests record to ask an administrator to create a new user.

Business process characteristics
The New User Requests business process is a company-level business process without line items but with workflow. You can create multiple New User Requests records for your company; each record specifies one new user. Integration is defined. An individual help file is available for this business process.

Groups associated with this business process
Company Administrator, Creator, Reviewer, All Company Users

Record Statuses
Pending (non-terminal status), Approved (terminal status), Rejected (terminal status), or Canceled (terminal status)

Additional Information
- Enabled for mobile devices.
- Step completion policy and resolving actions can differ between steps.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier’s Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project’s Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project’s Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
In This Section

New User Requests Workflow................................................................. 284
Creating a New User Requests Record .............................................. 284
Routing a New User Requests Record from the Approval Step .......... 286
Routing a New User Requests Record from the Revision Step .......... 287
Viewing a New User Request on the End Step ................................. 287

New User Requests Workflow

Below are the four steps of the New User Requests workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel New User" then the record moves to the End step with a record status of "Canceled." Sending a record to either the Approval step or the Revision step creates a task for the next record recipient.

Creating a New User Requests Record

To create a New User Requests Record

1) Navigate to the Company Workspace tab, Collaboration >Tasks. The Tasks log opens.
2) In the Tasks toolbar click New and select New User Requests from the menu drop-down list. A new New User Requests form opens.
3) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the form.
4) In Workflow Actions select the workflow action to take. In this case, your selection is Send for Approval. This action activates Action Details.
5) In Action Details, select who should receive the record.
   a. Click To... The User/Groups picker opens and displays a list of available task recipients.
   b. Select the user or group who will receive the task on the next step.
   c. Click Add.
d. Click OK. The User/Group picker closes and the selection appears in the To field. Upon sending, the record will appear in the recipient's Collaboration > Tasks log.

e. (Optional) Click Cc... and follow steps a - d. The record will appear in the recipient's Collaboration > Messages log.

6) Click Send to route the record to the Approval step. Unifier displays a message stating that the record has been submitted successfully.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates the first time you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter up to 16 characters to name the record.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator’s contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you first send the form to the next step in the workflow.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is populated based on the date established in Administration Mode &gt; Work Flow Settings.</td>
</tr>
<tr>
<td>Status</td>
<td>This is a read-only field that Unifier populates when you first send the form to the next step in the workflow.</td>
</tr>
<tr>
<td><strong>Request block</strong></td>
<td></td>
</tr>
<tr>
<td>Request Type</td>
<td>Select the request type from the field's drop-down menu.</td>
</tr>
<tr>
<td><strong>User Information block</strong></td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td>Enter the user's first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Enter the user's last name.</td>
</tr>
<tr>
<td>E-Mail</td>
<td>Enter the user's email address.</td>
</tr>
<tr>
<td>Work Phone</td>
<td>Enter the user's work telephone number.</td>
</tr>
<tr>
<td>Mobile Phone</td>
<td>Enter the user's mobile or smart-phone number.</td>
</tr>
<tr>
<td>Home Phone</td>
<td>Enter the user's home telephone number.</td>
</tr>
<tr>
<td>Pager</td>
<td>Enter the user's pager number.</td>
</tr>
<tr>
<td>Fax</td>
<td>Enter the user's fax number.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Enter the user's time zone.</td>
</tr>
</tbody>
</table>
Routing a New User Requests Record from the Approval Step

Upon sending the business process form forward to the Approval step, Unifier creates a permanent business process record and sends a task. An assignee can see the task in the Tasks log.

To route a New User Requests record from the Approval step

When working on the Approval step, first you accept the task, then when you are ready to do so, route the record to either the Revision or the End step.

1) Navigate to the Company Workspace tab, Collaboration > Tasks. The Tasks log opens.
2) In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
3) Click the Accept Task button.
   You cannot make changes to the Action form when you are on the Approval step.
   You can add Task Notes for the next step, but you cannot view previous Task Notes.
   If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.
4) When you are ready, select a workflow action. The choices are:
   Approve — this action sends the record to the End step in Approved status, which triggers auto-creation of the Vendor record.
   Send for Revision — this action sends the record back to the record creator in Pending status. The To field is preassigned and you can Cc anyone listed in Users/Groups.
   a. Click Cc... The User/Groups picker opens and displays a list of available message recipients.
   b. Select the user or group who will receive the message when the record returns to the Approval step.
   c. Click Add.
   d. Click OK. The User/Group picker closes and the selection appears in the Cc... field. Upon sending, the record copy will appear in the recipient's Collaboration > Messages log.
   Reject — this action sends the record to the End step in Rejected status.
5) When ready, click Send.
Routing a New User Requests Record from the Revision Step

Upon sending the business process form forward to the Revision step, Unifier sends a task to the assignee. You can see your active tasks in your Tasks log. When your task is complete, you can select one of two Workflow Action options, as described on step 4.

- To route a New User Requests record from the Revision step
  1) Navigate to the Company Workspace tab, Collaboration > Tasks. The Tasks log opens.
  2) In the Tasks log, double-click the task to open it. The business process form opens for viewing; you must accept the task before you can act on it.
     The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
     The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
  3) Click the Accept Task button. The form dynamically changes to an Action Form with editable fields. You can revise:
      - Title
      - All fields in the User Information block.
  4) When ready, select a workflow action. The choices are:
      - Resubmit for Approval — this action sends the record back to the Approval step in Pending status.
      a. Click To... The User/Groups picker opens and displays a list of available task recipients.
      b. Select the task recipient for the Approval step.
      c. Click Add.
      d. Click OK. The User/Group picker closes and the selection appears in the To field.
      e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
      f. Click Add.
      g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
      - Cancel New User — this action sends the record to the End step in Canceled status.
  5) When ready, click Send.

Viewing a New User Request on the End Step

This is the last step in the workflow. You cannot take action on this step. All form fields are read-only and the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.

- To view a Vendor Prequal Requests record on the End step
  1) Go to the Company Workspace tab and click Company Logs in the left Navigator. The Navigator shows a list of the business processes that reside at the company level.
  2) Click New User Requests. Unifier opens the log in the right pane.
     When the record is on the End step, Task Details displays the text "Record has been closed."
3) Click the "Click here" link in Task Details to open the Workflow Progress Window. In the Progress Window you can see that the record is on the End step, as well as retrace the record's path in the workflow.

4) Click **View Graphic** to see an image of the workflow.
**Payment Applications Business Process**

**Purpose**
The Payment Applications business process is used in procurement processes to request payment on Total Commitments (approved Contract and Change Orders). Each Payment Applications record:
- References a specific Contracts record
- Displays a ledger of that contract's payment and retainage information
- Updates that contract’s schedule of values (SOV)

**Business process characteristics**
The Payment Applications business process is a cost-type business process that includes an approval workflow. Approved data from this business process rolls up to the project cost sheet, updates the schedule of values, and triggers funding consumption. An individual help file is available for this business process.

**Record Statuses**
- Pending, a non-terminal status.
- Approved, a terminal status
- Rejected, a terminal status.
- Canceled, a terminal status.

**Groups associated with this business process:**
- Members of the **Creators** group can create and edit this business process.
- Members of the **Reviewer** group can review and approve this business process
- Members of the **All Project Users** group can receive a copy of the business process record in their **Collaboration > Messages** logs.

**Relationships associated with this business process**
The record creator must associate it with a contract.

**Additional Information**
- The Payment Application schedule of values is available after association with a contract.
- The Payment Application business process shows an abridged cost sheet on the Upper form.
- **Cost Rules:** A budget line item cannot be reduced below $0.
- **Step completion policy and resolving actions can differ between steps.**
- The Payment Application business process is enabled for smart phones and other hand held devices.
- The Payment Application business process is enabled for custom print.
- Enabled for integration.
- Enabled for publish path.
Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log. 

**Benefits**

In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

**Location**

To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

- Enabled for custom print.

**Print using a custom layout**

Custom printing can be used with templates created in Microsoft Word and PDF format. Depending on the template used for custom print, you can print the upper form, the current workflow step, comments and attachments of the record. The template may also allow printing of specific line items in their tabs. The printed output will list the name of the table with the line items following on separate lines.

**Note**: In Unifier 9.14 release, a specific Custom Print template has been added to the Payment Applications Business Process.

To print a business process form with a custom print layout, do the following:

1. Open the business record that you want to print.
2. From the File menu, select **Print Preview > Custom**.
3. Click **Save**.

**Note**: When opening a business Process form that includes fields that are auto-populated, or automatically updated, the system considers these automatic updates as changes and requires that you Save the work.

**In This Section**

Payment Applications Workflow ................................................................. 291
Creating a Payment Applications Record .................................................. 291
Routing a Payment Applications Record from the Approval Step ............ 297
Routing a Payment Applications Record from the Revision Step .......... 298
Viewing a Payment Applications Record on the End Step .................. 299
Payment Applications Workflow

Below are the four steps of the Payment Applications workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Pay App" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the assignee.

Creating a Payment Applications Record

The first step in the Payment Applications business process workflow is the Creation step. Members of the Creator group can create this business process.

- **To create a new Payment Applications record**
  1. Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.
  2. Double-click your project to open it.
  3. On your project landing page, navigate to the Collaboration > Tasks log
  4. Click New and select Payment Applications from the drop-down menu. A new Payment Applications business process form opens.
  5. Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in your Collaboration > Drafts folder.
6) In the **Line Items** section either click **Add** or **Grid**. The Line Items List opens.
7) Complete the Line Items list according to the Line Items table below. You must complete all required fields before you can save the Line Items form.
8) Click **OK** (if using the Line Item form), or **Save** (if using the grid) to save the form. The Line Items form closes.
   - If you are using the grid and do not click Save before closing it, you will lose your line item changes.
   - The SOV structure is derived from the Payment Applications detail form.
9) Complete the Line Items form according to the Line Items table below. You must complete all required fields before you can save the Line Items Grid.
10) Click **OK** to save the Line Items.
11) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This selection activates **Action Details**.
12) In **Action Details**, select who should receive the record.
   a. Click **To**... The **User/Groups** picker opens that shows a list of available task recipients.
   b. Select the user or group who will receive the task on the **Approval** step.
   c. Click **Add**.
   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipients **Collaboration > Tasks** log.
   e. (Optional) Click **Cc**... and follow steps a - d. The record will appear in the recipients **Collaboration > Messages** log.
13) Click **Send** to route the record to the **Approval** step.

### Upper Form

<table>
<thead>
<tr>
<th><strong>In this field</strong></th>
<th><strong>Do this</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td><strong>Record Number</strong></td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td><strong>Project Number</strong></td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td><strong>Project Name</strong></td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td><strong>Transaction Currency</strong></td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td><strong>Rate in Project Currency</strong></td>
<td>Unifier auto-calculates the rate. Currency conversions use the exchange rate defined in the active Exchange Rates set in Unifier's Standards &amp; Libraries. Unless you modify a currency rate, Unifier uses the last active rate for that currency.</td>
</tr>
<tr>
<td><strong>Creator</strong></td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the record to the next step in the routing.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date shows when the record is due, based on the business process setup. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items.</td>
</tr>
<tr>
<td>Project Currency Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in project currency.</td>
</tr>
</tbody>
</table>

**Contract Information block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract/PO*</td>
<td>This is a required field - Select the reference contract. This selection drives contract-related field values.</td>
</tr>
<tr>
<td>Contract No</td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td>Contract Type</td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td>Priority</td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td>Vendor ID</td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td>Contract Title</td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td>Contract Date</td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td>Expiry Date</td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>This field is auto-populated from the contract.</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
</tbody>
</table>

**Payment Application block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Pay App No.*</td>
<td>This is a required field - Enter the vendor payment application number.</td>
</tr>
<tr>
<td>Invoice Date*</td>
<td>This is a required field - Use the calendar icon to select the date of the invoice.</td>
</tr>
<tr>
<td>Payment Due Date*</td>
<td>This is a required field - Use the calendar icon to select the date of the invoice.</td>
</tr>
<tr>
<td>Work Retainage %</td>
<td>Enter the amount to retain from each payment. The Payment Applications SOV tracks retainage.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Check No</td>
<td>This field is read only until the record reaches the End step, where you can manually enter the check number.</td>
</tr>
<tr>
<td>Check Processed Date</td>
<td>This field is read only until the record reaches the End step, where you can manually enter the check processed date.</td>
</tr>
<tr>
<td>Check Date</td>
<td>This field is read only until the record reaches the End step, where you can manually enter the check date.</td>
</tr>
<tr>
<td>Original Contract Amount</td>
<td>Unifier auto-populates this value based on the contract selection.</td>
</tr>
<tr>
<td>Net Changes by Change Orders</td>
<td>Unifier auto-populates this value based on net changes to change order amounts (additions and reductions).</td>
</tr>
<tr>
<td>Revised Contract Amount</td>
<td>Unifier auto-populates this value based on the formula: Original Contract Amount + Net Changes by Change Orders</td>
</tr>
<tr>
<td>Total Work Completed</td>
<td>Unifier auto-populates this amount based on the sum of line item entries from this business process.</td>
</tr>
<tr>
<td>Total Retainage</td>
<td>Unifier auto-populates this amount based on the sum of line item entries from this business process.</td>
</tr>
<tr>
<td>Total Earned Less Retainage</td>
<td>Unifier auto-populates this amount based on the sum of line item entries from this business process.</td>
</tr>
<tr>
<td>Total Previous Payments</td>
<td>Unifier auto-populates this amount based on the sum of line item entries from this business process.</td>
</tr>
<tr>
<td>Current Payment Due</td>
<td>Unifier auto-populates this value based on the line item amount, less retainage.</td>
</tr>
<tr>
<td>Balance to Finish Plus Retainage</td>
<td>Unifier auto-populates this amount based on the sum of line item entries from this business process.</td>
</tr>
<tr>
<td><strong>Change Order Details block</strong></td>
<td></td>
</tr>
<tr>
<td>Add Change Orders</td>
<td>Unifier calculates the value of this field based on a query defined in Configuration.</td>
</tr>
<tr>
<td>Previous Add Change Orders</td>
<td>Unifier calculates the value of this field based on a query defined in Configuration.</td>
</tr>
<tr>
<td>This Period Add Change Orders</td>
<td>Unifier calculates the value of this field based on a query defined in Configuration.</td>
</tr>
<tr>
<td>Deduct Change Orders</td>
<td>Unifier calculates the value of this field based on a query defined in Configuration.</td>
</tr>
<tr>
<td>Previous Deduct Change Orders</td>
<td>Unifier calculates the value of this field based on a query defined in Configuration.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>This Period Deduct Change Orders</td>
<td>This is a read-only field. The value is calculated using the formula: Deduct Change Orders&lt;uconApvdDeductChgQE&gt; - Previous Deduct Change Orders&lt;uconPrvApvdDeductChgQE&gt;</td>
</tr>
</tbody>
</table>

**Vendor Information block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 1</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Address 3</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>State/Province</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Email</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Phone</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Fax</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Minority-owned Business</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Woman-owned Business</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
<tr>
<td>Disadvantage-owned Business</td>
<td>This field is auto-populated from the Vendor record associated with the Contract.</td>
</tr>
</tbody>
</table>

**Item Logs**

**Line Items Tab**
<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
<tr>
<td>Code Name</td>
<td>The code name is auto-populated from the cost code.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item.</td>
</tr>
<tr>
<td>Description</td>
<td>This is not a required field - Enter a description for the line item.</td>
</tr>
<tr>
<td>Commit Short Description</td>
<td>Enter a short description for the commitment.</td>
</tr>
<tr>
<td>Work Package</td>
<td>You can select a Work Package.</td>
</tr>
<tr>
<td><strong>Payment Application block</strong></td>
<td></td>
</tr>
<tr>
<td>Scheduled Value</td>
<td>Unifier calculates the schedule value based on the formula (approved contract + approved change orders) for that contract.</td>
</tr>
<tr>
<td>Previous Work Completed</td>
<td>Unifier carries forward the value from previous Payment Applications records.</td>
</tr>
<tr>
<td>Work Completed (This Period)</td>
<td>Enter a value for the amount of work completed, (based on a portion, or all, of Item Quantity).</td>
</tr>
<tr>
<td>Total Work Completed</td>
<td>Unifier calculates this value based on the formula (Previous Work Completed + Work Completed (This Period))</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>Unifier calculates this value based on the formula (Total Work Completed / Scheduled Value )*100</td>
</tr>
<tr>
<td>Balance To Finish</td>
<td>Unifier calculates this value based on the formula (Scheduled Value - Total Work Completed)</td>
</tr>
<tr>
<td>Previous Retainage</td>
<td>Unifier carries forward the value from previous Payment Applications records.</td>
</tr>
<tr>
<td>Work Retainage%</td>
<td>Unifier auto-populates this field from the Upper form of this record.</td>
</tr>
<tr>
<td>Retainage (This Period)</td>
<td>Unifier calculates the period retainage value based on the formula ((Work Completed (This Period) * Work Retainage%)/100)</td>
</tr>
<tr>
<td>Retainage Released</td>
<td>Enter a value for the amount of retainage paid on this cost code.</td>
</tr>
<tr>
<td>Total Retainage</td>
<td>Unifier calculates the total retainage value based on the formula (Previous Retainage + Retainage (This Period) - Retainage Released)</td>
</tr>
</tbody>
</table>
### Primavera Cost Controls (PCC)

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Earned Less Retainage</td>
<td>Unifier calculates the total earned less retainage value based on the formula (Total Work Completed - Total Retainage)</td>
</tr>
<tr>
<td>Total Previous Payments</td>
<td>Unifier auto-populates this value from the upper form of this record.</td>
</tr>
<tr>
<td>Current Payment Due</td>
<td>Unifier calculates the currently due payment based on the formula (Total Earned Less Retainage - Total Previous Payments)</td>
</tr>
<tr>
<td>Balance to Finish plus Retainage</td>
<td>Unifier calculates the balance-to-finish-plus-retainage value based on the formula (Scheduled Value - Total Earned Less Retainage)</td>
</tr>
<tr>
<td>Total Payments</td>
<td>Unifier calculates the total payments value based on the formula (Total Previous Payments + Current Payment Due)</td>
</tr>
</tbody>
</table>

### Routing a Payment Applications Record from the Approval Step

**To route a record from the Approval step**

1. Navigate to the **All Projects** tab and select your project from the Projects log located near the bottom of the landing page.
2. Double-click your project to open it.
3. On your project landing page, navigate to the **Collaboration > Tasks** log
4. The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in bold red font are late.
5. Double click on the **Payment Applications** task in the Tasks log. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section indicates who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.
6. When ready, click **Accept Task**. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.
7. Review the Payment Applications record and determine the appropriate course of action.
8. In the toolbar at the top right of the form, click the **Workflow Actions** drop-down menu. You may select:
   - **Approve Pay App** — this selection will send the record to the End step in **Approved** status.
   - **Send for Revision** — this action keeps the workflow in flight and in **Pending** status.
a. In the **Action Details** section To... is preassigned, but you can select message recipients in the Cc field.
b. Click Cc... Select the user or group who will receive the record on the next step.
c. Click Add.
d. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - **Reject Pay App** — this selection will send the record to the End step in Rejected status.

9) (Optional) Add comments to the record through General Comments or Task Notes.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.

10) Click Send.

---

**Routing a Payment Applications Record from the Revision Step**

Upon sending the business process form forward to the Revision step, Unifier sends a task to the record creator and a message to those selected in the Cc field. You can see your active tasks in your Tasks log.

- **To route a record from the Revision step**

  1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
  2) Double-click your project to open it.
  3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Tasks that you have not yet accepted are bold.
  4) In your Tasks log, double-click the task to open it. The business process form opens for viewing; you must accept the task before you can act on it.

   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.

   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

  5) Click the Accept Task button. The form dynamically changes to an Action Form.

  6) In the Upper form section you can change the following record details.

   - In the General block, you can revise the record Title.
   - In the Contract Information block, fields are read-only.
   - In the Vendor Information block, all fields are read-only and come from the vendor selected on the contract.
   - In the Payment Application block, you can edit Vendor Pay App No, Invoice Date, Payment Due Date, and Retainage %.

  7) In the Line Items section you can modify or delete line items. Changes to line items dynamically update fields in the Upper form's Payment Application block and the Payment Applications SOV.
8) When ready, select a workflow action. This action activates **Action Details**. The choices are:

- **Resubmit for Approval** — This action sends the record back to the Approval step in Pending status.
  a. Click **To**. The **User/Groups** picker opens and displays a list of available task recipients.
  b. Select the user or group who will receive the task when the record returns to the **Approval** step.
  c. Click **Add**.
  d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field.
  e. (Optional) Click **Cc**. Select the user or group who will receive the record on the next step.
  f. Click **Add**.
  g. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.

- **Cancel Pay App** — This action sends the record to the **End** step in Canceled status. The **To** and **Cc** field are unavailable.

9) In **Action Details**, depending upon the workflow action selection, select who should receive the task and who should be copied on the action.

10) When ready, click **Send**.

---

**Viewing a Payment Applications Record on the End Step**

This is the last step in the workflow. Once on the **End** step the record is viewable only in the business process log.

- **To view a record on the End step**
  1) Navigate to the **All Projects** tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
  2) Navigate to **Cost Controls > Payment Applications**. The Payment Applications log opens.
  3) Double-click a record to open it. From the End step you can:
   a. Enter the **Check No**.
   b. Select the **Check Processed Date** using the calendar icon or manually in dd/mm/yyyy format.
   c. Select the **Check Date** using the calendar icon or manually in dd/mm/yyyy format.
   d. Click **Save** to retain changes.
  4) In Task Details you can see the record status and the text "Record has been closed."
  5) Click the "**Click here**" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.
  6) Click **View Graphic** to see an image of the workflow.
  7) Click **SOV** to see the schedule of values.
Payments Business Process

Purpose
You can use a Payments record to record check number, check processing date, and check date information from an Invoices record or a Payment Applications record. The Payments record becomes like a "mini data base."

Business process characteristics
Payments is a non-workflow, project-level, line item-type business process. You can create multiple payments records for your company because this is a non-workflow business process, you access a Payments record in the business process log. Integration is defined for Upper and Detail forms, which means you can create a Payments integration file to batch upload financial system records. An individual help file is available for this business process.

Record Statuses
- Pending, which is a non-terminal status
- Closed, which is a terminal status. If you click Finish Editing while the record is in closed status, the record is permanently closed and can never be opened again.

Groups associated with this business process
Members of the Company Administrators group can create and edit this business process.

Additional Information
- Can be used for both Payment Application and Invoice payments.
- Enabled for mobile and hand-held devices.
- The Administrator can upload the business process help file.
- Enabled for integration.
- Enabled for publish path.
Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finish Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**In This Section**

Creating a Payments Record ................................................................. 302  
Adding Line Items to the Payment Record ............................................. 304  
Saving the Payments Record .................................................................. 305  

**Creating a Payments Record**

Members of the following groups can create and edit this business process:

- Creator
- Project Administrator
- Reviewer

To create a new Payments record

1) Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Cost Controls folder > Payments. The Payments log opens.
5) Complete the Upper form according to the Upper form table below. You must enter a Title before you can save, and thereby create a permanent Payments record.
6) In the Line Items section click Add or Grid. The Line Items form opens.
7) Complete the Line Items form according to the Line Items table in Adding Line Items to the Payment Record (on page 304). You must complete all required fields on each line that you entered before you can save the Line Items form.

**Upper Form**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you click Send.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Transaction Currency</td>
<td>This field is auto-populated.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rate in Project Currency</td>
<td>Unifier auto-calculates this value. Currency conversions use the exchange rate defined in the active Exchange Rates set in Unifier's Standards &amp; Libraries. Until you modify a currency rate, Unifier uses the last active rate for that currency.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates upon record creation.</td>
</tr>
<tr>
<td>Record Last Update Date</td>
<td>This is a read-only field that shows the last time the someone updated the record.</td>
</tr>
<tr>
<td>Status</td>
<td>This is a required field - select the status of the Payments record. The choices are Pending and Closed. Note: If you select Closed status and click Finish Editing, the record will be permanently closed.</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items.</td>
</tr>
<tr>
<td>Project Currency Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in project currency. Currency conversions use the exchange rate defined in the active Exchange Rates set in Unifier's Standards &amp; Libraries. Until you modify a currency rate, Unifier uses the last active rate for that currency.</td>
</tr>
</tbody>
</table>

**Description block**

**Description**
Enter a description for the payment.

**PO Information block**

Note: the PO Information block allows you to select an Invoices record or a Payment Applications record as the payment reference. The table that follows presents **Invoices** first, then **Payment Applications**.

**Invoices Selection**

<table>
<thead>
<tr>
<th>Invoice</th>
<th>This selection allows you to choose the reference Invoices record.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Number</td>
<td>Purchase order number is auto-populated from the selected Invoices record.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>Invoice date is auto-populated from the selected Invoices record.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority is auto-populated from the selected Invoices record.</td>
</tr>
</tbody>
</table>
### Adding Line Items to the Payment Record

The record must be in Edit mode to enter line items.

**To enter line items**

1. Click **Edit** if the Payments record is in read-only mode.
2. In the **Line Items** section click **Add** or **Grid**. The Line Item form opens.
3. Complete the Line Item form according to the Line Item table below. You must complete all required fields on each line that you enter before you can save the Line Item.
4. Click **Save** (if using the grid) or **OK** (if using the Line Item form) to save the form. The Line Items form closes.

   If you are using the grid and do not click **Save** before closing it, you will lose your line item changes.

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check No</td>
<td>Check number is auto-populated from the selected Invoices record.</td>
</tr>
<tr>
<td>Check Processed Date</td>
<td>Check processed date is auto-populated from the selected Invoices record.</td>
</tr>
<tr>
<td>Check Date</td>
<td>Check date is auto-populated from the selected Invoices record.</td>
</tr>
<tr>
<td>Payment Application Selection</td>
<td>This selection allows you to choose the reference Payment Applications record.</td>
</tr>
<tr>
<td>Contract No</td>
<td>Contract number is auto-populated from the selected Payment Applications record.</td>
</tr>
<tr>
<td>Invoice Date</td>
<td>Invoice date is auto-populated from the selected Payment Applications record.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority is auto-populated from the selected Payment Applications record.</td>
</tr>
<tr>
<td>Check No</td>
<td>Check number is auto-populated from the selected Payment Applications record.</td>
</tr>
<tr>
<td>Check Processed Date</td>
<td>Check processed date is auto-populated from the selected Payment Applications record.</td>
</tr>
<tr>
<td>Check Date</td>
<td>Check date is auto-populated from the selected Payment Applications record.</td>
</tr>
</tbody>
</table>

**Line Item Table**

| General block |
### General block

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Code*</td>
<td>Enter the cost code for this line item.</td>
</tr>
<tr>
<td>Code Name</td>
<td>This field is auto-populated from the cost code.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the payment amount for this cost code.</td>
</tr>
</tbody>
</table>

### Saving the Payments Record

- **To save the Payments record**

Click either:

- **Finish Editing** to save the form in read-only mode.
  - If the record status is Pending, you can return the record to Edit mode and modify the Upper form and Line Items form fields.
  - If the record status is Closed, the record is permanently read-only.
- **Save** to leave the form in edit mode.
PO Amendments Business Process

Purpose
You can use the PO Amendments business process to make a formal commitment change to a Purchase Order. You can see the change impact in the project's cost sheet.

Business process characteristics
This is a project-level, Cost-type business process with line items and workflow. The PO Amendments business process uses the General Spends schedule of values. An individual help file is available for this business process.

Record Statuses
- Pending, a non-terminal status.
- Approved, a terminal status
- Rejected, a terminal status.
- Canceled, a terminal status.

Groups associated with this business process
- Members of the Creators group can create the PO Amendments business process and send it for approval.
- Members of the Reviewers group can approve the business process 'as is,' send it to the Revision step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the change order.
- Members of All Project Users can receive Cc records and be added as assignees.

Relationships associated with this business process
- The Creator must select a Purchase Order.
- The business process auto-populates vendor information from the contract vendor selection.

Additional Information
- The General Spends SOV becomes available upon association with a Purchase Orders record during record creation.
- Enabled for mobile devices.
- Enabled for integration.
- Enabled for publish path.
  Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section
PO Amendments Workflow ................................................................. 308
Creating a PO Amendments Record ............................................... 309
Routing a PO Amendment Record from the Approval Step .............. 312
Routing a PO Amendment Record from the Revision Step ............. 314
Viewing a PO Amendment Record on the End Step ....................... 315

PO Amendments Workflow
Below are the four steps of the PO Amendments workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel PO Amendment" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the assignee.
Creating a PO Amendments Record

The first step in the PO Amendments business process workflow is the Creation step. Members of the **Creator** group can create this business process.

**To create a new Change Orders record**

1) Navigate to the **All Projects** tab and select your project from the list located on the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the **Collaboration > Tasks** log
4) Click **New** and select **PO Amendments** from the drop-down menu. A new PO Amendments business process form opens.
5) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in the **Collaboration > Drafts** folder.
6) In the **Line Items** section either click **Add** or **Grid**. The Line Items form or grid opens.
7) Enter Line Items according to the Line Items table below. You must complete all required fields before you can save the Line Items form.
8) Click **OK** (if using the Line Item form), or **Save** (if using the grid) to save the form. The Line Items form closes.
   If you are using the grid and do not click Save before closing it, you will lose your line item changes.
9) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This selection activates **Action Details**.
10) In **Action Details**, select who should receive the record.
   a. Click **To**... The **User/Groups** picker opens that shows a list of available task recipients.
b. Select the user or group who will receive the task on the Approval step.
c. Click **Add**.
d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipients **Collaboration > Tasks** log.
e. (Optional) Click **Cc...** and follow steps a - d. The record will appear in the recipients **Collaboration > Messages** log.

11) Click **Send** to route the record to the **Approval** step.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Record Number</strong></td>
<td>This is a read-only field that Unifier populates when you send the form to the Approval step.</td>
</tr>
<tr>
<td><strong>Title</strong>*</td>
<td>This is a required field - Enter a title for the record.</td>
</tr>
<tr>
<td><strong>Project Number</strong></td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td><strong>Project Name</strong></td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td><strong>Contract/PO</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Transaction Currency</strong></td>
<td>This is a read-only field that is auto-populated when you select the contract.</td>
</tr>
<tr>
<td><strong>Rate in Project Currency</strong></td>
<td>Currency conversions use the exchange rate defined in the active Exchange Rates set in Unifier's Standards &amp; Libraries. Until you modify a currency rate, Unifier uses the last active rate for that currency.</td>
</tr>
<tr>
<td><strong>Creator</strong></td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td><strong>Creation Date</strong></td>
<td>This is a read-only field that Unifier populates when you send the record to the next step in the routing.</td>
</tr>
<tr>
<td><strong>Due Date</strong></td>
<td>The Due Date is pre-populated from the workflow setup and reflects the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td><strong>Amount</strong></td>
<td>This is an auto-calculated field that shows the total amount of the line items.</td>
</tr>
<tr>
<td><strong>Project Currency Amount</strong></td>
<td>This is an auto-calculated field that shows the total amount of the line items in project currency.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>PO Information block</strong></td>
<td></td>
</tr>
<tr>
<td>PO Number</td>
<td>This field is auto-populated from the selected Purchase Order record.</td>
</tr>
<tr>
<td>Effective Date</td>
<td>This field is auto-populated from the selected Purchase Order record.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>This field is auto-populated from the selected Purchase Order record.</td>
</tr>
<tr>
<td>Contract Description</td>
<td>This field is auto-populated from the selected Purchase Order record.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>This field is auto-populated from the selected Purchase Order record.</td>
</tr>
<tr>
<td><strong>Vendor Information block</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor ID</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>Address 1</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>Address 3</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>State/Province</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>Email</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
<tr>
<td>Phone</td>
<td>This field is auto-populated from the Vendor record associated with the selected Purchase Order record.</td>
</tr>
</tbody>
</table>
In this field | Do this
---|---
Fax | This field is auto-populated from the Vendor record associated with the selected Purchase Order record.

**Item Logs**

*Line Items Tab*

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Block</strong></td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td>This is not a required field, but a helpful one. You can select a Purchase Order line item that you want to amend and the cost code information will populate the Cost Code field, the Code Name field, and the Short Description field.</td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
<tr>
<td>Code Name</td>
<td>This read-only field is auto-populated from the cost code name.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item</td>
</tr>
<tr>
<td>Description</td>
<td>You can enter a description for the line item.</td>
</tr>
<tr>
<td><strong>Spend Category block</strong></td>
<td></td>
</tr>
<tr>
<td>Spend Category</td>
<td>Select the category from the drop-down menu.</td>
</tr>
<tr>
<td>Work Package</td>
<td>You can select a Work Package.</td>
</tr>
<tr>
<td>Item Quantity*</td>
<td>This is a required field - Enter the number of items specified on the line item</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Select the Unit of Measure for the item specified on the line item</td>
</tr>
<tr>
<td>Item Unit Cost*</td>
<td>This is a required field - Enter the price of the item specified on the line item</td>
</tr>
<tr>
<td>Amount</td>
<td>This read-only field is auto-calculated using the formula (Item Quantity X Item Unit Cost).</td>
</tr>
</tbody>
</table>

**Routing a PO Amendment Record from the Approval Step**

▶ To route a record from the Approval step

1) Navigate to the All Projects tab and select your project from the log located near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the **Collaboration > Tasks** log
4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in bold red font are late.
5) Double click on the **PO Amendment** task in the Tasks log. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.
6) When ready, click **Accept Task**. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.
7) Review the PO Amendment record and determine the appropriate course of action.
8) In the toolbar at the top right of the form, click the **Workflow Actions** drop-down menu. You may select:
   - **Approve PO Amendment** — this selection will send the record to the End step in **Approved** status.
   - **Send for Revision** — this action keeps the workflow in flight and in **Pending** status.
   a. In the **Action Details** section **To...** is preassigned, but you can select message recipients in the **Cc** field.
   b. Click **Cc...** Select the user or group who will receive the record on the next step.
   c. Click **Add**.
   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.
   - **Reject PO Amendment** — this selection will send the record to the End step in **Rejected** status.
9) (Optional) Add comments to the record through **General Comments** or **Task Notes**.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.
10) Click **Send**.
Routing a PO Amendment Record from the Revision Step

Upon sending the business process form forward to the Revision step, Unifier sends a task to the record creator and a message to those selected in the Cc field. You can see your active tasks in your Tasks log.

To route a record from the Revision step
1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold.
4) In your Tasks log, double-click the task to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   a. The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
   b. The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
   c. The SOV button shows you the Schedule of Values for the selected Purchase Order.
5) Click the Accept Task button. The form dynamically changes to an Action Form.
   In the Upper form you can change the record Title in the General block.
   In Line Items you can:
      a. Modify any existing line items
      b. Add additional line items
      c. Remove Line Items.
   Follow the same directions as adding line items during record creation, then click OK to save any line item changes.
6) When ready, select a workflow action. This action activates Action Details. The choices are:
   a. Resubmit for Approval — This action sends the record back to the Approval step in Pending status.
      a. Click To... The User/Groups picker opens and displays a list of available task recipients.
      b. Select the user or group who will receive the task when the record returns to the Approval step.
      c. Click Add.
      d. Click OK. The User/Group picker closes and the selection appears in the To field.
      e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
      f. Click Add.
      g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   b. Cancel PO Amendment — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.
7) In Action Details, depending upon the workflow action selection, select who should receive the task and who should be copied on the action.
8) When ready, click **Send**.

---

**Viewing a PO Amendment Record on the End Step**

This is the last step in the workflow. You cannot take action on this step because the record is in a terminal status: Approved, Rejected, or Canceled. Once on the **End** step the record is viewable only in the business process log.

- **To view a record on the End step**
  1) Navigate to the **All Projects** tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
  2) Navigate to **Cost Controls > PO Amendments**. The PO Amendments log opens.
  3) Double-click a record to open it. In the record you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."
  4) Click the "**Click here**" link. The Workflow Progress window opens. This is where you can trace the record’s progress through the workflow.
  5) Click **View Graphic** to see an image of the workflow.
  6) Click **SOV** to see the schedule of values.
Potential Change Orders Business Process

Purpose
A contractor can use this business process to initiate a potential change order.

Business process characteristics
This is a project-level, Cost-type business process with line items and workflow. It does not use an SOV. An individual help file is available for this business process.

Record Statuses
- Pending, a non-terminal status
- Approved, a terminal status
- Rejected, a terminal status
- Canceled, a terminal status

Groups associated with this business process
- Members of the Creators group can create the Potential Change Orders business process and send it for approval.
- Members of the Reviewers group can approve the business process 'as is,' send it to the Revision step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the potential change order.
- Members of All Project Users and be added as message recipients

Relationships associated with this business process
The record creator must select a vendor.

Additional Information
- Enabled for mobile devices.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section

Potential Change Orders Workflow ............................................................. 318
Creating a Potential Change Orders Record .............................................. 318
Routing a Potential Change Orders Record from the Approval Step .......... 322
Routing a Potential Change Orders Record from the Revision Step .......... 323
Viewing a Potential Change Orders Record on the End Step ................. 324

Potential Change Orders Workflow

Below are the four steps of the Potential Change Orders workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel PCO" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the assignee.

Creating a Potential Change Orders Record

The first step in the Contracts business process workflow is the Creation step. Members of the Creator group can create this business process.

- To create a new Contracts record

1) Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log
4) Click New and select Potential Change Orders from the drop-down menu. A new Potential Change Orders business process form opens.
5) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in the Collaboration > Drafts folder.
6) In the Line Items section either click Add or Grid. The Line Items List opens.
7) Complete the Line Items list according to the Line Items table below. You must complete all required fields before you can save the Line Items form.
8) Click OK (if using the Line Item form), or Save (if using the grid) to save the form. The Line Items form closes.
   If you are using the grid and do not click Save before closing it, you will lose your line item changes.
9) In Workflow Actions select the workflow action to take. In this case, your selection is Send for Approval. This selection activates Action Details.
10) In Action Details, select who should receive the record.
   a. Click To... The User/Groups picker opens that shows a list of available task recipients.
   b. Select the user or group who will receive the task on the Approval step.
   c. Click Add.
   d. Click OK. The User/Group picker closes and the selection appears in the To field. Upon sending, the record will appear in the recipients Collaboration > Tasks log.
   e. (Optional) Click Cc... and follow steps a - d. The record will appear in the recipients Collaboration > Messages log.
11) Click Send to route the record to the Approval step.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Transaction Currency</td>
<td>You can select the currency for the transaction if it is different from the project currency. The transaction currency must be active in the project.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rate in Project Currency</td>
<td>Unifier auto-calculates this value and displays it on the next step after the task is accepted. Currency conversions use the exchange rate defined in the active Exchange Rates set in Unifier's Standards &amp; Libraries. Until you modify a currency rate, Unifier uses the last active rate for that currency.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the record to the next step in the routing.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items.</td>
</tr>
<tr>
<td>Project Currency Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in project currency.</td>
</tr>
</tbody>
</table>

**Potential CO Information block**

| Spec Section                 | Select a value from the field drop-down menu.                                                                                                                                                         |
| Description                  | Enter a description for the potential change order.                                                                                                                                                   |
| Current Contract Completion Date* | This is a required field - Either enter a date (dd/mm/yyyy) or use the calendar icon to select a date.                                                                                                    |
| Schedule Impact (Days)*      | This is a required field - Enter the number of days this potential change order could affect the schedule.                                                                                               |
| Priority                     | Select the priority from the drop-down menu.                                                                                                                                                           |
| Required Date                | Either enter a date (dd/mm/yyyy) or use the calendar icon to select a date.                                                                                                                             |
| Revised Contract Completion Date | This field is auto-calculated based on the current contract completion date + the schedule impact days.                                                                                                   |

**Scope of Change block**

| Reason*                      | This is a required field - Select a reason for the change from the drop-down menu.                                                                                                                      |
### In this field | Do this
---|---
Change Reason* | This is a required field - Enter a detailed reason, up to 4000 characters, for the potential change order.
Scope of Work* | This is a required field - Enter a detailed scope of work, up to 4000 characters, for the potential change order.

### Vendor Information block

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor*</td>
<td>This is a required field - Select a Vendor from the drop-down menu.</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Address 1</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Address 3</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>State/Province</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Email</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Phone</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Fax</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Minority-owned Business</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Woman-owned Business</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Disadvantage-owned Business</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
</tbody>
</table>

### Item Logs

**Line Items Tab**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Block</strong></td>
<td></td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
<tr>
<td>Code Name</td>
<td>This read-only field is auto-populated from the cost code name.</td>
</tr>
</tbody>
</table>
### In this field | Do this
---|---
Short Description* | This is a required field - Enter a brief description of the item specified on the line item
Description | This is not a required field - Enter a description for the line item.
Spend Category block
Spend Category | Select the category from the drop-down menu.
Work Package | You can select a Work Package.
Item Quantity* | This is a required field - Enter the number of items specified on the line item
Unit of Measure | Select the Unit of Measure for the item specified on the line item
Item Unit Cost* | This is a required field - Enter the price of the item specified on the line item
Amount | This read-only field is auto-calculated using the formula Item Quantity X Item Unit Cost.

### Routing a Potential Change Orders Record from the Approval Step

To route a Potential Change Orders record from the Approval step

1) Navigate to the All Projects tab and select your project from the log located near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log
4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in bold red font are late.
5) Double click the Potential Change Orders task in the Tasks log. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.
6) When ready, click Accept Task. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add Task Notes for the next step, but you cannot view previous Task Notes.
If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.

7) Review the Potential Change Orders record and determine the appropriate course of action.

8) In the toolbar at the top right of the form, click the Workflow Actions drop-down menu. You may select:
   - Approve PCO — this selection will send the record to the End step in Approved status.
   - Send for Revision — this action keeps the workflow in flight and in Pending status.
     a. In the Action Details section To... is preassigned, but you can select message recipients in the Cc field.
     b. Click Cc... Select the user or group who will receive the record on the next step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - Reject PCO — this selection will send the record to the End step in Rejected status.

The Action Details section changes according to the workflow action selection.

9) (Optional) Add comments to the record through General Comments or Task Notes.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.

10) Click Send.

Routing a Potential Change Orders Record from the Revision Step

Upon sending the business process form forward to the Revision step, Unifier sends a task to the record creator and a message to those selected in the Cc field. You can see your active tasks in your Tasks log.

To route a record from the Revision step

1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold.
4) In your Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   - The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
   - The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
5) Click the Accept Task button. The form dynamically changes to an Action Form.
   - In the General block, you can revise the record Title.
In the *Potential CO Information* block, most fields are editable except Revised Contract Completion Date, which is auto-calculated based on the number of days of the schedule impact.

In the *Scope of Change* block, you can change the vendor selection.

In *Line Items* you can modify any existing line items, add additional line items, or remove them. Follow the same directions as adding line items during record creation.

6) In the *Line Items* section you can Modify/Add/Delete Line Items as needed. You must complete all required fields on each line before you can save the Line Items form.

7) Click **OK** to save the Line Items.

8) When ready, select a workflow action. This action activates Action Details. The choices are:
   - **Resubmit for Approval** — This action sends the record back to the Approval step in Pending status.
     a. Click To... The User/Groups picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the Approval step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the To field.
     e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
     f. Click Add.
     g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - **Cancel PCO** — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.

9) In *Action Details*, select who should receive the task and who should receive a copy of the record in Collaboration > Messages.

10) When ready, click **Send**.

### Viewing a Potential Change Orders Record on the End Step

This is the last step in the workflow. You cannot take action on this step because the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.

- **To view a record on the End step**
  1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
  2) Navigate to Cost Controls > Potential Change Orders. The Potential Change Orders log opens.
  3) Double-click a record to open it. In the record you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."
  4) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.
  5) Click View Graphic to see an image of the workflow.
Purchase Orders Business Process

Prerequisite

You must have budget assigned to a WBS/Cost Code in the project's cost sheet prior to creating a Purchase Orders record. Use a Budget Approvals business process record to allocate budget to the code. See Budget Approvals Business Process (on page 209)

Purpose

The Purchase Orders business process is used for commitments in procurement workflows. It uses a General Spends schedule of values (SOV) that does not track retention, whereas the Contracts business process uses a Payment Applications SOV that does track retention. You can use a Purchase Orders business process record to approve or deny approval for a commitment.

Business process characteristics

The Purchase Orders business process is a cost-type business process that includes a workflow and requires you to select a Vendor. In turn, PO Amendments, Invoices and Payments require Purchase Order selection. You can create more than one Purchase Order record in a project. The item logs section of the Purchase Orders record displays two query tabs, Amendments and Invoices. An individual help file is available for this business process.

Record Statuses

- Pending, a non-terminal status.
- Approved, a terminal status
- Rejected, a terminal status.
- Canceled, a terminal status.

Groups associated with this business process

- Members of the Creators group can create and edit this business process.
- Members of the Reviewer group can review and approve this business process
- Members of the All Project Users group can receive a copy of the business process record in their Collaboration > Messages logs.

Relationships associated with this business process

The record creator must select a vendor, PO Amendments and Invoices must pick a Purchase Order record.

Additional Information

- The Purchase Orders business process uses the General Spends schedule of values; the SOV becomes available on the end step.
- Enabled for smart phones and other hand held devices.
- Enabled for integration.
- Enabled for publish path.
Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section
Purchase Orders Workflow ................................................................. 326
Creating a Purchase Orders Record .................................................. 327
Routing a Purchase Orders Record from the Approval Step ............... 330
Routing a Purchase Orders Record from the Revision Step ............... 331
Viewing a Purchase Orders Record on the End Step ......................... 332

Purchase Orders Workflow
Below are the four steps of the Purchase Orders workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel PO" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the assignee.
Creating a Purchase Orders Record

The first step in the Purchase Orders business process workflow is the Creation step. Members of the Creator group can create this business process.

1. To create a new Contracts record
2. Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.
3. Double-click your project to open it.
4. On your project landing page, navigate to the Collaboration > Tasks log
5. Click New and select Purchase Orders from the drop-down menu. A new Purchase Orders business process form opens.
6. Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in your the Collaboration > Drafts folder.
7. In the Line Items section click Add or Grid. The Line Items List opens.
8. Complete the Line Items list according to the Line Items table below. You must complete all required fields before you can save the Line Items form.
9. Click OK (if using the Line Item form), or Save (if using the grid) to save the form. The Line Items form closes.
10. In Workflow Actions select the workflow action to take. In this case, your selection is Send for Approval. This selection activates Action Details.
11. In Action Details, select who should receive the record.
a. Click To... The User/Groups picker opens that shows a list of available task recipients.
b. Select the user or group who will receive the task on the Approval step.
c. Click Add.
d. Click OK. The User/Group picker closes and the selection appears in the To field. Upon sending, the record will appear in the recipients Collaboration > Tasks log.
e. (Optional) Click Cc... and follow steps a - d. The record will appear in the recipients Collaboration > Messages log.

11) Click Send to route the record to the Approval step.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Transaction Currency</td>
<td>You can select the currency for the transaction if it is different from the project currency. The transaction currency must be active in the project.</td>
</tr>
<tr>
<td>Rate in Project Currency</td>
<td>Unifier auto-calculates this value and displays it on the next step after you accept the task. Currency conversions use the exchange rate defined in the active Exchange Rates set in Unifier's Standards &amp; Libraries. Until you modify a currency rate, Unifier uses the last active rate for that currency.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the record to the next step in the routing.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is pre-populated from the workflow setup and reflects the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in transaction currency.</td>
</tr>
<tr>
<td>Project Currency Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in project currency. You will see this value on the next step.</td>
</tr>
</tbody>
</table>

**PO Information block**

<table>
<thead>
<tr>
<th>PO Number</th>
<th>Enter the purchase order number.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spec Section</td>
<td>Select a value from the field drop-down menu.</td>
</tr>
<tr>
<td>Contract Description</td>
<td>Enter a description for the contract.</td>
</tr>
<tr>
<td>count</td>
<td>This value is based on a query.</td>
</tr>
<tr>
<td>Effective Date</td>
<td>Enter the date on which the contract becomes effective.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>Enter the day the contract expires <em>dd/mm/yyyy</em> or click the calendar icon to select the date.</td>
</tr>
</tbody>
</table>

**Vendor Information block**

<table>
<thead>
<tr>
<th>Vendor*</th>
<th>This is a required field - Select a Vendor from the drop-down menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Name</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Address 1</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Address 3</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>State/Province</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Email</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Phone</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
<tr>
<td>Fax</td>
<td>This field is auto-populated from the Vendor record.</td>
</tr>
</tbody>
</table>

**Item Logs**

**Line Items Tab**
In this field | Do this
---|---
**General Block**
Cost Code* | This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.
Code Name | This read-only field is auto-populated from the cost code name.
Short Description* | This is a required field - Enter a brief description of the item specified on the line item.
Description | This is not a required field - Enter a description for the line item.

**Spend Category block**
Spend Category | Select the category from the drop-down menu.
Work Package | You can select a Work Package.
Item Quantity* | This is a required field - Enter the number of items specified on the line item.
Unit of Measure | Select the Unit of Measure for the item specified on the line item.
Item Unit Cost* | This is a required field - Enter the price of the item specified on the line item.
Amount | This read-only field is auto-calculated using the formula Item Quantity X Item Unit Cost.

**Amendments Tab**
Use to create a new record as well as view, copy, or find existing records.

**Invoices Tab**
Use to create a new record as well as view, copy, or find existing records.

**Routing a Purchase Orders Record from the Approval Step**

- **To route a record from the Approval step**
  1) Navigate to the All Projects tab and select your project from the log located near the bottom of the landing page.
  2) Double-click your project to open it.
  3) On your project landing page, navigate to the Collaboration > Tasks log
  4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in bold red font are late.
  5) Double click on the Contracts task in the Tasks log. The view-only form displays all fields on the record.
    - The Upper Form contains project information, including the record number and title.
6) When ready, click **Accept Task**. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.

7) Review the Purchase Orders record and determine the appropriate course of action.
8) In the toolbar at the top right of the form, click the **Workflow Actions** drop-down menu. You may select:
   - **Approve PO** — this selection will send the record to the End step in **Approved** status.
   - **Send for Revision** — this action keeps the workflow in flight and in **Pending** status.
     - a. In the **Action Details** section **To**... is preassigned, but you can select message recipients in the **Cc** field.
     - b. Click **Cc...** Select the user or group who will receive the record on the next step.
     - c. Click **Add**.
     - d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.
   - **Reject PO** — this selection will send the record to the End step in **Rejected** status.

9) (Optional) Add comments to the record through **General Comments** or **Task Notes**.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.

10) Click **Send**.

### Routing a Purchase Orders Record from the Revision Step

Upon sending the business process form forward to the **Revision** step, Unifier sends a task to the record creator and a message to those selected in the **Cc** field. You can see your active tasks in your **Tasks** log.

**To route a record from the Revision step**

1) Navigate to the **All Projects** tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the **Collaboration > Tasks** log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold.
4) In your Tasks log, double-click the task to open it. The business process form opens for viewing; you must accept the task before you can act on it.

The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.
The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

5) Click the Accept Task button. The form dynamically changes to an Action Form. In the Upper form you can:
   - Change the record Title in the General block
   - Edit any field in the Contract Information bloc
   - Change the vendor selection in the Contract Summary block

In Line Items you can:
   - Modify any existing line items
   - Add additional line items
   - Remove Line Items.

Follow the same directions as adding line items during record creation, then click OK to save any line item changes.

6) When ready, select a workflow action. This action activates Action Details. The choices are:
   - Resubmit for Approval — This action sends the record back to the Approval step in Pending status.
     a. Click To... The User/Groups picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the Approval step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the To field.
     e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
     f. Click Add.
     g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - Cancel PO — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.

7) In Action Details, depending upon the workflow action selection, select who should receive the task and who should be copied on the action.

8) When ready, click Send.

---

**Viewing a Purchase Orders Record on the End Step**

This is the last step in the workflow. You cannot take action on this step. Once on the End step the record is viewable only in the business process log.

*To view a record on the End step*

1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
2) Navigate to Cost Controls > Purchase Orders. The Purchase Orders log opens.
3) Double-click a record to open it. In the record you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."
4) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.
5) Click View Graphic to see an image of the workflow.
6) Click SOV to see the schedule of values.
Requests for Bid Business Process

Purpose
The Request for Bid (RFB) business process allows companies to invite bids from vendors and suppliers. You can solicit bids from a specific set of vendors, or you can open the bid to all of the vendors listed in the Vendors log, as long as the Vendor record contains a valid email address. Each bidder receives an email notification of the bid invitation and login credentials to a private and secure Unifier workspace from which he or she can submit a bid. The Unifier interface is highly simplified so it does not require training to use.

Business process characteristics
Requests for Bid is a project-level business process with line items and a work flow. It collects all bids in a bid comparison sheet to help you compare received bids. An individual help file is available for this business process.

Groups associated with this business process
- Members of the Creators group can create this business process.
- Members of the Creators and Reviewers group can edit this business process.
- Members of the All Project Users groups may receive copies of this business process.

Statuses
- Pending, a non-terminal status
- Approved, a terminal status
- Rejected, a terminal status
- Withdrawn, a terminal status
- Canceled, a terminal status

Additional Information
There must be a bid URL and bid manager defined in the company properties.
- Enabled for publish path.
  Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**In This Section**

- Requests for Bid Workflow ................................................................. 336
- Creating a Requests for Bids Record ................................................. 337
- Routing a Requests for Bid Record from the Bid Package Finalization Step ........ 340
- Routing a Requests for Bid Record from the Package Revision Step ............ 340
- Inviting Bidders to Submit a Bid ........................................................ 341
- Submitting a Bid ................................................................................. 342
- Comparing Vendors’ Bids ................................................................. 345

**Requests for Bid Workflow**

The Requests for Bid workflow involves creating a Requests for Bid (RFB) record, revising it if necessary, and inviting vendors and suppliers to bid on the project. The business process supports an internal review that you can use to verify the scope of the project, as well as other things, such as terms and conditions, architectural drawings, and structural materials. After you create the bid request you can route it for approval, or you can directly start the bidding process. Each vendor receives a Unifier URL and password that will open a private, secure workspace where the vendor can complete and submit the bid. Vendors have the option of requesting clarification for questions or issues before submitting the bid; they can use the uMail link on the bid request for this purpose.

Once you send bid invitations, you must wait until after the bid due date to evaluate any received bids. When the due date for the RFB is reached, you can compare bids using the Bid Comparison Sheet. You also have the option to open discussions about the bids.

When you are ready you can award the bid to a vendor.
Creating a Requests for Bids Record

Prerequisites

You must have a bid URL and a Bid Manager Account defined on the General tab of the company properties page.

The first step in the Requests for Bid business process workflow is the Creation step. Members of the Creator group can create this business process.

To create a new Requests for Bid record

1) Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.

2) Double-click your project to open it.

3) On your project landing page, navigate to the Collaboration > Tasks log.

4) Click New and select Requests for Bid from the drop-down menu. A new Requests for Bid business process form opens.

5) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in the Collaboration > Drafts folder.

6) In the Line Items section click Add or Grid. The Line Items form opens.

   - Line items provide a granular scope by cost codes.
   - The bid initiator creates line items which are the items the bidder is to bid on.

7) Complete the Line Items list according to the Line Items table below. You must complete all required fields before you can save the Line Items form.

8) Click OK (if using the Line Item form), or Save (if using the grid) to save the form. The Line Items form closes.

   If you are using the grid and do not click Save before closing it, you will lose your line item changes.

9) In Workflow Actions select the workflow action to take. In this case, your selection is Submit Bid Package. This selection activates Action Details.

10) In Action Details, select who should receive the record.

   a. Click To... The User/Groups picker opens that shows a list of available task recipients.

   b. Select the user or group who will receive the task on the Approval step.

   c. Click Add.

   d. Click OK. The User/Group picker closes and the selection appears in the To field. Upon sending, the record will appear in the recipients Collaboration > Tasks log.

   e. (Optional) Click Cc... and follow steps a - d. The record will appear in the recipients Collaboration > Messages log.

11) Click Send to route the record to the Approval step.

<table>
<thead>
<tr>
<th>Upper Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>In this field</td>
</tr>
<tr>
<td>General block</td>
</tr>
<tr>
<td>In this field</td>
</tr>
<tr>
<td>-------------------------------</td>
</tr>
<tr>
<td>Record Number</td>
</tr>
<tr>
<td>Title*</td>
</tr>
<tr>
<td>Project Number</td>
</tr>
<tr>
<td>Project Name</td>
</tr>
<tr>
<td>Due Date</td>
</tr>
<tr>
<td>Status</td>
</tr>
</tbody>
</table>

**Bid Package Details block**

<table>
<thead>
<tr>
<th>Bidders Count</th>
<th>This is a read only field. Initially the value is 0.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bid Count</td>
<td>This is a read only field. Initially the value is 0.</td>
</tr>
<tr>
<td>Bid Priority*</td>
<td>This is a required field - Select a value from the field's drop-down menu.</td>
</tr>
<tr>
<td>Bid Package Revision Number*</td>
<td>This is a required field - Enter the revision number of the bid package.</td>
</tr>
<tr>
<td>RFB Due Date*</td>
<td>This is a required field - Use the calendar icon to select the date the RFB is due.</td>
</tr>
<tr>
<td>Order Delivery Date*</td>
<td>This is a required field - Use the calendar icon to select the date a date for the order delivery.</td>
</tr>
<tr>
<td>Question Cut Off Date*</td>
<td>This is a required field - Use the calendar icon to select the cut off date for questions about the bid requirements.</td>
</tr>
<tr>
<td>Bid Sponsor</td>
<td>Select the bid sponsor from the list that becomes available when you click the Select button.</td>
</tr>
<tr>
<td>Sponsor Phone</td>
<td>Enter the sponsor's phone number</td>
</tr>
<tr>
<td>Sponsor Email</td>
<td>Enter the sponsor's email address</td>
</tr>
</tbody>
</table>

**Bid Scope block**

| Bid Scope                     | Enter a detailed description of the overall Bid Package and requirements. This will be visible to all Bidders.                           |

**Instructions block**

| Bid Package Instructions      | Enter detailed instructions to assist bidders in completion and submittal of Bid Package.                                              |

**Vendor Requirements block**
### In this field | Do this
---|---
Qualifications | Enter any qualifications or other criteria that needs to be satisfied by vendor in order for bid to be evaluated.
Certifications | Enter any required certifications.
Insurance | Enter the insurance qualifications that you expect the vendor to carry.

**Bidder Meeting Details**

| In this field | Do this |
---|---|
Location | Enter a where you can meet with the bidder; e.g., teleconference, virtual meeting space, or physical address. |
Date and Time | Enter a date and time for the meeting. |
Dial-in Instructions | Enter the instructions to call into the meeting. |

### Item Logs

**Line Items Tab**

| In this field | Do this |
---|---|
**General Block** |  |
Cost Code* | This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker. |
Short Description | This is a required field - Enter a brief description for the line item. |
Code Name | This read-only field is auto-populated from the cost code. |
Item Unit Cost* | This is a required field - Enter the price of the item specified on the line item. |
Item Quantity* | This is a required field - Enter the number of items specified on the line item. |
Unit of Measure | Select the Unit of Measure for the item specified on the line item. |
Amount | This read-only field is auto-calculated using the formula (Item Quantity X Item Unit Cost). |
Routing a Requests for Bid Record from the Bid Package Finalization Step

Upon sending the business process form forward to the Bid Package Finalization step, Unifier creates a permanent business process record and sends a task. A task assignee can see the task in the Tasks log. When working on the Bid Package Finalization step, first you accept the task, then when you are ready to do so, route the record to either the Package Revision step or directly to the Bid Invitation step.

To route a Requests for Bid record from the Approval step
1) Navigate to the All Projects tab and select your project from the list located near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log.
   The Tasks log lists all of your open tasks. Tasks in bold black are new; tasks in red are late. In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
4) Click the Accept Task button. The form dynamically changes to an Action Form.
   ▶ You can make changes to most fields in the Upper form. The only fields you cannot change are Record Number, Project Number, Project Name, Due Date, Status, Bidders count, and Bid Count.
   ▶ You can make changes to Line Items when you are on this step.
   ▶ You can add Task Notes for the next step, but you cannot view previous Task Notes.
   ▶ If you want to revisit Task Notes from the Creation step, you must undo Accept Task via Actions > Undo Accept Task.
5) When ready, select the workflow action Submit Revised Package.
   This action sends the record back to the Package Revision step. The To field is preassigned and you can Cc anyone listed in Users/Groups. You can add instructions to the task recipient using Task Notes.
6) In Action Details, select who should receive the record. To... is preassigned for both selections, but you can select message recipients in the Cc field.
   a. Click Cc... Select the user or group who will receive the record on the next step.
   b. Click Add.
   c. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
7) When ready, click Send.

Routing a Requests for Bid Record from the Package Revision Step

Upon sending the business process form forward to the Package Revision step, Unifier sends a task to the record creator and a message to those selected in the Cc field. You can see your active tasks in your Tasks log.
To route a Requests for Bid record from the Package Revision step

1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold black font.
4) In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.
   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
5) Click the Accept Task button. The form dynamically changes to an Action Form with most fields editable.
6) In the Line Items section you can Modify/Add/Delete Line Items as needed. You must complete all required fields on each line before you can save the Line Items form.
7) Click OK to save Line Items.
8) When ready, select a workflow action. The choice is:
   - Resubmit for Approval — This action sends the record back to the Approval step in Pending status.
     a. Click To... The User/Groups picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the Bid Package Finalization step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the To field.
     e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
     f. Click Add.
     g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - This action activates Action Details.
9) In Action Details, select who should receive the task and who should receive a copy of the record.
10) When ready, click Send.

Inviting Bidders to Submit a Bid

To invite a bidder to submit a bid

1) Navigate to the All Projects tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the **Collaboration > Tasks** log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold black font.

4) In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.

   The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.

   The **Task Status** link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

5) Click the **Accept Task** button. The form dynamically changes to an Action Form. Expect for fields in the General block, most of the Upper form fields are editable on this step.

6) In the **Line Items** section you can Modify/Add/Delete Line Items as needed. You must complete all required fields on each line before you can save the Line Items form.

7) Click **OK** to save Line Items.

8) In the Requestor block there are three required fields:
   - **Name** — Unifier auto-populates this field from the user profile of the record creator, but it is editable and you can change it if desired.
   - **E-mail** — Unifier auto-populates this field from the user profile of the record creator, but it is editable and you can change it if desired.
   - **Phone** — Unifier auto-populates this field from the user profile of the record creator, but it is editable and you can change it if desired.

9) Click the **Invite Bids** button. This action saves the record and disallows further modifications until after the due date. The Bid Invitations window opens.

10) Click the **Add** button in the toolbar. The Vendors window opens and displays a list of available vendors.

11) Select the vendors that you want to receive the Requests for Bid and click the **Attach** button. Unifier displays the selected vendors in the Bid Invitations window.

    - You can add multiple vendors at once by using your keyboard's Shift key or Ctrl key.
    - If desired, you can add additional vendors, or remove them from the list as needed.

12) Select a vendor and click the **Send Invitation** button.

13) On the Confirmation dialog box click **Yes** to continue with the bid invitation or **No** to halt the bid invitation. If you selected Yes, an invitation to bid on the project is sent to the vendor's email address on file in the Vendors record.

14) Select the same vendor to whom you just sent the bid invitation and click the **Send Password** button. This action sends the vendor a user name, password, and URL which is needed to access a private, secure Unifier workspace where he or she can prepare the bid.

---

### Submitting a Bid

A vendor can reply to the bid invitation by following these instructions.

**To submit a bid invitation**

1) Open the email titled **Invitation to participate in Bid Request**. This email contains bidding information needed to participate in the bidding process. This message contains:

   - **Bid Title**: RFB - 002
   - **Record No**: RFB-002
To take action on this bid, please click here:
http://abc.your.company.com

2) Open the email titled Information to access Bid Request. This email contains information need to access the Bid Request.
   
   **User Name**: vendor.name@vendor.com  
   **Password**: 373B109A  
   **Bid Title**: RFB - 002  
   **Record No**: RFB-002  

3) Click the bid link. The Unifier sign in window opens.

4) Enter the **Username** and **Password** sent to you in the email titled Information to access Bid Request.

5) Click the **Sign In** button. A secure and private Unifier workspace opens.
   
   Under the Vendor Home node there are two sub-nodes:
   
   - uMail, which you can use to communicate with the Bid Requestor  
   - Requests for Bid / Bids, which opens the bid preparation workspace.

6) Click the Requests for Bid / Bids node. The bid preparation workspace opens.

7) Prepare your bid by modifying the line items in the bid record. Line items are the only thing you can change on this record.
   
   Using the buttons on the toolbar you can:
   
   - Submit your bid. You can withdraw your bid and rework it prior to the bid due date.  
   - Save a draft of your bid.  
   - Delete your bid.  
   - Add an attachment.  
   - Close the bid window.

8) Click the **Submit** button to submit your bid.

**Adding an Attachment to a Bid**

You can upload and attach supporting documentation to your bid submittal.
To add an attachment to a bid proposal
1) In your open Requests for Bid record, click the Add Attachment button in the record tool bar. The File Upload window opens.
2) Click the Browse button. The Choose File to Upload window opens.
3) Browse to the file that you want to attach to your bid. You can only select one file at a time.
4) Click the Open button. Unifier displays the file path and name in the File Name column.
   a. Click the Add Row button to browse to and select additional files.
   b. Select a row and click the Remove button if you do not want to upload a selected file.
5) Click the OK button. The Attachments link shows the number of record attachments.

Opening a Bid Draft
Follow this procedure if you closed your bid draft and want to open it before the bid due date.

To open your bid draft
1) Sign in to Unifier using the URL and sign in credentials the Bid Requester sent you.
2) Click the Requests for Bid / Bids node. Unifier displays your draft bid in the Requests for Bid log.
3) Double-click your bid, or select the bid and click the Open button in the log tool bar. The Requests for Bid record opens.
4) Click the Create Bid button. When the record opens, you will see any previous changes that you made before saving the draft.
5) Make your changes to the line items. At this point you can either save your draft again, or submit your bid.
   If you submit your bid but decide to make changes to it, you can cancel the bid and resubmit it as long as the bidding process is still open.

Withdrawing a Bid
After submitting a bid, you might want to withdraw the bid from the bidding process, or modify your original bid.

To withdraw a bid from the bidding process
1) Log into the bid site using the credentials and URL the bid requester sent you.
2) Select the Requests for Bid / Bid node. Unifier displays your bid in the Requests for Bid log.
3) Open the bid that you want to withdraw by selecting the bid the log and clicking the View Bid button in the log tool bar. If you prefer, you can:
   ▶ Click the Open button in the log tool bar.
   ▶ Double-click the record.
4) In the bid record click the Withdraw from Bid button in the record toolbar.
5) Click Yes in the Alert dialog box. You receive an Alert telling you that the bid was successfully withdrawn and that you can modify your bid.
6) Click OK.
Resubmitting a Withdrawn Bid

You have until the bid due date to modify and resubmit your bid.

**To resubmit your bid**

1. Sign in to Unifier using the URL and sign in credentials the bid requester originally sent you.
2. Click the **Requests for Bid / Bids** node. Unifier displays your draft bid in the Requests for Bid log.
3. Double-click your bid, or select it and click the **Open** button in the log tool bar. A read-only version of your Requests for Bid record opens.
4. Click the **Create Bid** button. An active version of your original bid opens.
5. Make your changes to the bid line items.
6. Click the **Submit** button to resubmit your bid.

Communicating Bid Information Via uMail

Request For Bid (RFB) business processes have special linked uMail functionality. For RFB business processes, the creator of the RFB form will be allowed to correspond with internal users or with RFB bidders.

**To send a uMail message from an RFB form**

1. Open the Requests for Bid (RFB) business process form and click the Linked Mail link in the lower-right corner of the form. The Linked Mail window opens.
2. Click New and select one of the following:
   - **To Internal**: The Message window opens. The selection list for To, Cc, and Bcc includes your Unifier project or shell team, as in other uMail messages.
   - **To Bidder**: The Message window opens. The selection list for To, Cc, and Bcc is generated from the list of invited bidders.
     You will not be able to save a draft copy of the uMail from this selection.

Bidders will be allowed to view and access uMails once they are signed in to Unifier using their bidder's sign in credentials. Bidders can also create and add uMail messages from the RFB form. The To field is auto-populated with the requester name. The Cc and Bcc buttons are not available; however, bidders can fill in external Cc and Bcc fields with external e-mail addresses. When bidders reply to or forward uMail messages, these will be linked with the record. Bidders will not be able to create any new uMails after the bid due date.

**Note**: If a bidder accesses Unifier through Oracle Identity Manager (OIM), the bidder cannot change password. Changing password can be done only in Unifier when it is not accessed through OIM.

Comparing Vendors' Bids

Once the bidding process ends (after the bid due date has passed), you can open a bid tabulation to compare the bids you received. A default bid tabulation sheet is available in Unifier, or your company may have a custom-designed bid tabulation sheet.

When you have made a decision, contact the winning vendor to award the bid. If it is your company's policy to do so, inform losing vendors that they did not receive the bid.
To compare bids

1) Open the Requests for Bid record. The record toolbar contains a Show Bids button.
2) Click the Show Bids button. The Show Bids window opens, listing the bids you received.
3) From the list, select the vendors you want to compare and click the Compare Bids button. The Compare Bids window opens displaying a bid comparison sheet.

The following table is a scaled down example of the bid comparison sheet.

- The first 15 Data Elements and their values are from the Requests for Bid business process Upper form.
- Bid line item entries are from the Line Item form. If a vendor adds line items to the bid, these line items will appear on the sheet as well.

<table>
<thead>
<tr>
<th>Data Elements</th>
<th>Vendor 1</th>
<th>Vendor 2</th>
<th>Vendor 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bids</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bid Package Instructions</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bid Scope</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RFB Due Date</td>
<td>Date and time of bid due date</td>
<td>Date and time of bid due date</td>
<td>Date and time of bid due date</td>
</tr>
<tr>
<td>Question Cut Off Date</td>
<td>Date and time of question cut-off date</td>
<td>Date and time of question cut-off date</td>
<td>Date and time of question cut-off date</td>
</tr>
<tr>
<td>Dial-in Instructions</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Certifications</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insurance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date and Time</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qualifications</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order Delivery Date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bid Priority</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bid Package Revision Number</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes/Resolution</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Elements</td>
<td>Vendor 1</td>
<td>Vendor 2</td>
<td>Vendor 3</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Bid Line Items</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LI-1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requester Short Description</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Short Description</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Item Unit Cost</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Item Quantity</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Amount</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Notes/Resolution</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>LI-2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requester Short Description</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Short Description</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Item Unit Cost</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Item Quantity</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Amount</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
<tr>
<td>Notes/Resolution</td>
<td>Vendor 1 entry</td>
<td>Vendor 2 entry</td>
<td>Vendor 3 entry</td>
</tr>
</tbody>
</table>

- Data Elements and their values are from the Requests for Bid business process Upper form.
- Bid line item entries. If a vendor adds line items to the bid, these line items will also appear on the sheet.
## Requests for Substitution Business Process

### Purpose
You can use the Requests for Substitution business process to ask for a change of identical material or equipment. You can add supporting documents to a Requests for Substitution record and Unifier will automatically publish them in the Document Manager.

### Business process characteristics
- This is a project-level, multiple-instance, Document-type business process with workflow. An individual help file is available for this business process.

### Record Statuses
- Pending, a non-terminal status
- Approved, a terminal status
- Rejected, a terminal status
- Canceled, a terminal status

### Line Item Statuses
- Closed
- Open

### Groups associated with this business process
- Creators create the Requests for Substitution business process and send it for approval.
- Members of the Reviewers group can approve the business process ‘as is,’ send it to the Revision step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the request.
- Members of the All Project Users group can be copied on this business process.

### Additional Information
- Requests for Substitution references Contracts.
- Enabled for integration.
- Enabled for publish path.
  Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

### Benefits
- In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.
Location
To view the published file attachments of a project-level business process record: In a project’s Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

In This Section
- Requests for Substitution Work Flow ................................................................. 350
- Creating a Requests for Substitution Record ....................................................... 350
- Routing a Requests for Substitution Record from the Approval Step.................. 354
- Routing a Requests for Substitution Record from the Revision Step .................... 355
- Viewing the Requests for Substitution on the End step ..................................... 356
- Publishing Documents ....................................................................................... 356

Requests for Substitution Work Flow
Below are the four steps of the Requests for Substitution workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Request" then the record moves to the End step with a record status of "Canceled." For all steps, except the End step, sending a record to the next step creates a task for the record recipient.

Creating a Requests for Substitution Record
The first step in the Requests for Substitution business process workflow is the Creation step. Members of the Creator group can create this business process.
To create a new Requests for Substitution record

1) Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Collaboration > Tasks log.
4) Click New and select Invoices from the drop-down menu. A new Requests for Substitution business process form opens.
5) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in your Collaboration > Drafts folder.
6) In the Line Items section attach supporting documentation. You can add one document per line item. All attachments will be automatically added to the Document Manager.
   a. Click the Add button. The Line Items window opens.
   b. In the tool bar located near the top of the Line Item window, click the Attachment button.
   c. Select Add Attachment from either:
      My Computer — Use this selection to select and upload a document from your computer.
      Unifier Folder — Use this selection to select and add an attachment that was already uploaded to the Document Manager.
   d. Select the document to attach to this line item and click OK. Unifier will show the name of the file in the Name field on the line items form.
   e. Complete the Line Items form according to the Line Items table below.
   f. Click OK to save the line item.
   g. Continue to add line items until you have completed attaching your substitution information. Uploaded documents remain in the Document Manager > Unpublished Documents folder until you publish them. See Publishing Documents (on page 356)
7) In Workflow Actions select the workflow action to take. In this case, your selection is Send for Approval. This selection activates Action Details.
8) In Action Details, select who should receive the record.
   a. Click To... The User/Groups picker opens that shows a list of available task recipients.
   b. Select the user or group who will receive the task on the Approval step.
   c. Click Add.
   d. Click OK. The User/Group picker closes and the selection appears in the To field. Upon sending, the record will appear in the recipients Collaboration > Tasks log.
   e. (Optional) Click Cc... and follow steps a - d. The record will appear in the recipients Collaboration > Messages log.
9) Click Send to route the record to the Approval step.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>General block</td>
<td></td>
</tr>
</tbody>
</table>
### In this field

<table>
<thead>
<tr>
<th>Field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you click <strong>Send</strong>.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator’s contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the record to the next step.</td>
</tr>
<tr>
<td>Due Date*</td>
<td>This is a required field - Unifier pre-populates the date from the workflow setup, but you can change it if desired.</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>Contract Reference</td>
<td>Select the contract for which you want to substitute an item.</td>
</tr>
</tbody>
</table>

### Details block

<table>
<thead>
<tr>
<th>Field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spec Title</td>
<td>Enter a name for the spec.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>Select a spec section from the drop-down menu.</td>
</tr>
<tr>
<td>Page</td>
<td>Enter the page number of the spec.</td>
</tr>
<tr>
<td>Article/Paragraph</td>
<td>Enter the article and paragraph on the spec page.</td>
</tr>
</tbody>
</table>

### Proposed Solution block

<table>
<thead>
<tr>
<th>Field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposed Substitution</td>
<td>Enter a synopsis of the proposed solution, up to 30 characters.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Enter the manufacturer name.</td>
</tr>
<tr>
<td>Model</td>
<td>Enter the model.</td>
</tr>
<tr>
<td>Trade Name</td>
<td>Enter the trade name.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the manufacturer's address.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the manufacturer's phone number.</td>
</tr>
<tr>
<td>Installer</td>
<td>Enter the installer's name.</td>
</tr>
<tr>
<td>Address 1</td>
<td>Enter the installer's address.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the installer's phone.</td>
</tr>
<tr>
<td>History</td>
<td>Enter the installer's history with this type of installation.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Proposed Solution</strong></td>
<td></td>
</tr>
<tr>
<td>Differences between proposed substitution and specified product</td>
<td>Enter a detailed comparison between the specified product and the proposed substitution.</td>
</tr>
<tr>
<td>Point-by-point comparative data attached - REQUIRED BY Fill in if required</td>
<td>Check this box if Point-by-point comparative data is attached.</td>
</tr>
<tr>
<td><strong>Reason block</strong></td>
<td></td>
</tr>
<tr>
<td>Reason for not providing specified product</td>
<td>Enter the reason why this product should be substituted.</td>
</tr>
<tr>
<td><strong>Similar Installation block</strong></td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>Enter the name of a project that used this substitution.</td>
</tr>
<tr>
<td>Architect</td>
<td>Enter the name of the project architect.</td>
</tr>
<tr>
<td>Address 1</td>
<td>Enter the address of the project that used the substituted product.</td>
</tr>
<tr>
<td>Owner</td>
<td>Enter the name of the project owner.</td>
</tr>
<tr>
<td>Date Installed</td>
<td>Enter the date the substituted product was installed.</td>
</tr>
<tr>
<td>Proposed substitution affects other parts of work</td>
<td>The default entry is <strong>Yes</strong>, use the drop-down menu to select <strong>No</strong>.</td>
</tr>
<tr>
<td><strong>Explain block</strong></td>
<td></td>
</tr>
<tr>
<td>Explain</td>
<td>Enter an explanation for substituting the originally specified product.</td>
</tr>
<tr>
<td><strong>Savings block</strong></td>
<td></td>
</tr>
<tr>
<td>Savings to Owner for accepting substitutions</td>
<td>Enter the amount the owner would save by accepting the substitution.</td>
</tr>
<tr>
<td>Changes*</td>
<td>This is a required field. Use the drop-down menu to select <strong>Add</strong> or <strong>Deduct</strong>.</td>
</tr>
<tr>
<td>Proposed Substitution changes Contract Time</td>
<td>The default entry is <strong>Yes</strong>, use the drop-down menu to select <strong>No</strong>.</td>
</tr>
<tr>
<td>Days*</td>
<td>Enter the number of days the substitution would change Contract Time.</td>
</tr>
</tbody>
</table>

**Item Logs**

**Line Items Tab**
### In this field | Do this
--- | ---
**General block** | 
Name* | An attachment is required. The document name is auto-populated from the attached file.

Document Type | Select the document type using the drop-down menu.

Short Description | Enter a brief description for the line item.

Line Item Status | Select the line item status using the drop-down menu.

Issue Date | Select the date using the calendar icon.

Action Required | The default value is Yes. Use the drop-down menu to change the value to —, if appropriate.

Regarding | Enter a brief description to explain how this document pertains to the Request for Substitution.

### Routing a Requests for Substitution Record from the Approval Step

1. **To route a Requests for Substitution record from the Approval step**
   
1) Navigate to the All Projects tab and select your project from the log located near the bottom of the landing page.

2) Double-click your project to open it.

3) On your project landing page, navigate to the Collaboration > Tasks log

4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in bold red font are late.

5) Double click the Requests for Substitution task in the Tasks log. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.

6) When ready, click Accept Task. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add Task Notes for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.

7) Review the Requests for Substitution record and determine the appropriate course of action. You can download any attached files but you cannot upload any on this step.

8) In the toolbar at the top right of the form, click the Workflow Actions drop-down menu. You may select:
Primavera Cost Controls (PCC)

- **Approve Request** — this selection will send the record to the End step in **Approved** status.
- **Send for Revision** — this action keeps the workflow in flight and in **Pending** status.
  a. In the **Action Details** section **To...** is preassigned, but you can select message recipients in the **Cc** field.
  b. Click **Cc...**. Select the user or group who will receive the record on the next step.
  c. Click **Add**.
  d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.
- **Reject Request** — this selection will send the record to the End step in **Rejected** status.

9) (Optional) Add comments to the record through **General Comments** or **Task Notes**.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.

10) Click **Send**.

### Routing a Requests for Substitution Record from the Revision Step

Upon sending the business process form forward to the **Revision** step, Unifier sends a task to the record creator and a message to those selected in the **Cc** field. You can see your active tasks in your **Tasks** log.

- **To route a record from the Requests for Substitution Revision step**
  1) Navigate to the **All Projects** tab and select your project from the Projects log near the bottom of the landing page.
  2) Double-click your project to open it.
  3) On your project landing page, navigate to the **Collaboration > Tasks** log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold.
  4) In your Tasks log, double-click the task to open it. The business process form opens for viewing; you must accept the task before you can act on it.
     - The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.
     - The **Task Status** link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
  5) Click the **Accept Task** button. The form dynamically changes to an Action Form.
  6) In the Upper form section you can change most record details.
  7) In the **Line Items** section you can Modify, Add, or Delete line items and attachments as needed. Follow the same directions as adding line items during record creation.
  8) Click **OK** to save the Line Items.
  9) When ready, select a workflow action. This action activates **Action Details**. The choices are:
     - **Resubmit for Approval** — This action sends the record back to the Approval step in **Pending** status.
a. Click To... The User/Groups picker opens and displays a list of available task recipients.
b. Select the user or group who will receive the task when the record returns to the Approval step.
c. Click Add.
d. Click OK. The User/Group picker closes and the selection appears in the To field.
e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
f. Click Add.
g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - Cancel Request — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.

10) In Action Details, depending upon the workflow action selection, select who should receive the task and who should be copied on the action.
11) When ready, click Send.

**Viewing the Requests for Substitution on the End step**

This is the last step in the workflow. You cannot take action on this step because the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.

- To view a Requests for Substitution record on the End step
  1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
  2) Navigate to Cost Controls > Requests for Substitution. The Requests for Substitution log opens.
  3) Double-click a record to open it. In the record you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."
  4) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.
  5) Click View Graphic to see an image of the workflow.

**Publishing Documents**

1) Published documents are documents that are ready to be used by team members.

- To publish a document to the Document folder
  1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.
  3) Select the file to publish and click the Publish button in the Unpublished Documents log.
  4) Click the Documents folder to see your published documents.
Risks & Issues Business Process

Purpose
The Risk & Issues business process provides a log for documenting, tracking, and estimating impacts of open issues and risks. In effect, it is a log of items that may impact schedule, scope, and cost.

Business process characteristics
Risks & Issues is a project-level, cost-type, non-workflow, business process from which you can create multiple instances. An individual help file is available for this business process.

Record Statuses
Open, Closed, Canceled, none of which are terminal.

References
Contracts

Groups associated with this business process
- Creators create the Requests for Substitution business process and send it for approval.
- Members of the Reviewers group can approve the business process 'as is,' send it to the Revision step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the budget.
- Members of the All Project Users group can be copied on this business process.

Additional Information
- Risks & Issues is enabled for mobile phones and hand-held devices.
- Enabled for integration.
- Enabled for publish path.
  Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**In This Section**

Creating a Risks & Issues Record ................................................................. 358
Adding Line Items to the Risks & Issues Record ........................................... 360
Saving the Risk & Issues Record ................................................................. 361

**Creating a Risks & Issues Record**

Members of the following groups can create and edit this business process:

- Creator
- Project Administrator
- Reviewer

**To create a new Risk & Issues record**

1) Navigate to the All Projects tab and select your project from the list located on the bottom of the landing page.
2) Double-click your project to open it.
3) On your project landing page, navigate to the Cost Controls folder > Risks & Issues. The Risks & Issues log opens.
5) Complete the Upper form according to the Upper form table below. You must enter a Title and a Status before you can save the Risks & Issues record.

Saving a non-workflow business process creates a permanent record.

6) In the Line Items section click Add or Grid. The Line Items form opens.
7) Complete the Line Items form by following the directions in the Line Items Table below. You must complete all required fields on each line that you entered.

**Upper Form**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you click Send.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates upon record creation.</td>
</tr>
<tr>
<td>Record Last Update</td>
<td>This is a read-only field that shows the last time the someone updated the record.</td>
</tr>
<tr>
<td>Status*</td>
<td>This is a required field - select the status of the Payments record. The choices are Pending and Closed. Note: If you select Closed status and click Finish Editing, the record will be permanently closed.</td>
</tr>
<tr>
<td>Contract Reference</td>
<td>Select the Contract that is at risk or has issues.</td>
</tr>
</tbody>
</table>

**Description block**

| Description           | Enter a description for the payment.                                                                                                                                                                     |

**Estimated Costs block**

| Best Case Amount      | Enter the value that would most likely be the least amount needed to resolve the risk or issue.                                                                                                         |
| Worst Case Amount     | Enter the value that would most likely be the highest amount needed to resolve the risk or issue.                                                                                                       |
| Probable Case Amount  | This value is the sum of all detail lines.                                                                                                                                                              |

**Risk Details block**

| Risk Category         | Use the drop-down menu to select the risk category.                                                                                                                                                     |
| Risk Priority         | Use the drop-down menu to select the risk priority.                                                                                                                                                     |
| Environmental Impact  | The default entry is Yes; use the drop-down menu to change this selection to No if appropriate.                                                                                                           |
| Legal Review Required | The default entry is Yes; use the drop-down menu to change this selection to No if appropriate.                                                                                                          |
| Change Request Required | The default entry is Yes; use the drop-down menu to change this selection to No if appropriate.                                                                                                        |
| Forecasted Resolution Date | Use the calendar icon to select the forecasted resolution date.                                                                                                                                          |
| Scope Change Required | The default entry is Yes; use the drop-down menu to change this selection to No if appropriate.                                                                                                          |
| Schedule Impact (Days) | Enter the number of days you expect resolving the risk or issue will impact the project schedule.                                                                                                         |
In this field | Do this
---|---
Schedule Change Required | The default entry is **Yes**; use the drop-down menu to change this selection to **No** if appropriate.

**Resolution block**

<table>
<thead>
<tr>
<th>Action to Resolve</th>
</tr>
</thead>
</table>

**Item Logs**

**Line Items Tab**

**General Block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Enter the cost code for this line item. You can either enter it directly or use the cost code picker.</td>
</tr>
<tr>
<td>Code Name</td>
<td>This read-only field is auto-populated from the cost code name.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the amount for the fund appropriation to this cost code.</td>
</tr>
<tr>
<td>Line Item Status</td>
<td>Enter the line item status.</td>
</tr>
</tbody>
</table>

**Adding Line Items to the Risks & Issues Record**

The record must be in Edit mode to enter line items.

* **To enter line items on the Risk & Issues Record**
  1) Click **Edit** if the Risks & Issues record is in read-only mode.
  2) In the **Line Items** section click **Add** or **Grid**. The Line Item form opens.
  3) Complete the Line Item form according to the Line Item table below. You must complete all required fields on each line that you enter.
  4) Click **Save** (if using the grid) or **OK** (if using the Line Item form) to save the form. The Line Items form close.

   If you are using the grid and do not click Save before closing it, you will lose your line item changes.

**Line Item Table**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab Name</td>
<td>You can enter a tab name.</td>
</tr>
<tr>
<td>General block</td>
<td></td>
</tr>
<tr>
<td>Cost Code*</td>
<td>This is a required field - Select the cost code using the cost code picker.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Code Name</td>
<td>This field is auto-populated from the cost code.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the Amount.</td>
</tr>
<tr>
<td>Line Item Status</td>
<td>Select the line item status.</td>
</tr>
</tbody>
</table>

**Saving the Risk & Issues Record**

- **To save the Risk & Issues record**

Click either:

- **Finish Editing** to save the form in read-only mode. Regardless of the record status, you can click the **Edit** button to return the record to edit mode.
- **Save** to leave the form in edit mode.
**Timesheets Business Process**

**Purpose**
Employees can use the Timesheets business process to record their hours for both project and non-project work. Employers can use this business process to approve employee hours.

**Business process characteristics**
This is a company-level, line-item, workflow business process from which you can create multiple instances. An individual help file is available for this business process.

**Record Statuses**
- Pending, a non-terminal status
- Approved, a terminal status
- Canceled, a terminal status

**Groups associated with this business process**
Members of the All Company Users group can create the Timesheets business process and send it for review.

**Additional Information**
- Enabled for mobile and hand-held devices.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

**Benefits**
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

**Location**
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
In This Section

Timesheets Workflow............................................................................................ 364
Creating a Timesheets Record.............................................................................. 364
Routing a Timesheets Record from the First Save as Draft Step .................... 368
Routing a Timesheets Record from the Second Save as Draft Step ............... 369
Routing a Timesheets Record from the Review Step........................................ 370
Viewing the Timesheets Record on the End Step............................................. 370

Timesheets Workflow

Below are the five steps of the Timesheets workflow. Notice that there are two Save as Draft steps. The second Save as Draft step is an intermediary step from which you can cancel the record or proceed to the Review step.

Creating a Timesheets Record

- **To create a Timesheets business process record**
  1. Navigate to the Company Workspace tab, Collaboration > Tasks. The Tasks log opens.
  2. In the Tasks toolbar click New and select Timesheets from the menu drop-down list. A new Timesheets form opens.
  3. Complete the Upper form according to the Upper form table below. You must enter a value in all required fields.
  4. Add line items to the detail form according to your project participation.
This portion of the form is divided into tabs:
- Project Hours — Record your project hours on this tab
- Non-Project Hours — Record your non-project hours on this tab

5) In **Workflow Actions** select the workflow action to take. This action activates **Action Details**. Your selections are:
- **Save as Draft** — This selection sends the record to the **Save as Draft** step and generates a new task in your Company Workspace **Collaboration > Tasks** log. It also saves the Timesheet record in your Company Workspace **Collaboration > Drafts** log.
- **Submit for Approval** — This selection sends the timesheet record to the **Review** step.

6) In **Action Details**, select who should receive the record on the next step.
   a. **To...** is preassigned.
   b. (Optional) Click **Cc**. to copy someone on the Timesheets record. The **User/Groups** picker opens that shows a list of available record recipients.
   c. Select the user or group who will receive a copy of the record on the next step.
   d. Click **Add**.
   e. Click **OK**. The **User/Groups** picker closes and the name or group appears in the **Cc** field. Upon sending, the record will appear in the recipient's Company Workspace **Collaboration > Messages** log.

7) Click **Send** to either send the Timesheet to the **Review** step or to the **Save as Draft** step.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you click <strong>Send</strong>.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Summary Average Shown</td>
<td></td>
</tr>
<tr>
<td>Week Of*</td>
<td>This is a required field. Use the calendar icon to select the date.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator’s contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the record to the next step.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Unifier pre-populates the date from the workflow setup.</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Employee Info block</strong></td>
<td></td>
</tr>
<tr>
<td>Employee*</td>
<td>This is a required field. Select the employee's name using the drop-down menu.</td>
</tr>
<tr>
<td>Name</td>
<td>This information is auto-populated from the employee's user profile.</td>
</tr>
<tr>
<td>Department</td>
<td>This information is auto-populated from the employee's user profile.</td>
</tr>
<tr>
<td>Regular hours</td>
<td>This information is auto-populated from the employee's user profile. You can overwrite this entry if desired.</td>
</tr>
<tr>
<td>Employee ID</td>
<td>This information is auto-populated from the employee's user profile.</td>
</tr>
<tr>
<td>Title</td>
<td>This information is auto-populated from the employee's user profile.</td>
</tr>
<tr>
<td>Manager</td>
<td>This information is auto-populated from the employee's user profile.</td>
</tr>
<tr>
<td><strong>Summary Project Hours block</strong></td>
<td></td>
</tr>
<tr>
<td>Monday</td>
<td>This value is auto-populated from the Project Hours tab.</td>
</tr>
<tr>
<td>Tuesday</td>
<td>This value is auto-populated from the Project Hours tab.</td>
</tr>
<tr>
<td>Wednesday</td>
<td>This value is auto-populated from the Project Hours tab.</td>
</tr>
<tr>
<td>Thursday</td>
<td>This value is auto-populated from the Project Hours tab.</td>
</tr>
<tr>
<td>Friday</td>
<td>This value is auto-populated from the Project Hours tab.</td>
</tr>
<tr>
<td>Saturday</td>
<td>This value is auto-populated from the Project Hours tab.</td>
</tr>
<tr>
<td>Sunday</td>
<td>This value is auto-populated from the Project Hours tab.</td>
</tr>
<tr>
<td>Total Project Hours</td>
<td>This value is auto-populated from the Project Hours tab.</td>
</tr>
<tr>
<td><strong>Summary Non Project Hours block</strong></td>
<td></td>
</tr>
<tr>
<td>Monday</td>
<td>This value is auto-populated from the Non Project Hours tab.</td>
</tr>
<tr>
<td>Tuesday</td>
<td>This value is auto-populated from the Non Project Hours tab.</td>
</tr>
<tr>
<td>Wednesday</td>
<td>This value is auto-populated from the Non Project Hours tab.</td>
</tr>
<tr>
<td>Thursday</td>
<td>This value is auto-populated from the Non Project Hours tab.</td>
</tr>
<tr>
<td>Friday</td>
<td>This value is auto-populated from the Non Project Hours tab.</td>
</tr>
<tr>
<td>Saturday</td>
<td>This value is auto-populated from the Non Project Hours tab.</td>
</tr>
<tr>
<td>Sunday</td>
<td>This value is auto-populated from the Non Project Hours tab.</td>
</tr>
<tr>
<td>Total Non-Project Hours</td>
<td>This value is auto-populated from the Non Project Hours tab.</td>
</tr>
</tbody>
</table>
### In this field

#### Summary Hours block

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Hours</td>
<td>This value is calculated and then auto-populated from the Project Hours + Non Project Hours tabs.</td>
</tr>
<tr>
<td>Total Overtime Hours</td>
<td>This value is calculated and then auto-populated from the Project Hours + Non Project Hours tabs.</td>
</tr>
</tbody>
</table>

### Item Logs

#### Line Items Tab

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project Hours tab</strong></td>
<td></td>
</tr>
<tr>
<td>Project*</td>
<td>This is a required field - Enter the name of the project.</td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description for the project.</td>
</tr>
<tr>
<td>Week Of</td>
<td>Select a date using the date picker.</td>
</tr>
<tr>
<td>Monday</td>
<td>Enter your hours for the day.</td>
</tr>
<tr>
<td>Tuesday</td>
<td>Enter your hours for the day.</td>
</tr>
<tr>
<td>Wednesday</td>
<td>Enter your hours for the day.</td>
</tr>
<tr>
<td>Thursday</td>
<td>Enter your hours for the day.</td>
</tr>
<tr>
<td>Friday</td>
<td>Enter your hours for the day.</td>
</tr>
<tr>
<td>Saturday</td>
<td>Enter your hours for the day.</td>
</tr>
<tr>
<td>Sunday</td>
<td>Enter your hours for the day.</td>
</tr>
<tr>
<td>Total Project Hours</td>
<td>Unifier automatically calculates the number of project hours.</td>
</tr>
<tr>
<td><strong>Non Project Hours tab</strong></td>
<td></td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description for the project.</td>
</tr>
<tr>
<td>P6 Cost</td>
<td>Enter the currency amount.</td>
</tr>
<tr>
<td>Earned Amount</td>
<td>Enter the Earned Amount</td>
</tr>
<tr>
<td>Total Costs</td>
<td>Unifier automatically calculates the total costs using the formula (Earned Amount - P6 Cost)</td>
</tr>
<tr>
<td>Total Regular Hours</td>
<td>Enter the total regular hours.</td>
</tr>
<tr>
<td>Total Overtime Hours</td>
<td>Enter the overtime hours.</td>
</tr>
</tbody>
</table>
### Routing a Timesheets Record from the First Save as Draft Step

While the Timesheets record is on the **Save as Draft** step you can edit any and all fields.

1. **To route a Timesheets record from the first Save as Draft step**
   1. Navigate to the **Company Workspace** tab, **Collaboration > Tasks**. The Tasks log opens.
   2. In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
      - The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.
      - The **Task Status** link opens the Workflow Progress window where you can see record and step details as well as access an image of the Timesheets Workflow.
   3. Click the **Accept Task** button. The form dynamically changes to an Action Form.
      - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
      - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.
   4. When ready, select a workflow action. The choices are:
      - **Save as Draft** — this action sends the record to the **Save as Draft** step in **Pending** status.
         - At this point you are on the first Save as Draft step; however, in this workflow there are two Save as Draft steps. See the **Timesheets Workflow** (on page 364).
         - You can update the Timesheets record and send it between Save as Draft steps until you are ready to either submit the Timesheets record for approval (from the first Save as Draft step), or cancel the record (from the second Save as Draft step).
• Sending the record between Save as Draft steps creates a new task for you in your Company Workspace Collaborations > Tasks log each time you click Send.

  Submit for Approval — this action sends the record to the record reviewer in Pending status.
  
a. Click Cc... The User/Groups picker opens and displays a list of available message recipients.
  
b. Select the user or group who will receive the message when the record returns to the Approval step.
  
c. Click Add.
  
d. Click OK. The User/Group picker closes and the selection appears in the Cc... field. Upon sending, the record copy will appear in the recipient's Collaboration > Messages log.

5) In Action Details, select who should receive the record. To... is preassigned but you can select message recipients in the Cc field.

  a. Click Cc... Select the user or group who will receive the record on the next step.
  
  b. Click Add.
  
  c. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.

6) When ready, click Send.

Routing a Timesheets Record from the Second Save as Draft Step

To route a Timesheets record from the second Save as Draft step

1) Navigate to the Company Workspace tab, Collaboration > Tasks. The Tasks log opens.

2) In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.

The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.

The Task Status link opens the Workflow Progress window where you can see record and step details as well as an image of the Timesheets Workflow.

3) Click the Accept Task button. The form dynamically changes to an Action Form.

  You can add Task Notes for the next step, but you cannot view previous Task Notes.

  If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.

4) Select a workflow action. The choices are:

  Save as Draft — This action sends the record to the Save as Draft step in Pending status.

    • At this point you are on the second Save as Draft step. See the Timesheets Workflow (on page 364).

    • You can update the Timesheets record and send it between Save as Draft steps until you are ready to either submit the Timesheets record for approval (from the first Save as Draft step), or cancel the record (from the second Save as Draft step).

  Cancel — this action sends the record to the End step in Canceled status.

5) Click Send.
Routing a Timesheets Record from the Review Step

To route a Timesheets record from the Review step

1) Navigate to the Company Workspace tab, Collaboration > Tasks. The Tasks log opens.
2) In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.

   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.

   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the Timesheets Workflow.
3) Click the Accept Task button. The form dynamically changes to an Action Form.

   You can add Task Notes for the next step, but you cannot view previous Task Notes.

   If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.
4) Select a workflow action. The choices are:
   
   - Request Revision — this action sends the record to the Save as Draft step in Pending status.
     
     - This is the second Save as Draft step. See the Timesheets Workflow (on page 364).
     
     - You can update the Timesheets record and send it between Save as Draft steps until you are ready to either submit the Timesheets record for approval (from the first Save as Draft step), or cancel the record (from the second Save as Draft step).
   - Approve — This action sends the record to the End step in Approved status.
5) Click Send.

Viewing the Timesheets Record on the End Step

This is the last step in the workflow. You cannot take action on this step because the record is in a terminal status: Approved, or Canceled. Once on the End step the record is viewable only in the business process log.

To view a Requests for Substitution record on the End step

1) Go to the Company Workspace tab and click Company Logs in the left Navigator. Company logs display a list of the business processes that reside at the company level.
2) Click Timesheets. Unifier opens the business process log.

   When the record is on the End step, Task Details displays the text "Record has been closed."
3) Click the "Click here" link in Task Details to open the Workflow Progress Window. In the Progress Window you can see that the record is on the End step, as well as retrace the record’s path in the workflow.
4) Click View Graphic to see an image of the workflow.
Vendor Prequal Requests Business Process

Purpose
You can use a Vendor Prequal Requests record to initiate and confirm or deny a new vendor approval request. You can use the Vendor Prequal Request to capture and store information regarding a vendor; for example, vendor contact information, vendor type, insurance coverage, and the delivery method the vendor uses. Upon approval, the Vendor Prequal Requests record auto-creates a Vendor record, which will be in edit mode when you open the record.

Business process characteristics
Vendor Prequal Requests is a company-level business process without line items but with workflow. You can create multiple Vendor Prequal Requests records for your company; each record specifies one vendor. Integration is defined. An individual help file is available for this business process.

Groups associated with this business process
Company Administrator, Reviewer, All Company Users, Auto-creation names the Coadmin as the Vendor record creator, Company Administrators receive error notifications

Record Statuses
Pending (non-terminal status), Approved (terminal status), Rejected (terminal status), or Canceled (terminal status)

Additional Information
- Enabled for mobile devices.
- Step completion policy and resolving actions can differ between steps. See Completion Policies and Resolving Actions.
- Enabled for integration.
- Enabled for publish path.
- Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**In This Section**

- Vendor Prequal Requests Workflow ................................................................. 372
- Creating a Vendor Prequal Requests Record .................................................... 372
- Routing a Vendor Prequal Requests Record from the Approval Step .............. 375
- Routing a Vendor Prequal Requests Record from the Revision Step ............... 376
- Viewing a Vendor Prequal Requests Record on the End Step ...................... 377

**Vendor Prequal Requests Workflow**

Below are the four steps of the **Vendor Prequal Requests** workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Vendor Prequal" then the record moves to the **End** step with a record status of "Canceled." Sending a record to either the **Approval** step or the **Revision** step creates a task for the next record recipient.

![Vendor Prequal Requests Workflow Diagram]

**Creating a Vendor Prequal Requests Record**

- To create a Vendor Prequal Requests record
  1) Navigate to the **Company Workspace** tab, **Collaboration >Tasks**. The Tasks log opens.
  2) In the Tasks toolbar click **New** and select **Vendors Prequal Requests** from the menu drop-down list. A new Vendors Prequal Requests form opens.
3) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the form.

4) In **Workflow Actions** select the workflow action to take. In this case, your selection is **Send for Approval**. This action activates **Action Details**.

5) In **Action Details**, select who should receive the record.
   a. Click **To...** The **User/Groups** picker opens and displays a list of available task recipients.
   b. Select the user or group who will receive the task on the next step.
   c. Click **Add**.
   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field. Upon sending, the record will appear in the recipient's **Collaboration > Tasks** log.
   e. (Optional) Click **Cc...** and follow steps a - d. The record will appear in the recipient's **Collaboration > Messages** log.

6) Click **Send** to route the record to the **Approval** step. Unifier displays a message stating that the record has been submitted successfully.

## Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates the first time you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter up to 16 alpha-numeric characters to identify the vendor.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in red in both the Tasks log and the business process log.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator’s contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you first send the form to the next step in the workflow.</td>
</tr>
<tr>
<td>Status</td>
<td>This is a read-only field that Unifier populates when you first send the form to the next step in the workflow.</td>
</tr>
<tr>
<td><strong>Vendor Details block</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor ID</td>
<td>This is a required field - Enter up to 16 alpha-numeric characters to identify the vendor.</td>
</tr>
<tr>
<td>Tax ID</td>
<td>Enter the vendor's Tax ID. You can enter up to 16 alpha-numeric characters.</td>
</tr>
</tbody>
</table>
**In this field** | **Do this**
---|---
License No | Enter the vendor’s License Number. You can enter up to 16 alpha-numeric characters.
Contact First Name* | This is a required field - Enter the contact’s first name.
Contact Last Name* | This is a required field. Enter the contact's last name.
Vendor Name | Enter the vendor's name. You can enter up to 50 alpha-numeric characters.
Vendor Type | Select the Vendor Type from the drop-down menu.
Reference ID | Enter the vendor’s Reference ID. You can enter up to 16 alpha-numeric characters.
User ID | This is a required field - Enter the contact's email address.

**Vendor Address block**

| **Address 1** | Enter the vendor's address. You can enter up to 120 alpha-numeric characters.
| **Address 2** | You can use this field as needed. You can enter up to 120 alpha-numeric characters.
| **Address 3** | You can use this field as needed. You can enter up to 120 alpha-numeric characters.
| **City** | Enter the vendor’s city.
| **State/Province** | Select the vendor's state or province.
| **Zip/Postal Code** | Enter the vendor’s zip or postal code.
| **Country** | Select the vendor’s country
| **Primary Contact** | Enter the name of the vendor contact.
| **Email** | Enter the vendor contact's email.
| **Phone** | Enter the vendor contact's phone number.
| **Fax** | Enter the vendor contact's fax number.

**Justification block**

| **Justification** | Enter a justification. You can enter up to 4000 alpha-numeric characters.

**Certificate of Insurance block**

| **Insurance Company** | Enter the name of the insurance company. You can enter up to 32 alpha-numeric characters.
| **COI expiration Date** | Enter the Certification of Insurance expiration date using the date picker. 

---

374
### Routing a Vendor Prequal Requests Record from the Approval Step

Upon sending the business process form forward to the **Approval** step, Unifier creates a permanent business process record and sends a task. An assignee can see the task in the **Tasks** log.

- **To route a Vendor Prequal Requests record from the Approval step**

When working on the **Approval step**, first you accept the task, then when you are ready to do so, route the record to either the **Revision** or the **End** step.

1. Navigate to the **Company Workspace** tab, **Collaboration > Tasks**. The Tasks log opens.
2. In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   - The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.
   - The **Task Status** link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.
3. Click the **Accept Task** button.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.
4. When you are ready, select a workflow action. The choices are:
   - **Approve Vendor Prequal** — this action sends the record to the **End** step in **Approved** status, which triggers auto-creation of the Vendor record.
   - **Send for Revision** — this action sends the record back to the record creator in **Pending** status. The **To** field is preassigned and you can **Cc** anyone listed in Users/Groups.
a. Click **Cc...** The **User/Groups** picker opens and displays a list of available message recipients.

b. Select the user or group who will receive the message when the record returns to the **Approval** step.

c. Click **Add**.

d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc...** field. Upon sending, the record copy will appear in the recipient's **Collaboration > Messages** log.

   - **Reject Vendor Prequal** — this action sends the record to the **End** step in **Rejected** status; this action does not trigger auto-creation of the Vendor record.

5) When ready, click **Send**.

---

### Routing a Vendor Prequal Requests Record from the Revision Step

When sending the business process forward to the Revision step, Unifier sends a task to the assignee. You can see your active tasks in your **Tasks** log. When your task is complete, you can select one of two Workflow Action options, as described on step 4.

- **To route a Vendor Prequal Requests record from the Revision step**

1) Navigate to the **Company Workspace** tab, **Collaboration >Tasks**. The Tasks log opens.

2) In the Tasks log, double-click the task to open it. The business process form opens for viewing; you must accept the task before you can act on it.

   - The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.

   - The **Task Status** link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

3) Click the **Accept Task** button. The form dynamically changes to an Action Form with editable fields. You can revise:

   - The record title field.

   - All fields in the **User Information** block.

4) When ready, select a workflow action. The choices are:

   - **Resubmit for Approval** — this action sends the record back to the Approval step in **Pending** status.

   a. Click **To...** The **User/Groups** picker opens and displays a list of available task recipients.

   b. Select the user or group who will receive the task when the record returns to the **Approval** step.

   c. Click **Add**.

   d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field.

   e. (Optional) Click **Cc...** Select the user or group who will receive the record on the next step.

   f. Click **Add**.

   g. Click **OK**. The **User/Group** picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.

   - **Cancel** — this action sends the record to the End step in Canceled status.

5) When ready, click **Send**.
Viewing a Vendor Prequal Requests Record on the End Step

This is the last step in the workflow. You cannot take action on this step. All form fields are read-only and the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.

To view a Vendor Prequal Requests record on the End step

1) Go to the Company Workspace tab and click Company Logs in the left Navigator. The Navigator shows a list of the business processes that reside at the company level.

2) Click Vendor Prequal Requests. Unifier opens the log in the right pane.

   When the record is on the End step, Task Details displays the text "Record has been closed."

3) Click the "Click here" link in Task Details to open the Workflow Progress Window. In the Progress Window you can see that the record is on the End step, as well as retrace the record's path in the workflow.

4) Click View Graphic to see an image of the workflow.
Vendors Business Process

Purpose
You can use a Vendors record to capture and store vital information regarding a Vendor; for example, bidding information, vendor type, vendor contact information, insurance coverage, and any business certifications. Each type of information, up to eight types, can have its own detail-form tab.

Business process characteristics
Vendors is a non-workflow, company-level, line item-type business process. You can create multiple Vendors records for your company; each Vendors record specifies one Vendor. The Vendors record can be auto-created from an approved Vendor Prequal Requests record, or it can be manually created. Because this is a non-workflow business process you access a Vendors record in Company Logs > Vendors log. Integration is defined for Upper and Detail forms. The item logs section of the Vendors record displays a query tab, Contracts. An individual help file is available for this business process.

Groups associated with this business process
Members of the Company Administrators group can create and edit this business process.

Record Statuses
Active and Inactive, neither of which are terminal.

Additional Information
- Designated as the Request for Bid (RFB) master vendor list.
- Enabled for mobile and hand-held devices.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record:
- In a project's Navigator, click Document Manager and select Documents.
- In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

To view the published file attachments of a company-level business process record:
In the Company Workspace Navigator, click **Document Manager** and select **Company Documents**.
In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**In This Section**

Creating a Vendors Record Manually ................................................................. 380
Adding Line Items .................................................................................................. 382
Saving the Vendors Record ..................................................................................... 383

**Creating a Vendors Record Manually**

Before you begin, check to make sure you do not already have a Vendor record that was auto-created by the Vendor Prequal Requests record, or there is not a Vendor Prequal Request already being routed for approval.

▶ **To create a Vendors record manually**

1) Navigate to the **Company Workspace** tab, **Company Logs > Vendors**. The Vendors log opens.
2) In the toolbar click **New** and select Vendors from the drop-down menu. A new Vendors form opens.
3) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can save the form or add line items. See Adding Line Items.

**Upper Form**

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates the first time you save the form.</td>
</tr>
<tr>
<td>Record Last Update Date</td>
<td>This is a read-only field that Unifier populates when you save the record.</td>
</tr>
<tr>
<td>Status*</td>
<td>This is a required field - Select the status of the record. Selections are Active and Inactive, neither of which are Terminal statuses</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you initially saved the form and it became a record.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Electronic Bidding Information block</strong></td>
<td></td>
</tr>
<tr>
<td>Contact Company</td>
<td>Enter the Vendor name.</td>
</tr>
<tr>
<td>User ID*</td>
<td>This is a required field - Enter the contact's <strong>email address</strong>.</td>
</tr>
<tr>
<td>Contact First Name*</td>
<td>This is a required field - Enter the vendor contact's <strong>first name</strong>.</td>
</tr>
<tr>
<td>Contact Last Name*</td>
<td>This is a required field - Enter the vendor contact's <strong>last name</strong>.</td>
</tr>
<tr>
<td>Email</td>
<td>Enter the vendor contact's email address.</td>
</tr>
<tr>
<td><strong>Vendor Details block</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor ID</td>
<td>This is a required field - Enter up to 16 alpha-numeric characters to identify the vendor.</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>Enter the vendor's name. You can enter up to 50 alpha-numeric characters.</td>
</tr>
<tr>
<td>Vendor Type</td>
<td>Select the Vendor Type from the drop-down menu.</td>
</tr>
<tr>
<td>Tax ID</td>
<td>Enter the vendor’s Tax ID. You can enter up to 16 alpha-numeric characters.</td>
</tr>
<tr>
<td>License No</td>
<td>Enter the vendor’s License Number. You can enter up to 16 alpha-numeric characters.</td>
</tr>
<tr>
<td>Reference ID</td>
<td>Enter the vendor’s Reference ID. You can enter up to 16 alpha-numeric characters.</td>
</tr>
<tr>
<td><strong>Vendor Address block</strong></td>
<td></td>
</tr>
<tr>
<td>Address 1</td>
<td>Enter the vendor’s address. You can enter up to 120 alpha-numeric characters.</td>
</tr>
<tr>
<td>Address 2</td>
<td>You can use this field as needed. You can enter up to 120 alpha-numeric characters.</td>
</tr>
<tr>
<td>Address 3</td>
<td>You can use this field as needed. You can enter up to 120 alpha-numeric characters.</td>
</tr>
<tr>
<td>City</td>
<td>Enter the vendor’s city.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Select the vendor’s state or province.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>Enter the vendor’s zip or postal code.</td>
</tr>
<tr>
<td>Country</td>
<td>Select the vendor’s country</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>Enter the name of the vendor contact.</td>
</tr>
<tr>
<td>Email</td>
<td>Enter the vendor contact's email.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the vendor contact's phone number.</td>
</tr>
<tr>
<td>Fax</td>
<td>Enter the vendor contact's fax number.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Certificate of Insurance block</strong></td>
<td></td>
</tr>
<tr>
<td>Insurance Company</td>
<td>Enter the name of the insurance company.</td>
</tr>
<tr>
<td>Policy No</td>
<td>Enter the vendor’s insurance policy number.</td>
</tr>
<tr>
<td>COI expiration Date</td>
<td>Enter the date on which the insurance expires.</td>
</tr>
<tr>
<td>Indemnification Amount</td>
<td>Enter the liability amount.</td>
</tr>
<tr>
<td><strong>Business Classification</strong></td>
<td></td>
</tr>
<tr>
<td>Minority-owned Business</td>
<td>Select the check-box if appropriate.</td>
</tr>
<tr>
<td>Woman-owned Business</td>
<td>Select the check-box if appropriate.</td>
</tr>
<tr>
<td>Disadvantaged-own Business</td>
<td>Select the check-box if appropriate.</td>
</tr>
<tr>
<td>Certificate Number</td>
<td>Enter the certification number of the business classification.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>Select the appropriate date using the date picker.</td>
</tr>
<tr>
<td><strong>Remarks block</strong></td>
<td></td>
</tr>
<tr>
<td>Remarks</td>
<td>Enter up to 4000 alpha-numeric characters.</td>
</tr>
</tbody>
</table>

### Item Logs

**Line Items Tab**

Provides general information about the record.

**Contracts Tab**

Use to create a new record as well as view, copy, or find existing records.

### Adding Line Items

The record must be in Edit mode to be able to modify it.

1. Click **Edit** if the Vendor record was auto-created, or is otherwise in read-only mode.
2. In the **Line Items** section click **Add** or **Grid**. The Line Item form opens.
3. Complete the Line Item form according to the Line Item table below. You must complete all required fields on each line that you enter before you can save the Line Item.
4. Click **Save** (if using the grid) or **OK** (if using the Line Item form) to save the form. The Line Items form closes.
5. In the **Line Items** section click **Add** or **Grid**. The Line Items List opens.
   - If you are using the grid and do not click Save before closing it, you will lose your line item changes.
### Line Item List Table

<table>
<thead>
<tr>
<th>In this field Use</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab Name</td>
<td>You can enter a name for the tab.</td>
</tr>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Short Description*</td>
<td>This is a required field - Enter a brief description of the item specified on the line item</td>
</tr>
<tr>
<td>Contact First Name</td>
<td>Enter the contact's first name.</td>
</tr>
<tr>
<td>Contact Last Name</td>
<td>Enter the contact's last name.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter a title for the line item</td>
</tr>
<tr>
<td>Address 1</td>
<td>The Upper form auto-populates this field.</td>
</tr>
<tr>
<td>Address 2</td>
<td>The Upper form auto-populates this field.</td>
</tr>
<tr>
<td>Address 3</td>
<td>The Upper form auto-populates this field.</td>
</tr>
<tr>
<td>City</td>
<td>The Upper form auto-populates this field.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The Upper form auto-populates this field.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>The Upper form auto-populates this field.</td>
</tr>
<tr>
<td>Email</td>
<td>Enter the contact's email address.</td>
</tr>
<tr>
<td>Work Phone</td>
<td>Enter the contact's work phone number.</td>
</tr>
</tbody>
</table>

### Saving the Vendors Record

- **To save the Vendors record**

Click either:

- **Finish Editing** to save the form in read-only mode.
- **Save** to leave the form in edit mode.
Vendors Evaluations Business Process

Purpose
You can use a Vendor Evaluations record to document vendor performance in consideration of future work.

Business process characteristics
The Vendor Evaluation is a company-level business process without line items but with workflow. You can create multiple Vendor Evaluation records for your company; each record specifies one vendor. Integration is defined. An individual help file is available for this business process.

Groups associated with this business process
Creator, Reviewer, All Company Users

Statuses
Pending (non-terminal status), Approved (terminal status), Rejected (terminal status), or Canceled (terminal status)

Additional Information
- Enabled for mobile devices.
- The Administrator can upload the business process help file in business process set up, where it is viewable in the business process log Help menu.
- Step completion policy and resolving actions can differ between steps.
- Enabled for integration.
- Enabled for publish path.

Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**In This Section**

- Vendors Evaluations Workflow .......................................................... 386
- Creating a Vendors Evaluations Record ............................................. 386
- Routing a Vendors Evaluations Record from the Approval Step .......... 389
- Routing a Vendors Evaluations Record from the Revision Step .......... 390
- Viewing a Vendors Evaluations Record on the End Step ...................... 390

**Vendors Evaluations Workflow**

Below are the four steps of the Vendors Evaluation workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Vendor Eval" then the record moves to the End step with a record status of "Canceled." Sending a record to either the Approval step or the Revision step creates a task for the next record recipient.

![Vendors Evaluations Workflow Diagram]

**Creating a Vendors Evaluations Record**

- To create a Vendors Evaluations record
  
  1) Navigate to the Company Workspace tab, Collaboration > Tasks. The Tasks log opens.
  2) In the Tasks toolbar click New and select Vendors Evaluations from the menu drop-down list. A new Vendors Evaluation form opens.
3) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the form.

4) In Workflow Actions select the workflow action to take. In this case, your selection is Send for Approval. This action activates Action Details.

5) In Action Details, select who should receive the record.
   a. Click To... The User/Groups picker opens and displays a list of available task recipients.
   b. Select the user or group who will receive the task on the next step.
   c. Click Add.
   d. Click OK. The User/Group picker closes and the selection appears in the To field. Upon sending, the record will appear in the recipient's Collaboration > Tasks log.
   e. (Optional) Click Cc... and follow steps a - d. The record will appear in the recipient's Collaboration > Messages log.

6) Click Send to route the record to the Approval step. Unifier displays a message stating that the record has been submitted successfully.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General block</strong></td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates the first time you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter up to 50 alpha-numeric characters to identify the record.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you first send the form to the next step in the workflow.</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is pre-populated and reflects the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>Status</td>
<td>This is a read-only field that Unifier populates when you send the form to the next step in the workflow.</td>
</tr>
<tr>
<td><strong>Vendor Information block</strong></td>
<td></td>
</tr>
<tr>
<td>Selected Vendor*</td>
<td>This is a required field - Select the vendor using the Vendors picker.</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
</tbody>
</table>
### In this field

<table>
<thead>
<tr>
<th><strong>In this field</strong></th>
<th><strong>Do this</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Type</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>Address 1</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>Address 3</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>City</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>State/Province</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>Country</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>Email</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>Phone</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
<tr>
<td>Fax</td>
<td>This is a read-only field that Unifier auto-populates from the Vendor record.</td>
</tr>
</tbody>
</table>

### Evaluation block

<table>
<thead>
<tr>
<th><strong>Evaluation block</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Timely Completion</td>
<td>Select your assessment from the drop-down menu.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter your comments, up to 4000 characters.</td>
</tr>
<tr>
<td>Quality of Job</td>
<td>Select your assessment from the drop-down menu.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter your comments, up to 4000 characters.</td>
</tr>
<tr>
<td>Cleanliness of Job Site</td>
<td>Select your assessment from the drop-down menu.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter your comments, up to 4000 characters.</td>
</tr>
<tr>
<td>Cost Management</td>
<td>Select your assessment from the drop-down menu.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter your comments, up to 4000 characters.</td>
</tr>
<tr>
<td>Compliance with Policies &amp; Procedures</td>
<td>Select your assessment from the drop-down menu.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter your comments, up to 4000 characters.</td>
</tr>
<tr>
<td><strong>Summary block</strong></td>
<td></td>
</tr>
<tr>
<td>Would you hire again?</td>
<td>Select either Yes or No from the drop-down menu.</td>
</tr>
<tr>
<td>Was contract terminated for cause?</td>
<td>Select either Yes or No from the drop-down menu.</td>
</tr>
<tr>
<td>Overall Evaluation</td>
<td>Enter your comments, up to 4000 characters.</td>
</tr>
</tbody>
</table>

### Routing a Vendors Evaluations Record from the Approval Step

#### To route a Vendors Evaluations record from the Approval step

1. Navigate to the **Company Workspace** tab, **Collaboration > Tasks**. The Tasks log opens.
2. In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.
   - The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.
   - The **Task Status** link opens the Workflow Progress window where you can see record and step details as well as access an image of the Vendors Evaluations Workflow.
3. Click the **Accept Task** button. The form dynamically changes to an Action Form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via **Actions > Undo Accept Task**.
4. When ready, select a workflow action. The choices are:
   - **Approve Vendor Eval** — this action sends the record to the **End** step in **Approved** status.
   - **Send for Revision** — this action sends the record back to the record creator in **Pending** status. The **To** field is preassigned and you can **Cc** anyone listed in Users/Groups. You can add instructions to the task recipient using **Task Notes**.
     a. Click **Cc...** The **User/Groups** picker opens and displays a list of available message recipients.
     b. Select the user or group who will receive the message when the record returns to the **Approval** step.
     c. Click **Add**.
     d. Click **OK**. The **User/Groups** picker closes and the selection appears in the **Cc...** field. Upon sending, the record copy will appear in the recipient's **Collaboration > Messages** log.
   - **Reject Vendor Eval** — this action sends the record to the **End** step in **Rejected** status.
5. In **Action Details**, select who should receive the record. **To...** is preassigned but you can select message recipients in the **Cc** field.
   a. Click **Cc...** Select the user or group who will receive the record on the next step.
b. Click Add.
c. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient’s Collaboration > Messages log.

6) When ready, click Send.

### Routing a Vendors Evaluations Record from the Revision Step
Upon sending the business process form forward to the Revision step, Unifier sends a task to the assignee. You can see your active tasks in your Tasks log. When your task is complete, you can select one of two Workflow Action options, as described on step 4.

1. Navigate to the Company Workspace tab, Collaboration > Tasks. The Tasks log opens.
2. In the Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.

   The View form displays Task Details in which you can see who sent you the task, the Task Due Date, Task Status, any Task Notes, and the current step in the workflow.

   The Task Status link opens the Workflow Progress window where you can see record and step details as well as access an image of the Vendors Evaluations Workflow (on page 386).
3. Click the Accept Task button. The form dynamically changes to an Action Form with editable fields. You can revise:
   - Title
   - Selected Vendor
4. When ready, select a workflow action. The choices are:
   - Resubmit for Approval — this action sends the record back to the Approval step in Pending status.
     a. Click To... The User/Groups picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the Approval step.
     c. Click Add.
     d. Click OK. The User/Group picker closes and the selection appears in the To field.
     e. (Optional) Click Cc... Select the user or group who will receive the record on the next step.
     f. Click Add.
     g. Click OK. The User/Group picker closes and the selection appears in the Cc field. Upon sending, the record will appear in the recipient’s Collaboration > Messages log.
   - Cancel Vendors Evaluations — This action sends the record to the End step in Canceled status.
5. When ready, click Send.

### Viewing a Vendors Evaluations Record on the End Step
This is the last step in the workflow. You cannot take action on this step. All form fields are read-only and the record is in a terminal status: Approved, Rejected, or Canceled. Once on the End step the record is viewable only in the business process log.
To view a Vendors Evaluations record on the End step

1) Go to the Company Workspace tab and click Company Logs in the left Navigator. Company logs display a list of the business processes that reside at the company level.

2) Click Vendors Evaluations. Unifier opens the business process log.
   When the record is on the End step, Task Details displays the text "Record has been closed."

3) Click the "Click here" link in Task Details to open the Workflow Progress Window. In the Progress Window you can see that the record is on the End step, as well as retrace the record's path in the workflow.

4) Click View Graphic to see an image of the workflow.
Work Releases Business Process

Purpose
This business process references the company-level Blanket Purchase Order business process.

Business process characteristics
This is a project-level, Cost-type business process with line items and workflow. An individual help file is available for this business process.

Record Statuses
- Pending, a non-terminal status
- Approved, a terminal status
- Rejected, a terminal status
- Canceled, a terminal status

Groups associated with this business process
- Creators create the business process and send it for approval.
- Members of the Reviewers group can approve the business process 'as is,' send it to the Revision step for clarification, evaluate the revision upon resubmission from the creator, and either approve or reject the Work Release record.
- Members of the All Project Users group can be copied on this business process.

Additional Information
- Step completion policy and resolving actions can differ between steps.
- Enabled for integration.
- Enabled for publish path.
  Files attached to business process forms or to line items will be automatically published to pre-defined folders in Unifier's Document Manager. Attachments in company-level business processes will be published to specified folders in Company Documents and those in project-level business processes will be published to folders in a project's Documents log.

Benefits
In Unifier, files that are attached to a business process form or to its line items from your computer or local system are uploaded, by default, to the Unpublished Documents folder in Document Manager when sent to the next workflow step or by clicking Finished Editing in non-workflow business processes. It requires administrators to publish them from there to the Documents folder. By establishing a publish path, file attachments are directly published to pre-designated folders in the Document Manager for team members to view, comment and collaborate.

Location
To view the published file attachments of a project-level business process record: In a project's Navigator, click Document Manager and select Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.
To view the published file attachments of a company-level business process record: In the Company Workspace Navigator, click Document Manager and select Company Documents. In the Folder panel, locate the pre-defined folder with the same name and view the published documents.

**In This Section**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Releases Business Process Workflow</td>
<td>394</td>
</tr>
<tr>
<td>Creating a Work Releases Record</td>
<td>394</td>
</tr>
<tr>
<td>Routing a Work Releases Record from the Approval Step</td>
<td>396</td>
</tr>
<tr>
<td>Routing a Work Releases Record from the Revision Step</td>
<td>397</td>
</tr>
<tr>
<td>Viewing a Work Releases Record on the End Step</td>
<td>398</td>
</tr>
</tbody>
</table>

**Work Releases Business Process Workflow**

Below are the four steps of the Work Releases business process workflow. The action you take on a step determines the record status on the next step; for example, if on the Revision step you select and send "Cancel Work Authorization" then the record moves to the **End** step with a record status of "Canceled." For all steps, except the **End** step, sending a record to the next step creates a task for the assignee.

**Creating a Work Releases Record**

Follow these steps to create a Work Releases business process. Members of the **Creator** group can create this business process.

- **To create a new Work Releases record**
  1. Navigate to the **All Projects** tab and select your project from the list located on the bottom of the landing page.
  2. Double-click your project to open it.
  3. On your project landing page, navigate to the **Collaboration > Tasks** log
  4. Click **New** and select **Work Releases** from the drop-down menu. A new Work Releases business process form opens.
5) Complete the Upper form according to the Upper form table below. You must enter a value in all required fields before you can send the record to the next step in the workflow. If you save the form before you send it, Unifier will save it in the Collaboration > Drafts folder.

6) In the Line Items section click Add or Grid. The Line Items form opens.

7) Complete the Line Items form according to the Line Items table below. You must complete all required fields before you can save the Line Items form.

8) Click OK (if using the Line Item form), or Save (if using the grid) to save the form. The Line Items form closes.
   If you are using the grid and do not click Save before closing it, you will lose your line item changes.

9) In Workflow Actions select the workflow action to take. In this case, your selection is Send for Approval. This selection activates Action Details.

10) In Action Details, select who should receive the record.
   a. Click To... The User/Groups picker opens that shows a list of available task recipients.
   b. Select the user or group who will receive the task on the Approval step.
   c. Click Add.
   d. Click OK. The User/Group picker closes and the selection appears in the To field. Upon sending, the record will appear in the recipients Collaboration > Tasks log.
   e. (Optional) Click Cc... and follow steps a - d. The record will appear in the recipients Collaboration > Messages log.

11) Click Send to route the record to the Approval step.

### Upper Form

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>General block</td>
<td></td>
</tr>
<tr>
<td>Record Number</td>
<td>This is a read-only field that Unifier populates when you send the form to the Approval step.</td>
</tr>
<tr>
<td>Title*</td>
<td>This is a required field - Enter a name for the record.</td>
</tr>
<tr>
<td>Project Number</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Project Name</td>
<td>This field is auto-populated from the project.</td>
</tr>
<tr>
<td>Reference BPO*</td>
<td>This is a required field - Select the Blanket Purchase Order against which this Work Releases record will reference.</td>
</tr>
<tr>
<td>Spec Section</td>
<td>Select a Spec Section from the drop down menu.</td>
</tr>
<tr>
<td>Creator</td>
<td>This is a read-only field that identifies the person that created the record. The field appears as a link to the creator's contact information.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>This is a read-only field that Unifier populates when you send the record to the next step in the routing.</td>
</tr>
<tr>
<td>In this field</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due Date</td>
<td>This is a read-only field. Due Date is pre-populated to reflect the number of days you have to finish routing the record. If the record becomes late, Unifier displays the record Title in bold red.</td>
</tr>
<tr>
<td>Status</td>
<td>This read-only field is blank while on the Creation step. The status will change when the task is accepted on the next step in the workflow.</td>
</tr>
<tr>
<td>Amount</td>
<td>This is an auto-calculated field that shows the total amount of the line items in transaction currency.</td>
</tr>
<tr>
<td>Contract Type</td>
<td>This is a required field - Enter the contract number.</td>
</tr>
</tbody>
</table>

**Vendor Details block**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor ID</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Address 1</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Address 3</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>State/Province</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Email</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Phone</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Fax</td>
<td>This field is auto-populated from the reference BPO selection.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the Work Releases record.</td>
</tr>
</tbody>
</table>

**Routing a Work Releases Record from the Approval Step**

To route a Work Releases record from the Approval step

1. Navigate to the All Projects tab and select your project from the log located near the bottom of the landing page.
2. Double-click your project to open it.
3. On your project landing page, navigate to the Collaboration > Tasks log
4) The Tasks log lists all of your open tasks. Tasks in bold black font are new; tasks in red font are late.

5) Double click on the **Work Releases** task in the Tasks log. The view-only form displays all fields on the record.
   - The Upper Form contains project information, including the record number and title.
   - The Task Details section displays who sent the record, who can take action on the record, who was copied on the record, the step to which the record was sent, the task due date, the task status, and any task notes.

6) When ready, click **Accept Task**. The View form dynamically changes to an Action form.
   - You cannot make changes to the Action form when you are on the Approval step.
   - You can add **Task Notes** for the next step, but you cannot view previous Task Notes.
   - If you want to revisit Task Notes from the previous step, you must undo Accept Task via Actions > Undo Accept Task.

7) Review the Contracts record and determine the appropriate course of action.

8) In the toolbar at the top right of the form, click the **Workflow Actions** drop-down menu. You may select:
   - **Approve Work Authorization** — this selection will send the record to the End step in Approved status.
   - **Send for Revision** — this action keeps the workflow in flight and in Pending status.
     a. In the **Action Details** section **To...** is preassigned, but you can select message recipients in the Cc field.
     b. Click **Cc...** Select the user or group who will receive the record on the next step.
     c. Click **Add**.
     d. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's Collaboration > Messages log.
   - **Reject Work Authorization** — this selection will send the record to the End step in Rejected status.

9) (Optional) Add comments to the record through **General Comments** or **Task Notes**.
   - To add General Comments click the link at the bottom center of the form. These comments are permanent.
   - To add Task Notes click the icon in the Action Details section of the form. Task Notes will be visible on the View form at the next step in the workflow until the task assignee accepts the task.

10) Click **Send**.

### Routing a Work Releases Record from the Revision Step

Upon sending the business process record forward to the Revision step, Unifier sends a task to the record creator and a message to those selected in the Cc field. You can see your active tasks in your Tasks log.

- **To route a record from the Revision step**

1) Navigate to the **All Projects** tab and select your project from the Projects log near the bottom of the landing page.
2) Double-click your project to open it.

3) On your project landing page, navigate to the **Collaboration > Tasks** log. The Tasks log opens. Tasks that you have not yet accepted are shown in bold.

4) In your Tasks log, double-click the record to open it. The business process form opens for viewing; you must accept the task before you can act on it.

   The View form displays **Task Details** in which you can see who sent you the task, the **Task Due Date**, **Task Status**, any **Task Notes**, and the current step in the workflow.

   The **Task Status** link opens the Workflow Progress window where you can see record and step details as well as access an image of the workflow.

5) Click the **Accept Task** button. The form dynamically changes to an Action Form. In the Upper form you can:
   - Change the record **Title** in the **General** block
   - Change the Description in the **Description** block

   In **Line Items** you can:
   - Modify any existing line items.
   - Add additional line items.
   - Remove Line Items.

   For line item modification, follow the same directions as adding line items during record creation, and then click **OK** to save any line item changes.

6) When ready, select a workflow action. This action activates **Action Details**. The choices are:
   - **Resubmit for Approval** — This action sends the record back to the Approval step in Pending status.
     a. Click **To**... The **User/Groups** picker opens and displays a list of available task recipients.
     b. Select the user or group who will receive the task when the record returns to the **Approval** step.
     c. Click **Add**.
     d. Click **OK**. The **User/Group** picker closes and the selection appears in the **To** field.
     e. (Optional) Click **Cc**... Select the user or group who will receive the record on the next step.
     f. Click **Add**.
     g. Click **OK**. The **User/Group** picker closes and the selection appears in the **Cc** field. Upon sending, the record will appear in the recipient's **Collaboration > Messages** log.

   - **Cancel Work Authorization** — This action sends the record to the End step in Canceled status. The To and Cc field are unavailable.

7) In **Action Details**, select who should receive the task and who should receive a copy of the record in **Collaboration > Messages**.

8) When ready, click **Send**.

### Viewing a Work Releases Record on the End Step

This is the last step in the workflow. You cannot take action on this step. All form fields are read-only and the record is in a terminal status: Approved, Rejected, or Canceled. Once on the **End** step the record is viewable only in the business process log.
To view a Work Releases record on the End step

1) Navigate to the All Projects tab and select your project from the Projects log on the bottom of the All Projects landing page. Your project opens.

2) Navigate to Cost Controls > Work Releases. The Work Releases log opens.

3) Double-click a record to open it. In the business process record you can see the record status. When the record is on the End step, Task Details displays the text "Record has been closed."

4) Click the "Click here" link. The Workflow Progress window opens. This is where you can trace the record's progress through the workflow.

5) Click View Graphic to see an image of the workflow.

For More Information

Where to Get Documentation

If you need help with an operation in Primavera Unifier, there are a number of resources to help you.

Online Help

If you have a question or need further assistance regarding a specific feature, review the online help.

Click the Help menu from any Primavera Unifier window, and choose:

- **Unifier Help**: This link goes to the Oracle Technical Network (OTN) Primavera Unifier Online Document Library. From here you can access:
  - Primavera Unifier Online Help
  - Primavera Unifier Administration Guide
  - Primavera Unifier User’s Guide
  - Primavera uDesigner User’s Guide
  - Primavera Unifier Reference Guide

  You must have Adobe Acrobat Reader installed (available free at www.adobe.com).

- **BP-specific Help**: If your company has provided customized Help files for individual business processes, you can access them through the business process log or the Help menu.

  **Note**: For the full list of system requirements, supported software, and versions, see the Tested Configurations document under "Installation and Configuration Documentation" in the Primavera Unifier Online Documentation Library.

Documentation

Complete documentation libraries for Primavera Unifier releases are available on the Oracle Technology Network (OTN) at:
From this location you can either view libraries online or download them to have local copies. We recommend viewing them from OTN to ensure you always access the latest versions, including critical corrections and enhancements.

Primavera Unifier is configured to access its help system directly on OTN. However, a downloadable version of the help system is also available on OTN if you need to download, deploy, and access a local copy.

The documentation assumes a standard setup of the product, with full access rights to all features and functions.

The following table describes the core documents available for Primavera Unifier.

### Supplementary Documentation

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What's New</strong></td>
<td>Contains key enhancements in the current release of Primavera Unifier. All users should read this guide.</td>
</tr>
<tr>
<td><strong>Cumulative Features Overview Tool</strong></td>
<td>Provides an overview of features and enhancements included in Oracle Primavera products. It is intended solely to help you assess the business benefits of upgrading and to plan your I.T. projects. All users should read this guide.</td>
</tr>
<tr>
<td><strong>Readme for Media Pack</strong></td>
<td>Contains a table that can help you determine what downloads are required to run your licenses. All users should read this guide.</td>
</tr>
<tr>
<td><strong>Licensing Information User Manual</strong></td>
<td>Contains information about the third-party proprietary and open source software used in Oracle Primavera Unifier. All users should read this guide.</td>
</tr>
<tr>
<td><strong>Where to Get Documentation, Training, and Support</strong></td>
<td>Contains information about resources to help you with the operation of Oracle Primavera Unifier. All users should read this guide.</td>
</tr>
</tbody>
</table>
### Installation Documentation

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Primavera Unifier Installation and Setup Guide For WebLogic Application Server** | Describes how to:  
- Set up Primavera Unifier servers and third party services  
- Install and configure Primavera Unifier components  
IT professionals who are installing and configuring the server environment, and the Primavera Unifier network administrator/database administrator and Primavera Unifier administrator should read this guide. |
| **Primavera Unifier Installation and Setup Guide for WebSphere Application Server** | Describes how to:  
- Set up the Primavera Unifier servers and third party services on Linux (64-bit)  
- Install and configure Primavera Unifier components  
IT professionals who are installing and configuring the server environment, and the Primavera Unifier network administrator/database administrator and Primavera Unifier administrator should read this guide. |
| **Unifier Performance and Sizing Guide**                              | Provides guidance for planning product deployment with:  
- Estimates of hardware and software requirements for Primavera Unifier  
- Recommendations for deploying small-scale to large-scale configurations  
The Unifier network administrator/database administrator and Unifier administrator should read this guide. |
| **Unifier Upgrade Guide**                                             | Provides information on how to upgrade to the latest version of with Oracle Primavera Unifier.  
The Unifier network administrator/database administrator and Unifier administrator should read this guide. |
## Tested Configurations

**Previously: System Configuration Information**

Provides the tested configurations for Oracle Primavera Unifier and includes list of applications and supported version levels.

All users should read this guide.

The Unifier network administrator/database administrator and Unifier administrator should read this guide.

## Primavera Unifier Security Guide

Provides guidelines on how to plan your security strategy for Oracle Primavera Unifier.

All users should read this guide.

The Unifier network administrator/database administrator and Unifier administrator should read this guide.

## Configuration Documentation

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primavera uClient Configurator Setup Guide</td>
<td>Describes how to set up the Primavera uClient Configurator. All users should read this guide.</td>
</tr>
<tr>
<td>Primavera Unifier SmartForm Installation and User Guide</td>
<td>Describes how to download and install the Primavera Unifier SmartForm utility for Microsoft Word® 2003 Professional and how to use the SmartForm utility to create or update Primavera Unifier business process records. <strong>Note:</strong> If you use Microsoft Word® 2007 it must be a version prior to SP2 and you must save your document in Microsoft Word® 2003 (.doc) format. All users should read this guide.</td>
</tr>
<tr>
<td>Primavera Unifier File Transfer Utility Instructions</td>
<td>Describes how to download and install the Primavera Unifier File Transfer Utility.</td>
</tr>
<tr>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>uCAD Installation and User’s Guide</strong></td>
<td>Provides instructions on how to download and install the Primavera Unifier uCAD Application on your desktop and configure it to work with your AutoCAD® application. It also includes details on how to use uCAD with AutoCAD and Primavera Unifier. All users should read this guide.</td>
</tr>
</tbody>
</table>
| **Configuring BI Publisher for Unifier**       | Provides instructions on how to:  
  - Download BI Publisher.  
  - Configure BI Publisher settings.  
  - Configure BI Publisher in Primavera Unifier.  
  - Create BI Publisher reports.  
  - Run BI Publisher reports.  
  The Primavera Unifier network administrator/database administrator and Primavera Unifier administrator should read this guide. |
| **Configuring Unifier for Single Sign On**     | Provides procedures to configure Primavera Unifier that is running on Windows (64-bit) or on Linux operating systems for Single Sign On (SSO).  
  The Primavera Unifier network administrator/database administrator and Primavera Unifier administrator should read this guide. |
| **Connecting Oracle Enterprise Manager to Primavera Unifier Metrics** | Provides instructions on how to enable Enterprise Manager to display certain Primavera Unifier metrics.  
  The Primavera Unifier network administrator/database administrator and Primavera Unifier administrator should read this guide. |
| **Connecting Oracle Identity Manager 11g to Primavera Unifier** | Guides administrators in configuring Oracle Identity Manager (OIM) to be used with Primavera Unifier.  
  The Primavera Unifier network administrator/database administrator and Primavera Unifier administrator should read this guide. |
### Connecting the Content Repository to Primavera Unifier

Provides instructions on how to:

- Configure Oracle WebCenter Content Core Capabilities after you install it.
- Configure Microsoft SharePoint after you install it.
- Configure CMIS-compliant repositories after you install one.
- Configure the Primavera Unifier File Repository.
- Set your content repository settings in Primavera Unifier to connect to your content repository.

The Primavera Unifier network administrator/database administrator and Primavera Unifier administrator should read this guide.

---

### User Documentation

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primavera Unifier Help</strong></td>
<td>Provides topic-oriented information about Primavera Unifier to assist users with features and procedures. All users should read this guide.</td>
</tr>
<tr>
<td><strong>Primavera Unifier User's Guide</strong></td>
<td>Guides users on how to use Primavera Unifier application. All users should read this guide.</td>
</tr>
<tr>
<td><strong>Primavera uDesigner User's Guide</strong></td>
<td>Guides users on how to use the uDesigner feature of Primavera Unifier application. All users should read this guide.</td>
</tr>
<tr>
<td><strong>Primavera Unifier Administration Guide</strong></td>
<td>Provides details about the Administration Mode of Primavera Unifier, which covers access to Primavera Unifier functionality that is granted through permissions. All users should read this guide.</td>
</tr>
</tbody>
</table>
Primavera Unifier Project Controls User's Guide

Explains Oracle Primavera:

- Capital Planning which is used for managing budget forecasts (both planned and in execution) for the user company.
- Cost Controls which supports project tracking and project cost management.
- Project Delivery Management which is designed to optimize project results.

Anyone who wants to use the Unifier Project Controls base product should read this guide.

Database Documentation

Primavera Unifier Reference Guide

Provides details about data definitions, data elements, permission settings, import codes, and pickers with Primavera Unifier. All users should read this guide.

Integration Documentation

Primavera Unifier Integration Interface Guide

Describes the methods required for the integration, and the data being passed, between Primavera Unifier and an external system.

Anyone who wants to develop applications which interact with Primavera Unifier should read this guide.

Distributing Information to the Team

You can copy the online documentation to a network drive for access by project participants. Each team member can then view or print those portions that specifically relate to his or her role in the organization.
**Where to Get Training**

To access comprehensive training for all Primavera products, go to: http://education.oracle.com

**Oracle Learning Library**

The Oracle Learning Library (OLL) provides online learning content covering Primavera products. Content includes whitepapers, videos, tutorials, articles, demos, step-by-step instructions to accomplish specific tasks, and self-paced interactive learning modules.

To access the learning library’s Primavera content, go to: http://www.oracle.com/oll/primavera

**Where to Get Support**

If you have a question about using Oracle products that you or your network administrator cannot resolve with information in the documentation or help, click http://support.oracle.com/. This page provides the latest information on contacting Oracle Global Customer Support, knowledge articles, and the support renewals process. For more information about working with Support, visit https://support.oracle.com/epmos/faces/DocumentDisplay?id=888813.2 to view **Support Tools & Tips**.

**Access to Oracle Support**

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/us/support/contact-068555.html or visit http://www.oracle.com/us/corporate/accessibility/support/index.html if you are hearing impaired.

**Using Primavera’s Support Resource Centers**

Primavera’s Support Resource Center provides links to important support and product information. Primavera’s Product Information Centers (PICs) organize documents found on My Oracle Support (MOS), providing quick access to product and version specific information such as important knowledge documents, Release Value Propositions, and Oracle University training. PICs also offer documentation on Lifetime Management, from planning to installs, upgrades, and maintenance.

Visit https://support.oracle.com/epmos/faces/DocumentDisplay?id=1486951.1 to access links to all of the current PICs.

PICs also provide access to:

- **Communities**, which are moderated by Oracle providing a place for collaboration among industry peers to share best practices.
- **News** from our development and strategy groups.
- **Education** via a list of available Primavera product trainings through Oracle University. The Oracle Advisor Webcast program brings interactive expertise straight to the desktop using Oracle Web Conferencing technology. This capability brings you and Oracle experts together to access information about support services, products, technologies, best practices, and more.
Additional Support

The following is a list of additional support that are available in Unifier:

- Unifier Help
- Unifier Library
- Contact Support
- Download Plugins
- About Unifier

**Note:** The Contact Support and Download Plugins options both open a single window, Support. The only difference is as follows:
- Contact Support opens the *Contact* tab of the Support window by default
- Download Plugins opens the *Download* tab of the Support window by default

**Unifier Help**

Click *Help* from the upper right-hand section of the Unifier window to open a contextual menu and click *Unifier Help* to open the Unifier and uDesigner Help.

**Unifier Library**

Click *Help* from the upper right-hand section of the Unifier window to open a contextual menu and click *Unifier Library* to open the Unifier documentation library.

**Contact Support**

Click *Help* from the upper right-hand section of the Unifier window to open a contextual menu and click *Contact Support* to open the Support window.

The Support window has two tabs:

- Contact, which opens by default
- Download

In the Contact tab, Contact Information section, you can see the name, phone, and contact instructions of someone at your company that you can contact when you need help with Primavera Unifier. For assistance, try this person, first.

**Note:** This information is available only if your company administrator has provided internal support contact information.

In the Contact tab, eLearning section, you see the location (Access), name of the contact (Contact), and any instructions that you might need in order to access the eLearning materials.
Note: Your company may elect to provide access to the eLearning suite, where you can access interactive Primavera Unifier learning materials. Alternatively, your company may have its own customized support or training materials that can be accessed on an internal site/location. If your company administrator provides this contact information, it will be listed at the bottom of the window.

In the Download tab, Download section, you can see a list of the following application and plug-ins available to download, with installation instructions.

- File Transfer Application
- Unifier uCAD Plug-in

Each application and plug-in has two options:

- Download
- Installation instructions

Follow the links within each option to proceed.

**Download Plugins**

Click Help from the upper right-hand section of the Unifier window to open a contextual menu and click **Download Plugins** to open the Support window.

The Support window has two tabs:

- Contact
- Download, which opens by default

In the Download tab, Download section, you can see a list of the following application and plug-ins available to download, with installation instructions.

- File Transfer Application
- Unifier uCAD Plug-in

Each application and plug-in has two options:

- Download
- Installation instructions

Follow the links within each option to proceed.

In the Contact tab, Contact Information section, you can see the name, phone, and contact instructions of someone at your company that you can contact when you need help with Primavera Unifier. For assistance, try this person, first.

**Note:** This information is available only if your company administrator has provided internal support contact information.

In the Contact tab, eLearning section, you see the location (Access), name of the contact (Contact), and any instructions that you might need in order to access the eLearning materials.
Note: Your company may elect to provide access to the eLearning suite, where you can access interactive Primavera Unifier learning materials. Alternatively, your company may have its own customized support or training materials that can be accessed on an internal site/location. If your company administrator provides this contact information, it will be listed at the bottom of the window.

About Unifier

Click Help from the upper right-hand section of the Unifier window to open a contextual menu and click About Unifier to access version number, copyright information, and software agreement details for the Oracle Primavera Unifier.
Legal Notices

Oracle Primavera Primavera Unifier Project Controls User's Guide

Copyright © 1998, 2014, Oracle and/or its affiliates. All rights reserved. Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are “commercial computer software” pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate failsafe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

This software or hardware and documentation may provide access to or information on content, products and services from third-parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.